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Preface
Welcome to the IAR C/C++ Development Guide for SH. The purpose of this 
guide is to provide you with detailed reference information that can help you 
to use the build tools to best suit your application requirements. This guide 
also gives you suggestions on coding techniques so that you can develop 
applications with maximum efficiency.

Who should read this guide
Read this guide if you plan to develop an application using the C or C++ language for 
the SH microprocessor and need detailed reference information on how to use the build 
tools. You should have working knowledge of:

● The architecture and instruction set of the SH microprocessor. Refer to the 
documentation from Renesas for information about the SH microprocessor

● The C or C++ programming language

● Application development for embedded systems

● The operating system of your host computer.

How to use this guide 
When you start using the IAR C/C++ compiler and linker for SH, you should read Part 
1. Using the build tools in this guide.

When you are familiar with the compiler and linker and have already configured your 
project, you can focus more on Part 2. Reference information.

If you are new to using the IAR Systems build tools, we recommend that you first study 
the IAR Embedded Workbench® IDE User Guide. This guide contains a product 
overview, tutorials that can help you get started, conceptual and user information about 
the IDE and the IAR C-SPY® Debugger, and corresponding reference information.
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What this guide contains
What this guide contains 
Below is a brief outline and summary of the chapters in this guide.

Part 1. Using the build tools

● Introduction to the IAR build tools gives an introduction to the IAR build tools, 
which includes an overview of the tools, the programming languages, the available 
device support, and extensions provided for supporting specific features of the SH 
microprocessor.

● Developing embedded applications gives the information you need to get started 
developing your embedded software using the IAR build tools.

● Data storage describes how to store data in memory, focusing on the different data 
models and data memory type attributes. 

● Functions gives a brief overview of function-related extensions—mechanisms for 
controlling functions—and describes some of these mechanisms in more detail.

● Linking using ILINK describes the linking process using the IAR ILINK Linker and 
the related concepts.

● Linking your application lists aspects that you must consider when linking your 
application, including using ILINK options and tailoring the linker configuration 
file.

● The DLIB runtime environment describes the DLIB runtime environment in which 
an application executes. It covers how you can modify it by setting options, 
overriding default library modules, or building your own library. The chapter also 
describes system initialization introducing the file cstartup, how to use modules 
for locale, and file I/O.

● Assembler language interface contains information required when parts of an 
application are written in assembler language. This includes the calling convention.

● Using C gives an overview of the two supported variants of the C language and an 
overview of the compiler extensions, such as extensions to Standard C.

● Using C++ gives an overview of the two levels of C++ support: The 
industry-standard EC++ and IAR Extended EC++.

● Application-related considerations discusses a selected range of application issues 
related to using the compiler and linker.

● Efficient coding for embedded applications gives hints about how to write code that 
compiles to efficient code for an embedded application.

Part 2. Reference information

● External interface details provides reference information about how the compiler 
and linker interact with their environment—the invocation syntax, methods for 
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passing options to the compiler and linker, environment variables, the include file 
search procedure, and the different types of compiler and linker output. The chapter 
also describes how the diagnostic system works.

● Compiler options explains how to set options, gives a summary of the options, and 
contains detailed reference information for each compiler option.

● Linker options gives a summary of the options, and contains detailed reference 
information for each linker option.

● Data representation describes the available data types, pointers, and structure types. 
This chapter also gives information about type and object attributes.

● Extended keywords gives reference information about each of the SH-specific 
keywords that are extensions to the standard C/C++ language.

● Pragma directives gives reference information about the pragma directives.

● Intrinsic functions gives reference information about functions to use for accessing 
SH-specific low-level features.

● The preprocessor gives a brief overview of the preprocessor, including reference 
information about the different preprocessor directives, symbols, and other related 
information.

● Library functions gives an introduction to the C or C++ library functions, and 
summarizes the header files. 

● The linker configuration file describes the purpose of the linker configuration file 
and describes its contents.

● Section reference gives reference information about the use of sections.

● IAR utilities describes the IAR utilities that handle the ELF and DWARF object 
formats.

● Implementation-defined behavior describes how the compiler handles the 
implementation-defined areas of the C language standard.

Other documentation
The complete set of IAR Systems development tools for the SH microprocessor is 
described in a series of guides. For information about:

● Using the IDE and the IAR C-SPY Debugger®, refer to the IAR Embedded 
Workbench® IDE User Guide

● Programming for the IAR Assembler for SH, refer to the IAR Assembler Reference 
Guide for SH

● Using the IAR DLIB Library functions, refer to the online help system
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Document conventions
● Using the MISRA-C:1998 rules or the MISRA-C:2004 rules, refer to the IAR 
Embedded Workbench® MISRA C:1998 Reference Guide or the IAR Embedded 
Workbench® MISRA C:2004 Reference Guide, respectively.

All of these guides are delivered in hypertext PDF or HTML format on the installation 
media.

FURTHER READING

These books might be of interest to you when using the IAR Systems development tools: 

● Barr, Michael, and Andy Oram, ed. Programming Embedded Systems in C and 
C++ . O’Reilly & Associates. 

● Harbison, Samuel P. and Guy L. Steele (contributor). C: A Reference Manual. 
Prentice Hall.

● Kernighan, Brian W. and Dennis M. Ritchie. The C Programming Language. 
Prentice Hall.

● Labrosse, Jean J. Embedded Systems Building Blocks: Complete and Ready-To-Use 
Modules in C. R&D Books.

● Lippman, Stanley B. and Josée Lajoie. C++ Primer. Addison-Wesley.

● Mann, Bernhard. C für Mikrocontroller. Franzis-Verlag. [Written in German.]

● Stroustrup, Bjarne. The C++ Programming Language. Addison-Wesley.

● Stroustrup, Bjarne. Programming Principles and Practice Using C++. 
Addison-Wesley.

We recommend that you visit these web sites:

● The Renesas web site, www.renesas.com, contains information and news about the 
SH microprocessors.

● The IAR Systems web site, www.iar.com, holds application notes and other 
product information.

● Finally, the Embedded C++ Technical Committee web site, 
www.caravan.net/ec2plus, contains information about the Embedded C++ 
standard.

Document conventions 
When, in this text, we refer to the programming language C, the text also applies to C++, 
unless otherwise stated.

When referring to a directory in your product installation, for example sh\doc, the full 
path to the location is assumed, for example c:\Program Files\IAR 
Systems\Embedded Workbench 6.n\sh\doc.
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TYPOGRAPHIC CONVENTIONS

This guide uses the following typographic conventions:

NAMING CONVENTIONS

The following naming conventions are used for the products and tools from IAR 
Systems® referred to in this guide:

Style Used for

computer • Source code examples and file paths.
• Text on the command line.
• Binary, hexadecimal, and octal numbers.

parameter A placeholder for an actual value used as a parameter, for example 
filename.h where filename represents the name of the file.

[option] An optional part of a command, where [] is part of the described 
syntax.

{option} A mandatory part of a command, where {} is part of the described 
syntax.

[option] An optional part of a command.

a|b|c Alternatives in a command.

{a|b|c} A mandatory part of a command with alternatives.

bold Names of menus, menu commands, buttons, and dialog boxes that 
appear on the screen.

italic • A cross-reference within this guide or to another guide.
• Emphasis.

… An ellipsis indicates that the previous item can be repeated an arbitrary 
number of times.

Identifies instructions specific to the IAR Embedded Workbench® IDE 
interface.

Identifies instructions specific to the command line interface.

Identifies helpful tips and programming hints.

Identifies warnings.

Table 1: Typographic conventions used in this guide

Brand name Generic term

IAR Embedded Workbench® for SH IAR Embedded Workbench®

Table 2: Naming conventions used in this guide
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IAR Embedded Workbench® IDE for SH the IDE

IAR C-SPY® Debugger for SH C-SPY, the debugger

IAR C-SPY® Simulator the simulator

IAR C/C++ Compiler™ for SH the compiler

IAR Assembler™ for SH the assembler

IAR ILINK™ Linker ILINK, the linker

IAR DLIB Library™ the DLIB library

Brand name Generic term

Table 2: Naming conventions used in this guide (Continued)
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Part 1. Using the build 
tools
This part of the IAR C/C++ Development Guide for SH includes these chapters:

● Introduction to the IAR build tools

● Developing embedded applications

● Data storage

● Functions

● Linking using ILINK

● Linking your application

● The DLIB runtime environment

● Assembler language interface

● Using C

● Using C++

● Application-related considerations

● Efficient coding for embedded applications.
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Introduction to the IAR 
build tools
This chapter gives an introduction to the IAR build tools for the SH 
microprocessor, which means you will get an overview of:

● The IAR build tools—the build interfaces, compiler, assembler, and linker

● The programming languages

● The available device support

● The extensions provided by the IAR C/C++ Compiler for SH to support 
specific features of the SH microprocessor.

The IAR build tools—an overview
In the IAR product installation you can find a set of tools, code examples, and user 
documentation, all suitable for developing software for SH-based embedded 
applications. The tools allow you to develop your application in C, C++, or in assembler 
language.

IAR Embedded Workbench® is a very powerful Integrated Development Environment 
(IDE) that allows you to develop and manage complete embedded application projects. 
It provides an easy-to-learn and highly efficient development environment with 
maximum code inheritance capabilities, comprehensive and specific target support. IAR 
Embedded Workbench promotes a useful working methodology, and thus a significant 
reduction of the development time.

The compiler, assembler, and linker can also be run from a command line environment, 
if you want to use them as external tools in an already established project environment.

IAR C/C++ COMPILER

The IAR C/C++ Compiler for SH is a state-of-the-art compiler that offers the standard 
features of the C and C++ languages, plus extensions designed to take advantage of the 
SH-specific facilities.
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The IAR build tools—an overview
IAR ASSEMBLER

The IAR Assembler for SH is a powerful relocating macro assembler with a versatile set 
of directives and expression operators. The assembler features a built-in C language 
preprocessor and supports conditional assembly.

THE IAR ILINK LINKER

The IAR ILINK Linker is a powerful, flexible software tool for use in the development 
of embedded controller applications. It is equally well suited for linking small, 
single-file, absolute assembler programs as it is for linking large, relocatable input, 
multi-module, C/C++, or mixed C/C++ and assembler programs.

SPECIFIC ELF TOOLS

Because ILINK both uses and produces industry-standard ELF and DWARF as object 
format, additional IAR utilities that handle these formats can be used:

● The IAR Archive Tool—iarchive—creates and manipulates a library (archive) of 
several ELF object files

● The IAR ELF Tool—ielftool—performs various transformations on an ELF 
executable image (such as, fill, checksum, format conversion etc)

● The IAR SH ELF Dumper—ielfdumpsh—creates a text representation of the 
contents of an ELF relocatable or executable image

● The IAR ELF Object Tool—iobjmanip—is used for performing low-level 
manipulation of ELF object files

● The IAR Absolute Symbol Exporter—isymexport—exports absolute symbols 
from a ROM image file, so that they can be used when linking an add-on 
application.

EXTERNAL TOOLS

For information about how to extend the tool chain in the IDE, see the IAR Embedded 
Workbench® IDE User Guide.
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IAR language overview
There are two high-level programming languages you can use with the IAR C/C++ 
Compiler for SH:

● C, the most widely used high-level programming language in the embedded systems 
industry. You can build freestanding applications that follow either one of the 
following standards:

● The standard ISO/IEC 9899:1999 (including technical corrigendum No.3), also 
known as C99. Hereafter, this standard is referred to as Standard C in this guide.

● The standard ISO 9899:1990 (including all technical corrigenda and addendum), 
also known as C94, C90, C89, and ANSI C. Hereafter, this standard is referred to 
as C89 in this guide. This standard is required when MISRA C is enabled.

● C++, a modern object-oriented programming language with a full-featured library 
well suited for modular programming. IAR Systems supports two levels of the C++ 
language: 

● Embedded C++ (EC++), a subset of the C++ programming standard, which is 
intended for embedded systems programming. It is defined by an industry 
consortium, the Embedded C++ Technical committee. See the chapter Using 
C++.

● IAR Extended Embedded C++, with additional features such as full template 
support, multiple inheritance, namespace support, the new cast operators, as well 
as the Standard Template Library (STL).

Each of the supported languages can be used in strict or relaxed mode, or relaxed with 
IAR extensions enabled. The strict mode adheres to the standard, whereas the relaxed 
mode allows some deviations from the standard.

For more information about C, see the chapter Using C.

For more information about the Embedded C++ language and Extended Embedded 
C++, see the chapter Using C++.

For information about how the compiler handles the implementation-defined areas of 
the C language, see the chapter Implementation-defined behavior.

It is also possible to implement parts of the application, or the whole application, in 
assembler language. See the IAR Assembler Reference Guide for SH.
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Device support
Device support
To get a smooth start with your product development, the IAR product installation 
comes with wide range of device-specific support.

SUPPORTED SH DEVICES

The IAR C/C++ Compiler for SH supports all SH2A devices, including devices with a 
hardware floating-point unit.

PRECONFIGURED SUPPORT FILES

The IAR product installation contains preconfigured files for supporting different 
devices. If you need additional files for device support, they can be created using one of 
the provided ones as a template.

Header files for I/O

Standard peripheral units are defined in device-specific I/O header files with the 
filename extension h. The product package supplies I/O files for all devices that are 
available at the time of the product release. You can find these files in the sh\inc 
directory. Make sure to include the appropriate include file in your application source 
files.

Linker configuration files

The sh\config\linker directory contains ready-made linker configuration files for 
all supported devices. The files have the filename extension icf and contain the 
information required by ILINK. To read more about the linker configuration file, see 
Placing code and data—the linker configuration file, page 74, and for reference 
information, the chapter The linker configuration file.

Device description files

The debugger handles several of the device-specific requirements, such as definitions of 
peripheral registers and groups of these, by using device description files. These files are 
located in the sh\config\debugger directory and they have the filename extension 
ddf. To read more about these files, see the IAR Embedded Workbench® IDE User 
Guide.

EXAMPLES FOR GETTING STARTED

The sh\examples directory contains examples of working applications to give you a 
smooth start with your development.
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Special support for embedded systems
This section briefly describes the extensions provided by the compiler to support 
specific features of the SH microprocessor.

EXTENDED KEYWORDS

The compiler provides a set of keywords that can be used for configuring how the code 
is generated. For example, there are keywords for controlling the memory type for 
individual variables as well as for declaring special function types.

By default, language extensions are enabled in the IDE.

The command line option -e makes the extended keywords available, and reserves them 
so that they cannot be used as variable names. See, -e, page 213 for additional 
information. 

For detailed descriptions of the extended keywords, see the chapter Extended keywords.

PRAGMA DIRECTIVES

The pragma directives control the behavior of the compiler, for example how it allocates 
memory, whether it allows extended keywords, and whether it issues warning messages. 

The pragma directives are always enabled in the compiler. They are consistent with 
Standard C, and are very useful when you want to make sure that the source code is 
portable.

For detailed descriptions of the pragma directives, see the chapter Pragma directives.

PREDEFINED SYMBOLS

With the predefined preprocessor symbols, you can inspect your compile-time 
environment, for example time of compilation, and the code and data models.

For detailed descriptions of the predefined symbols, see the chapter The preprocessor.

SPECIAL FUNCTION TYPES

The special hardware features of the SH microprocessor are supported by the compiler’s 
special function types: interrupt, monitor, TBR, and trap. You can write a complete 
application without having to write any of these functions in assembler language.

For detailed information, see Primitives for interrupts, concurrency, and OS-related 
programming, page 65.
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Special support for embedded systems
ACCESSING LOW-LEVEL FEATURES

For hardware-related parts of your application, accessing low-level features is essential. 
The compiler supports several ways of doing this: intrinsic functions, mixing C and 
assembler modules, and inline assembler. For information about the different methods, 
see Mixing C and assembler, page 125.
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applications
This chapter provides the information you need to get started developing your 
embedded software for the SH microprocessor using the IAR build tools.

First, you will get an overview of the tasks related to embedded software 
development, followed by an overview of the build process, including the steps 
involved for compiling and linking an application.

Next, the program flow of an executing application is described.

Finally, you will get an overview of the basic settings needed for a project.

Developing embedded software using IAR build tools
Typically, embedded software written for a dedicated microcontroller is designed as an 
endless loop waiting for some external events to happen. The software is located in 
ROM and executes on reset. You must consider several hardware and software factors 
when you write this kind of software.

MAPPING OF INTERNAL AND EXTERNAL MEMORY

Embedded systems typically contain various types of memory, such as on-chip RAM, 
external DRAM or SRAM, ROM, EEPROM, or flash memory.

As an embedded software developer, you must understand the features of the different 
memory types. For example, on-chip RAM is often faster than other types of memories, 
and variables that are accessed often would in time-critical applications benefit from 
being placed here. Conversely, some configuration data might be accessed seldom but 
must maintain their value after power off, so they should be saved in EEPROM or flash 
memory.

For efficient memory usage, the compiler provides several mechanisms for controlling 
placement of functions and data objects in memory. For an overview see Controlling 
data and function placement in memory, page 173. The linker places sections of code in 
memory according to the directives you specify in the linker configuration file, see 
Placing code and data—the linker configuration file, page 74.
DSH-2

Part 1. Using the build tools 41



42

Developing embedded software using IAR build tools
COMMUNICATION WITH PERIPHERAL UNITS

If external devices are connected to the microcontroller, you might need to initialize and 
control the signalling interface, for example by using chip select pins, and detect and 
handle external interrupt signals. Typically, this must be initialized and controlled at 
runtime. The normal way to do this is to use special function registers, or SFRs. These 
are typically available at dedicated addresses, containing bits that control the chip 
configuration.

Standard peripheral units are defined in device-specific I/O header files with the 
filename extension h. See Device support, page 38. For an example, see Accessing 
special function registers, page 184.

EVENT HANDLING

In embedded systems, using interrupts is a method for handling external events 
immediately; for example, detecting that a button was pressed. In general, when an 
interrupt occurs in the code, the microprocessor simply stops executing the code it runs, 
and starts executing an interrupt routine instead.

The compiler supports the following processor exception types: trap, interrupt, and fast 
interrupt, which means that you can write your interrupt routines in C, see Interrupt 
functions, page 65.

SYSTEM STARTUP

In all embedded systems, system startup code is executed to initialize the system—both 
the hardware and the software system—before the main function of the application is 
called. The CPU imposes this by starting execution from a fixed memory address.

As an embedded software developer, you must ensure that the startup code is located at 
the dedicated memory addresses, or can be accessed using a pointer from the vector 
table. This means that startup code and the initial vector table must be placed in 
non-volatile memory, such as ROM, EPROM, or flash.

A C/C++ application further needs to initialize all global variables. This initialization is 
handled by the linker and the system startup code in conjunction. For more information, 
see Application execution—an overview, page 46.

REAL-TIME OPERATING SYSTEMS

In many cases, the embedded application is the only software running in the system. 
However, using an RTOS has some advantages.

For example, the timing of high-priority tasks is not affected by other parts of the 
program which are executed in lower priority tasks. This typically makes a program 
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Developing embedded applications
more deterministic and can reduce power consumption by using the CPU efficiently and 
putting the CPU in a lower-power state when idle.

Using an RTOS can make your program easier to read and maintain, and in many cases 
smaller as well. Application code can be cleanly separated in tasks which are truly 
independent of each other. This makes teamwork easier, as the development work can 
be easily split into separate tasks which are handled by one developer or a group of 
developers.

Finally, using an RTOS reduces the hardware dependence and creates a clean interface 
to the application, making it easier to port the program to different target hardware.

The build process—an overview
This section gives an overview of the build process; how the various build 
tools—compiler, assembler, and linker—fit together, going from source code to an 
executable image.

To get familiar with the process in practice, you should run one or more of the tutorials 
available in the IAR Embedded Workbench® IDE User Guide.

THE TRANSLATION PROCESS

There are two tools in the IDE that translate application source files to intermediary 
object files. The IAR C/C++ Compiler and the IAR Assembler. Both produce 
relocatable object files in the industry-standard format ELF, including the DWARF 
format for debug information.

Note: The compiler can also be used for translating C/C++ source code into assembler 
source code. If required, you can modify the assembler source code which then can be 
assembled into object code. For more information about the IAR Assembler, see the IAR 
Assembler Reference Guide for SH.
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The build process—an overview
This illustration shows the translation process:

Figure 1: The build process before linking

After the translation, you can choose to pack any number of modules into an archive, or 
in other words, a library. The important reason you should use libraries is that each 
module in a library is conditionally linked in the application, or in other words, is only 
included in the application if the module is used directly or indirectly by a module 
supplied as an object file. Optionally, you can create a library; then use the IAR utility 
iarchive.

THE LINKING PROCESS

The relocatable modules, in object files and libraries, produced by the IAR compiler and 
assembler cannot be executed as is. To become an executable application, they must be 
linked.

The IAR ILINK Linker (ilinksh.exe) is used for building the final application. 
Normally, ILINK requires the following information as input:

● Several object files and possibly certain libraries

● A program start label (set by default)

● The linker configuration file that describes placement of code and data in the 
memory of the target system.
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This illustration shows the linking process:

Figure 2: The linking process

Note: The Standard C/C++ library contains support routines for the compiler, and the 
implementation of the C/C++ standard library functions.

During the linking, ILINK might produce error messages and logging messages on 
stdout and stderr. The log messages are useful for understanding why an application 
was linked the way it was, for example, why a module was included or a section 
removed.

For an in-depth description of the procedure performed by ILINK, see The linking 
process, page 72.

AFTER LINKING

The IAR ILINK Linker produces an absolute object file in ELF format that contains the 
executable image. After linking, the produced absolute executable image can be used 
for:

● Loading into the IAR C-SPY Debugger

● Programming to a flash/PROM using a flash/PROM programmer. Before this is 
possible, the actual bytes in the image must be converted into the standard Motorola 
32-bit S-record format or the Intel Hex-32 format. For this, use ielftool, see The 
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IAR ELF Tool—ielftool, page 350.

This illustration shows the possible uses of the absolute output ELF/DWARF file:

Figure 3: Possible uses of the absolute output ELF/DWARF file

Application execution—an overview
This section gives an overview of the execution of an embedded application divided into 
three phases, the:

● Initialization phase

● Execution phase

● Termination phase.

THE INITIALIZATION PHASE

Initialization is executed when an application is started (the CPU is reset) but before the 
main function is entered. The initialization phase can for simplicity be divided into:

● Hardware initialization, which generally at least initializes the stack pointer.

The hardware initialization is typically performed in the system startup code 
cstartup.s and if required, by an extra low-level routine that you provide. It might 
include resetting/starting the rest of the hardware, setting up the CPU, etc, in 
preparation for the software C/C++ system initialization.
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● Software C/C++ system initialization

Typically, this includes assuring that every global (statically linked) C/C++ symbol 
receives its proper initialization value before the main function is called.

● Application initialization

This depends entirely on your application. Typically, it can include setting up an 
RTOS kernel and starting initial tasks for an RTOS-driven application. For a 
bare-bone application, it can include setting up various interrupts, initializing 
communication, initializing devices, etc.

For a ROM/flash-based system, constants and functions are already placed in ROM. All 
symbols placed in RAM must be initialized before the main function is called. The 
linker has already divided the available RAM into different areas for variables, stack, 
heap, etc.

The following sequence of illustrations gives a simplified overview of the different 
stages of the initialization.

1 When an application is started, the system startup code first performs hardware 
initialization, such as initialization of the stack pointer to point at the predefined stack 
area: 

Figure 4: Initializing hardware
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2 Then, memories that should be zero-initialized are cleared, in other words, filled with 
zeros:

Figure 5: Zero-initializing variables

Typically, this is data referred to as zero-initialized data; variables declared as, for 
example, int i = 0;
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3 For initialized data, data declared, for example, like int i = 6; the initializers are 
copied from ROM to RAM:

Figure 6: Initializing variables

4 Finally, the main function is called:

Figure 7: Calling main
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For a detailed description about each stage, see System startup and termination, page 
104. For more details about initialization of data, see Initialization at system startup, 
page 77.

THE EXECUTION PHASE

The software of an embedded application is typically implemented as a loop which is 
either interrupt-driven or uses polling for controlling external interaction or internal 
events. For an interrupt-driven system, the interrupts are typically initialized at the 
beginning of the main function.

In a system with real-time behavior and where responsiveness is critical, a multi-task 
system might be required. This means that your application software should be 
complemented with a real-time operating system. In this case, the RTOS and the 
different tasks must also be initialized at the beginning of the main function.

THE TERMINATION PHASE

Typically, the execution of an embedded application should never end. If it does, you 
must define a proper end behavior.

To terminate an application in a controlled way, either call one of the Standard C library 
functions exit, _Exit, or abort, or return from main. If you return from main, the 
exit function is executed, which means that C++ destructors for static and global 
variables are called (C++ only) and all open files are closed.

Of course, in case of incorrect program logic, the application might terminate in an 
uncontrolled and abnormal way—a system crash.

To read more about this, see System termination, page 106.

Building applications—an overview
In the command line interface, this line compiles the source file myfile.c into the 
object file myfile.o using the default settings:

iccsh myfile.c

On the command line, this line can be used for starting ILINK:

ilinksh myfile.o myfile2.o -o a.out --config my_configfile.icf

In this example, myfile.o and myfile2.o are object files, and my_configfile.icf 
is the linker configuration file. The option -o specifies the name of the output file.

Note: By default, the label where the application starts is __iar_program_start. 
You can use the --entry command line option to change this.
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Basic project configuration
This section gives an overview of the basic settings for the project setup that are needed 
to make the compiler and linker generate the best code for the SH device you are using. 
You can specify the options either from the command line interface or in the IDE.

You need to make settings for:

● Core

● Data model

● Code model

● Size of double floating-point type

● Optimization settings

● Runtime environment

● Customizing the ILINK configuration, see the chapter Linking your application

In addition to these settings, many other options and settings can fine-tune the result 
even further. For details about how to set options and for a list of all available options, 
see the chapters Compiler options, Linker options, and the IAR Embedded Workbench® 
IDE User Guide, respectively.

CORE 

The compiler supports the SH2A core with and without a dedicated floating-point 
processor. Use the --core={sh2a|sh2afpu} option to select the core variant for 
which the code will be generated.

In the IDE, choose Project>Options and select the core an appropriate device from the 
Device drop-down list on the Target page. The core and device options will then be 
automatically selected.

DATA MODEL

In the compiler, you can set a default memory address size by selecting a data model. 
These data models are supported:

● In the Small data model, pointers are initialized using 16-bit signed addresses

● In the Medium data model, pointers are initialized using 20-bit signed addresses

● In the Large data model, pointers are initialized using 28-bit signed addresses

● In the Huge data model, pointers are initialized using 32-bit addresses.

The chapter Data storage covers data models in greater detail. The chapter also covers 
how to override the default access method for individual variables.
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CODE MODEL

The compiler supports code models that you can set on file- or function-level to control 
which function calls are generated, which determines the size of the linked application. 
These code models are available:

● In the Small code model, pointers are initialized using 16-bit signed addresses

● In the Medium code model, pointers are initialized using 20-bit signed addresses

● In the Large code model, pointers are initialized using 28-bit signed addresses

● In the Huge code model, pointers are initialized using 32-bit addresses.

For detailed information about the code models, see the chapter Functions.

SIZE OF DOUBLE FLOATING-POINT TYPE

Floating-point values are represented by 32- and 64-bit numbers in standard IEEE 754 
format. If you use the compiler option --double={32|64}, you can choose whether 
data declared as double should be represented with 32 bits or 64 bits. The data type 
float is always represented using 32 bits.

OPTIMIZATION FOR SPEED AND SIZE

The compiler is a state-of-the-art compiler with an optimizer that performs, among other 
things, dead-code elimination, constant propagation, inlining, common sub-expression 
elimination, and precision reduction. It also performs loop optimizations, such as 
unrolling and induction variable elimination.

You can decide between several optimization levels and for the highest level you can 
choose between different optimization goals—size, speed, or balanced. Most 
optimizations will make the application both smaller and faster. However, when this is 
not the case, the compiler uses the selected optimization goal to decide how to perform 
the optimization.

The optimization level and goal can be specified for the entire application, for individual 
files, and for individual functions. In addition, some individual optimizations, such as 
function inlining, can be disabled.

For details about compiler optimizations and for more information about efficient 
coding techniques, see the chapter Efficient coding for embedded applications.

RUNTIME ENVIRONMENT

To create the required runtime environment you should choose a runtime library and set 
library options. You might also need to override certain library modules with your own 
customized versions.
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The runtime library provided is the IAR DLIB Library, which supports Standard C and 
C++. This library also supports floating-point numbers in IEEE 754 format and it can 
be configured to include different levels of support for locale, file descriptors, multibyte 
characters, etc.

The runtime library contains the functions defined by the C and the C++ standards, and 
include files that define the library interface (the system header files).

The runtime library you choose can be one of the prebuilt libraries, or a library that you 
customized and built yourself. The IDE provides a library project template that you can 
use for building your own library version. This gives you full control of the runtime 
environment. If your project only contains assembler source code, you do not need to 
choose a runtime library.

For detailed information about the runtime environments, see the chapter The DLIB 
runtime environment.

Setting up for the runtime environment in the IDE

The library is automatically chosen by the linker according to the settings you made in 
Project>Options>General Options, on the pages Library Configuration, Library 
Options, and Library Usage.

Note that there are two different library configurations—Normal and Full—which 
include different levels of support for locale, file descriptors, multibyte characters, etc. 
See Library configurations, page 108, for more information.

Based on which library configuration you choose and your other project settings, the 
correct library file is used automatically. For the device-specific include files, a correct 
include path is set up.

Setting up for the runtime environment from the command line

You do not have to specify a library file explicitly, as ILINK automatically uses the 
correct library file.

A library configuration file that matches the library object file is automatically used. To 
explicitly specify a library configuration, use the --dlib_config option.

In addition to these options you might want to specify any target-specific linker options 
or the include path to application-specific header files by using the -I option, for 
example:

-I sh\inc
DSH-2

Part 1. Using the build tools 53



54

Basic project configuration
Setting library and runtime environment options

You can set certain options to reduce the library and runtime environment size:

● The formatters used by the functions printf, scanf, and their variants, see 
Choosing formatters for printf and scanf, page 97.

● The size of the stack and the heap, see Setting up the stack, page 86, and Setting up 
the heap, page 86, respectively.
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Data storage 
This chapter gives a brief introduction to the memory layout of the SH 
microprocessor and the fundamental ways data can be stored in memory: on 
the stack, in static (global) memory, or in heap memory. For efficient memory 
usage, the compiler provides a set of data models and data memory attributes, 
allowing you fine-grained control of data storage. The concepts of data models 
and memory types are described in relation to pointers, structures, Embedded 
C++ class objects, and non-initialized memory. Finally, detailed information 
about data storage on the stack and the heap is provided.

Introduction 
The SH microprocessor has one continuous memory space for both code and data, 
ranging from 0x00000000 to 0xFFFFFFFF. Different types of memory can be placed in 
the memory range.

DIFFERENT WAYS TO STORE DATA

In a typical application, data can be stored in memory in three different ways:

● Auto variables.

All variables that are local to a function, except those declared static, are stored on 
the stack. These variables can be used as long as the function executes. When the 
function returns to its caller, the memory space is no longer valid.

● Global variables and local variables declared static.

In this case, the memory is allocated once and for all. The word static in this context 
means that the amount of memory allocated for this kind of variables does not change 
while the application is running. For more information, see Data models, page 56 and 
Memory types, page 57.

● Dynamically allocated data.

An application can allocate data on the heap, where the data remains valid until it is 
explicitly released back to the system by the application. This type of memory is 
useful when the number of objects is not known until the application executes. Note 
that there are potential risks connected with using dynamically allocated data in 
systems with a limited amount of memory, or systems that are expected to run for a 
long time. For more information, see Dynamic memory on the heap, page 62.
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Data models
Technically, the data model specifies the default memory type. This means that the data 
model controls the default placement of static and global variables, and constant literals

The data model only specifies the default memory type. It is possible to override this for 
individual variables and pointers. For information about how to specify a memory type 
for individual objects, see Using data memory attributes, page 58.

SPECIFYING A DATA MODEL

Four data models are implemented: Small, Medium, Large, and Huge. These models are 
controlled by the --data_model option. Each model has a default memory type. If you 
do not specify a data model option, the compiler will use the Huge data model.

Your project can only use one data model at a time, and the same model must be used 
by all user modules and all library modules. However, you can override the default 
memory type for individual data objects by explicitly specifying a memory attribute, see 
Using data memory attributes, page 58.

This table summarizes the different data models:

See the IAR Embedded Workbench® IDE User Guide for information about setting 
options in the IDE.

Use the --data_model option to specify the data model for your project; see 
--data_model, page 207. 

Data model name
Default memory 

attribute
Pointer attribute Default placement of data

Small __data16 __data32 Low 32 Kbytes or high 32 
Kbytes

Medium __data20 __data32 Low 512 Kbytes or high 
512 Kbytes

Large __data28 __data32 Low 128 Mbytes or high 
128 Mbytes

Huge (default) __data32 __data32 The entire 4 Gbytes of 
memory

Table 3: Data model characteristics 
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Memory types
This section describes the concept of memory types used for accessing data by the 
compiler. It also discusses pointers in the presence of multiple memory types. For each 
memory type, the capabilities and limitations are discussed.

Because all memory accesses are performed via pointers, the memory type only controls 
the placement of variables and pointer initialization.

To choose a default memory type that your application will use, select a data model. 
However, it is possible to specify—for individual variables—different memory types. 
This makes it possible to create an application that can contain a large amount of data, 
and at the same time make sure that variables that are used often are placed in memory 
that can be efficiently accessed.

DATA16  

The data16 memory consists of the low and the high 32 Kbytes of data memory. In 
hexadecimal notation, this is the address ranges 0x00000000-0x00007FFF and 
0xFFFF8000-0xFFFFFFFF.

A data16 object can only be placed in data16 memory, and the size of such an object is 
limited to 32 Kbytes-1. If you use objects of this type, the code generated by the 
compiler to access them is minimized. This means a smaller footprint for the 
application.

DATA20  

The data20 memory consists of the low and the high 512 Kbytes of data memory. In 
hexadecimal notation, this is the address ranges 0x00000000-0x0007FFFF and 
0xFFF80000-0xFFFFFFFF.

A data20 object can only be placed in data20 memory, and the size of such an object is 
limited to 512 Kbytes-1.

DATA28 

The data28 memory consists of the low and the high 128 Mbytes of data memory. In 
hexadecimal notation, this is the address ranges 0x00000000-0x07FFFFFF and 
0xF8000000-0xFFFFFFFF.

A data28 object can only be placed in data28 memory, and the size of such an object is 
limited to 128 Mbytes-1. 
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DATA32 

Data32 objects can be placed anywhere in data memory. Also, unlike the other memory 
types, there is no limitation on the size of the objects that can be placed in this memory 
type.

USING DATA MEMORY ATTRIBUTES

The compiler provides a set of extended keywords, which can be used as data memory 
attributes. These keywords let you override the default memory type for individual data 
objects, which means that you can place data objects in other memory areas than the 
default memory. This also means that you can fine-tune the access method for each 
individual data object, which results in smaller code size.

This table summarizes the available memory types and their corresponding keywords:

All data pointers are 32 bits.

The keywords are only available if language extensions are enabled in the compiler.

In the IDE, language extensions are enabled by default.

Use the -e compiler option to enable language extensions. See -e, page 213 for 
additional information.

For reference information about each keyword, see Descriptions of extended keywords, 
page 265.

Syntax

The keywords follow the same syntax as the type qualifiers const and volatile. The 
memory attributes are type attributes and therefore they must be specified both when 
variables are defined and in the declaration, see General syntax rules for extended 
keywords, page 261.

Memory type Keyword Address range Default in data model

Data16 __data16 0x00000000-0x00007FFF

0xFFFF8000-0xFFFFFFFF

Small

Data20 __data20 0x00000000-0x0007FFFF

0xFFF80000-0xFFFFFFFF

Medium

Data28 __data28 0x00000000-0x07FFFFFF

0xF8000000-0xFFFFFFFF

Large

Data32 __data32 0x00000000-0xFFFFFFFF Huge

Table 4: Memory types and their corresponding memory attributes 
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The following declarations place the variable i and j in data20 memory. The variables 
k and l will also be placed in data20 memory. The position of the keyword does not have 
any effect in this case:

__data20 int i, j;
int __data20 k, l;

Note that the keyword affects both identifiers. If no memory type is specified, the default 
memory type is used.

The #pragma type_attribute directive can also be used for specifying the memory 
attributes. The advantage of using pragma directives for specifying keywords is that it 
offers you a method to make sure that the source code is portable. Refer to the chapter 
Pragma directives for details about how to use the extended keywords together with 
pragma directives.

Type definitions

Storage can also be specified using type definitions. These two declarations are 
equivalent:

/* Defines via a typedef */
typedef char __data16 Byte;
Byte AByte;

/* Defines directly  */
__data16 char AByte;

STRUCTURES AND MEMORY TYPES 

For structures, the entire object is placed in the same memory type. It is not possible to 
place individual structure members in different memory types.

In the example below, the variable Gamma is a structure placed in data20 memory.

struct MyStruct
{
  int mAlpha;
  int mBeta;
};

__data20 struct MyStruct Gamma;

This declaration is incorrect:

struct MyStruct
{
  int mAlpha;
  __data20 int mBeta; /* Incorrect declaration*/
};
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C++ and memory types
MORE EXAMPLES

The following is a series of examples with descriptions. First, some integer variables are 
defined and then pointer variables are introduced. Finally, a function accepting a pointer 
to an integer in data16 memory is declared. The function returns a pointer to an integer 
in data20 memory. It makes no difference whether the memory attribute is placed before 
or after the data type. To read the following examples, start from the left and add one 
qualifier at each step 

C++ and memory types 
Instances of C++ classes are placed into a memory (just like all other objects) either 
implicitly, or explicitly using memory type attributes or other IAR language extensions. 
Non-static member variables, like structure fields, are part of the larger object and 
cannot be placed individually into specified memories.

In non-static member functions, the non-static member variables of a C++ object can be 
referenced via the this pointer, explicitly or implicitly. The this pointer is of the 
default data pointer type unless class memory is used, see Classes, page 169.

Static member variables can be placed individually into a data memory in the same way 
as free variables.

All member functions except for constructors and destructors can be placed individually 
into a code memory in the same way as free functions.

For more information about C++ classes, see Classes, page 169.

Auto variables—on the stack
Variables that are defined inside a function—and not declared static—are named auto 
variables by the C standard. A few of these variables are placed in processor registers; 
the rest are placed on the stack. From a semantic point of view, this is equivalent. The 

int MyA; A variable defined in default memory 
determined by the data model in use.

int __data16 MyB; A variable in data16 memory.

__data20 int MyC; A variable in data20 memory.

int * MyD; A pointer stored in default memory. The pointer 
points to an integer in default memory.

int * __data20 MyF; A pointer stored in data20 memory.
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main differences are that accessing registers is faster, and that less memory is required 
compared to when variables are located on the stack.

Auto variables can only live as long as the function executes; when the function returns, 
the memory allocated on the stack is released.

THE STACK

The stack can contain:

● Local variables and parameters not stored in registers

● Temporary results of expressions

● The return value of a function (unless it is passed in registers)

● Processor state during interrupts

● Processor registers that should be restored before the function returns (callee-save 
registers).

The stack is a fixed block of memory, divided into two parts. The first part contains 
allocated memory used by the function that called the current function, and the function 
that called it, etc. The second part contains free memory that can be allocated. The 
borderline between the two areas is called the top of stack and is represented by the stack 
pointer, which is a dedicated processor register. Memory is allocated on the stack by 
moving the stack pointer.

A function should never refer to the memory in the area of the stack that contains free 
memory. The reason is that if an interrupt occurs, the called interrupt function can 
allocate, modify, and—of course—deallocate memory on the stack.

Advantages

The main advantage of the stack is that functions in different parts of the program can 
use the same memory space to store their data. Unlike a heap, a stack will never become 
fragmented or suffer from memory leaks.

It is possible for a function to call itself—a recursive function—and each invocation can 
store its own data on the stack.

Potential problems

The way the stack works makes it impossible to store data that is supposed to live after 
the function returns. The following function demonstrates a common programming 
mistake. It returns a pointer to the variable x, a variable that ceases to exist when the 
function returns.

int *MyFunction()
{
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  int x;
  /* Do something here. */
  return &x; /* Incorrect */
}

Another problem is the risk of running out of stack. This will happen when one function 
calls another, which in turn calls a third, etc., and the sum of the stack usage of each 
function is larger than the size of the stack. The risk is higher if large data objects are 
stored on the stack, or when recursive functions—functions that call themselves either 
directly or indirectly—are used.

Dynamic memory on the heap 
Memory for objects allocated on the heap will live until the objects are explicitly 
released. This type of memory storage is very useful for applications where the amount 
of data is not known until runtime.

In C, memory is allocated using the standard library function malloc, or one of the 
related functions calloc and realloc. The memory is released again using free.

In C++, a special keyword, new, allocates memory and runs constructors. Memory 
allocated with new must be released using the keyword delete.

Potential problems

Applications that are using heap-allocated objects must be designed very carefully, 
because it is easy to end up in a situation where it is not possible to allocate objects on 
the heap.

The heap can become exhausted if your application uses too much memory. It can also 
become full if memory that no longer is in use was not released.

For each allocated memory block, a few bytes of data for administrative purposes is 
required. For applications that allocate a large number of small blocks, this 
administrative overhead can be substantial.

There is also the matter of fragmentation; this means a heap where small sections of free 
memory is separated by memory used by allocated objects. It is not possible to allocate 
a new object if no piece of free memory is large enough for the object, even though the 
sum of the sizes of the free memory exceeds the size of the object.

Unfortunately, fragmentation tends to increase as memory is allocated and released. For 
this reason, applications that are designed to run for a long time should try to avoid using 
memory allocated on the heap.
DSH-2

IAR C/C++ Development Guide
Compiling and Linking for SH



Functions
This chapter contains information about functions. It gives a brief overview of 
function-related extensions—mechanisms for controlling functions—and 
describes some of these mechanisms in more detail.

Function-related extensions
In addition to supporting Standard C, the compiler provides several extensions for 
writing functions in C. Using these, you can:

● Control the storage of functions in memory

● Use primitives for interrupts, concurrency, and OS-related programming

● Facilitate function optimization

● Access hardware features.

The compiler uses compiler options, extended keywords, pragma directives, and 
intrinsic functions to support this.

For more information about optimizations, see Efficient coding for embedded 
applications, page 169. For information about the available intrinsic functions for 
accessing hardware operations, see the chapter Intrinsic functions.

Code models and memory attributes for function storage 
By means of code models, the compiler supports placing functions in a default part of 
memory, or in other words, use a default size of the function address. Technically, the 
code models control the following:

● The default memory range for storing the function, which implies a default memory 
attribute

● The maximum module size

● The maximum application size.

The compiler supports four code models. If you do not specify a code model, the 
compiler will use the Huge code model as default. Your project can only use one code 
model at a time, and the same model must be used by all user modules and all library 
modules.
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Code models and memory attributes for function storage
These code models are available:

See the IAR Embedded Workbench® IDE User Guide for information about specifying 
a code model in the IDE.

Use the --code_model option to specify the code model for your project; see 
--code_model, page 205. 

USING FUNCTION MEMORY ATTRIBUTES

It is possible to override the default placement for individual functions. Use the 
appropriate function memory attribute to specify this. These attributes are available:

All function pointers are 32 bits.

For detailed syntax information and for detailed information about each attribute, see the 
chapter Extended keywords.

Code model name Default address ranges for placing functions

Small 0x00000000-0x00007FFF

0xFFFF8000-0xFFFFFFFF

Medium 0x00000000-0x0007FFFF

0xFFF80000-0xFFFFFFFF

Large 0x00000000-0x07FFFFFF

0xF8000000-0xFFFFFFFF

Huge (default) 0x00000000-0xFFFFFFFF

Table 5: Code models

Function memory 

attribute
Address ranges Default in code model

__code16 0x00000000-0x00007FFF

0xFFFF8000-0xFFFFFFFF

Small

__code20 0x00000000-0x0007FFFF

0xFFF80000-0xFFFFFFFF

Medium

__code28 0x00000000-0x07FFFFFF

0xF8000000-0xFFFFFFFF

Large

__code32 0x00000000-0xFFFFFFFF Huge

Table 6: Function memory attributes 
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Primitives for interrupts, concurrency, and OS-related programming
The IAR C/C++ Compiler for SH provides the following primitives related to writing 
interrupt functions, concurrent functions, and OS-related functions: 

● The extended keywords __fast_interrupt, __interrupt,__monitor, __tbr, 
and __trap

● The #pragma vector directive

● The intrinsic functions __enable_interrupt, __disable_interrupt, 
__get_interrupt_state, and __set_interrupt_state.

INTERRUPT FUNCTIONS 

In embedded systems, using interrupts is a method for handling external events 
immediately; for example, detecting that a button was pressed.

In general, when an interrupt occurs in the code, the microprocessor simply stops 
executing the code it runs, and starts executing an interrupt routine instead. It is 
extremely important that the environment of the interrupted function is restored after the 
interrupt is handled; this includes the values of processor registers and the processor 
status register. This makes it possible to continue the execution of the original code after 
the code that handled the interrupt was executed.

The SH microprocessor supports many interrupt sources. For each interrupt source, an 
interrupt routine can be written. Each interrupt routine is associated with a vector 
number, which is specified in the SH microprocessor documentation from the chip 
manufacturer. If you want to handle several different interrupts using the same interrupt 
function, you can specify several interrupt vectors.

The header file iodevice.h, where device corresponds to the selected device, 
contains predefined names for the existing exception vectors.

To define an interrupt function, the __interrupt keyword and the #pragma vector 
directive can be used. For example:

#pragma vector = 20
__interrupt void MyInterruptRoutine(void)
{
  /* Do something */
}

Note: An interrupt function must have the return type void, and it cannot specify any 
parameters.
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Primitives for interrupts, concurrency, and OS-related programming
TRAP FUNCTIONS 

A trap is a kind of exception that can be activated when a specific event occurs or is 
called, by using the processor instruction TRAPA. In many respects, a trap function 
behaves as a normal function; it can accept parameters, and return a value.

The typical use for trap functions is for the client interface of an operating system. If this 
interface is implemented using trap functions, the operating system part of an 
application can be updated independently of the rest of the system.

Each trap function is typically associated with a vector. The header file 
ioderivative.h, which corresponds to the selected derivative, contains predefined 
names for the existing exception vectors.

The __trap keyword and the #pragma vector directive can be used to define trap 
functions. For example, this piece of code defines a function doubling its argument:

#pragma vector = 32
__trap int Twice(int x)
{
  return x + x;
}

When a trap function is defined with a vector, the processor interrupt vector table is 
populated. It is also possible to define a trap function without a vector. This is useful if 
an application is capable of populating or changing the interrupt vector table at runtime. 
See the chip manufacturer’s SH microprocessor documentation for more information 
about the interrupt vector table. 

When a trap function is used, the compiler ensures that the application also will include 
the appropriate trap-handling code. See the chapter Assembler language interface for 
more information.

MONITOR FUNCTIONS

A monitor function causes interrupts to be disabled during execution of the function. At 
function entry, the status register is saved and interrupts are disabled. At function exit, 
the original status register is restored, and thereby the interrupt status that existed before 
the function call is also restored.

To define a monitor function, you can use the __monitor keyword. For reference 
information, see __monitor, page 269.

Avoid using the __monitor keyword on large functions, since the interrupt will 
otherwise be turned off for too long. 
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Example of implementing a semaphore in C 

In the following example, a binary semaphore—that is, a mutex—is implemented using 
one static variable and two monitor functions. A monitor function works like a critical 
region, that is no interrupt can occur and the process itself cannot be swapped out. A 
semaphore can be locked by one process, and is used for preventing processes from 
simultaneously using resources that can only be used by one process at a time, for 
example a USART. The __monitor keyword assures that the lock operation is atomic; 
in other words it cannot be interrupted.

/* This is the lock-variable. When non-zero, someone owns it. */
static volatile unsigned int sTheLock = 0;

/* Function to test whether the lock is open, and if so take it.
 * Returns 1 on success and 0 on failure. 
 */

__monitor int TryGetLock(void)
{
  if (sTheLock == 0)
  {
    /* Success, nobody has the lock. */

    sTheLock = 1;
    return 1;
  }
  else
  {
    /* Failure, someone else has the lock. */
    return 0;
  }
}

/* Function to unlock the lock. 
 * It is only callable by one that has the lock. */

__monitor void ReleaseLock(void)
{
  sTheLock = 0;
}

/* Function to take the lock. It will wait until it gets it. */

void GetLock(void)
{
  while (!TryGetLock())
  {
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Primitives for interrupts, concurrency, and OS-related programming
    /* Normally a sleep instruction is used here. */
  }
}

/* An example of using the semaphore. */

void MyProgram(void)
{
  GetLock();
  /* Do something here. */
  ReleaseLock();
}

Example of implementing a semaphore in C++ 

In C++, it is common to implement small methods with the intention that they should be 
inlined. However, the compiler does not support inlining of functions and methods that 
are declared using the __monitor keyword.

In the following example in C++, an auto object is used for controlling the monitor 
block, which uses intrinsic functions instead of the __monitor keyword. 

#include <intrinsics.h>

/* Class for controlling critical blocks. */
class Mutex
{
public:
  Mutex()
  {
    // Get hold of current interrupt state.
    mState = __get_interrupt_state();

    // Disable all interrupts.
    __disable_interrupt();
  }

  ~Mutex()
  {
    // Restore the interrupt state.
    __set_interrupt_state(mState);
  }

private:
  __istate_t mState;
};

class Tick
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{
public:
  // Function to read the tick count safely.
  static long GetTick()
  {
    long t;

    // Enter a critical block.
    {
      Mutex m;

      // Get the tick count safely,
      t = smTickCount;
    }
    // and return it.
    return t;
  }

private:
  static volatile long smTickCount;
};

volatile long Tick::smTickCount = 0;

extern void DoStuff();

void MyMain()
{
  static long nextStop = 100;
  
  if (Tick::GetTick() >= nextStop)
  {
    nextStop += 100;
    DoStuff();
  }
}

C++ AND SPECIAL FUNCTION TYPES 

C++ member functions can be declared using special function types. However, two 
restrictions apply:

● Interrupt member functions must be static. When a non-static member function is 
called, it must be applied to an object. When an interrupt occurs and the interrupt 
function is called, there is no object available to apply the member function to.

● Trap member functions cannot be declared virtual. The reason for this is that trap 
functions cannot be called via function pointers.
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Linking using ILINK 
This chapter describes the linking process using the IAR ILINK Linker and the 
related concepts—first with an overview and then in more detail.

Linking—an overview
The IAR ILINK Linker is a powerful, flexible software tool for use in the development 
of embedded applications. It is equally well suited for linking small, single-file, absolute 
assembler programs as it is for linking large, relocatable, multi-module, C/C++, or 
mixed C/C++ and assembler programs.

ILINK combines one or more relocatable object files—produced by the IAR Systems 
compiler or assembler—with selected parts of one or more object libraries to produce 
an executable image in the industry-standard format Executable and Linking Format 
(ELF).

ILINK will automatically load only those library modules—user libraries and Standard 
C or C++ library variants—that are actually needed by the application you are linking. 
Further, ILINK eliminates duplicate sections and sections that are not required.

ILINK uses a configuration file where you can specify separate locations for code and 
data areas of your target system memory map. This file also supports automatic handling 
of the application’s initialization phase, which means initializing global variable areas 
and code areas by copying initializers and possibly decompressing them as well.

The final output produced by ILINK is an absolute object file containing the executable 
image in the ELF (including DWARF for debug information) format. The file can be 
downloaded to C-SPY or it can be programmed into EPROM.

To handle ELF files, various tools are included. For a list of included utilities, see 
Specific ELF tools, page 36.

Modules and sections
Each relocatable object file contains one module, which consists of:

● Several sections of code or data

● Runtime attributes specifying various types of information, for example the used 
device

● Optionally, debug information in DWARF format

● A symbol table of all global symbols and all external symbols used.
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The linking process
A section is a logical entity containing a piece of data or code that should be placed at a 
physical location in memory. A section can consist of several section fragments, 
typically one for each variable or function (symbols). A section can be placed either in 
RAM or in ROM. In a normal embedded application, sections that are placed in RAM 
do not have any content, they only occupy space.

Each section has a name and a type attribute that determines the content. The type 
attribute is used (together with the name) for selecting sections for the ILINK 
configuration. The most commonly used attributes are:

Note: In addition to these section types—sections that contain the code and data that 
are part of your application—a final object file will contain many other types of 
sections, for example sections that contain debugging information or other type of meta 
information.

A section is the smallest linkable unit; but if possible, ILINK can exclude smaller 
units—section fragments—from the final application. For more information, see 
Keeping modules, page 85, and Keeping symbols and sections, page 85.

At compile time, data and functions are placed in different sections. At link time, one of 
the most important functions of the linker is to assign execute addresses to the various 
sections used by the application.

The IAR build tools have many predefined section names. See the chapter Section 
reference for more details about each section.

The linking process
The relocatable modules in object files and libraries, produced by the IAR compiler and 
assembler, cannot be executed as is. To become an executable application, they must be 
linked.

The IAR ILINK Linker is used for the link process. It normally performs the following 
procedure (note that some of the steps can be turned off by command line options or by 
directives in the linker configuration file):

● Determine which modules to include in the application. Modules provided in object 
files are always included. A module in a library file is only included if it provides a 
definition for a global symbol that is referenced from an included module.

code Executable code

readonly Constant variables

readwrite Initialized variables

zeroinit Zero-initialized variables
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● Select which standard library files to use. The selection is based on attributes of the 
included modules. These libraries are then used for satisfying any still outstanding 
undefined symbols.

● Determine which sections/section fragments from the included modules to include 
in the application. Only those sections/section fragments that are actually needed by 
the application are included. There are several ways to determine of which 
sections/section fragments that are needed, for example, the __root object 
attribute, the #pragma required directive, and the keep linker directive. In case 
of duplicate sections, only one is included.

● Where appropriate, arrange for the initialization of initialized variables and code in 
RAM. The initialize directive causes the linker to create extra sections to 
enable copying from ROM to RAM. Each section that will be initialized by copying 
is divided into two sections, one for the ROM part and one for the RAM part. If 
manual initialization is not used, the linker also arranges for the startup code to 
perform the initialization.

● Determine where to place each section according to the section placement directives 
in the linker configuration file. Sections that are to be initialized by copying appear 
twice in the matching against placement directives, once for the ROM part and once 
for the RAM part, with different attributes.

● Produce an absolute file that contains the executable image and any debug 
information provided. The contents of each needed section in the relocatable input 
files is calculated using the relocation information supplied in its file and the 
addresses determined when placing sections. This process can result in one or more 
relocation failures if some of the requirements for a particular section are not met, 
for instance if placement resulted in the destination address for a PC-relative call 
instruction being out of range for that instruction.

● Optionally, produce a map file that lists the result of the section placement, the 
address of each global symbol, and finally, a summary of memory usage for each 
module and library.
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Placing code and data—the linker configuration file
This illustration shows the linking process:

Figure 8: The linking process

During the linking, ILINK might produce error messages and logging messages on 
stdout and stderr. The log messages are useful for understanding why an application 
was linked as it was. For example, why a module or section (or section fragment) was 
included.

Note: To see the actual content of an ELF object file, use ielfdumpsh. See The IAR 
ELF Dumper for SH—ielfdumpsh, page 352.

Placing code and data—the linker configuration file
The placement of sections in memory is performed by the IAR ILINK Linker. It uses the 
linker configuration file where you can define how ILINK should treat each section and 
how they should be placed into the available memories.

A typical linker configuration file contains definitions of:

● Available addressable memories

● Populated regions of those memories

● How to treat input sections
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● Created sections

● How to place sections into the available regions.

The file consists of a sequence of declarative directives. This means that the linking 
process will be governed by all directives at the same time.

To use the same source code with different derivatives, just rebuild the code with the 
appropriate configuration file.

A SIMPLE EXAMPLE OF A CONFIGURATION FILE

A simple configuration file can look like this:

/* The memory space denoting the maximum possible amount
   of addressable memory */
define memory Mem with size = 4G;

/* Memory regions in an address space */
define region ROM_16 = Mem:[from 0x00000000 to 0x00007FFF];
define region RAM_16 = Mem:[from 0xFFFF8000 to 0xFFFFFFFF];

/* Create a stack */
define block CSTACK with size = 0x1000, alignment = 4 { };

/* Handle initialization */
do not initialize { section .noinit };
initialize by copy { readwrite }; /* Initialize RW sections,
                                     exclude zero-initialized
                                     sections */

/* Place startup code at a fixed address */
place at start of ROM { readonly section .cstartup };

/* Place code and data */
place in ROM_16 { readonly }; /* Place constants and initializers
                               in ROM: .rodata and .data_init */
place in RAM_16 { readwrite,  /* Place .data, .bss, and .noinit*/
                  block CSTACK };  /* and CSTACK  */

This configuration file defines one addressable memory Mem with the maximum of 
4 Gbytes of memory. Further, it defines a ROM region and a RAM region in Mem, 
namely ROM_16 and RAM_16. Each region has the size of 32 Kbytes. 

The file then creates an empty block called CSTACK with a size of 4 Kbytes in which the 
application stack will reside. To create a block is the basic method which you can use to 
get detailed control of placement, size, etc. It can be used for grouping sections, but also 
as in this example, to specify the size and placement of an area of memory.
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Placing code and data—the linker configuration file
Next, the file defines how to handle the initialization of variables, read/write type 
(readwrite) sections. In this example, the initializers are placed in ROM and copied at 
startup of the application to the RAM area. By default, ILINK may compress the 
initializers if this appears to be advantageous.

The last part of the configuration file handles the actual placement of all the sections into 
the available regions. First, the startup code—defined to reside in the read-only 
(readonly) section .cstartup—is placed at the start of the ROM region, that is at 
address 0x10000. Note that the part within {} is referred to as section selection and it 
selects the sections for which the directive should be applied to. Then the rest of the 
read-only sections are placed in the ROM region. Note that the section selection 
{ readonly section .cstartup } takes precedence over the more generic section 
selection { readonly }.

Finally, the read/write (readwrite) sections and the CSTACK block are placed in the 
RAM region.

This illustration gives a schematic overview of how the application is placed in memory:

Figure 9: Application in memory

In addition to these standard directives, a configuration file can contain directives that 
define how to:

● Map a memory that can be addressed in multiple ways

● Handle conditional directives
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● Create symbols with values that can be used in the application

● More in detail, select the sections a directive should be applied to

● More in detail, initialize code and data.

For more details and examples about customizing the linker configuration file, see the 
chapter Linking your application.

For reference information about the linker configuration file, see the chapter The linker 
configuration file.

Initialization at system startup
In Standard C, all static variables—variables that are allocated at a fixed memory 
address—must be initialized by the runtime system to a known value at application 
startup. This value is either an explicit value assigned to the variable, or if no value is 
given, it is cleared to zero. In the compiler, there is one exception to this rule and that is 
variables declared __no_init which are not initialized at all.

The compiler generates a specific type of section for each type of variable initialization:

For a summary of all supported sections, see the chapter Section reference.

THE INITIALIZATION PROCESS

Initialization of data is handled by ILINK and the system startup code in conjunction. 

Categories of 

declared data
Source Section type Section name

Section 

content

Zero-initialized 
data

int i; Read/write data, 
zero-init

.bss None

Zero-initialized 
data

int i = 0; Read/write data, 
zero-init

.bss None

Initialized data 
(non-zero)

int i = 6; Read/write data .data The initializer

Non-initialized 
data

__no_init int i; Read/write data, 
zero-init

.noinit None

Constants const int i = 6; Read-only data .rodata The constant

Initialized 
constants

const __memattr 
int i = 6;

Read-only data .memattr.rodataThe constant

Table 7: Sections holding initialized data 
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Initialization at system startup
To configure the initialization of variables, you must consider these issues:

● Sections that should be zero-initialized are handled automatically by ILINK; they 
should only be placed in RAM

● Sections that should be initialized, except for zero-initialized sections, should be 
listed in an initialize directive 

Normally during linking, a section that should be initialized is split in two sections, 
where the original initialized section will keep the name. The contents are placed in 
the new initializer section, which will keep the original name suffixed with _init. 
The initializers should be placed in ROM and the initialized sections in RAM, by 
means of placement directives. The most common example is the .data section that 
the linker splits in .data and .data_init.

● Sections that contains constants should not be initialized; they should only be 
placed in flash/ROM

● Sections holding __no_init declared variables should not be initialized and thus 
should be listed in a do not initialize directive. They should also be placed in 
RAM.

In the linker configuration file, it can look like this:

/* Handle initialization */
do not initialize { section .noinit };
initialize by copy { readwrite }; /* Initialize RW sections,
                                     exclude zero-initialized
                                     sections */

/* Place startup code at a fixed address */
place at start of ROM { readonly section .cstartup };

/* Place code and data */
place in ROM { readonly }; /* Place constants and initializers in
                              ROM: .rodata and .data_init    */
place in RAM { readwrite,  /* Place .data, .bss, and .noinit */
               block STACK }; /* and STACK                   */

For detailed information and examples about how to configure the initialization, see 
Linking considerations, page 81.

C++ DYNAMIC INITIALIZATION

The compiler places subroutine pointers for performing C++ dynamic initialization into 
sections of the ELF section types SHT_PREINIT_ARRAY and SHT_INIT_ARRAY. By 
default, the linker will place these into a linker-created block, ensuring that all sections 
of the section type SHT_PREINIT_ARRAY are placed before those of the type 
SHT_INIT_ARRAY. If any such sections were included, code to call the routines will also 
be included.
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The linker-created blocks are only generated if the linker configuration does not contain 
section selector patterns for the preinit_array and init_array section types. The 
effect of the linker-created blocks will be very similar to what happens if the linker 
configuration file contains this:

define block SHT$$PREINIT_ARRAY { preinit_array };
define block SHT$$INIT_ARRAY { init_array }; 
define block CPP_INIT with fixed order { block
                                         SHT$$PREINIT_ARRAY,
                                         block SHT$$INIT_ARRAY };

If you put this into your linker configuration file, you must also mention the CPP_INIT 
block in one of the section placement directives. If you wish to select where the 
linker-created block is placed, you can use a section selector with the name 
".init_array".

See also Section-selectors, page 329.
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Linking your application
This chapter lists aspects that you must consider when linking your application. 
This includes using ILINK options and tailoring the linker configuration file.

Finally, this chapter provides some hints for troubleshooting.

Linking considerations
Before you can link your application, you must set up the configuration required by 
ILINK. Typically, you must consider:

● Defining your own memory areas

● Placing sections

● Keeping modules in the application

● Keeping symbols and sections in the application

● Application startup

● Setting up the stack and heap

● Setting up the atexit limit

● Changing the default initialization

● Symbols for controlling the application

● Standard library handling

● Other output formats than ELF/DWARF.

CHOOSING A LINKER CONFIGURATION FILE

The config directory contains ready-made linker configuration files for all supported 
devices. The files contain the information required by ILINK. The only change you will 
normally have to make to the supplied configuration file is to customize the start and end 
addresses of each region so they fit the target system memory map. If, for example, your 
application uses additional external RAM, you must also add details about the external 
RAM memory area. 

To edit a linker configuration file, use the editor in the IDE, or any other suitable editor.

Remember not to change the original template file. We recommend that you make a 
copy in the working directory, and modify the copy instead.
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Linking considerations
Each project in the IDE should have a reference to one, and only one, linker 
configuration file. This file can be edited, but for the majority of all projects it is 
sufficient to configure the vital parameters in Project>Options>Linker>Config.

DEFINING YOUR OWN MEMORY AREAS

The default configuration file that you selected has predefined ROM and RAM regions. 
This example will be used as a starting-point for all further examples in this chapter:

/* Define the addressable memory */
define memory Mem with size = 4G;

/* Define a region named ROM with start address 0 and to be 64 
Kbytes large */
define region ROM = Mem:[from 0 size 0x10000];

/* Define a region named RAM with start address 0x20000 and to be 
64 Kbytes large */
define region RAM = Mem:[from 0x20000 size 0x10000];

Each region definition must be tailored for the actual hardware.

To find out how much of each memory that was filled with code and data after linking, 
inspect the memory summary in the map file (command line option --map).

Adding an additional region

To add an additional region, use the define region directive, for example:

/* Define a 2nd ROM region to start at address 0x80000 and to be 
128 Kbytes large */
define region ROM2 = Mem:[from 0x80000 size 0x20000];

Merging different areas into one region

If the region is comprised of several areas, use a region expression to merge the different 
areas into one region, for example:

/* Define the 2nd ROM region to have two areas. The first with 
the start address 0x80000 and 128 Kbytes large, and the 2nd with 
the start address 0xC0000 and 32 Kbytes large */
define region ROM2 = Mem:[from 0x80000 size 0x20000]
                   | Mem:[from 0xC0000 size 0x08000];

or equivalently

define region ROM2 = Mem:[from 0x80000 to 0xC7FFF]
                     –Mem:[from 0xA0000 to 0xBFFFF];
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Adding a region in a new memory

To add a region in a new memory, write:

/* Define a 2nd addressable memory */
define memory Mem2 with size = 64k;
/* Define a region for constants with start address 0 and 64 
Kbytes large */
define region CONSTANT = Mem2:[from 0 size 0x10000];

Defining the unit size for a new memory

If the new memory is not byte-oriented (8-bits per byte) you should define what unit size 
to use:

/* Define the bit addressable memory */
define memory Bit with size = 256, unitbitsize = 1;

PLACING SECTIONS

The default configuration file that you selected places all predefined sections in memory, 
but there are situations when you might want to modify this. For example, if you want 
to place the section that holds constant symbols in the CONSTANT region instead of in 
the default place. In this case, use the place in directive, for example:

/* Place sections with readonly content in the ROM region */
place in ROM {readonly};
/* Place the constant symbols in the CONSTANT region */
place in CONSTANT {readonly section .rodata};

Note: Placing a section—used by the IAR build tools—in a different memory which 
use a different way of referring to its content, will fail.

For the result of each placement directive after linking, inspect the placement summary 
in the map file (the command line option --map).

Placing a section at a specific address in memory

To place a section at a specific address in memory, use the place at directive, for 
example:

/* Place section .vectors at address 0 */
place at address Mem:[0] {readonly section .vectors};

Placing a section first or last in a region

To place a section first or last in a region is similar, for example:

/* Place section .vectors at start of ROM */
place at start of ROM {readonly section .vectors};
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Declare and place your own sections

To declare new sections—in addition to the ones used by the IAR build tools—to hold 
specific parts of your code or data, use mechanisms in the compiler and assembler. For 
example:

/* Places a variable in your own section MyOwnSection. */
const int MyVariable @ "MyOwnSection" = 5;

            name    createSection

            /* Create a section */
            section myOwnSection:CONST

            /* And fill it with constant bytes */
            dcb     5, 6, 7, 8

            end

To place your new section, the original place in ROM {readonly}; directive is 
sufficient.

However, to place the section MyOwnSection explicitly, update the linker configuration 
file with a place in directive, for example:

/* Place MyOwnSection in the ROM region */
place in ROM {readonly section MyOwnSection};

RESERVING SPACE IN RAM

Often, an application must have an empty uninitialized memory area to be used for 
temporary storage, for example a heap or a stack. It is easiest to achieve this at link time. 
You must create a block with a specified size and then place it in a memory.

In the linker configuration file, it can look like this:

define block TempStorage with size = 0x1000, alignment = 4 { };
place in RAM { block TempStorage };
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To retrieve the start of the allocated memory from the application, the source code could 
look like this:

/* Declares a section */
#pragma section = "TempStorage"

char *TempStorage()
{
  /* Return start address of section TempStorage. */
  return __section_begin("TempStorage");
}

KEEPING MODULES

If a module is linked as an object file, it is always kept. That is, it will contribute to the 
linked application. However, if a module is part of a library, it is included only if it is 
symbolically referred to from other parts of the application. This is true, even if the 
library module contains a root symbol. To assure that such a library module is always 
included, use iarchive to extract the module from the library, see The IAR Archive 
Tool—iarchive, page 347.

For information about included and excluded modules, inspect the log file (the 
command line option --log modules).

For more information about modules, see Modules and sections, page 71.

KEEPING SYMBOLS AND SECTIONS

By default, ILINK removes any sections, section fragments, and global symbols that are 
not needed by the application. To retain a symbol that does not appear to be needed—or 
actually, the section fragment it is defined in—you can either use the root attribute on 
the symbol in your C/C++ or assembler source code, or use the ILINK option --keep. 
To retain sections based on attribute names or object names, use the directive keep in 
the linker configuration file.

To prevent ILINK from excluding sections and section fragments, use the command line 
options --no_remove or --no_fragments, respectively.

For information about included and excluded symbols and sections, inspect the log file 
(the command line option --log sections).

For more information about the linking procedure for keeping symbols and sections, see 
The linking process, page 72.
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APPLICATION STARTUP

By default, the point where the application starts execution is defined by the 
__iar_program_start label, which is defined to point at the reset vector. The label 
is also communicated via ELF to any debugger that is used.

To change the start point of the application to another label, use the ILINK option 
--entry; see --entry, page 238.

SETTING UP THE STACK

The size of the CSTACK block is defined in the linker configuration file. To change the 
allocated amount of memory, change the block definition for CSTACK:

define block CSTACK with size = 0x2000, alignment = 4{ };

Specify an appropriate size for your application.

To read more about the stack, see Stack considerations, page 161.

SETTING UP THE HEAP

The size of the heap is defined in the linker configuration file as a block:

define block HEAP with size = 0x1000, alignment = 4{ };
place in RAM {block HEAP};

Specify the appropriate size for your application.

SETTING UP THE ATEXIT LIMIT

By default, the atexit function can be called a maximum of 32 times from your 
application. To either increase or decrease this number, add a line to your configuration 
file. For example, to reserve room for 10 calls instead, write:

define symbol __iar_maximum_atexit_calls = 10;

CHANGING THE DEFAULT INITIALIZATION

By default, memory initialization is performed during application startup. ILINK sets 
up the initialization process and chooses a suitable packing method. If the default 
initialization process does not suit your application and you want more precise control 
over the initialization process, these alternatives are available:

● Choosing the packing algorithm

● Manual initialization

● Initializing code—copying ROM to RAM.
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For information about the performed initializations, inspect the log file (the command 
line option --log initialization).

Choosing a packing algorithm

To override the default packing algorithm, write for example:

initialize by copy with packing = lzw { readwrite };

To read more about the available packing algorithms, see Initialize directive, page 323.

Manual initialization

The initialize manually directive lets you take complete control over initialization. 
For each involved section, ILINK creates an extra section that contains the initialization 
data, but makes no arrangements for the actual copying. This directive is, for example, 
useful for overlays:

/* Sections MYOVERLAY1 and MYOVERLAY2 will be overlaid in 
MyOverlay */
define overlay MyOverlay { section MYOVERLAY1 };
define overlay MyOverlay { section MYOVERLAY2 };

/* Split the overlay sections but without initialization during 
system startup */
initialize manually { section MYOVERLAY* };

/* Place the initializer sections in a block each */
define block MyOverlay1InRom { section MYOVERLAY1_init };
define block MyOverlay2InRom { section MYOVERLAY2_init };

/* Place the overlay and the initializers for it */
place in RAM { overlay MyOverlay };
place in ROM { block MyOverlay1InRom, block MyOverlay2InRom };

The application can then start a specific overlay by copying, as in this case, ROM to 
RAM:

#include <string.h>

/* Declare the sections. */

#pragma section = "MyOverlay"
#pragma section = "MyOverlay1InRom"
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/* Function that switches in image 1 into the overlay. */

void SwitchToOverlay1()
{
  char *targetAddr     = __section_begin("MyOverlay");
  char *sourceAddr     = __section_begin("MyOverlay1InRom");
  char *sourceAddrEnd  = __section_end("MyOverlay1InRom");
  int size = sourceAddrEnd - sourceAddr;

  memcpy(targetAddr, sourceAddr, size);
}

Initializing code—copying ROM to RAM

Sometimes, an application copies pieces of code from flash/ROM to RAM. This can be 
easily achieved by ILINK for whole code regions.

List the code sections that should be initialized in an initialize directive and then 
place the initializer and initialized sections in ROM and RAM, respectively.

In the linker configuration file, it can look like this:

/* Split the RAMCODE section into a readonly and a readwrite 
section */
initialize by copy { section RAMCODE };

/* Place both in a block */
define block RamCode { section RAMCODE };
define block RamCodeInit { section RAMCODE_init };

/* Place them in ROM and RAM */
place in ROM { block RamCodeInit };
place in RAM { block RamCode };

The block definitions makes it possible to refer to the start and end of the blocks from 
the application.

For more examples, see Interaction between the tools and your application, page 163.

Running all code from RAM

If you want to copy the entire application from ROM to RAM at program startup, use 
the initilize by copy directive, for example:

initialize by copy { readonly, readwrite };

The readwrite pattern will match all statically initialized variables and arrange for 
them to be initialized at startup. The readonly pattern will do the same for all read-only 
code and data, except for code and data needed for the initialization.
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To reduce the ROM space that is needed, it might be useful to compress the data with 
one of the available packing algorithms. For example,

initialize by copy with packing = lzw { readonly, readwrite };

To read more about the available compression algorithms, see Initialize directive, page 
323.

Because the function __low_level_init, if present, is called before initialization, it, 
and anything it needs, will not be copied from ROM to RAM either. In some 
circumstances—for example, if the ROM contents are no longer available to the 
program after startup—you might need to avoid using the same functions during startup 
and in the rest of the code.

If anything else should not be copied, include it in an except clause. This can apply to, 
for example, the interrupt vector table.

It is also recommended to exclude the C++ dynamic initialization table from being 
copied to RAM, as it is typically only read once and then never referenced again. For 
example, like this:

initialize by copy { readonly, readwrite }
            except { section .intvec,       /* Don’t copy
                                               interrupt table */
                     section .init_array }; /* Don’t copy
                                               C++ init table */

INTERACTION BETWEEN ILINK AND THE APPLICATION

ILINK provides the command line options --config_def and --define_symbol to 
define symbols which can be used for controlling the application. You can also use 
symbols to represent the start and end of a continuous memory area that is defined in the 
linker configuration file. For more details, see Interaction between the tools and your 
application, page 163.

To change a reference to one symbol to another symbol, use the ILINK command line 
option --redirect. This is useful, for example, to redirect a reference from a 
non-implemented function to a stub function, or to choose one of several different 
implementations of a certain function, for example, how to choose the DLIB formatter 
for the standard library functions printf and scanf.

The compiler generates mangled names to represent complex C/C++ symbols. If you 
want to refer to these symbols from assembler source code, you must use the mangled 
names.

For information about the addresses and sizes of all global (statically linked) symbols, 
inspect the entry list in the map file (the command line option --map).

For more information, see Interaction between the tools and your application, page 163.
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Hints for troubleshooting
STANDARD LIBRARY HANDLING

By default, ILINK determines automatically which variant of the standard library to 
include during linking. The decision is based on the sum of the runtime attributes 
available in each object file and the library options passed to ILINK.

To disable the automatic inclusion of the library, use the option 
--no_library_search. In this case, you must explicitly specify every library file to 
be included. For information about available library files, see Using a prebuilt library, 
page 95.

PRODUCING OTHER OUTPUT FORMATS THAN ELF/DWARF

ILINK can only produce an output file in the ELF/DWARF format. To convert that 
format into a format suitable for programming PROM/flash, see The IAR ELF 
Tool—ielftool, page 350.

Hints for troubleshooting 
ILINK has several features that can help you manage code and data placement correctly, 
for example:

● Messages at link time, for examples when a relocation error occurs

● The --log option that makes ILINK log information to stdout, which can be 
useful to understand why an executable image became the way it is, see --log, page 
241

● The --map option that makes ILINK produce a memory map file, which contains 
the result of the linker configuration file, see --map, page 242. 

RELOCATION ERRORS

For each instruction that cannot be relocated correctly, ILINK will generate a relocation 
error. This can occur for instructions where the target is out of reach or is of an 
incompatible type, or for many other reasons.

A relocation error produced by ILINK can look like this:

Error[Lp002]: relocation failed: out of range or illegal value
    Kind     :   R_XXX_YYY[0x1]
    Location :   0x40000448
                 "myfunc" + 0x2c
                 Module:  somecode.o
                 Section: 7 (.text)
                 Offset:  0x2c
    Destination: 0x9000000c
                 "read"
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                 Module:  read.o(iolib.a)
                 Section: 6 (.text)
                 Offset:  0x0

The message entries are described in this table:

Possible solutions

In this case, the distance from the instruction in getchar to __read is too long for the 
branch instruction.

Possible solutions include ensuring that the two .text sections are allocated closer to 
each other or using some other calling mechanism that can reach the required distance. 
It is also possible that the referring function tried to refer to the wrong target and that 
this caused the range error.

Message entry Description

Kind The relocation directive that failed. The directive depends on the 
instruction used.

Location The location where the problem occurred, described with the following 
details:
• The instruction address, expressed both as a hexadecimal value and as
   a label with an offset. In this example, 0x40000448 and
   "myfunc" + 0x2c.
• The module, and the file. In this example, the
   module somecode.o.
• The section number and section name. In this example, section number
  7 with the name .text.
• The offset, specified in number of bytes, in the section. In this example,
   0x2c.

Destination The target of the instruction, described with the following details:
• The instruction address, expressed both as a hexadecimal value and as
   a label with an offset. In this example, 0x9000000c and
   "read" (thus, no offset).
• The module, and when applicable the library. In this example, the
   module read.o and the library iolib.a.
• The section number and section name. In this example, section number
  6 with the name .text.
• The offset, specified in number of bytes, in the section. In this example,
   0x0.

Table 8: Description of a relocation error 
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Different range errors have different solutions. Usually, the solution is a variant of the 
ones presented above, in other words modifying either the code or the section 
placement.
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environment 
This chapter describes the runtime environment in which an application 
executes. In particular, the chapter covers the DLIB runtime library and how 
you can optimize it for your application.

Introduction to the runtime environment
The runtime environment is the environment in which your application executes. The 
runtime environment depends on the target hardware, the software environment, and the 
application code.

RUNTIME ENVIRONMENT FUNCTIONALITY

The runtime environment supports Standard C and C++, including the standard template 
library. The runtime environment consists of the runtime library, which contains the 
functions defined by the C and the C++ standards, and include files that define the 
library interface (the system header files).

The runtime library is delivered both as prebuilt libraries and (depending on your 
product package) as source files, and you can find them in the product subdirectories 
sh\lib and sh\src\lib, respectively.

The runtime environment also consists of a part with specific support for the target 
system, which includes:

● Support for hardware features:

● Direct access to low-level processor operations by means of intrinsic functions, 
such as functions for register handling

● Peripheral unit registers and interrupt definitions in include files

● Target-specific arithmetic support modules, like floating-point coprocessors.

● Runtime environment support, that is, startup and exit code and low-level interface 
to some library functions.

● A floating-point environment (fenv) that contains floating-point arithmetics support, 
see fenv.h, page 312.

● Special compiler support, for instance functions for switch handling or integer 
arithmetics.
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Introduction to the runtime environment
The runtime environment support and the size of the heap must be tailored for the 
specific hardware and application requirements.

For further information about the library, see the chapter Library functions.

SETTING UP THE RUNTIME ENVIRONMENT

The IAR DLIB runtime environment can be used as is together with the debugger. 
However, to run the application on hardware, you must adapt the runtime environment. 
Also, to configure the most code-efficient runtime environment, you must determine 
your application and hardware requirements. The more functionality you need, the 
larger your code will become.

This is an overview of the steps involved in configuring the most efficient runtime 
environment for your target hardware:

● Choose which runtime library object file to use

It is not necessary to specify a library file explicitly, as ILINK automatically uses the 
correct library file. See Using a prebuilt library, page 95.

● Choose which predefined runtime library configuration to use—Near or Full

You can configure the level of support for certain library functionality, for example, 
locale, file descriptors, and multibyte characters. If you do not specify anything, a 
default library configuration file that matches the library object file is automatically 
used. To specify a library configuration explicitly, use the --dlib_config compiler 
option. See Library configurations, page 108.

● Optimize the size of the runtime library

You can specify the formatters used by the functions printf, scanf, and their 
variants, see Choosing formatters for printf and scanf, page 97. You can also specify 
the size and placement of the stack and the heap, see Setting up the stack, page 86, 
and Setting up the heap, page 86, respectively.

● Include debug support for runtime and I/O debugging

The library offers C-SPY debug support and if you want to debug your application, 
you must choose to use it, see Application debug support, page 99

● Adapt the library functionality

Some library functions must be customized to suit your target hardware, for example 
low-level functions for character-based I/O, environment functions, signal functions, 
and time functions. This can be done without rebuilding the entire library, see 
Overriding library modules, page 101.

● Customize system initialization

It is likely that you need to customize the source code for system initialization, for 
example, your application might need to initialize memory-mapped special function 
registers, or omit the default initialization of data sections. You do this by 
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customizing the routine __low_level_init, which is executed before the data 
sections are initialized. See System startup and termination, page 104 and 
Customizing system initialization, page 107.

● Configure your own library configuration files

In addition to the prebuilt library configurations, you can make your own library 
configuration, but that requires that you rebuild the library. This gives you full 
control of the runtime environment. See Building and using a customized library, 
page 103.

● Check module consistency

You can use runtime model attributes to ensure that modules are built using 
compatible settings, see Checking module consistency, page 123.

● Manage a multithreaded environment

In a multithreaded environment, you must adapt the runtime library to treat all library 
objects according to whether they are global or local to a thread. See Managing a 
multithreaded environment, page 118.

Using a prebuilt library
The prebuilt runtime libraries are configured for different combinations of these 
features:

● Code model

● Size of the double floating-point type

● Hardware floating-point unit

● Library configuration—Normal, or Full.

CHOOSING A LIBRARY

In the IDE, the linker will include the correct library object file and library configuration 
file based on the options you select. See the IAR Embedded Workbench® IDE User 
Guide for additional information.

If you build your application from the command line, a default library configuration is 
used automatically, However, you can specify the library configuration explicitly for the 
compiler:

--dlib_config C:\...\dlshldff.h

You can find the library object files and the library configuration files in the subdirectory 
sh\lib\.
DSH-2

Part 1. Using the build tools 95



96

Using a prebuilt library
GROUPS OF LIBRARY FILES

The libraries are delivered in these groups of library functions:

● C/C++ standard library functions

Contains all functions defined by Standard C and C++, for example functions like 
printf and scanf.

● Debug support functions

Library filename syntax

The names of the libraries are constructed in this way:

<lib><cpu><code_model><double_size><fpu><lib_config>.a

where

● <lib> is dl for the IAR DLIB runtime environment

● <cpu> is sh

● <code_model> is one of s|m|l|h

● <double_size> is either f for 32 bits or d for 64 bits

● <fpu> is either f for FPU support or n for no FPU support

● <lib_config> is either n or f for the Normal or the Full library configuration, 
respectively.

Note: The library configuration file has the same base name as the library.

Library files for debug support functions

The names of the library files are constructed in the following way:

dbg<code_model><debug_IO>.a

where <debug_IO> is d for debug I/O support and n for no debug I/O support.

More specifically, this means:

dbg{s|m|l|h}{d|n}.a

CUSTOMIZING A PREBUILT LIBRARY WITHOUT REBUILDING 

The prebuilt libraries delivered with the compiler can be used as is. However, you can 
customize parts of a library without rebuilding it.
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These items can be customized:

For a description about how to override library modules, see Overriding library 
modules, page 101.

Choosing formatters for printf and scanf
To override the default formatter for all the printf- and scanf-related functions, 
except for wprintf and wscanf variants, you simply set the appropriate library 
options. This section describes the different options available.

Note: If you rebuild the library, you can optimize these functions even further, see 
Configuration symbols for printf and scanf, page 111.

CHOOSING PRINTF FORMATTER 

The printf function uses a formatter called _Printf. The default version is quite 
large, and provides facilities not required in many embedded applications. To reduce the 
memory consumption, three smaller, alternative versions are also provided in the 
Standard C/EC++ library.

This table summarizes the capabilities of the different formatters:

Items that can be customized Described in

Formatters for printf and scanf Choosing formatters for printf and scanf, page 97

Startup and termination code System startup and termination, page 104

Low-level input and output Standard streams for input and output, page 109

File input and output File input and output, page 112

Low-level environment functions Environment interaction, page 115

Low-level signal functions Signal and raise, page 116

Low-level time functions Time, page 117

Size of heaps, stacks, and sections Stack considerations, page 161
Heap considerations, page 162
Placing code and data—the linker configuration file, 
page 74

Table 9: Customizable items 

Formatting capabilities _PrintfTiny _PrintfSmall _PrintfLarge _PrintfFull

Basic specifiers c, d, i, o, p, s, u, X, x, 
and %

Yes Yes Yes Yes

Table 10: Formatters for printf 
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Choosing formatters for printf and scanf
† Depends on the library configuration that is used.

For information about how to fine-tune the formatting capabilities even further, see 
Configuration symbols for printf and scanf, page 111.

Specifying the print formatter in the IDE

To use any other formatter than the default (Small), choose Project>Options and select 
the General Options category. Select the appropriate option on the Library options 
page.

Specifying printf formatter from the command line

To use any other formatter than the default (_PrintfFull), add one of these ILINK 
command line options:

--redirect __Printf=__PrintfTiny
--redirect __Printf=__PrintfSmall
--redirect __Printf=__PrintfLarge

CHOOSING SCANF FORMATTER 

In a similar way to the printf function, scanf uses a common formatter, called 
_Scanf. The default version is very large, and provides facilities that are not required 
in many embedded applications. To reduce the memory consumption, two smaller, 
alternative versions are also provided in the Standard C/C++ library.

This table summarizes the capabilities of the different formatters:

Multibyte support No † † †

Floating-point specifiers a, and A No No No Yes

Floating-point specifiers e, E, f, F, g, and 
G

No No Yes Yes

Conversion specifier n No No Yes Yes

Format flag space, +, -, #, and 0 No Yes Yes Yes

Length modifiers h, l, L, s, t, and Z No Yes Yes Yes

Field width and precision, including * No Yes Yes Yes

long long support No No Yes Yes

Formatting capabilities _ScanfSmall _ScanfLarge _ScanfFull

Basic specifiers c, d, i, o, p, s, u, X, x, and % Yes Yes Yes

Table 11: Formatters for scanf 

Formatting capabilities _PrintfTiny _PrintfSmall _PrintfLarge _PrintfFull

Table 10: Formatters for printf  (Continued)
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† Depends on the library configuration that is used.

For information about how to fine-tune the formatting capabilities even further, see 
Configuration symbols for printf and scanf, page 111.

Specifying scanf formatter in the IDE

To use any other formatter than the default (Small), choose Project>Options and select 
the General Options category. Select the appropriate option on the Library options 
page.

Specifying scanf formatter from the command line

To use any other variant than the default (_ScanfFull), add one of these ILINK 
command line options:

--redirect __Scanf=__ScanfSmall
--redirect __Scanf=__ScanfLarge

Application debug support
In addition to the tools that generate debug information, there is a debug version of the 
DLIB low-level interface (typically, I/O handling and basic runtime support). If your 
application uses this interface, you can either use the debug version of the interface or 
you must implement the functionality of the parts that your application uses.

INCLUDING DEBUG SUPPORT

You can make the library provide debugging support for:

● Handling program abort, exit, and assertions

● I/O handling, which means that stdin and stdout are redirected to the C-SPY 
Terminal I/O window, and that it is possible to access files on the host computer 
during debugging.

Multibyte support † † †

Floating-point specifiers a, and A No No Yes

Floating-point specifiers e, E, f, F, g, and G No No Yes

Conversion specifier n No No Yes

Scan set [ and ] No Yes Yes

Assignment suppressing * No Yes Yes

long long support No No Yes

Formatting capabilities _ScanfSmall _ScanfLarge _ScanfFull

Table 11: Formatters for scanf  (Continued)
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Application debug support
To set linker options for debug support in the IDE, choose Project>Options and select 
the Linker category. On the Library page, select the Include C-SPY debugging 
support option.

On the command line, use the linker option --debug_lib.

Note: If you enable debug information during compilation, this information will be 
included also in the linker output, unless you use the linker option --strip.

THE DEBUG LIBRARY FUNCTIONALITY

The debug library is used for communication between the application being debugged 
and the debugger itself. The debugger provides runtime services to the application via 
the low-level DLIB interface; services that allow capabilities like file and terminal I/O 
to be performed on the host computer. 

These capabilities can be valuable during the early development of an application, for 
example in an application that uses file I/O before any flash file system I/O drivers are 
implemented. Or, if you need to debug constructions in your application that use stdin 
and stdout without the actual hardware device for input and output being available. 
Another debugging purpose can be to produce debug trace printouts.

The mechanism used for implementing this feature works as follows:

The debugger will detect the presence of the function __DebugBreak, which will be 
part of the application if you linked it with the ILINK options for C-SPY debug support. 
In this case, the debugger will automatically set a breakpoint at the __DebugBreak 
function. When the application calls, for example, open; the __DebugBreak function 
is called, which will cause the application to break and perform the necessary services. 
The execution will then resume.

If you have included the runtime library debugging support, C-SPY will make the 
following responses when the application uses the DLIB low-level interface:

Function in DLIB 

low-level interface
Response by C-SPY

abort Notifies that the application has called abort

clock Returns the clock on the host computer

__close Closes the associated host file on the host computer

__exit C-SPY notifies that the end of the application was reached

__open Opens a file on the host computer

__read stdin, stdout, and stderr will be directed to the Terminal I/O 
window; all other files will read the associated host file

remove Writes a message to the Debug Log window and returns -1

Table 12: Functions with special meanings when linked with debug library
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THE C-SPY TERMINAL I/O WINDOW

To make the Terminal I/O window available, the application must be linked with support 
for I/O debugging. This means that when the functions __read or __write are called 
to perform I/O operations on the streams stdin, stdout, or stderr, data will be sent 
to or read from the C-SPY Terminal I/O window.

Note: The Terminal I/O window is not opened automatically just because __read or 
__write is called; you must open it manually.

See the IAR Embedded Workbench® IDE User Guide for more information about the 
Terminal I/O window.

Speeding up terminal output

On some systems, terminal output might be slow because the host computer and the 
target hardware must communicate for each character.

For this reason, a replacement for the __write function called __write_buffered is 
included in the DLIB library. This module buffers the output and sends it to the debugger 
one line at a time, speeding up the output. Note that this function uses about 80 bytes of 
RAM memory.

To use this feature you can either choose Project>Options>Linker>Library and select 
the option Buffered write in the IDE, or add this to the linker command line:

--redirect ___write=___write_buffered

Overriding library modules 
The library contains modules which you probably need to override with your own 
customized modules, for example functions for character-based I/O and cstartup. 
This can be done without rebuilding the entire library. This section describes the 

rename Writes a message to the Debug Log window and returns -1

_ReportAssert Handles failed asserts

__seek Seeks in the associated host file on the host computer

system Writes a message to the Debug Log window and returns -1

time Returns the time on the host computer

__write stdin, stdout, and stderr will be directed to the Terminal I/O 
window, all other files will write to the associated host file

Function in DLIB 

low-level interface
Response by C-SPY

Table 12: Functions with special meanings when linked with debug library (Continued)
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Overriding library modules
procedure for including your version of the module in the application project build 
process. The library files that you can override with your own versions are located in the 
sh\src\lib directory.

Note: If you override a default I/O library module with your own module, C-SPY 
support for the module is turned off. For example, if you replace the module __write 
with your own version, the C-SPY Terminal I/O window will not be supported.

Overriding library modules using the IDE

This procedure is applicable to any source file in the library, which means that 
library_module.c in this example can be any module in the library.

1 Copy the appropriate library_module.c file to your project directory.

2 Make the required additions to the file (or create your own routine, using the default 
file as a model).

3 Add the customized file to your project.

4 Rebuild your project.

Overriding library modules from the command line

This procedure is applicable to any source file in the library, which means that 
library_module.c in this example can be any module in the library.

1 Copy the appropriate library_module.c to your project directory.

2 Make the required additions to the file (or create your own routine, using the default 
file as a model), and make sure that it has the same module name as the original 
module. The easiest way to achieve this is to save the new file under the same name as 
the original file.

3 Compile the modified file using the same options as for the rest of the project:

iccsh library_module.c

This creates a replacement object module file named library_module.o.

Note: The code model, include paths, and the library configuration file must be the 
same for library_module as for the rest of your code.

4 Add library_module.o to the ILINK command line, either directly or by using an 
linker configuration file, for example:

ilinksh library_module.o

Make sure that library_module.o is placed before the library on the command line. 
This ensures that your module is used instead of the one in the library.
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Run ILINK to rebuild your application.

This will use your version of library_module.o, instead of the one in the library. For 
information about the ILINK options, see the chapter Linker options.

Building and using a customized library
Building a customized library is a complex process. Therefore, consider carefully 
whether it is really necessary.

You must build your own library when you want to define your own library 
configuration with support for locale, file descriptors, multibyte characters, et cetera.

In those cases, you must:

● Set up a library project

● Make the required library modifications

● Build your customized library

● Finally, make sure your application project will use the customized library.

Note: To build IAR Embedded Workbench projects from the command line, use the 
IAR Command Line Build Utility (iarbuild.exe). However, no make or batch files 
for building the library from the command line are provided.

For information about the build process and the IAR Command Line Build Utility, see 
the IAR Embedded Workbench® IDE User Guide. 

SETTING UP A LIBRARY PROJECT

The IDE provides a library project template which can be used for customizing the 
runtime environment configuration. This library template uses the Full library 
configuration, see Table 13, Library configurations, page 108.

In the IDE, modify the generic options in the created library project to suit your 
application, see Basic project configuration, page 51.

Note: If you set an option on file level (file level override), no options on higher levels 
that operate on files will affect that file.

MODIFYING THE LIBRARY FUNCTIONALITY

You must modify the library configuration file and build your own library if you want 
to modify support for, for example, locale, file descriptors, and multibyte characters. 
This will include or exclude certain parts of the runtime environment.

The library functionality is determined by a set of configuration symbols. The default 
values of these symbols are defined in the file DLib_Defaults.h. This read-only file 
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describes the configuration possibilities. Your library also has its own library 
configuration file dlshlibraryname.h, which sets up that specific library with full 
library configuration. For more information, see Table 9, Customizable items, page 97.

The library configuration file is used for tailoring a build of the runtime library, and for 
tailoring the system header files.

Modifying the library configuration file

In your library project, open the file dlshlibraryname.h and customize it by setting 
the values of the configuration symbols according to the application requirements.

When you are finished, build your library project with the appropriate project options.

USING A CUSTOMIZED LIBRARY

After you build your library, you must make sure to use it in your application project. 

In the IDE you must do these steps:

1 Choose Project>Options and click the Library Configuration tab in the General 
Options category. 

2 Choose Custom DLIB from the Library drop-down menu.

3 In the Configuration file text box, locate your library configuration file.

4 Click the Library tab, also in the Linker category. Use the Additional libraries text 
box to locate your library file.

System startup and termination
This section describes the runtime environment actions performed during startup and 
termination of your application.

The code for handling startup and termination is located in the source files 
cstartup.s, cexit.s, and low_level_init.c or low_level_init.s located in 
the sh\src\lib directory.

For information about how to customize the system startup code, see Customizing 
system initialization, page 107.

SYSTEM STARTUP

During system startup, an initialization sequence is executed before the main function 
is entered. This sequence performs initializations required for the target hardware and 
the C/C++ environment.
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For the hardware initialization, it looks like this:

Figure 10: Target hardware initialization phase

● When the CPU is reset it will jump to the program entry label 
__iar_program_start in the system startup code.

● The stack pointer is initialized to the end of the CSTACK block

● The function __low_level_init is called if you defined it, giving the application 
a chance to perform early initializations.

For the C/C++ initialization, it looks like this:

Figure 11: C/C++ initialization phase

● Static and global variables are initialized. That is, zero-initialized variables are 
cleared and the values of other initialized variables are copied from ROM to RAM 
memory. This step is skipped if __low_level_init returns zero. For more details, 
see Initialization at system startup, page 77
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● Static C++ objects are constructed

● The main function is called, which starts the application.

For an overview of the initialization phase, see Application execution—an overview, 
page 46.

SYSTEM TERMINATION

This illustration shows the different ways an embedded application can terminate in a 
controlled way:

Figure 12: System termination phase

An application can terminate normally in two different ways:

● Return from the main function

● Call the exit function.

Because the C standard states that the two methods should be equivalent, the system 
startup code calls the exit function if main returns. The parameter passed to the exit 
function is the return value of main.

The default exit function is written in C. It calls a small assembler function _exit that 
will perform these operations:

● Call functions registered to be executed when the application ends. This includes 
C++ destructors for static and global variables, and functions registered with the C 
function atexit

● Close all open files

● Call __exit

● When __exit is reached, stop the system.
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An application can also exit by calling the abort or the _Exit function. The abort 
function just calls __exit to halt the system, and does not perform any type of cleanup. 
The _Exit function is equivalent to the abort function, except for the fact that _Exit 
takes an argument for passing exit status information.

If you want your application to do anything extra at exit, for example resetting the 
system, you can write your own implementation of the __exit(int) function.

C-SPY interface to system termination

If your project is linked with the C-SPY debug library semihosted interface, the normal 
__exit and abort functions are replaced with special ones. C-SPY will then recognize 
when those functions are called and can take appropriate actions to simulate program 
termination. For more information, see Application debug support, page 99.

Customizing system initialization
It is likely that you need to customize the code for system initialization. For example, 
your application might need to initialize memory-mapped special function registers 
(SFRs), or omit the default initialization of data sections performed by cstartup.

You can do this by providing a customized version of the routine __low_level_init, 
which is called from cstartup.s before the data sections are initialized. Modifying the 
file cstartup directly should be avoided.

The code for handling system startup is located in the source files cstartup.s and 
low_level_init.c, located in the sh\src\lib directory. 

Note: Normally, you do not need to customize cexit.s.

If you intend to rebuild the library, the source files are available in the template library 
project, see Building and using a customized library, page 103. 

Note: Regardless of whether you modify the routine __low_level_init or the file 
cstartup.s, you do not have to rebuild the library.

__LOW_LEVEL_INIT 

Two skeleton low-level initialization files are supplied with the product: a C source file, 
low_level_init.c and an alternative assembler source file, low_level_init.s. 
The latter is part of the prebuilt runtime environment. The only limitation using the C 
source version is that static initialized variables cannot be used within the file, as 
variable initialization has not been performed at this point.

The value returned by __low_level_init determines whether or not data sections 
should be initialized by the system startup code. If the function returns 0, the data 
sections will not be initialized.
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MODIFYING THE FILE CSTARTUP.S 

As noted earlier, you should not modify the file cstartup.s if a customized version of 
__low_level_init is enough for your needs. However, if you do need to modify the 
file cstartup.s, we recommend that you follow the general procedure for creating a 
modified copy of the file and adding it to your project, see Overriding library modules, 
page 101.

Note that you must make sure that the linker uses the start label used in your version of 
cstartup.s. For information about how to change the start label used by the linker, see 
--entry, page 238.

Library configurations 
It is possible to configure the level of support for, for example, locale, file descriptors, 
multibyte characters. 

The runtime library configuration is defined in the library configuration file. It contains 
information about what functionality is part of the runtime environment. The 
configuration file is used for tailoring a build of a runtime library, and tailoring the 
system header files used when compiling your application. The less functionality you 
need in the runtime environment, the smaller it becomes.

The library functionality is determined by a set of configuration symbols. The default 
values of these symbols are defined in the file DLib_Defaults.h. This read-only file 
describes the configuration possibilities.

These predefined library configurations are available:

CHOOSING A RUNTIME CONFIGURATION

To choose a runtime configuration, use one of these methods:

● Default prebuilt configuration—if you do not specify a library configuration 
explicitly you will get the default configuration. A configuration file that matches 
the runtime library object file will automatically be used.

Library configuration Description

Normal DLIB (default) No locale interface, C locale, no file descriptor support, no multibyte 
characters in printf and scanf, and no hexadecimal floating-point 
numbers in strtod.

Full DLIB Full locale interface, C locale, file descriptor support, multibyte 
characters in printf and scanf, and hexadecimal floating-point 
numbers in strtod.

Table 13: Library configurations 
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● Prebuilt configuration of your choice—to specify a runtime configuration explicitly, 
use the --dlib_config compiler option. See --dlib_config, page 212.

● Your own configuration—you can define your own configurations, which means 
that you must modify the configuration file. Note that the library configuration file 
describes how a library was built and thus cannot be changed unless you rebuild the 
library. For further information, see Building and using a customized library, page 
103.

The prebuilt libraries are based on the default configurations, see Table 13, Library 
configurations.

Standard streams for input and output
Standard communication channels (streams) are defined in stdio.h. If any of these 
streams are used by your application, for example by the functions printf and scanf, 
you must customize the low-level functionality to suit your hardware.

There are primitive I/O functions, which are the fundamental functions through which 
C and C++ performs all character-based I/O. For any character-based I/O to be available, 
you must provide definitions for these functions using whatever facilities the hardware 
environment provides.

IMPLEMENTING LOW-LEVEL CHARACTER INPUT AND 
OUTPUT

To implement low-level functionality of the stdin and stdout streams, you must write 
the functions __read and __write, respectively. You can find template source code for 
these functions in the sh\src\lib directory. 

If you intend to rebuild the library, the source files are available in the template library 
project, see Building and using a customized library, page 103. Note that customizing 
the low-level routines for input and output does not require you to rebuild the library.

Note: If you write your own variants of __read or __write, special considerations 
for the C-SPY runtime interface are needed, see Application debug support, page 99.

Example of using __write

The code in this example uses memory-mapped I/O to write to an LCD display:

#include <stddef.h>

__no_init volatile unsigned char lcdIO @ 0xFFFF8000;
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size_t __write(int handle,
               const unsigned char *buf,
               size_t bufSize)
{
  size_t nChars = 0;

  /* Check for the command to flush all handles */
  if (handle == -1)
  {
    return 0;
  }
  
  /* Check for stdout and stderr 
     (only necessary if FILE descriptors are enabled.) */
  if (handle != 1 && handle != 2)
  {
    return -1;
  }

  for (/* Empty */; bufSize > 0; --bufSize)
  {
    lcdIO = *buf;
    ++buf;
    ++nChars;
  }

  return nChars;
}

Note: A call to __write where buf has the value NULL is a command to flush the 
handle. When the handle is -1, all streams should be flushed.

Example of using __read

The code in this example uses memory-mapped I/O to read from a keyboard:

#include <stddef.h>

__no_init volatile unsigned char kbIO @ 0xFFFF8004;

size_t __read(int handle, 
              unsigned char *buf,
              size_t bufSize)
{
  size_t nChars = 0;

  /* Check for stdin 
     (only necessary if FILE descriptors are enabled) */
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  if (handle != 0)
  {
    return -1;
  }

  for (/*Empty*/; bufSize > 0; --bufSize)
  {
    unsigned char c = kbIO;
    if (c == 0)
      break;

    *buf++ = c;
    ++nChars;
  }

  return nChars;
}

For information about the @ operator, see Controlling data and function placement in 
memory, page 173.

Configuration symbols for printf and scanf
When you set up your application project, you typically need to consider what printf 
and scanf formatting capabilities your application requires, see Choosing formatters 
for printf and scanf, page 97.

If the provided formatters do not meet your requirements, you can customize the full 
formatters. However, that means you must rebuild the runtime library.

The default behavior of the printf and scanf formatters are defined by configuration 
symbols in the file DLib_Defaults.h.

These configuration symbols determine what capabilities the function printf should 
have:

Printf configuration symbols Includes support for

_DLIB_PRINTF_MULTIBYTE Multibyte characters

_DLIB_PRINTF_LONG_LONG Long long (ll qualifier)

_DLIB_PRINTF_SPECIFIER_FLOAT Floating-point numbers

_DLIB_PRINTF_SPECIFIER_A Hexadecimal floating-point numbers

_DLIB_PRINTF_SPECIFIER_N Output count (%n)

_DLIB_PRINTF_QUALIFIERS Qualifiers h, l, L, v, t, and z

Table 14: Descriptions of printf configuration symbols 
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When you build a library, these configurations determine what capabilities the function 
scanf should have:

CUSTOMIZING FORMATTING CAPABILITIES

To customize the formatting capabilities, you must;

1 Set up a library project, see Building and using a customized library, page 103.

2 Define the configuration symbols according to your application requirements.

File input and output
The library contains a large number of powerful functions for file I/O operations. If you 
use any of these functions, you must customize them to suit your hardware. To simplify 
adaptation to specific hardware, all I/O functions call a small set of primitive functions, 
each designed to accomplish one particular task; for example, __open opens a file, and 
__write outputs characters.

Note that file I/O capability in the library is only supported by libraries with full library 
configuration, see Library configurations, page 108. In other words, file I/O is 
supported when the configuration symbol __DLIB_FILE_DESCRIPTOR is enabled. If 
not enabled, functions taking a FILE * argument cannot be used. 

_DLIB_PRINTF_FLAGS Flags -, +, #, and 0

_DLIB_PRINTF_WIDTH_AND_PRECISION Width and precision

_DLIB_PRINTF_CHAR_BY_CHAR Output char by char or buffered

Scanf configuration symbols Includes support for

_DLIB_SCANF_MULTIBYTE Multibyte characters

_DLIB_SCANF_LONG_LONG Long long (ll qualifier)

_DLIB_SCANF_SPECIFIER_FLOAT Floating-point numbers

_DLIB_SCANF_SPECIFIER_N Output count (%n)

_DLIB_SCANF_QUALIFIERS Qualifiers h, j, l, t, z, and L

_DLIB_SCANF_SCANSET Scanset ([*])

_DLIB_SCANF_WIDTH Width

_DLIB_SCANF_ASSIGNMENT_SUPPRESSING Assignment suppressing ([*])

Table 15: Descriptions of scanf configuration symbols 

Printf configuration symbols Includes support for

Table 14: Descriptions of printf configuration symbols  (Continued)
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Template code for these I/O files are included in the product: 

The primitive functions identify I/O streams, such as an open file, with a file descriptor 
that is a unique integer. The I/O streams normally associated with stdin, stdout, and 
stderr have the file descriptors 0, 1, and 2, respectively.

Note: If you link your library with I/O debugging support, C-SPY variants of the 
low-level I/O functions are linked for interaction with C-SPY. For more information, 
see Application debug support, page 99.

Locale
Locale is a part of the C language that allows language- and country-specific settings for 
several areas, such as currency symbols, date and time, and multibyte character 
encoding.

Depending on what runtime library you are using you get different level of locale 
support. However, the more locale support, the larger your code will get. It is therefore 
necessary to consider what level of support your application needs.

The DLIB library can be used in two main modes:

● With locale interface, which makes it possible to switch between different locales 
during runtime

● Without locale interface, where one selected locale is hardwired into the 
application.

LOCALE SUPPORT IN PREBUILT LIBRARIES

The level of locale support in the prebuilt libraries depends on the library configuration. 

● All prebuilt libraries support the C locale only

I/O function File Description

__close close.c Closes a file.

__lseek lseek.c Sets the file position indicator.

__open open.c Opens a file.

__read read.c Reads a character buffer.

__write write.c Writes a character buffer.

remove remove.c Removes a file.

rename rename.c Renames a file.

Table 16: Low-level I/O files 
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● All libraries with full library configuration have support for the locale interface. For 
prebuilt libraries with locale interface, it is by default only supported to switch 
multibyte character encoding at runtime.

● Libraries with normal library configuration do not have support for the locale 
interface.

If your application requires a different locale support, you must rebuild the library.

CUSTOMIZING THE LOCALE SUPPORT

If you decide to rebuild the library, you can choose between these locales:

● The Standard C locale

● The POSIX locale

● A wide range of European locales.

Locale configuration symbols

The configuration symbol _DLIB_FULL_LOCALE_SUPPORT, which is defined in the 
library configuration file, determines whether a library has support for a locale interface 
or not. The locale configuration symbols _LOCALE_USE_LANG_REGION and 
_ENCODING_USE_ENCODING define all the supported locales and encodings:

#define _DLIB_FULL_LOCALE_SUPPORT 1
#define _LOCALE_USE_C        /* C locale */
#define _LOCALE_USE_EN_US    /* American English */
#define _LOCALE_USE_EN_GB    /* British English */
#define _LOCALE_USE_SV_SE    /* Swedish in Sweden */

See DLib_Defaults.h for a list of supported locale and encoding settings.

If you want to customize the locale support, you simply define the locale configuration 
symbols required by your application. For more information, see Building and using a 
customized library, page 103.

Note: If you use multibyte characters in your C or assembler source code, make sure 
that you select the correct locale symbol (the local host locale).

Building a library without support for locale interface

The locale interface is not included if the configuration symbol 
_DLIB_FULL_LOCALE_SUPPORT is set to 0 (zero). This means that a hardwired locale 
is used—by default the Standard C locale—but you can choose one of the supported 
locale configuration symbols. The setlocale function is not available and can 
therefore not be used for changing locales at runtime.
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Building a library with support for locale interface 

Support for the locale interface is obtained if the configuration symbol 
_DLIB_FULL_LOCALE_SUPPORT is set to 1. By default, the Standard C locale is used, 
but you can define as many configuration symbols as required. Because the setlocale 
function will be available in your application, it will be possible to switch locales at 
runtime.

CHANGING LOCALES AT RUNTIME 

The standard library function setlocale is used for selecting the appropriate portion 
of the application’s locale when the application is running.

The setlocale function takes two arguments. The first one is a locale category that is 
constructed after the pattern LC_CATEGORY. The second argument is a string that 
describes the locale. It can either be a string previously returned by setlocale, or it 
can be a string constructed after the pattern:

lang_REGION

or

lang_REGION.encoding

The lang part specifies the language code, and the REGION part specifies a region 
qualifier, and encoding specifies the multibyte character encoding that should be used.

The lang_REGION part matches the _LOCALE_USE_LANG_REGION preprocessor 
symbols that can be specified in the library configuration file.

Example

This example sets the locale configuration symbols to Swedish to be used in Finland and 
UTF8 multibyte character encoding:

setlocale (LC_ALL, "sv_FI.Utf8");

Environment interaction
According to the C standard, your application can interact with the environment using 
the functions getenv and system.

Note: The putenv function is not required by the standard, and the library does not 
provide an implementation of it.
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THE GETENV FUNCTION

The getenv function searches the string, pointed to by the global variable __environ, 
for the key that was passed as argument. If the key is found, the value of it is returned, 
otherwise 0 (zero) is returned. By default, the string is empty.

To create or edit keys in the string, you must create a sequence of null terminated strings 
where each string has the format:

key=value\0

End the string with an extra null character (if you use a C string, this is added 
automatically). Assign the created sequence of strings to the __environ variable.

For example:

const char MyEnv[] = ”Key=Value\0Key2=Value2\0”;
__environ = MyEnv;

If you need a more sophisticated environment variable handling, you should implement 
your own getenv, and possibly putenv function. This does not require that you rebuild 
the library. You can find source templates in the files getenv.c and environ.c in the 
sh\src\lib directory. For information about overriding default library modules, see 
Overriding library modules, page 101. 

THE SYSTEM FUNCTION

If you need to use the system function, you must implement it yourself. The system 
function available in the library simply returns -1.

If you decide to rebuild the library, you can find source templates in the library project 
template. For further information, see Building and using a customized library, page 
103.

Note: If you link your application with support for I/O debugging, the functions 
getenv and system are replaced by C-SPY variants. For further information, see 
Application debug support, page 99.

Signal and raise
Default implementations of the functions signal and raise are available. If these 
functions do not provide the functionality that you need, you can implement your own 
versions.

This does not require that you rebuild the library. You can find source templates in the 
files signal.c and raise.c in the sh\src\lib directory. For information about 
overriding default library modules, see Overriding library modules, page 101. 
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If you decide to rebuild the library, you can find source templates in the library project 
template. For further information, see Building and using a customized library, page 
103.

Time
To make the time and date functions work, you must implement the three functions 
clock, time, and __getzone.

This does not require that you rebuild the library. You can find source templates in the 
files clock.c and time.c, and getzone.c in the sh\src\lib directory. For 
information about overriding default library modules, see Overriding library modules, 
page 101. 

If you decide to rebuild the library, you can find source templates in the library project 
template. For further information, see Building and using a customized library, page 
103.

The default implementation of __getzone specifies UTC as the time zone.

Note: If you link your application with support for I/O debugging, the functions clock 
and time are replaced by C-SPY variants that return the host clock and time 
respectively. For further information, see Application debug support, page 99.

Strtod
The function strtod does not accept hexadecimal floating-point strings in libraries 
with the Normal library configuration. To make a library do so, you must rebuild the 
library, see Building and using a customized library, page 103. Enable the configuration 
symbol _DLIB_STRTOD_HEX_FLOAT in the library configuration file.

Assert
If you linked your application with support for runtime debugging, an assert will print a 
message on stdout. If this is not the behavior you require, you must add the source file 
xreportassert.c to your application project. The __ReportAssert function 
generates the assert notification. You can find template code in the sh\src\lib 
directory. For further information, see Building and using a customized library, page 
103. To turn off assertions, you must define the symbol NDEBUG.

In the IDE, this symbol NDEBUG is by default defined in a Release project and not 
defined in a Debug project. If you build from the command line, you must explicitly 
define the symbol according to your needs. See NDEBUG, page 304.
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Atexit
The linker allocates a static memory area for atexit function calls. By default, the 
number of calls to the atexit function are limited to 32 bytes. To change this limit, see 
Setting up the atexit limit, page 86.

Hardware support
If you are generating code for an SH microprocessor with a hardware floating-point unit, 
the compiler will always try to take advantage of it for floating-point operations.

Managing a multithreaded environment
In a multithreaded environment, the standard library must treat all library objects 
according to whether they are global or local to a thread. If an object is a true global 
object, any updates of its state must be guarded by a locking mechanism to make sure 
that only one thread can update it at any given time. If an object is local to a thread, the 
static variables containing the object state must reside in a variable area local to that 
thread. This area is commonly named thread-local storage (TLS).

There are three possible scenarios, and you need to consider which one that applies to 
you:

● If you are using an RTOS that supports the multithreading provided by the DLIB 
library, the RTOS and the DLIB library will handle multithreading which means 
you do not need to adapt the DLIB library.

● If you are using an RTOS that does not support or only partly supports the 
multithreading provided by the DLIB library, you probably need to adapt both the 
RTOS and the DLIB library.

● If you are not using an RTOS, you must adapt the DLIB library to get support for 
multithreading.

MULTITHREAD SUPPORT IN THE DLIB LIBRARY

The DLIB library uses two kinds of locks—system locks and file stream locks. The file 
stream locks are used as guards when the state of a file stream is updated, and are only 
needed in the Full library configuration. The following library objects are guarded with 
system locks:

● The heap, in other words when malloc, new, free, delete, realloc, or calloc 
is used.
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● The file system (only available in the Full library configuration), but not the file 
streams themselves. The file system is updated when a stream is opened or closed, 
in other words when fopen, fclose, fdopen, fflush, or freopen is used.

● The signal system, in other words when signal is used.

● The temporary file system, in other words when tmpnam is used.

● Dynamically initialized function local objects with static storage duration.

These library objects use TLS:

ENABLING MULTITHREAD SUPPORT

To enable multithread support in the library, you must:

● Implement code for the library’s system locks interface

● If file streams are used, implement code for the library’s file stream locks interface 
or redirect the interface to the system locks interface (using the linker option 
--redirect)

● Implement source code that handles thread creation, thread destruction, and TLS 
access methods for the library

● Modify the linker configuration file accordingly

● If any of the C++ variants are used, use the compiler option --guard_calls. 
Otherwise, function static variables with dynamic initializers might be initialized 
simultaneously by several threads.

● Use the linker option --threaded_lib, which automatically configures the 
runtime library for use with threads.

You can find the required declaration of functions and definitions of macros in the 
DLib_Threads.h file, which is included by yvals.h.

Library objects using TLS When these functions are used

Error functions errno, strerror

Locale functions localeconv, setlocale

Time functions asctime, localtime, gmtime, mktime

Multibyte functions mbrlen, mbrtowc, mbsrtowc, mbtowc, wcrtomb, 
wcsrtomb, wctomb

Rand functions rand, srand

Miscellaneous functions atexit, strtok

C++ exception engine N/A

Table 17: Library objects using TLS 
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Managing a multithreaded environment
Note: If you are using a third-party RTOS, check their guidelines for how to enable 
multithread support with IAR Systems tools.

System locks interface

This interface must be fully implemented for system locks to work:

typedef void *__iar_Rmtx;                /* Lock info object */

void __iar_system_Mtxinit(__iar_Rmtx *); /* Initialize a system
                                            lock */
void __iar_system_Mtxdst(__iar_Rmtx *);/*Destroy a system lock */
void __iar_system_Mtxlock(__iar_Rmtx *); /* Lock a system lock */
void __iar_system_Mtxunlock(__iar_Rmtx *); /* Unlock a system
                                              lock */

The lock and unlock implementation must survive nested calls.

File streams locks interface

This interface is only needed for the Full library configuration. If file streams are used, 
they can either be fully implemented or they can be redirected to the system locks 
interface. This interface must be implemented for file streams locks to work:

typedef void *__iar_Rmtx;               /* Lock info object */

void __iar_file_Mtxinit(__iar_Rmtx *);/*Initialize a file lock */
void __iar_file_Mtxdst(__iar_Rmtx *);   /* Destroy a file lock */
void __iar_file_Mtxlock(__iar_Rmtx *);  /* Lock a file lock */
void __iar_file_Mtxunlock(__iar_Rmtx *); /* Unlock a file lock */

The lock and unlock implementation must survive nested calls.

DLIB lock usage

The number of locks that the DLIB library assumes exist are:

● _FOPEN_MAX—the maximum number of file stream locks. These locks are only 
used in the Full library configuration, in other words only if both the macro symbols 
_DLIB_FILE_DESCRIPTOR and _FILE_OP_LOCKS are true.

● _MAX_LOCK—the maximum number of system locks.

Note that even if the application uses fewer locks, the DLIB library will initialize and 
destroy all of the locks above.

For information about the initialization and destruction code, see xsyslock.c.
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TLS handling

The DLIB library supports TLS memory areas for two types of threads: the main thread 
(the main function including the system startup and exit code) and secondary threads.

The main thread’s TLS memory area:

● Is automatically created and initialized by your application’s startup sequence

● Is automatically destructed by the application’s destruct sequence

● Is located in the section __DLIB_PERTHREAD

● Exists also for non-threaded applications.

Each secondary thread’s TLS memory area:

● Must be manually created and initialized

● Must be manually destructed

● Is located in a manually allocated memory area.

If you need the runtime library to support secondary threads, you must override the 
function:

void *__iar_dlib_perthread_access(void *symbp);

The parameter is the address to the TLS variable to be accessed—in the main thread’s 
TLS area—and it should return the address to the symbol in the current TLS area.

Two interfaces can be used for creating and destroying secondary threads. You can use 
the following interface that allocates a memory area on the heap and initializes it. At 
deallocation, it destroys the objects in the area and then frees the memory.

void *__iar_dlib_perthread_allocate(void);
void  __iar_dlib_perthread_deallocate(void *);

Alternatively, if the application handles the TLS allocation, you can use this interface 
for initializing and destroying the objects in the memory area:

void __iar_dlib_perthread_initialize(void *);
void __iar_dlib_perthread_destroy(void *);

These macros can be helpful when you implement an interface for creating and 
destroying secondary threads:

Macro Description

__IAR_DLIB_PERTHREAD_SIZE The size needed for the TLS memory area.

Table 18: Macros for implementing TLS allocation 
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Note that the size needed for TLS variables depends on which DLIB resources your 
application uses.

This is an example of how you can handle threads:

#include <yvals.h>

/* A thread's TLS pointer */
void _DLIB_TLS_MEMORY *TLSp;

/* Are we in a secondary thread? */
int InSecondaryThread = 0;

/* Allocate a thread-local TLS memory
   area and store a pointer to it in TLSp. */
void AllocateTLS()
{
  TLSp = __iar_dlib_perthread_allocate();
}

/* Deallocate the thread-local TLS memory area. */
void DeallocateTLS()
{
  __iar_dlib_perthread_deallocate(TLSp);
}

/* Access an object in the 
   thread-local TLS memory area. */
void _DLIB_TLS_MEMORY *__iar_dlib_perthread_access(
  void _DLIB_TLS_MEMORY *symbp)

__IAR_DLIB_PERTHREAD_INIT_SIZE The initializer size for the TLS memory area. 
You should initialize the rest of the TLS 
memory area, up to 
__IAR_DLIB_PERTHREAD_SIZE to zero.

__IAR_DLIB_PERTHREAD_SYMBOL_

OFFSET(symbolptr)

The offset to the symbol in the TLS memory 
area.

Macro Description

Table 18: Macros for implementing TLS allocation  (Continued)
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{
  char _DLIB_TLS_MEMORY *p = 0;
  if (InSecondaryThread)
    p = (char _DLIB_TLS_MEMORY *) TLSp;
  else
    p = (char _DLIB_TLS_MEMORY *) 
      __segment_begin("__DLIB_PERTHREAD");

  p += __IAR_DLIB_PERTHREAD_SYMBOL_OFFSET(symbp);
  return (void _DLIB_TLS_MEMORY *) p;
}

The TLSp variable is unique for each thread, and must be exchanged by the RTOS or 
manually whenever a thread switch occurs.

TLS IN THE LINKER CONFIGURATION FILE

Normally, the linker automatically chooses how to initialize static data. If threads are 
used, the main thread’s TLS memory area must be initialized by plain copying because 
the initializers are used for each secondary thread’s TLS memory area as well. This is 
controlled by the following statement in your linker configuration file:

initialize by copy with packing = none {section __DLIB_PERTHREAD };

Checking module consistency
This section introduces the concept of runtime model attributes, a mechanism that you 
can use to ensure that modules are built using compatible settings.

When developing an application, it is important to ensure that incompatible modules are 
not used together. For example, if you have a UART that can run in two modes, you can 
specify a runtime model attribute, for example uart. For each mode, specify a value, 
for example mode1 and mode2. Declare this in each module that assumes that the UART 
is in a particular mode.

The tools provided by IAR Systems use a set of predefined runtime model attributes to 
automatically ensure module consistency.

RUNTIME MODEL ATTRIBUTES 

A runtime attribute is a pair constituted of a named key and its corresponding value. In 
general, two modules can only be linked together if they have the same value for each 
key that they both define.

There is one exception: if the value of an attribute is *, then that attribute matches any 
value. The reason for this is that you can specify this in a module to show that you have 
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considered a consistency property, and this ensures that the module does not rely on that 
property.

Note: For IAR predefined runtime model attributes, the linker uses several ways of 
checking them.

Example

In this table, the object files could (but do not have to) define the two runtime attributes 
color and taste:

In this case, file1 cannot be linked with any of the other files, since the runtime 
attribute color does not match. Also, file4 and file5 cannot be linked together, 
because the taste runtime attribute does not match. 

On the other hand, file2 and file3 can be linked with each other, and with either 
file4 or file5, but not with both.

USING RUNTIME MODEL ATTRIBUTES

To ensure module consistency with other object files, use the #pragma rtmodel 
directive to specify runtime model attributes in your C/C++ source code. For example:

#pragma rtmodel="uart", "mode1"

For detailed syntax information, see rtmodel, page 289.

You can also use the rtmodel assembler directive to specify runtime model attributes 
in your assembler source code. For example:

            rtmodel "color", "red"

For detailed syntax information, see the IAR Assembler Reference Guide for SH.

At link time, the IAR ILINK Linker checks module consistency by ensuring that 
modules with conflicting runtime attributes will not be used together. If conflicts are 
detected, an error is issued.

Object file Color Taste

file1 blue not defined

file2 red not defined

file3 red *

file4 red spicy

file5 red lean

Table 19: Example of runtime model attributes 
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When you develop an application for an embedded system, there might be 
situations where you will find it necessary to write parts of the code in 
assembler, for example when using mechanisms in the SH microprocessor that 
require precise timing and special instruction sequences.

This chapter describes the available methods for this and some C alternatives, 
with their advantages and disadvantages. It also describes how to write 
functions in assembler language that work together with an application written 
in C or C++.

Finally, the chapter covers how functions are called and how you can 
implement support for call frame information in your assembler routines for 
use in the C-SPY® Call Stack window.

Mixing C and assembler
The IAR C/C++ Compiler for SH provides several ways to access low-level resources: 

● Modules written entirely in assembler

● Intrinsic functions (the C alternative)

● Inline assembler.

It might be tempting to use simple inline assembler. However, you should carefully 
choose which method to use.

INTRINSIC FUNCTIONS

The compiler provides many predefined functions that allow direct access to low-level 
processor operations without having to use the assembler language. These functions are 
known as intrinsic functions. They can be very useful in, for example, time-critical 
routines. 

An intrinsic function looks like a normal function call, but it is really a built-in function 
that the compiler recognizes. The intrinsic functions compile into inline code, either as 
a single instruction, or as a short sequence of instructions. 
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The advantage of an intrinsic function compared to using inline assembler is that the 
compiler has all necessary information to interface the sequence properly with register 
allocation and variables. The compiler also knows how to optimize functions with such 
sequences; something the compiler is unable to do with inline assembler sequences. The 
result is that you get the desired sequence properly integrated in your code, and that the 
compiler can optimize the result.

For detailed information about the available intrinsic functions, see the chapter Intrinsic 
functions.

MIXING C AND ASSEMBLER MODULES

It is possible to write parts of your application in assembler and mix them with your C 
or C++ modules. This gives several benefits compared to using inline assembler:

● The function call mechanism is well-defined

● The code will be easy to read

● The optimizer can work with the C or C++ functions.

This causes some overhead in the form of a function call and return instruction 
sequences, and the compiler will regard some registers as scratch registers. However, the 
compiler will also assume that all scratch registers are destroyed by an inline assembler 
instruction. In many cases, the overhead of the extra instructions can be removed by the 
optimizer.

An important advantage is that you will have a well-defined interface between what the 
compiler produces and what you write in assembler. When using inline assembler, you 
will not have any guarantees that your inline assembler lines do not interfere with the 
compiler generated code.

When an application is written partly in assembler language and partly in C or C++, you 
are faced with several questions:

● How should the assembler code be written so that it can be called from C?

● Where does the assembler code find its parameters, and how is the return value 
passed back to the caller?

● How should assembler code call functions written in C?

● How are global C variables accessed from code written in assembler language?

● Why does not the debugger display the call stack when assembler code is being 
debugged?

The first issue is discussed in the section Calling assembler routines from C, page 128. 
The following two are covered in the section Calling convention, page 131.

The answer to the final question is that the call stack can be displayed when you run 
assembler code in the debugger. However, the debugger requires information about the 
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call frame, which must be supplied as annotations in the assembler source file. For more 
information, see Call frame information, page 138.

The recommended method for mixing C or C++ and assembler modules is described in 
Calling assembler routines from C, page 128, and Calling assembler routines from 
C++, page 130, respectively.

To comply with the SH ABI, the compiler generates assembler labels for symbol and 
function names by prefixing an underscore. You must remember to add this extra 
underscore when you access C symbols from assembler. For example, main must be 
written as _main.

INLINE ASSEMBLER 

It is possible to insert assembler code directly into a C or C++ function. The asm and 
__asm keywords both insert the supplied assembler statement in-line. The following 
example demonstrates the use of the asm keyword. This example also shows the risks of 
using inline assembler.

static __data20 int sFlag;
extern __data20 int IO_PORT;

#pragma required=IO_PORT
void Foo(void)
{
  while (!sFlag )
  {
    asm("MOVI20 #_sFlag, R1");
    asm("MOVI20 #_IO_PORT, R2");
    asm("MOV.W  @R2, R0");
    asm("MOV.W  R0, @R1"); 
  }
}

In this example, the assignment to the global variable sFlag is not noticed by the 
compiler, which means the surrounding code cannot be expected to rely on the inline 
assembler statement.

The inline assembler instruction will simply be inserted at the given location in the 
program flow. The consequences or side-effects the insertion might have on the 
surrounding code are not taken into consideration. If, for example, registers or memory 
locations are altered, they might have to be restored within the sequence of inline 
assembler instructions for the rest of the code to work properly.

Inline assembler sequences have no well-defined interface with the surrounding code 
generated from your C or C++ code. This makes the inline assembler code fragile, and 
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will possibly also become a maintenance problem if you upgrade the compiler in the 
future. There are also several limitations to using inline assembler:

● The compiler’s various optimizations will disregard any effects of the inline 
sequences, which will not be optimized at all

● In general, assembler directives will cause errors or have no meaning. Data 
definition directives will however work as expected

● Alignment cannot be controlled; this means, for example, that DC32 directives 
might be misaligned

● Auto variables cannot be accessed

● Automatic use of constant tables is not possible.

Inline assembler is therefore often best avoided. If no suitable intrinsic function is 
available, we recommend that you use modules written in assembler language instead 
of inline assembler, because the function call to an assembler routine normally causes 
less performance reduction.

Calling assembler routines from C
An assembler routine that will be called from C must:

● Conform to the calling convention

● Have a PUBLIC entry-point label

● Be declared as external before any call, to allow type checking and optional 
promotion of parameters, as in these examples:

extern int foo(void);

or

extern int foo(int i, int j);

One way of fulfilling these requirements is to create skeleton code in C, compile it, and 
study the assembler list file.

CREATING SKELETON CODE

The recommended way to create an assembler language routine with the correct 
interface is to start with an assembler language source file created by the C compiler. 
Note that you must create skeleton code for each function prototype.

The following example shows how to create skeleton code to which you can easily add 
the functional body of the routine. The skeleton source code only needs to declare the 
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variables required and perform simple accesses to them. In this example, the assembler 
routine takes an int and a char, and then returns an int:

extern int gInt;
extern char gChar;

int Func(int arg1, char arg2)
{
  int locInt = arg1;
  gInt = arg1;
  gChar = arg2;
  return locInt;
}

int main()
{
  int locInt = gInt;
  gInt = Func(locInt, gChar);
  return 0;
}

Note: In this example we use a low optimization level when compiling the code to 
show local and global variable access. If a higher level of optimization is used, the 
required references to local variables could be removed during the optimization. The 
actual function declaration is not changed by the optimization level.

COMPILING THE CODE

In the IDE, specify list options on file level. Select the file in the workspace window. 
Then choose Project>Options. In the C/C++ Compiler category, select Override 
inherited settings. On the List page, deselect Output list file, and instead select the 
Output assembler file option and its suboption Include source. Also, be sure to specify 
a low level of optimization.

Use these options to compile the skeleton code:

iccsh skeleton.c -lA .

The -lA option creates an assembler language output file including C or C++ source 
lines as assembler comments. The . (period) specifies that the assembler file should be 
named in the same way as the C or C++ module (skeleton), but with the filename 
extension s. Also remember to specify the code model and data model you are using, 
whether the device has a floating-point unit, a low level of optimization, and -e for 
enabling language extensions.

The result is the assembler source output file skeleton.s.
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Note: The -lA option creates a list file containing call frame information (CFI) 
directives, which can be useful if you intend to study these directives and how they are 
used. If you only want to study the calling convention, you can exclude the CFI 
directives from the list file. In the IDE, choose Project>Options>C/C++ 
Compiler>List and deselect the suboption Include call frame information. On the 
command line, use the option -lB instead of -lA. Note that CFI information must be 
included in the source code to make the C-SPY Call Stack window work. 

The output file

The output file contains the following important information:

● The calling convention

● The return values

● The global variables

● The function parameters

● How to create space on the stack (auto variables)

● Call frame information (CFI).

The CFI directives describe the call frame information needed by the Call Stack window 
in the debugger. For more information, see Call frame information, page 138.

Calling assembler routines from C++
The C calling convention does not apply to C++ functions. Most importantly, a function 
name is not sufficient to identify a C++ function. The scope and the type of the function 
are also required to guarantee type-safe linkage, and to resolve overloading. 

Another difference is that non-static member functions get an extra, hidden argument, 
the this pointer.

However, when using C linkage, the calling convention conforms to the C calling 
convention. An assembler routine can therefore be called from C++ when declared in 
this manner:

extern "C" 
{
  int MyRoutine(int);
}

In C++, data structures that only use C features are known as PODs (“plain old data 
structures”), they use the same memory layout as in C. However, we do not recommend 
that you access non-PODs from assembler routines.
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The following example shows how to achieve the equivalent to a non-static member 
function, which means that the implicit this pointer must be made explicit. It is also 
possible to “wrap” the call to the assembler routine in a member function. Use an inline 
member function to remove the overhead of the extra call—this assumes that function 
inlining is enabled:

class MyClass;

extern "C" 
{
  void DoIt(MyClass *ptr, int arg);
}

class MyClass 
{
public:
  inline void DoIt(int arg) 
  { 
    ::DoIt(this, arg); 
  }
};

Calling convention
A calling convention is the way a function in a program calls another function. The 
compiler handles this automatically, but, if a function is written in assembler language, 
you must know where and how its parameters can be found, how to return to the program 
location from where it was called, and how to return the resulting value.

It is also important to know which registers an assembler-level routine must preserve. If 
the program preserves too many registers, the program might be ineffective. If it 
preserves too few registers, the result would be an incorrect program.

Note: Which registers that the calling convention makes use of depends on whether 
you are using the chip’s hardware floating-point unit (FPU) or not.

This section describes the calling convention used by the compiler. These items are 
examined:

● Function declarations

● C and C++ linkage

● Preserved versus scratch registers

● Function entrance

● Function exit

● Return address handling. 
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At the end of the section, some examples are shown to describe the calling convention 
in practice. 

FUNCTION DECLARATIONS 

In C, a function must be declared in order for the compiler to know how to call it. A 
declaration could look as follows:

int MyFunction(int first, char * second);

This means that the function takes two parameters: an integer and a pointer to a 
character. The function returns a value, an integer.

In the general case, this is the only knowledge that the compiler has about a function. 
Therefore, it must be able to deduce the calling convention from this information.

USING C LINKAGE IN C++ SOURCE CODE

In C++, a function can have either C or C++ linkage. To call assembler routines from 
C++, it is easiest if you make the C++ function have C linkage.

This is an example of a declaration of a function with C linkage:

extern "C"
{
  int F(int);
}

It is often practical to share header files between C and C++. This is an example of a 
declaration that declares a function with C linkage in both C and C++:

#ifdef __cplusplus
extern "C" 
{
#endif

int F(int);

#ifdef __cplusplus
}
#endif

PRESERVED VERSUS SCRATCH REGISTERS 

The general SH CPU registers are divided into three separate sets, which are described 
in this section.
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Scratch registers 

Any function is permitted to destroy the contents of a scratch register. If a function needs 
the register value after a call to another function, it must store it during the call, for 
example on the stack.

No FPU: Any of the registers R0–R7 can be used as a scratch register by the function.

FPU: Any of the registers R0–R7 and FR0–FR11 can be used as a scratch register by the 
function.

Preserved registers 

Preserved registers, on the other hand, are preserved across function calls. The called 
function can use the register for other purposes, but must save the value before using the 
register and restore it at the exit of the function.

No FPU: The registers R8–R14 are preserved registers.

FPU: The registers R8–R14 and FR12–FR15 are preserved registers.

Special registers

For some registers, you must consider certain prerequisites:

● The FPU single/double mode register (FPRSC) is always in single mode at the 
entrance of the function

● The stack pointer and the frame pointer registers must at all times point to or below 
the last element on the stack. In the eventuality of an interrupt, everything below the 
point the stack pointer or frame pointer points to, will be destroyed.

● The global base pointer register (points to an area of data that is addressed with 
indexed addressing modes) must never be changed. In the eventuality of an 
interrupt, the register must have a specific value.

FUNCTION ENTRANCE 

Parameters can be passed to a function using one of two basic methods: in registers or 
on the stack. It is much more efficient to use registers than to take a detour via memory, 
so the calling convention is designed to use registers as much as possible. Only a limited 
number of registers can be used for passing parameters; when no more registers are 
available, the remaining parameters are passed on the stack. The parameters are also 
passed on the stack in these cases:

● Structure types: struct, union, and classes

● The data type double (64-bit floating-point numbers)
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● Unnamed parameters to variable length (variadic) functions; in other words, 
functions declared as foo(param1, ...), for example printf. This includes the 
parameter immediately preceding the ... argument.

Note: Interrupt functions cannot take any parameters.

Hidden parameters 

In addition to the parameters visible in a function declaration and definition, there can 
be hidden parameters:

If the function returns a structure or a double, the memory location where the structure 
will be stored is passed on the stack as a hidden parameter.

Register parameters 

The registers available for passing parameters are R4–R7 and (if there is an FPU) 
FR4–FR11 and DR4–DR10.

The assignment of registers to parameters is a straightforward process. Traversing the 
parameters in strict order from left to right, the first parameter is assigned to the 
available register or registers. Should there be no suitable register available, the 
parameter is passed on the stack. In this case, any remaining parameters will also be 
passed on the stack. If there is no FPU, 64-bit floating-point values are passed on the 
stack.

Stack parameters and layout 

Stack parameters are stored in the main memory, starting at the location pointed to by 
the stack pointer. Below the stack pointer (toward low memory) there is free space that 
the called function can use. The first stack parameter is stored at the location pointed to 

Parameters Passed in registers

char, short, and long values R4–R7

32-bit floating-point values (no FPU) R4–R7

32-bit floating-point values (FPU) FR4–FR11

64-bit floating-point values (FPU) DR4, DR6, DR8, DR10

Table 20: Registers used for passing parameters 
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by the stack pointer. The next one is stored at the next location on the stack that is 
divisible by 4, etc. 

Figure 13: Stack image after the function call

See also Stack considerations, page 161.

FUNCTION EXIT 

A function can return a value to the function or program that called it, or it can have the 
return type void.

The return value of a function, if any, can be scalar (such as integers and pointers), 
floating-point, or a structure. 

Registers used for returning values

The registers available for returning values are R0, FR0, and DR0.

Hidden return value pointers are not returned. If there is no FPU, 64-bit floating-point 
values are passed on the stack.

Stack layout at function exit

It is the responsibility of the caller to clean the stack after the called function returns.

Return values Passed in registers

char, short, and long values R0

32-bit floating-point values (no FPU) R0

32-bit floating-point values (FPU) FR0

64-bit floating-point values (FPU) DR0

Table 21: Registers used for returning values 
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Return address handling

A function written in assembler language should, when finished, return to the caller. At 
a function call, the return address is stored in the return address register PR. 

Typically, a function returns by using the RTS instruction, for example:

        rts/n     (PR)

If a function is to call another function, the original return address must be stored 
somewhere. This is normally done on the stack, for example:

        section   `.code32.text`:CODE:NOROOT(2)
        extern    func
        
        sts.l     PR, @-R15
        
        ; do something
        
        bsr       func
        
        ; do something
        
        lds.l     @R15+, PR
        rts/n

The return address is restored directly from the stack with the POP PC instruction.

EXAMPLES

The following section shows a series of declaration examples and the corresponding 
calling conventions. The complexity of the examples increases toward the end.

Example 1

Assume this function declaration:

int add1(int);

This function takes one parameter in the register R4, and the return value is passed back 
to its caller in the register R0.

This assembler routine is compatible with the declaration; it will return a value that is 
one number higher than the value of its parameter:

        section `.code32.text`:CODE:NOROOT(2)
        
        add     #1, R4
        rtv/n   R4
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Example 2

This example shows how structures are passed on the stack. Assume these declarations:

struct MyStruct 
{ 
  int mA; 
};

int MyFunction(struct MyStruct x, int y);

The calling function must reserve 4 bytes on the top of the stack and copy the contents 
of the struct to that location. The integer parameter y is passed in the register R4. The 
return value is passed back to its caller in the register R0.

Example 3

The function below will return a structure of type struct.

struct MyStruct 
{ 
  int mA; 
};

struct MyStruct MyFunction(int x);

It is the responsibility of the calling function to allocate a memory location for the return 
value and pass a pointer to it as a hidden first parameter. The pointer to the location 
where the return value should be stored is passed on the stack. The caller assumes that 
these registers remain untouched. The parameter x is passed in R4.

Assume that the function instead was declared to return a pointer to the structure:

struct MyStruct *MyFunction(int x);

In this case, the return value is a scalar, so there is no hidden parameter. The parameter 
x is passed in R4, and the return value is returned in R0.

Calling functions
Functions can be called in two different ways—directly or via a function pointer. In this 
section we will discuss how these calls will be performed.

The normal function calling instruction is the jump instruction:

        jsr     @Rn

The location that the called function should return to (that is, the location immediately 
after this instruction) is stored in the Procedure register, PR.
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There is no difference between a direct call and a function pointer call, as both use the 
same instruction to make the call (regardless of the code model). The only exceptions 
are trap and TBR functions:

● Trap functions use the TRAPA instruction to make the call and return with the RTE 
instruction.

● TBR functions use the JSR/N @@(disp8,TBR) instruction to make a direct call but 
otherwise behave like normal functions.

Call frame information
When you debug an application using C-SPY, you can view the call stack, that is, the 
chain of functions that called the current function. To make this possible, the compiler 
supplies debug information that describes the layout of the call frame, in particular 
information about where the return address is stored.

If you want the call stack to be available when debugging a routine written in assembler 
language, you must supply equivalent debug information in your assembler source using 
the assembler directive CFI. This directive is described in detail in the IAR Assembler 
Reference Guide for SH.

CFI DIRECTIVES

The CFI directives provide C-SPY with information about the state of the calling 
function(s). Most important of this is the return address, and the value of the stack 
pointer at the entry of the function or assembler routine. Given this information, C-SPY 
can reconstruct the state for the calling function, and thereby unwind the stack. 

A full description about the calling convention might require extensive call frame 
information. In many cases, a more limited approach will suffice.

When describing the call frame information, the following three components must be 
present:

● A names block describing the available resources to be tracked

● A common block corresponding to the calling convention

● A data block describing the changes that are performed on the call frame. This 
typically includes information about when the stack pointer is changed, and when 
permanent registers are stored or restored on the stack.
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This table lists all the resources defined in the names block used by the compiler:

CREATING ASSEMBLER SOURCE WITH CFI SUPPORT

The recommended way to create an assembler language routine that handles call frame 
information correctly is to start with an assembler language source file created by the 
compiler.

1 Start with suitable C source code, for example:

int F(int);
int cfiExample(int i)
{
  return i + F(i);
}

2 Compile the C source code, and make sure to create a list file that contains call frame 
information—the CFI directives. 

On the command line, use the option -lA. 

In the IDE, choose Project>Options>C/C++ Compiler>List and make sure the 
suboption Include call frame information is selected. 

For the source code in this example, the list file looks like this:

        NAME test

        EXTERN _F

        PUBLIC _cfiExample
        
        CFI Names cfiNames0
        CFI StackFrame CFA SP DATA
        CFI Resource R0:32, R1:32, R2:32, R3:32, R4:32, R5:32,
                     R6:32, R7:32
        CFI Resource R8:32, R9:32, R10:32, R11:32, R12:32,
                     R13:32, R14:32
        CFI Resource SP:32, PR:32

Resource Description

R0–R14 Normal registers

FR0–FR15 FPU registers (only if the device has an FPU)

?RET The return address register

SP The stack pointer

PR Program return value

Table 22: Call frame information resources defined in a names block 
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        CFI VirtualResource ?RET:32
        CFI EndNames cfiNames0
        
        CFI Common cfiCommon0 Using cfiNames0
        CFI CodeAlign 2
        CFI DataAlign 1
        CFI ReturnAddress ?RET CODE
        CFI CFA SP+0
        CFI R0 Undefined
        CFI R1 Undefined
        CFI R2 Undefined
        CFI R3 Undefined
        CFI R4 Undefined
        CFI R5 Undefined
        CFI R6 Undefined
        CFI R7 Undefined
        CFI R8 SameValue
        CFI R9 SameValue
        CFI R10 SameValue
        CFI R11 SameValue
        CFI R12 SameValue
        CFI R13 SameValue
        CFI R14 SameValue
        CFI PR Undefined
        CFI ?RET PR
        CFI EndCommon cfiCommon0
        
_cfiExample:
        CFI Block cfiBlock0 Using cfiCommon0
        CFI Function _cfiExample
        CODE

        MOVMU.L   R14, @-R15
        CFI ?RET Frame(CFA, -4)
        CFI R14 Frame(CFA, -8)
        CFI CFA SP+8

        MOV       R4, R14
        MOV.L     ??cfiExample_0, R0  ; #_F
        JSR/N     @R0
        ADD       R14, R0
        MOVMU.L   @R15+, R14
        CFI R14 SameValue
        CFI ?RET PR
        CFI CFA SP+0

        RTS/N     
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        NOP                          ; Alignment pad
        DATA
??cfiExample_0:
        DATA32
        DC32      _F
        CFI EndBlock cfiBlock0
        CODE

        END

Note: The header file cfi.m contains the macros XCFI_NAMES and XCFI_COMMON, 
which declare a typical names block and a typical common block. These two macros 
declare several resources, both concrete and virtual.
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Using C
This chapter gives an overview of the compiler’s support for the C language. 
The chapter also gives a brief overview of the IAR C language extensions.

C language overview
The IAR C/C++ Compiler for SH supports the ISO/IEC 9899:1999 standard (including 
up to technical corrigendum No.3), also known as C99. In this guide, this standard is 
referred to as Standard C and is the default standard used in the compiler. This standard 
is stricter than C89.

In addition, the compiler also supports the ISO 9899:1990 standard (including all 
technical corrigenda and addenda), also known as C94, C90, C89, and ANSI C. In this 
guide, this standard is referred to as C89. Use the --c89 compiler option to enable this 
standard.

The C99 standard is derived from C89, but adds features like these:

● The inline keyword advises the compiler that the function declared immediately 
after the directive should be inlined

● Declarations and statements can be mixed within the same scope

● A declaration in the initialization expression of a for loop

● The bool data type

● The long long data type

● The complex floating-point type

● C++ style comments

● Compound literals

● Incomplete arrays at the end of structs

● Hexadecimal floating-point constants 

● Designated initializers in structures and arrays

● The preprocessor operator _Pragma()

● Variadic macros, which are the preprocessor macro equivalents of printf style 
functions

● VLA (variable length arrays) must be explicitly enabled with the compiler option 
--vla

● Inline assembler using the asm or the __asm keyword.
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Note: Even though it is a C99 feature, the IAR C/C++ Compiler for SH does not 
support UCNs (universal character names).

Inline assembler

Inline assembler can be used for inserting assembler instructions in the generated 
function.

The asm extended keyword and its alias __asm both insert assembler instructions. 
However, when you compile C source code, the asm keyword is not available when the 
option --strict is used. The __asm keyword is always available.

Note: Not all assembler directives or operators can be inserted using these keywords.

The syntax is:

asm ("string");

The string can be a valid assembler instruction or a data definition assembler directive, 
but not a comment. You can write several consecutive inline assembler instructions, for 
example:

asm ("Label: nop\n"
     " bra Label");

where \n (new line) separates each new assembler instruction. Note that you can define 
and use local labels in inline assembler instructions.

For more information about inline assembler, see Mixing C and assembler, page 125.

Extensions overview
The compiler offers the features of Standard C and a wide set of extensions, ranging 
from features specifically tailored for efficient programming in the embedded industry 
to the relaxation of some minor standards issues.

This is an overview of the available extensions:

● IAR C language extensions

For a summary of available language extensions, see IAR C language extensions, 
page 146. For reference information about the extended keywords, see the chapter 
Extended keywords. For information about C++, the two levels of support for the 
language, and C++ language extensions; see the chapter Using C++.

● Pragma directives

The #pragma directive is defined by Standard C and is a mechanism for using 
vendor-specific extensions in a controlled way to make sure that the source code is 
still portable. 
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The compiler provides a set of predefined pragma directives, which can be used for 
controlling the behavior of the compiler, for example how it allocates memory, 
whether it allows extended keywords, and whether it outputs warning messages. 
Most pragma directives are preprocessed, which means that macros are substituted 
in a pragma directive. The pragma directives are always enabled in the compiler. For 
several of them there is also a corresponding C/C++ language extension. For a list of 
available pragma directives, see the chapter Pragma directives.

● Preprocessor extensions

The preprocessor of the compiler adheres to Standard C. The compiler also makes 
several preprocessor-related extensions available to you. For more information, see 
the chapter The preprocessor.

● Intrinsic functions

The intrinsic functions provide direct access to low-level processor operations and 
can be very useful in, for example, time-critical routines. The intrinsic functions 
compile into inline code, either as a single instruction or as a short sequence of 
instructions. To read more about using intrinsic functions, see Mixing C and 
assembler, page 125. For a list of available functions, see the chapter Intrinsic 
functions.

● Library functions

The IAR DLIB Library provides the C and C++ library definitions that apply to 
embedded systems. For more information, see IAR DLIB Library, page 308.

Note: Any use of these extensions, except for the pragma directives, makes your source 
code inconsistent with Standard C.

ENABLING LANGUAGE EXTENSIONS

You can choose different levels of language conformance by means of project options:

* In the IDE, choose Project>Options> C/C++ Compiler>Language>Language conformance and 
select the appropriate option. Note that language extensions are enabled by default.

Command line IDE* Description

--strict Strict All IAR C language extensions are disabled; errors 
are issued for anything that is not part of 
Standard C.

None Standard All extensions to Standard C are enabled, but no 
extensions for embedded systems programming. 
For a list of extensions, see IAR C language 
extensions, page 146.

-e Standard with IAR 
extensions

All IAR C language extensions are enabled.

Table 23: Language extensions 
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The compiler provides a wide set of C language extensions. To help you to find the 
extensions required by your application, they are grouped like this in this section:

● Extensions for embedded systems programming—extensions specifically tailored 
for efficient embedded programming for the specific microprocessor you are using, 
typically to meet memory restrictions

● Relaxations to Standard C—that is, the relaxation of some minor Standard C issues 
and also some useful but minor syntax extensions, see Relaxations to Standard C, 
page 148.

EXTENSIONS FOR EMBEDDED SYSTEMS PROGRAMMING

The following language extensions are available both in the C and the C++ 
programming languages and they are well suited for embedded systems programming:

● Memory attributes, type attributes, and object attributes

For information about the related concepts, the general syntax rules, and for 
reference information, see the chapter Extended keywords.

● Placement at an absolute address or in a named section

The @ operator or the directive #pragma location can be used for placing global 
and static variables at absolute addresses, or placing a variable or function in a named 
section. For more information about using these features, see Controlling data and 
function placement in memory, page 173, and location, page 284.

● Alignment control

Each data type has its own alignment; for more details, see Alignment, page 249. If 
you want to change the alignment, the #pragma pack and 
#pragma data_alignment directive are available. If you want to check the 
alignment of an object, use the __ALIGNOF__() operator.

The __ALIGNOF__ operator is used for accessing the alignment of an object. It takes 
one of two forms:

● __ALIGNOF__ (type)

● __ALIGNOF__ (expression)

In the second form, the expression is not evaluated.

● Anonymous structs and unions

C++ includes a feature called anonymous unions. The compiler allows a similar 
feature for both structs and unions in the C programming language. For more 
information, see Anonymous structs and unions, page 171.
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● Bitfields and non-standard types

In Standard C, a bitfield must be of the type int or unsigned int. Using IAR C 
language extensions, any integer type or enumeration can be used. The advantage is 
that the struct will sometimes be smaller. For more information, see Bitfields, page 
251.

Dedicated section operators

The compiler supports getting the start address, end address, and size for a section with 
these built-in section operators:

● __section_begin returns the address of the first byte of the named section or 
block.

● __section_end returns the address of the first byte after the named section or 
block.

● __section_size returns the size of the named section or block in bytes.

Note: The aliases __segment_begin/__sfb, __segment_end/__sfe, and 
__segment_size/__sfs can also be used.

These operators behave syntactically as if declared like:

void * __section_begin(char const * section)
void * __section_end(char const * section)
size_t * __section_size(char const * section)

The operators can be used on named sections or on named blocks defined in the linker 
configuration file.

When you use the @ operator or the #pragma location directive to place a data object 
or a function in a user-defined section, or when you use named blocks in the linker 
configuration file, the section operators can be used for getting the start and end address 
of the memory range where the sections or blocks were placed.

The named section must be a string literal and it must have been declared earlier with 
the #pragma section directive. If the section was declared with a memory attribute 
memattr, the type of the __section_begin operator is a pointer to memattr void. 
Otherwise, the type is a default pointer to void. Note that you must enable language 
extensions to use these operators.

The operators are implemented in terms of symbols with dedicated names, and will 
appear in the linker map file under these names:

.

Operator Symbol

__section_begin(sec) sec$$Base

Table 24: Section operators and their symbols 
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Note that the linker will not necessarily place sections with the same name consecutively 
when these operators are not used. Using one of these operators (or the equivalent 
symbols) will cause the linker to behave as if the sections were in a named block. This 
is to assure that the sections are placed consecutively, so that the operators can be 
assigned meaningful values. If this is in conflict with the section placement as specified 
in the linker configuration file, the linker will issue an error.

Example

In this example, the type of the __section_begin operator is void *.

#pragma section="MYSECTION"
...
section_start_address = __section_begin("MYSECTION");

See also section, page 290, and location, page 284.

RELAXATIONS TO STANDARD C

This section lists and briefly describes the relaxation of some Standard C issues and also 
some useful but minor syntax extensions:

● Arrays of incomplete types

An array can have an incomplete struct, union, or enum type as its element type. 
The types must be completed before the array is used (if it is), or by the end of the 
compilation unit (if it is not).

● Forward declaration of enum types

The extensions allow you to first declare the name of an enum and later resolve it by 
specifying the brace-enclosed list.

● Accepting missing semicolon at the end of a struct or union specifier

A warning—instead of an error—is issued if the semicolon at the end of a struct 
or union specifier is missing.

● Null and void

In operations on pointers, a pointer to void is always implicitly converted to another 
type if necessary, and a null pointer constant is always implicitly converted to a null 
pointer of the right type if necessary. In Standard C, some operators allow this kind 
of behavior, while others do not allow it.

__section_end(sec) sec$$Limit

__section_size(sec) sec$$Length

Operator Symbol

Table 24: Section operators and their symbols  (Continued)
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● Casting pointers to integers in static initializers

In an initializer, a pointer constant value can be cast to an integral type if the integral 
type is large enough to contain it. For more information about casting pointers, see 
Casting, page 255.

● Taking the address of a register variable

In Standard C, it is illegal to take the address of a variable specified as a register 
variable. The compiler allows this, but a warning is issued.

● long float means double

The type long float is accepted as a synonym for double.

● Repeated typedef declarations

Redeclarations of typedef that occur in the same scope are allowed, but a warning 
is issued.

● Mixing pointer types

Assignment and pointer difference is allowed between pointers to types that are 
interchangeable but not identical; for example, unsigned char * and char *. This 
includes pointers to integral types of the same size. A warning is issued.

Assignment of a string constant to a pointer to any kind of character is allowed, and 
no warning is issued.

● Non-top level const

Assignment of pointers is allowed in cases where the destination type has added type 
qualifiers that are not at the top level (for example, int ** to int const **). 
Comparing and taking the difference of such pointers is also allowed.

● Non-lvalue arrays

A non-lvalue array expression is converted to a pointer to the first element of the 
array when it is used.

● Comments at the end of preprocessor directives

This extension, which makes it legal to place text after preprocessor directives, is 
enabled unless the strict Standard C mode is used. The purpose of this language 
extension is to support compilation of legacy code; we do not recommend that you 
write new code in this fashion.

● An extra comma at the end of enum lists

Placing an extra comma is allowed at the end of an enum list. In strict Standard C 
mode, a warning is issued.

● A label preceding a }

In Standard C, a label must be followed by at least one statement. Therefore, it is 
illegal to place the label at the end of a block. The compiler allows this, but issues a 
warning.
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Note that this also applies to the labels of switch statements. 

● Empty declarations

An empty declaration (a semicolon by itself) is allowed, but a remark is issued 
(provided that remarks are enabled).

● Single-value initialization

Standard C requires that all initializer expressions of static arrays, structs, and unions 
are enclosed in braces. 

Single-value initializers are allowed to appear without braces, but a warning is 
issued. The compiler accepts this expression:

struct str
{
  int a;
} x = 10;

● Declarations in other scopes

External and static declarations in other scopes are visible. In the following example, 
the variable y can be used at the end of the function, even though it should only be 
visible in the body of the if statement. A warning is issued.

int test(int x)
{
  if (x)
  {
    extern int y;
    y = 1;
  }

  return y;
}

● Expanding function names into strings with the function as context

Use any of the symbols __func__ or __FUNCTION__ inside a function body to 
make the symbol expand into a string, with the function name as context. Use the 
symbol __PRETTY_FUNCTION__ to also include the parameter types and return 
type. The result might, for example, look like this if you use the 
__PRETTY_FUNCTION__ symbol: 

"void func(char)"

These symbols are useful for assertions and other trace utilities and they require that 
language extensions are enabled, see -e, page 213.

● Static functions in function and block scopes

Static functions may be declared in function and block scopes. Their declarations are 
moved to the file scope.
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● Numbers scanned according to the syntax for numbers

Numbers are scanned according to the syntax for numbers rather than the 
pp-number syntax. Thus, 0x123e+1 is scanned as three tokens instead of one valid 
token. (If the --strict option is used, the pp-number syntax is used instead.)
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IAR Systems supports two levels of the C++ language: The industry-standard 
Embedded C++ and IAR Extended Embedded C++. They are described in this 
chapter.

Overview 
Embedded C++ is a subset of the C++ programming language which is intended for 
embedded systems programming. It was defined by an industry consortium, the 
Embedded C++ Technical Committee. Performance and portability are particularly 
important in embedded systems development, which was considered when defining the 
language.

STANDARD EMBEDDED C++

The following C++ features are supported:

● Classes, which are user-defined types that incorporate both data structure and 
behavior; the essential feature of inheritance allows data structure and behavior to 
be shared among classes

● Polymorphism, which means that an operation can behave differently on different 
classes, is provided by virtual functions

● Overloading of operators and function names, which allows several operators or 
functions with the same name, provided that their argument lists are sufficiently 
different

● Type-safe memory management using the operators new and delete

● Inline functions, which are indicated as particularly suitable for inline expansion.

C++ features that are excluded are those that introduce overhead in execution time or 
code size that are beyond the control of the programmer. Also excluded are late 
additions to the ISO/ANSI C++ standard. This is because they represent potential 
portability problems, due to that few development tools support the standard. Embedded 
C++ thus offers a subset of C++ which is efficient and fully supported by existing 
development tools.

Standard Embedded C++ lacks these features of C++:

● Templates 

● Multiple and virtual inheritance 

● Exception handling 
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● Runtime type information 

● New cast syntax (the operators dynamic_cast, static_cast, 
reinterpret_cast, and const_cast)

● Namespaces

● The mutable attribute.

The exclusion of these language features makes the runtime library significantly more 
efficient. The Embedded C++ library furthermore differs from the full C++ library in 
that:

● The standard template library (STL) is excluded

● Streams, strings, and complex numbers are supported without the use of templates

● Library features which relate to exception handling and runtime type information 
(the headers except, stdexcept, and typeinfo) are excluded.

Note: The library is not in the std namespace, because Embedded C++ does not 
support namespaces.

EXTENDED EMBEDDED C++

IAR Systems’ Extended EC++ is a slightly larger subset of C++ which adds these 
features to the standard EC++:

● Full template support

● Multiple and virtual inheritance

● Namespace support

● The mutable attribute

● The cast operators static_cast, const_cast, and reinterpret_cast.

All these added features conform to the C++ standard.

To support Extended EC++, this product includes a version of the standard template 
library (STL), in other words, the C++ standard chapters utilities, containers, iterators, 
algorithms, and some numerics. This STL is tailored for use with the Extended EC++ 
language, which means no exceptions, and no support for runtime type information 
(rtti). Moreover, the library is not in the std namespace.

Note: A module compiled with Extended EC++ enabled is fully link-compatible with 
a module compiled without Extended EC++ enabled.

ENABLING C++ SUPPORT

In the compiler, the default language is C. To be able to compile files written in 
Embedded C++, you must use the --ec++ compiler option. See --ec++, page 213.
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To take advantage of Extended Embedded C++ features in your source code, you must 
use the --eec++ compiler option. See --eec++, page 213.

To set the equivalent option in the IDE, choose Project>Options>C/C++ 
Compiler>Language.

Feature descriptions
When you write C++ source code for the IAR C/C++ Compiler for SH, you must be 
aware of some benefits and some possible quirks when mixing C++ features—such as 
classes, and class members—with IAR language extensions, such as IAR-specific 
attributes.

CLASSES

A class type class and struct in C++ can have static and non-static data members, 
and static and non-static function members. The non-static function members can be 
further divided into virtual function members, non-virtual function members, 
constructors, and destructors. For the static data members, static function members, and 
non-static non-virtual function members the same rules apply as for statically linked 
symbols outside of a class. In other words, they can have any applicable IAR-specific 
type, memory, and object attribute.

The non-static virtual function members can have any applicable IAR-specific type, 
memory, and object attribute as long as a pointer to the member function can be 
implicitly converted to the default function pointer type. The constructors, destructors, 
and non-static data members cannot have any IAR attributes.

The location operator @ can be used on static data members and on any type of function 
members.

For further information about attributes, see Type qualifiers, page 258.

Example

class MyClass 
{
public:
  // Locate a static variable in __data16 memory at address 60
  static __data16 __no_init int mI @ 60;

  // Locate a static function in __code20 memory
  static __code20 void F(); 

  // Locate a function in __code20 memory
  __code20 void G();
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  // Locate a virtual function in __code20 memory
  virtual __code20 void H();

  // Locate a virtual function into SPECIAL 
  virtual void M() const volatile @ "SPECIAL"; 
};

FUNCTION TYPES

A function type with extern "C" linkage is compatible with a function that has C++ 
linkage.

Example

extern "C" 
{
  typedef void (*FpC)(void);    // A C function typedef
}

typedef void (*FpCpp)(void);    // A C++ function typedef

FpC F1;
FpCpp F2;
void MyF(FpC);

void MyG()
{
  MyF(F1);                      // Always works
  MyF(F2);                      // FpCpp is compatible with FpC
}

TEMPLATES 

Extended EC++ supports templates according to the C++ standard, except for the 
support of the export keyword. The implementation uses a two-phase lookup which 
means that the keyword typename must be inserted wherever needed. Furthermore, at 
each use of a template, the definitions of all possible templates must be visible. This 
means that the definitions of all templates must be in include files or in the actual source 
file.

The standard template library 

The STL (standard template library) delivered with the product is tailored for Extended 
EC++, as described in Extended Embedded C++, page 154.
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STL and the IAR C-SPY® Debugger 

C-SPY has built-in display support for the STL containers. The logical structure of 
containers is presented in the watch views in a comprehensive way that is easy to 
understand and follow.

To read more about displaying STL containers in the C-SPY debugger, see the IAR 
Embedded Workbench® IDE User Guide.

VARIANTS OF CAST OPERATORS

In Extended EC++ these additional variants of C++ cast operators can be used:

const_cast<to>(from)
static_cast<to>(from)
reinterpret_cast<to>(from)

MUTABLE

The mutable attribute is supported in Extended EC++. A mutable symbol can be 
changed even though the whole class object is const.

NAMESPACE 

The namespace feature is only supported in Extended EC++. This means that you can 
use namespaces to partition your code. Note, however, that the library itself is not placed 
in the std namespace.

THE STD NAMESPACE

The std namespace is not used in either standard EC++ or in Extended EC++. If you 
have code that refers to symbols in the std namespace, simply define std as nothing; 
for example:

#define std

You must make sure that identifiers in your application do not interfere with identifiers 
in the runtime library.

USING INTERRUPTS AND EC++ DESTRUCTORS

If interrupts are enabled and the interrupt functions use static class objects that need to 
be destroyed (using destructors), there might be problems if the interrupt occur during 
or after application exits. If an interrupt occurs after the static class object was destroyed, 
the application will not work properly.

To avoid this, make sure that interrupts are disabled when returning from main or when 
calling exit or abort. To do this, call the intrinsic function __disable_interrupt.
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When you use the compiler in C++ mode and enable IAR language extensions, the 
following C++ language extensions are available in the compiler:

● In a friend declaration of a class, the class keyword can be omitted, for example:

class B;
class A
{
  friend B;       //Possible when using IAR language
                  //extensions
  friend class B; //According to standard
};

● Constants of a scalar type can be defined within classes, for example:

class A 
{
  const int mSize = 10; //Possible when using IAR language
                        //extensions
  int mArr[mSize];
};

According to the standard, initialized static data members should be used instead.

● In the declaration of a class member, a qualified name can be used, for example:

struct A 
{
  int A::F(); // Possible when using IAR language extensions
  int G();    // According to standard
};

● It is permitted to use an implicit type conversion between a pointer to a function 
with C linkage (extern "C") and a pointer to a function with C++ linkage 
(extern "C++"), for example:

extern "C" void F(); // Function with C linkage
void (*PF)()       // PF points to a function with C++ linkage
             = &F; // Implicit conversion of function pointer. 

According to the standard, the pointer must be explicitly converted.
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● If the second or third operands in a construction that contains the ? operator are 
string literals or wide string literals (which in C++ are constants), the operands can 
be implicitly converted to char * or wchar_t *, for example: 

bool X;

char *P1 = X ? "abc" : "def";       //Possible when using IAR
                                    //language extensions
char const *P2 = X ? "abc" : "def"; //According to standard

● Default arguments can be specified for function parameters not only in the top-level 
function declaration, which is according to the standard, but also in typedef 
declarations, in pointer-to-function function declarations, and in pointer-to-member 
function declarations.

● In a function that contains a non-static local variable and a class that contains a 
non-evaluated expression (for example a sizeof expression), the expression can 
reference the non-static local variable. However, a warning is issued.

Note: If you use any of these constructions without first enabling language extensions, 
errors are issued.
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Application-related 
considerations
This chapter discusses a selected range of application issues related to 
developing your embedded application.

Typically, this chapter highlights issues that are not specifically related to only 
the compiler or the linker.

Output format considerations
The linker produces an absolute executable image in the ELF/DWARF object file 
format.

You can use the IAR ELF Tool—ielftool— to convert an absolute ELF image to a 
format more suitable for loading directly to memory, or burning to a PROM or flash 
memory etc. 

ielftool can produce these output formats:

● Plain binary

● Motorola S-records

● Intel hex.

Note: ielftool can also be used for other types of transformations, such as filling and 
calculating checksums in the absolute image.

The source code for ielftool is provided in the sh/src directory. For more 
information about ielftool, see The IAR ELF Tool—ielftool, page 350.

Stack considerations
The stack is used by functions to store variables and other information that is used 
locally by functions, as described in the chapter Data storage. It is a continuous block 
of memory pointed to by the processor stack pointer register SP. 

The data block used for holding the stack is called CSTACK. The system startup code 
initializes the stack pointer to the end of the stack.
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Heap considerations
STACK SIZE CONSIDERATIONS

The compiler uses the internal data stack, CSTACK, for a variety of user application 
operations, and the required stack size depends heavily on the details of these 
operations. If the given stack size is too large, RAM will be wasted. If the given stack 
size is too small, two things can happen, depending on where in memory you located 
your stack. Both alternatives are likely to result in application failure. Either variable 
storage will be overwritten, leading to undefined behavior, or the stack will fall outside 
of the memory area, leading to an abnormal termination of your application. Because 
the second alternative is easier to detect, you should consider placing your stack so that 
it grows toward the end of the memory. 

For more information about the stack size, see Setting up the stack, page 86, and Saving 
stack space and RAM memory, page 182.

Heap considerations
The heap contains dynamic data allocated by use of the C function malloc (or one of 
its relatives) or the C++ operator new. 

If your application uses dynamic memory allocation, you should be familiar with:

● Linker sections used for the heap

● Allocating the heap size, see Setting up the heap, page 86.

The memory allocated to the heap is placed in the HEAP block, which is only included 
in the application if dynamic memory allocation is actually used.

 Heap size and standard I/O

If you excluded FILE descriptors from the DLIB runtime environment, as in the Normal 
configuration, there are no input and output buffers at all. Otherwise, as in the Full 
configuration, be aware that the size of the input and output buffers is set to 512 bytes 
in the stdio library header file. If the heap is too small, I/O will not be buffered, which 
is considerably slower than when I/O is buffered. If you execute the application using 
the simulator driver of the IAR C-SPY® Debugger, you are not likely to notice the speed 
penalty, but it is quite noticeable when the application runs on an SH microprocessor. If 
you use the standard I/O library, you should set the heap size to a value which 
accommodates the needs of the standard I/O buffer.
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Interaction between the tools and your application
The linking process and the application can interact symbolically in four ways:

● Creating a symbol by using the ILINK command line option --define_symbol. 
ILINK will create a public absolute constant symbol that the application can use as 
a label, as a size, as setup for a debugger, etc.

● Creating an exported configuration symbol by using the command line option 
--config_def or the configuration directive define symbol, and exporting the 
symbol using the export symbol directive. ILINK will create a public absolute 
constant symbol that the application can use as a label, as a size, as setup for a 
debugger, etc.

One advantage of this symbol definition is that this symbol can also be used in 
expressions in the configuration file, for example to control the placement of sections 
into memory ranges.

● Using the compiler operators __section_begin,  __section_end, or 
__section_size, or the assembler operators SFB, SFE, or SIZEOF on a named 
section or block. These operators provide access to the start address, end address, 
and size of a contiguous sequence of sections with the same name, or of a linker 
block specified in the linker configuration file.

● The command line option --entry informs ILINK about the start label of the 
application. It is used by ILINK as a root symbol and to inform the debugger where 
to start execution.

The following lines illustrate how to use these mechanisms. Add these options to your 
command line:

--define_symbol NrOfElements=10
--config_def HeapSize=1024

The linker configuration file can look like this:

define memory Mem with size = 4G;
define region ROM = Mem:[from 0x00000 size 0x10000];
define region RAM = Mem:[from 0x20000 size 0x10000];

/* Export of symbol */
export symbol HeapSize;

/* Setup a heap area witha size defined by an ILINK option */
define block MyHEAP with size = HeapSize, alignment = 4 {};

place in RAM { block MyHEAP };
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Checksum calculation
Add these lines to your application source code:

#include <stdlib.h>

/* Use symbol defined by ILINK option to dynamically allocate
   an array of elements with specified size */
extern char NrOfElements;

typedef long Elements;
Elements *GetElementArray()
{
  return malloc(sizeof(Elements) * (int)& NrOfElements);
}

/* Use a symbol defined by ILINK option, a symbol that in the
   configuration file was made available to the application */
extern char HeapSize;

/* Declares the section that contains our heap */
#pragma section = "MyHEAP"

char *MyHeap()
{
  /* First get start of statically allocated section */
  char *p = __section_begin("MyHEAP");

  /* then we zero it, using the imported size */
  for (int i = 0; i < (int)& HeapSize; ++i)
  {
    p[i] = 0;
  }
  return p;
}

Checksum calculation
The IAR ELF Tool—ielftool—fills specific ranges of memory with a pattern and 
then calculates a checksum for those ranges. The calculated checksum replaces the value 
of an existing symbol in the input ELF image. The application can then verify that the 
ranges did not change.

To use checksumming to verify the integrity of your application, you must:

● Reserve a place, with an associated name and size, for the checksum calculated by 
ielftool
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● Choose a checksum algorithm, set up ielftool for it, and include source code for 
the algorithm in your application

● Decide what memory ranges to verify and set up both ielftool and the source 
code for it in your application source code.

Note: To set up ielftool in the IDE, choose Project>Options>Linker>Checksum.

CALCULATING A CHECKSUM

In this example, a checksum is calculated for ROM memory at 0x8002 up to 0x8FFF 
and the 2-byte calculated checksum is placed at 0x8000.

Creating a place for the calculated checksum

You can create a place for the calculated checksum in two ways; by creating a global 
C/C++ or assembler constant symbol with a proper size, residing in a specific section 
(in this example .checksum), or by using the linker option --place_holder.

For example, to create a 2-byte space for the symbol __checksum in the section 
.checksum, with alignment 4:

--place_holder __checksum,2,.checksum,4

To place the .checksum section, you must modify the linker configuration file. It can 
look like this (note the handling of the block CHECKSUM):

define memory Mem with size = 4G;

define region ROM_region = Mem:[from 0x8000 to 0x80000000 - 1];
define region RAM_region = Mem:[from 0x80000000 to 0x100000000 -2 ];

initialize by copy { rw };
do not initialize  { section .noinit };

define block HEAP      with alignment = 4, size = 16M {};
define block CSTACK    with alignment = 4, size = 16K {};

define block CHECKSUM    { ro section .checksum };
place at address Mem:0x0 { ro section .intvec};
place in ROM_region  { ro, first block CHECKSUM }; 
place in RAM_region { rw, block HEAP, block CSTACK };

Running ielftool

To calculate the checksum, run ielftool:

ielftool --fill=0x00;0x8000–0x8FFF
--checksum=__checksum:2,crc16;0x8000–0x8FFF sourceFile.out 
destinationFile.out
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Checksum calculation
To calculate a checksum you also must define a fill operation. In this example, the fill 
pattern 0x0 is used. The checksum algorithm used is crc16.

Note that ielftool needs an unstripped input ELF image. If you use the --strip 
linker option, remove it and use the --strip ielftool option instead.

ADDING A CHECKSUM FUNCTION TO YOUR SOURCE CODE

To check the value of the ielftool generated checksum, it must be compared with a 
checksum that your application calculated. This means that you must add a function for 
checksum calculation (that uses the same algorithm as ielftool) to your application 
source code. Your application must also include a call to this function.

A function for checksum calculation

This function—a slow variant but with small memory footprint—uses the crc16 
algorithm:

unsigned short slow_crc16(unsigned short sum, 
                          unsigned char *p,
                          unsigned int len)
{
  while (len--)
  {
    int i;
    unsigned char byte = *(p++);

    for (i = 0; i < 8; ++i)
    {
      unsigned long oSum = sum;
      sum <<= 1;
      if (byte & 0x80)
        sum |= 1;
      if (oSum & 0x8000)
        sum ^= 0x1021;
      byte <<= 1;
    }
  }
  return sum;
}

You can find the source code for the checksum algorithms in the sh\src\linker 
directory of your product installation.
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Checksum calculation

This code gives an example of how the checksum can be calculated:

/* Start and end of the checksum range */
unsigned long ChecksumStart = 0x8000+2;
unsigned long ChecksumEnd   = 0x8FFF;

/* The checksum calculated by ielftool
 * (note that it lies on address 0x8000)
 */
extern unsigned short const __checksum;

void TestChecksum()
{
  unsigned short calc = 0;
  unsigned char zeros[2] = {0, 0};

  /* Run the checksum algorithm */
  calc = slow_crc16(0,
                    (unsigned char *) ChecksumStart,
                    (ChecksumEnd - ChecksumStart+1));

  /* Rotate out the answer */
  calc = slow_crc16(calc, zeros, 2);

  /* Test the checksum */
  if (calc != __checksum)
  {
    abort();   /* Failure */
  }
}

THINGS TO REMEMBER

When calculating a checksum, you must remember that:

● The checksum must be calculated from the lowest to the highest address for every 
memory range

● Each memory range must be verified in the same order as defined

● It is OK to have several ranges for one checksum

● If several checksums are used, you should place them in sections with unique names 
and use unique symbol names

● If a slow function is used, you must make a final call to the checksum calculation 
with as many bytes (with the value 0x00) as there are bytes in the checksum.
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Checksum calculation
For more information, see also The IAR ELF Tool—ielftool, page 350.

C-SPY CONSIDERATIONS

By default, a symbol that you have allocated in memory by using the linker option 
--place_holder is considered by C-SPY to be of the type int. If the size of the 
checksum is less than four bytes, you can change the display format of the checksum 
symbol to match its size. 

In the C-SPY Watch window, select the symbol and choose Show As from the context 
menu. Choose the display format that matches the size of the checksum symbol.
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embedded applications
For embedded systems, the size of the generated code and data is very 
important, because using smaller external memory or on-chip memory can 
significantly decrease the cost and power consumption of a system.

The topics discussed are:

● Selecting data types

● Controlling data and function placement in memory

● Controlling compiler optimizations

● Facilitating good code generation.

As a part of this, the chapter also demonstrates some of the more common 
mistakes and how to avoid them, and gives a catalog of good coding 
techniques.

Selecting data types
For efficient treatment of data, you should consider the data types used and the most 
efficient placement of the variables.

USING EFFICIENT DATA TYPES

The data types you use should be considered carefully, because this can have a large 
impact on code size and code speed.

● Try to avoid 64-bit data types, such as double and long long.

● Bitfields with sizes other than 1 bit should be avoided because they will result in 
inefficient code compared to bit operations.

● Using floating-point types on a microprocessor without a floating-point 
co-processor is very inefficient, both in terms of code size and execution speed.

● Declaring a pointer parameter to point to const data might open for better 
optimizations in the calling function.
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Selecting data types
For details about representation of supported data types, pointers, and structures types, 
see the chapter Data representation.

FLOATING-POINT TYPES

Using floating-point types on a microprocessor without a math coprocessor is very 
inefficient, both in terms of code size and execution speed. Thus, you should consider 
replacing code that uses floating-point operations with code that uses integers, because 
these are more efficient.

The compiler supports two floating-point formats—32 and 64 bits. The 32-bit 
floating-point type float is more efficient in terms of code size and execution speed. 
However, the 64-bit format double supports higher precision and larger numbers.

In the compiler, the floating-point type float always uses the 32-bit format. The format 
used by the double floating-point type depends on the setting of the --double 
compiler option.

Unless the application requires the extra precision that 64-bit floating-point numbers 
give, we recommend using 32-bit floating-point numbers instead.

Note: If your target processor is an SH2A device with a hardware FPU, the FPU might 
not be as exact as the software-based floating-point support because the FPU does not 
support all operations.

By default, a floating-point constant in the source code is treated as being of the type 
double. This can cause innocent-looking expressions to be evaluated in double 
precision. In the example below a is converted from a float to a double, the double 
constant 1.0 is added and the result is converted back to a float:

float Test(float a)
{
   return a + 1.0;
}

To treat a floating-point constant as a float rather than as a double, add the suffix f 
to it, for example:

float Test(float a)
{
   return a + 1.0f;
}

For more information about floating-point types, see Floating-point types, page 253.

ALIGNMENT OF ELEMENTS IN A STRUCTURE

The SH microprocessor requires that when accessing data in memory, the data must be 
aligned. Each element in a structure must be aligned according to its specified type 
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requirements. This means that the compiler might need to insert pad bytes to keep the 
alignment correct. 

There are two reasons why this can be considered a problem:

● Due to external demands; for example, network communication protocols are 
usually specified in terms of data types with no padding in between

● You need to save data memory.

For information about alignment requirements, see Alignment, page 249.

There are two ways to solve the problem:

● Use the #pragma pack directive for a tighter layout of the structure. The drawback 
is that each access to an unaligned element in the structure will use more code.

● Write your own customized functions for packing and unpacking structures. This is 
a more portable way, which will not produce any more code apart from your 
functions. The drawback is the need for two views on the structure data—packed 
and unpacked.

For further details about the #pragma pack directive, see pack, page 287.

ANONYMOUS STRUCTS AND UNIONS

When a structure or union is declared without a name, it becomes anonymous. The effect 
is that its members will only be seen in the surrounding scope. Anonymous structures 
are part of the C++ language; however, they are not part of the C standard. In the IAR 
C/C++ Compiler for SH they can be used in C if language extensions are enabled.

In the IDE, language extensions are enabled by default.

Use the -e compiler option to enable language extensions. See -e, page 213, for 
additional information.

Example

In this example, the members in the anonymous union can be accessed, in function f, 
without explicitly specifying the union name:

struct S
{
  char mTag;
  union
  {
    long mL;
    float mF;
  };
} St;
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Selecting data types
void F(void)
{
  St.mL = 5;
}

The member names must be unique in the surrounding scope. Having an anonymous 
struct or union at file scope, as a global, external, or static variable is also allowed. 
This could for instance be used for declaring I/O registers, as in this example:

__no_init volatile
union
{
  unsigned char IOPORT;
  struct
  {
    unsigned char Way: 1;
    unsigned char Out: 1;
  };
} @ 0x0FFFF8000;

/* Here the variables are used*/

void Test(void)
{
  IOPORT = 0;
  Way = 1;
  Out = 1;
}

This declares an I/O register byte IOPORT at address 0. The I/O register has 2 bits 
declared, Way and Out. Note that both the inner structure and the outer union are 
anonymous.

Anonymous structures and unions are implemented in terms of objects named after the 
first field, with a prefix _A_ to place the name in the implementation part of the 
namespace. In this example, the anonymous union will be implemented through an 
object named _A_IOPORT.
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Controlling data and function placement in memory
The compiler provides different mechanisms for controlling placement of functions and 
data objects in memory. To use memory efficiently, you should be familiar with these 
mechanisms to know which one is best suited for different situations. You can use:

● Code and data models

Use the different compiler options for code and data models, respectively, to take 
advantage of the different addressing modes available for the microprocessor and 
thereby also place functions and data objects in different parts of memory. To read 
more about data and code models, see Data models, page 56, and Code models and 
memory attributes for function storage, page 63, respectively.

● Memory attributes

Use memory attributes to override the default addressing mode and placement of 
individual functions and data objects. To read more about memory attributes for data 
and functions, see Using data memory attributes, page 58, and Using function 
memory attributes, page 64, respectively.

● The @ operator and the #pragma location directive for absolute placement

Use the @ operator or the #pragma location directive to place individual global and 
static variables at absolute addresses. The variables must be declared __no_init. 
This is useful for individual data objects that must be located at a fixed address, for 
example variables with external requirements, or for populating any hardware tables 
similar to interrupt vector tables. Note that it is not possible to use this notation for 
absolute placement of individual functions.

● The @ operator and the #pragma location directive for section placement

Use the @ operator or the #pragma location directive to place groups of functions 
or global and static variables in named sections, without having explicit control of 
each object. The sections can, for example, be placed in specific areas of memory, or 
initialized or copied in controlled ways using the section begin and end operators. 
This is also useful if you want an interface between separately linked units, for 
example an application project and a boot loader project. Use named sections when 
absolute control over the placement of individual variables is not needed, or not 
useful.

At compile time, data and functions are placed in different sections as described in 
Modules and sections, page 71. At link time, one of the most important functions of the 
linker is to assign load addresses to the various sections used by the application. All 
sections, except for the sections holding absolute located data, are automatically 
allocated to memory according to the specifications in the linker configuration file, as 
described in Placing code and data—the linker configuration file, page 74. 
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Controlling data and function placement in memory
DATA PLACEMENT AT AN ABSOLUTE LOCATION

The @ operator, alternatively the #pragma location directive, can be used for placing 
global and static variables at absolute addresses. The variables must be declared using 
one of these combinations of keywords:

● __no_init

● __no_init and const (without initializers).

To place a variable at an absolute address, the argument to the @ operator and the 
#pragma location directive should be a literal number, representing the actual 
address. The absolute location must fulfill the alignment requirement for the variable 
that should be located.

Note: A variable placed in an absolute location should be defined in an include file, to 
be included in every module that uses the variable. An unused definition in a module 
will be ignored. A normal extern declaration—one that does not use an absolute 
placement directive—can refer to a variable at an absolute address; however, 
optimizations based on the knowledge of the absolute address cannot be performed.

Examples

In this example, a __no_init declared variable is placed at an absolute address. This 
is useful for interfacing between multiple processes, applications, etc:

__no_init volatile char alpha @ 0xFFFF2000;/* OK */

This example contains a const declared object which is not initialized. The object is 
placed in ROM. This is useful for configuration parameters, which are accessible from 
an external interface. 

#pragma location=0xFFFF2002
__no_init const int beta; /* OK */

The actual value must be set by other means. The typical use is for configurations where 
the values are loaded to ROM separately, or for special function registers that are 
read-only.

These examples show incorrect usage:

int delta @ 0xFFFF2006; /* Error, not __no_init */

__no_init int epsilon @ 0xFFFF2007; /* Error, misaligned. */

C++ considerations 

In C++, module scoped const variables are static (module local), whereas in C they are 
global. This means that each module that declares a certain const variable will contain 
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a separate variable with this name. If you link an application with several such modules 
all containing (via a header file), for instance, the declaration:

volatile const __no_init int x @ 0x10000;      /* Bad in C++ */

the linker will report that more than one variable is located at address 0x10000.

To avoid this problem and make the process the same in C and C++, you should declare 
these variables extern, for example:

/* The extern keyword makes x public. */
extern volatile const __no_init int x @ 0x10000;                                       

Note: C++ static member variables can be placed at an absolute address just like any 
other static variable.

DATA AND FUNCTION PLACEMENT IN SECTIONS

The following method can be used for placing data or functions in named sections other 
than default:

● The @ operator, alternatively the #pragma location directive, can be used for 
placing individual variables or individual functions in named sections. The named 
section can either be a predefined section, or a user-defined section. 

C++ static member variables can be placed in named sections just like any other static 
variable.

If you use your own sections, in addition to the predefined sections, the sections must 
also be defined in the linker configuration file.

Note: Take care when explicitly placing a variable or function in a predefined section 
other than the one used by default. This is useful in some situations, but incorrect 
placement can result in anything from error messages during compilation and linking to 
a malfunctioning application. Carefully consider the circumstances; there might be strict 
requirements on the declaration and use of the function or variable.

The location of the sections can be controlled from the linker configuration file.

For more information about sections, see the chapter Section reference.

Examples of placing variables in named sections

In the following examples, a data object is placed in a user-defined section. The variable 
will be treated as if it is located in the default memory. Note that you must place the 
section accordingly in the linker configuration file.

__no_init int alpha @ "MY_NOINIT"; /* OK */

#pragma location="MY_CONSTANTS"
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Controlling compiler optimizations
const int beta; /* OK */

As usual, you can use memory attributes to direct the variable to a non-default memory 
(and then also place the section accordingly in the linker configuration file):

__data32 __no_init int alpha @ "MY_DATA32_NOINIT";/* Placed in
                                                     data32*/

Examples of placing functions in named sections

void f(void) @ "MY_FUNCTIONS";

void g(void) @ "MY_FUNCTIONS"
{
}

#pragma location="MY_FUNCTIONS"
void h(void);

Specify a memory attribute to direct the function to a specific memory, and then modify 
the segment placement in the linker configuration file accordingly:

__code16 void f(void) @ "MY_CODE16_FUNCTIONS";

Controlling compiler optimizations
The compiler performs many transformations on your application to generate the best 
possible code. Examples of such transformations are storing values in registers instead 
of memory, removing superfluous code, reordering computations in a more efficient 
order, and replacing arithmetic operations by cheaper operations.

The linker should also be considered an integral part of the compilation system, because 
some optimizations are performed by the linker. For instance, all unused functions and 
variables are removed and not included in the final output.

SCOPE FOR PERFORMED OPTIMIZATIONS

You can decide whether optimizations should be performed on your whole application 
or on individual files. By default, the same types of optimizations are used for an entire 
project, but you should consider using different optimization settings for individual files. 
For example, put code that must execute very quickly into a separate file and compile it 
for minimal execution time, and the rest of the code for minimal code size. This will give 
a small program, which is still fast enough where it matters.

You can also exclude individual functions from the performed optimizations. The 
#pragma optimize directive allows you to either lower the optimization level, or 
specify another type of optimization to be performed. Refer to optimize, page 286, for 
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information about the pragma directive.

Multi-file compilation units

In addition to applying different optimizations to different source files or even functions, 
you can also decide what a compilation unit consists of—one or several source code 
files.

By default, a compilation unit consists of one source file, but you can also use multi-file 
compilation to make several source files in a compilation unit. The advantage is that 
interprocedural optimizations such as inlining and cross jump have more source code to 
work on. Ideally, the whole application should be compiled as one compilation unit. 
However, for large applications this is not practical because of resource restrictions on 
the host computer. For more information, see --mfc, page 217.

If the whole application is compiled as one compilation unit, it is very useful to make 
the compiler also discard unused public functions and variables before the 
interprocedural optimizations are performed. Doing this limits the scope of the 
optimizations to functions and variables that are actually used. For more information, 
see --discard_unused_publics, page 211.

OPTIMIZATION LEVELS

The compiler supports different levels of optimizations. This table lists optimizations 
that are typically performed on each level:

Optimization level Description

None (Best debug support) Variables live through their entire scope
Dead code elimination
Redundant label elimination
Redundant branch elimination
Static clustering

Low Same as above but variables only live for as long as they are 
needed, not necessarily through their entire scope

Medium Same as above, and:
Code motion
Live-dead analysis and optimization
Code hoisting
Register content analysis and optimization
Type-based alias analysis

Table 25: Compiler optimization levels 
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Controlling compiler optimizations
Note: Some of the performed optimizations can be individually enabled or disabled. 
For more information about these, see Fine-tuning enabled transformations, page 178.

A high level of optimization might result in increased compile time, and will most likely 
also make debugging more difficult, because it is less clear how the generated code 
relates to the source code. For example, at the low, medium, and high optimization 
levels, variables do not live through their entire scope, which means processor registers 
used for storing variables can be reused immediately after they were last used. Due to 
this, the C-SPY Watch window might not be able to display the value of the variable 
throughout its scope. At any time, if you experience difficulties when debugging your 
code, try lowering the optimization level.

SPEED VERSUS SIZE

At the high optimization level, the compiler balances between size and speed 
optimizations. However, it is possible to fine-tune the optimizations explicitly for either 
size or speed. They only differ in what thresholds that are used; speed will trade size for 
speed, whereas size will trade speed for size. Note that one optimization sometimes 
enables other optimizations to be performed, and an application might in some cases 
become smaller even when optimizing for speed rather than size.

If you use the optimization level High speed, the --no_size_constraints compiler 
option relaxes the normal restrictions for code size expansion and enables more 
aggressive optimizations.

FINE-TUNING ENABLED TRANSFORMATIONS

At each optimization level you can disable some of the transformations individually. To 
disable a transformation, use either the appropriate option, for instance the command 
line option --no_inline, alternatively its equivalent in the IDE Function inlining, or 
the #pragma optimize directive. These transformations can be disabled individually: 

● Common subexpression elimination

● Loop unrolling

High (Balanced) Same as above, and:
Common subexpression elimination
Peephole optimization
Cross jumping
Instruction scheduling
Memory content analysis and optimization
Loop unrolling (when optimizing for speed)
Function inlining

Optimization level Description

Table 25: Compiler optimization levels  (Continued)
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● Function inlining

● Code motion

● Type-based alias analysis

● Static clustering

● Instruction scheduling.

Common subexpression elimination   

Redundant re-evaluation of common subexpressions is by default eliminated at 
optimization levels Medium and High. This optimization normally reduces both code 
size and execution time. However, the resulting code might be difficult to debug.

Note: This option has no effect at optimization levels None and Low.

To read more about the command line option, see --no_cse, page 218.

Loop unrolling   

It is possible to duplicate the loop body of a small loop, whose number of iterations can 
be determined at compile time, to reduce the loop overhead.

This optimization, which can be performed at optimization level High, normally 
reduces execution time, but increases code size. The resulting code might also be 
difficult to debug.

The compiler heuristically decides which loops to unroll. Different heuristics are used 
when optimizing for speed, size, or when balancing between size and speed.

Note: This option has no effect at optimization levels None, Low, and Medium.

To read more about the command line option, see --no_unroll, page 222.

Function inlining 

Function inlining means that a simple function, whose definition is known at compile 
time, is integrated into the body of its caller to eliminate the overhead of the call. This 
optimization, which is performed at optimization level High, normally reduces 
execution time, but the resulting code might be difficult to debug.

The compiler heuristically decides which functions to inline. Different heuristics are 
used when optimizing for speed, size, or when balancing between size and speed. 
Normally, code size does not increase when optimizing for size. To control the heuristics 
for individual functions, use the #pragma inline directive or the Standard C inline 
keyword.

Note: This option has no effect at optimization levels None, Low, and Medium.
DSH-2

Part 1. Using the build tools 179



180

Controlling compiler optimizations
To read more about the command line option, see --no_inline, page 219. For information 
about the pragma directive, see inline, page 282.

Code motion 

Evaluation of loop-invariant expressions and common subexpressions are moved to 
avoid redundant re-evaluation. This optimization, which is performed at optimization 
level High, normally reduces code size and execution time. The resulting code might 
however be difficult to debug.

Note: This option has no effect at optimization levels None, and Low.

Type-based alias analysis 

When two or more pointers reference the same memory location, these pointers are said 
to be aliases for each other. The existence of aliases makes optimization more difficult 
because it is not necessarily known at compile time whether a particular value is being 
changed.

Type-based alias analysis optimization assumes that all accesses to an object are 
performed using its declared type or as a char type. This assumption lets the compiler 
detect whether pointers can reference the same memory location or not. 

Type-based alias analysis is performed at optimization level High. For application code 
conforming to standard C or C++ application code, this optimization can reduce code 
size and execution time. However, non-standard C or C++ code might result in the 
compiler producing code that leads to unexpected behavior. Therefore, it is possible to 
turn this optimization off.

Note: This option has no effect at optimization levels None, Low, and Medium.

To read more about the command line option, see --no_tbaa, page 221.

Example

short F(short *p1, long *p2)
{
  *p2 = 0;
  *p1 = 1;
  return *p2;
}

With type-based alias analysis, it is assumed that a write access to the short pointed to 
by p1 cannot affect the long value that p2 points to. Thus, it is known at compile time 
that this function returns 0. However, in non-standard-conforming C or C++ code these 
pointers could overlap each other by being part of the same union. If you use explicit 
casts, you can also force pointers of different pointer types to point to the same memory 
location.
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Static clustering

When static clustering is enabled, static and global variables that are defined within the 
same module are arranged so that variables that are accessed in the same function are 
stored close to each other. This makes it possible for the compiler to use the same base 
pointer for several accesses.

Note: This option has no effect at optimization levels None and Low.

Facilitating good code generation
This section contains hints on how to help the compiler generate good code, for 
example:

● Using efficient addressing modes

● Helping the compiler optimize

● Generating more useful error message.

WRITING OPTIMIZATION-FRIENDLY SOURCE CODE

The following is a list of programming techniques that will, when followed, enable the 
compiler to better optimize the application.

● Local variables—auto variables and parameters—are preferred over static or global 
variables. The reason is that the optimizer must assume, for example, that called 
functions can modify non-local variables. When the life spans for local variables 
end, the previously occupied memory can then be reused. Globally declared 
variables will occupy data memory during the whole program execution.

● Avoid taking the address of local variables using the & operator. This is inefficient 
for two main reasons. First, the variable must be placed in memory, and thus cannot 
be placed in a processor register. This results in larger and slower code. Second, the 
optimizer can no longer assume that the local variable is unaffected over function 
calls.

● Module-local variables—variables that are declared static—are preferred over 
global variables. Also avoid taking the address of frequently accessed static 
variables.

● The compiler is capable of inlining functions, see Function inlining, page 179. To 
maximize the effect of the inlining transformation, it is good practice to place the 
definitions of small functions called from more than one module in the header file 
rather than in the implementation file. Alternatively, you can use multi-file 
compilation. For more information, see Multi-file compilation units, page 177.

● Avoid using inline assembler. Instead, try writing the code in C or C++, use intrinsic 
functions, or write a separate module in assembler language. For more details, see 
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Mixing C and assembler, page 125.

SAVING STACK SPACE AND RAM MEMORY

The following is a list of programming techniques that will, when followed, save 
memory and stack space:

● If stack space is limited, avoid long call chains and recursive functions.

● Avoid using large non-scalar types, such as structures, as parameters or return type. 
To save stack space, you should instead pass them as pointers or, in C++, as 
references.

FUNCTION PROTOTYPES

It is possible to declare and define functions using one of two different styles:

● Prototyped

● Kernighan & Ritchie C (K&R C)

Both styles are included in the C standard; however, it is recommended to use the 
prototyped style, since it makes it easier for the compiler to find problems in the code. 
Using the prototyped style will also make it possible to generate more efficient code, 
since type promotion (implicit casting) is not needed. The K&R style is only supported 
for compatibility reasons.

To make the compiler verify that all functions have proper prototypes, use the compiler 
option Require prototypes (--require_prototypes).

Prototyped style

In prototyped function declarations, the type for each parameter must be specified.

int Test(char, int); /* Declaration */

int Test(char ch, int i) /* Definition */
{
  return i + ch;
}

Kernighan & Ritchie style

In K&R style—pre-Standard C—it is not possible to declare a function prototyped. 
Instead, an empty parameter list is used in the function declaration. Also, the definition 
looks different.
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For example:

int Test();     /* Declaration */

int Test(ch, i) /* Definition */
char ch;
int i;
{
  return i + ch;
}

INTEGER TYPES AND BIT NEGATION

In some situations, the rules for integer types and their conversion lead to possibly 
confusing behavior. Things to look out for are assignments or conditionals (test 
expressions) involving types with different size, and logical operations, especially bit 
negation. Here, types also includes types of constants.

In some cases there might be warnings (for example, for constant conditional or 
pointless comparison), in others just a different result than what is expected. Under 
certain circumstances the compiler might warn only at higher optimizations, for 
example, if the compiler relies on optimizations to identify some instances of constant 
conditionals. In this example an 8-bit character, a 32-bit integer, and two’s complement 
is assumed:

void F1(unsigned char c1)
{
  if (c1 == ~0x80)
    ;
}

Here, the test is always false. On the right hand side, 0x80 is 0x00000080, and 
~0x00000080 becomes 0xFFFFFF7F. On the left hand side, c1 is an 8-bit unsigned 
character, so it cannot be larger than 255. It also cannot be negative, which means that 
the integral promoted value can never have the topmost 8 bits set.

PROTECTING SIMULTANEOUSLY ACCESSED VARIABLES

Variables that are accessed asynchronously, for example by interrupt routines or by code 
executing in separate threads, must be properly marked and have adequate protection. 
The only exception to this is a variable that is always read-only.

To mark a variable properly, use the volatile keyword. This informs the compiler, 
among other things, that the variable can be changed from other threads. The compiler 
will then avoid optimizing on the variable (for example, keeping track of the variable in 
registers), will not delay writes to it, and be careful accessing the variable only the 
number of times given in the source code. To read more about the volatile type 
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qualifier, see Declaring objects volatile, page 258.

A sequence that accesses a volatile declared variable must also not be interrupted. 
Use the __monitor keyword in interruptible code to ensure this. This must be done for 
both write and read sequences, otherwise you might end up reading a partially updated 
variable. This is true for all variables of all sizes. Accessing a small-sized variable can 
be an atomic operation, but this is not guaranteed and you should not rely on it unless 
you continuously study the compiler output. It is safer to use the __monitor keyword 
to ensure that the sequence is an atomic operation.

ACCESSING SPECIAL FUNCTION REGISTERS

Specific header files for several SH devices are included in the IAR product installation. 
The header files are named iodevice.h and define the processor-specific special 
function registers (SFRs). 

Note: Each header file contains one section used by the compiler, and one section used 
by the assembler. 

SFRs with bitfields are declared in the header file. This example is from io7254r.h:

struct st_stby 
{                                          /* struct STBY */
  union  
  {                                        /* STBCR */
    unsigned short WORD;                   /* Word Access */
     struct  {                             /* Bit Access */
        unsigned short STBCRKEY :8;        /* STBCRKEY */
        unsigned short  :3;                /* Reserved Bits */
        unsigned short MSTP4 :1;           /* MSTP4 */
        unsigned short MSTP3 :1;           /* MSTP3 */
        unsigned short MSTP2 :1;           /* MSTP2 */
        unsigned short MSTP1 :1;           /* MSTP1 */
        unsigned short MSTP0 :1;           /* MSTP0 */
    } BIT;
  } STBCR;
};

#define STBY    (*(volatile struct st_stby    __data32 *)
                   0xFFFE0400u)

By including the appropriate include file in your code, it is possible to access either the 
whole register or any individual bit (or bitfields) from C code as follows:

void Test()
{
  /* Whole register access */
  STBY.STBCR.WORD = 0x1234;
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  /* Bitfield accesses */
  STBY.STBCR.BIT.MSTP4 = 1;
  STBY.STBCR.BIT.MSTP3 = 1;
}

You can also use the header files as templates when you create new header files for other 
SH devices. For details about the @ operator, see Controlling data and function 
placement in memory, page 173.

NON-INITIALIZED VARIABLES

Normally, the runtime environment will initialize all global and static variables when the 
application is started.

The compiler supports the declaration of variables that will not be initialized, using the 
__no_init type modifier. They can be specified either as a keyword or using the 
#pragma object_attribute directive. The compiler places such variables in a 
separate section, according to the specified memory keyword.

For __no_init, the const keyword implies that an object is read-only, rather than that 
the object is stored in read-only memory. It is not possible to give a __no_init object 
an initial value. 

Variables declared using the __no_init keyword could, for example, be large input 
buffers or mapped to special RAM that keeps its content even when the application is 
turned off.

For information about the __no_init keyword, see page 270. Note that to use this 
keyword, language extensions must be enabled; see -e, page 213. For information about 
the #pragma object_attribute, see page 285.
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Part 2. Reference 
information
This part of the IAR C/C++ Development Guide for SH contains these 
chapters:

● External interface details

● Compiler options

● Linker options

● Data representation

● Extended keywords

● Pragma directives

● Intrinsic functions

● The preprocessor

● Library functions

● The linker configuration file

● Section reference

● IAR utilities

● Implementation-defined behavior.
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External interface details
This chapter provides reference information about how the compiler and 
linker interact with their environment. The chapter briefly lists and describes 
the invocation syntax, methods for passing options to the tools, environment 
variables, the include file search procedure, and finally the different types of 
compiler and linker output.

Invocation syntax 
You can use the compiler and linker either from the IDE or from the command line. 
Refer to the IAR Embedded Workbench® IDE User Guide for information about using 
the build tools from the IDE.

COMPILER INVOCATION SYNTAX

The invocation syntax for the compiler is:

iccsh [options] [sourcefile] [options]

For example, when compiling the source file prog.c, use this command to generate an 
object file with debug information:

iccsh prog.c --debug

The source file can be a C or C++ file, typically with the filename extension c or cpp, 
respectively. If no filename extension is specified, the file to be compiled must have the 
extension c.

Generally, the order of options on the command line, both relative to each other and to 
the source filename, is not significant. There is, however, one exception: when you use 
the -I option, the directories are searched in the same order that they are specified on the 
command line.

If you run the compiler from the command line without any arguments, the compiler 
version number and all available options including brief descriptions are directed to 
stdout and displayed on the screen.

ILINK INVOCATION SYNTAX

The invocation syntax for ILINK is:

ilinksh [arguments]

Each argument is either a command-line option, an object file, or a library.
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For example, when linking the object file prog.o, use this command:

ilinksh prog.o --config configfile

If no filename extension is specified for the linker configuration file, the configuration 
file must have the extension icf.

Generally, the order of arguments on the command line is not significant. There is, 
however, one exception: when you supply several libraries, the libraries are searched in 
the same order that they are specified on the command line. The default libraries are 
always searched last.

The output executable image will be placed in a file named a.out, unless the -o option 
is used.

If you run ILINK from the command line without any arguments, the ILINK version 
number and all available options including brief descriptions are directed to stdout and 
displayed on the screen.

PASSING OPTIONS

There are three different ways of passing options to the compiler and to ILINK:

● Directly from the command line

Specify the options on the command line after the iccsh or ilinksh commands; 
see Invocation syntax, page 189.

● Via environment variables

The compiler and linker automatically append the value of the environment variables 
to every command line; see Environment variables, page 191.

● Via a text file, using the -f option; see -f, page 215.

For general guidelines for the option syntax, an options summary, and a detailed 
description of each option, see the Compiler options chapter.
DSH-2

IAR C/C++ Development Guide
Compiling and Linking for SH



External interface details
ENVIRONMENT VARIABLES

These environment variables can be used with the compiler:

This environment variable can be used with ILINK:

Include file search procedure
This is a detailed description of the compiler’s #include file search procedure:

● If the name of the #include file is an absolute path, that file is opened.

● If the compiler encounters the name of an #include file in angle brackets, such as:

#include <stdio.h>

it searches these directories for the file to include:

1 The directories specified with the -I option, in the order that they were 
specified, see -I, page 216.

2 The directories specified using the C_INCLUDE environment variable, if any; see 
Environment variables, page 191.

3 The automatically set up library system include directories. See --dlib, page 211 
and --dlib_config, page 212.

● If the compiler encounters the name of an #include file in double quotes, for 
example:

#include "vars.h"

it searches the directory of the source file in which the #include statement occurs, 
and then performs the same sequence as for angle-bracketed filenames.

Environment variable Description

C_INCLUDE Specifies directories to search for include files; for example: 
C_INCLUDE=c:\program files\iar systems\embedded 

workbench 6.n\sh\inc;c:\headers

QCCSH Specifies command line options; for example: QCCSH=-lA asm.lst

Table 26: Compiler environment variables

Environment variable Description

ILINKSH_CMD_LINE Specifies command line options; for example: 
ILINKSH_CMD_LINE=--config full.icf 

--silent

Table 27: ILINK environment variables
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Compiler output
If there are nested #include files, the compiler starts searching the directory of the file 
that was last included, iterating upwards for each included file, searching the source file 
directory last. For example:

src.c in directory dir\src
#include "src.h"
...

src.h in directory dir\include
#include "config.h"
...

When dir\exe is the current directory, use this command for compilation:

iccsh ..\src\src.c -I..\include -I..\debugconfig

Then the following directories are searched in the order listed below for the file 
config.h, which in this example is located in the dir\debugconfig directory:

dir\include Current file is src.h.

dir\src File including current file (src.c).

dir \include As specified with the first -I option.

dir\debugconfig As specified with the second -I option.

Use angle brackets for standard header files, like stdio.h, and double quotes for files 
that are part of your application.

Note: Both \ and / can be used as directory delimiters.

For information about the syntax for including header files, see Overview of the 
preprocessor, page 301.

Compiler output
The compiler can produce the following output:

● A linkable object file

The object files produced by the compiler use the industry-standard format ELF. By 
default, the object file has the filename extension o.

● Optional list files

Various kinds of list files can be specified using the compiler option -l, see -l, page 
216. By default, these files will have the filename extension lst. 

● Optional preprocessor output files

A preprocessor output file is produced when you use the --preprocess option; by 
default, the file will have the filename extension i.
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● Diagnostic messages

Diagnostic messages are directed to the standard error stream and displayed on the 
screen, and printed in an optional list file. To read more about diagnostic messages, 
see Diagnostics, page 194.

● Error return codes

These codes provide status information to the operating system which can be tested 
in a batch file, see Error return codes, page 193.

● Size information

Information about the generated amount of bytes for functions and data for each 
memory is directed to the standard output stream and displayed on the screen. Some 
of the bytes might be reported as shared.

Shared objects are functions or data objects that are shared between modules. If any 
of these occur in more than one module, only one copy is retained. For example, in 
some cases inline functions are not inlined, which means that they are marked as 
shared, because only one instance of each function will be included in the final 
application. This mechanism is sometimes also used for compiler-generated code or 
data not directly associated with a particular function or variable, and when only one 
instance is required in the final application.

Error return codes

The compiler and linker return status information to the operating system that can be 
tested in a batch file. 

These command line error codes are supported:

Code Description

0 Compilation or linking successful, but there might have been warnings.

1 Warnings were produced and the option --warnings_affect_exit_code was 
used.

2 Errors occurred.

3 Fatal errors occurred, making the tool abort.

4 Internal errors occurred, making the tool abort.

Table 28: Error return codes  
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ILINK output
ILINK can produce the following output:

● An absolute executable image

The final output produced by the IAR ILINK Linker is an absolute object file 
containing the executable image that can be put into an EPROM, downloaded to a 
hardware emulator, or executed on your PC using the IAR C-SPY Debugger 
Simulator. By default, the file has the filename extension out. The output format is 
always in ELF, which optionally includes debug information in the DWARF format.

● Optional logging information

During operation, ILINK logs its decisions on stdout, and optionally to a file. For 
example, if a library is searched, whether a required symbol is found in a library 
module, or whether a module will be part of the output. Timing information for each 
ILINK subsystem is also logged.

●  Optional map files

A linker map file—containing summaries of linkage, runtime attributes, memory, 
and placement, as well as an entry list— can be generated by the ILINK option 
--map, see --map, page 242. By default, the map file has the filename extension map. 

● Diagnostic messages

Diagnostic messages are directed to stderr and displayed on the screen, as well as 
printed in the optional map file. To read more about diagnostic messages, see 
Diagnostics, page 194.

● Error return codes

ILINK returns status information to the operating system which can be tested in a 
batch file, see Error return codes, page 193.

● Size information about used memory and amount of time

Information about the generated amount of bytes for functions and data for each 
memory is directed to stdout and displayed on the screen.

Diagnostics
This section describes the format of the diagnostic messages and explains how 
diagnostic messages are divided into different levels of severity. 

MESSAGE FORMAT FOR THE COMPILER

All diagnostic messages are issued as complete, self-explanatory messages. A typical 
diagnostic message from the compiler is produced in the form:

filename,linenumber  level[tag]: message
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with these elements:

Diagnostic messages are displayed on the screen, as well as printed in the optional list 
file.

Use the option --diagnostics_tables to list all possible compiler diagnostic 
messages.

MESSAGE FORMAT FOR THE LINKER

All diagnostic messages are issued as complete, self-explanatory messages. A typical 
diagnostic message from ILINK is produced in the form:

level[tag]: message

with these elements:

Diagnostic messages are displayed on the screen, as well as printed in the optional map 
file.

Use the option --diagnostics_tables to list all possible linker diagnostic messages.

SEVERITY LEVELS

The diagnostic messages are divided into different levels of severity:

Remark

A diagnostic message that is produced when the compiler or linker finds a construct that 
can possibly lead to erroneous behavior in the generated code. Remarks are by default 
not issued, but can be enabled, see --remarks, page 227.

filename The name of the source file in which the issue was encountered

linenumber The line number at which the compiler detected the issue

level The level of seriousness of the issue

tag A unique tag that identifies the diagnostic message

message An explanation, possibly several lines long

level The level of seriousness of the issue

tag A unique tag that identifies the diagnostic message

message An explanation, possibly several lines long
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Warning

A diagnostic message that is produced when the compiler or linker finds a problem 
which is of concern, but not so severe as to prevent the completion of compilation or 
linking. Warnings can be disabled by use of the command line option --no_warnings, 
see page 222.

Error

A diagnostic message that is produced when the compiler or linker finds a serious error. 
An error will produce a non-zero exit code.

Fatal error

A diagnostic message that is produced when the compiler finds a condition that not only 
prevents code generation, but which makes further processing pointless. After the 
message is issued, compilation terminates. A fatal error will produce a non-zero exit 
code.

SETTING THE SEVERITY LEVEL

The diagnostic messages can be suppressed or the severity level can be changed for all 
diagnostics messages, except for fatal errors and some of the regular errors. 

See Summary of compiler options, page 202, for a description of the compiler options 
that are available for setting severity levels.

For the compiler see also the chapter Pragma directives, for a description of the pragma 
directives that are available for setting severity levels.

INTERNAL ERROR

An internal error is a diagnostic message that signals that there was a serious and 
unexpected failure due to a fault in the compiler or linker. It is produced using this form:

Internal error: message

where message is an explanatory message. If internal errors occur, they should be 
reported to your software distributor or IAR Systems Technical Support. Include enough 
information to reproduce the problem, typically: 

● The product name

● The version number of the compiler or of ILINK, which can be seen in the header of 
the list or map files generated by the compiler or by ILINK, respectively

● Your license number

● The exact internal error message text

● The files involved of the application that generated the internal error
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● A list of the options that were used when the internal error occurred.
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Compiler options
This chapter describes the syntax of compiler options and the general syntax 
rules for specifying option parameters, and gives detailed reference 
information about each option.

Options syntax
Compiler options are parameters you can specify to change the default behavior of the 
compiler. You can specify options from the command line—which is described in more 
detail in this section—and from within the IDE. 

Refer to the IAR Embedded Workbench® IDE User Guide for information about the 
compiler options available in the IDE and how to set them.

TYPES OF OPTIONS

There are two types of names for command line options, short names and long names. 
Some options have both.

● A short option name consists of one character, and it can have parameters. You 
specify it with a single dash, for example -e

● A long option name consists of one or several words joined by underscores, and it 
can have parameters. You specify it with double dashes, for example 
--char_is_signed.

For information about the different methods for passing options, see Passing options, 
page 190.

RULES FOR SPECIFYING PARAMETERS

There are some general syntax rules for specifying option parameters. First, the rules 
depending on whether the parameter is optional or mandatory, and whether the option 
has a short or a long name, are described. Then, the rules for specifying filenames and 
directories are listed. Finally, the remaining rules are listed.

Rules for optional parameters

For options with a short name and an optional parameter, any parameter should be 
specified without a preceding space, for example:

-O or -Oh
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For options with a long name and an optional parameter, any parameter should be 
specified with a preceding equal sign (=), for example:

--misrac2004=n

Rules for mandatory parameters

For options with a short name and a mandatory parameter, the parameter can be 
specified either with or without a preceding space, for example:

-I..\src or -I ..\src\

For options with a long name and a mandatory parameter, the parameter can be specified 
either with a preceding equal sign (=) or with a preceding space, for example:

--diagnostics_tables=MyDiagnostics.lst

or 

--diagnostics_tables MyDiagnostics.lst

Rules for options with both optional and mandatory parameters

For options taking both optional and mandatory parameters, the rules for specifying the 
parameters are:

● For short options, optional parameters are specified without a preceding space

● For long options, optional parameters are specified with a preceding equal sign (=)

● For short and long options, mandatory parameters are specified with a preceding 
space.

For example, a short option with an optional parameter followed by a mandatory 
parameter:

-lA MyList.lst

For example, a long option with an optional parameter followed by a mandatory 
parameter:

--preprocess=n PreprocOutput.lst

Rules for specifying a filename or directory as parameters

These rules apply for options taking a filename or directory as parameters:

● Options that take a filename as a parameter can optionally also take a path. The path 
can be relative or absolute. For example, to generate a listing to the file List.lst 
in the directory ..\listings\:

iccsh prog.c -l ..\listings\List.lst
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● For options that take a filename as the destination for output, the parameter can be 
specified as a path without a specified filename. The compiler stores the output in 
that directory, in a file with an extension according to the option. The filename will 
be the same as the name of the compiled source file, unless a different name was 
specified with the option -o, in which case that name is used. For example:

iccsh prog.c -l ..\listings\

The produced list file will have the default name ..\listings\prog.lst

● The current directory is specified with a period (.). For example:

iccsh prog.c -l .

● / can be used instead of \ as the directory delimiter.

● By specifying -, input files and output files can be redirected to the standard input 
and output stream, respectively. For example:

iccsh prog.c -l -

Additional rules

These rules also apply:

● When an option takes a parameter, the parameter cannot start with a dash (-) 
followed by another character. Instead, you can prefix the parameter with two 
dashes; this example will create a list file called -r:

iccsh prog.c -l ---r

● For options that accept multiple arguments of the same type, the arguments can be 
provided as a comma-separated list (without a space), for example:

--diag_warning=Be0001,Be0002

Alternatively, the option can be repeated for each argument, for example:

--diag_warning=Be0001
--diag_warning=Be0002
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Summary of compiler options
Summary of compiler options
This table summarizes the compiler command line options:

Command line option Description

--c89 Uses the C89 standard

--char_is_signed Treats char as signed

--char_is_unsigned Treats char as unsigned

--code_model Specifies the code model

--core Specifies a CPU core

-D Defines preprocessor symbols

--data_model Specifies the data model

--debug Generates debug information

--dependencies Lists file dependencies

--diag_error Treats these as errors

--diag_remark Treats these as remarks

--diag_suppress Suppresses these diagnostics

--diag_warning Treats these as warnings

--diagnostics_tables Lists all diagnostic messages

--discard_unused_publics Discards unused public symbols

--dlib Uses the system header files for the DLIB library

--dlib_config Uses the system header files for the DLIB library 
and determines which configuration of the library 
to use

--double Forces the compiler to use 32-bit or 64-bit doubles

-e Enables language extensions

--ec++ Enables Embedded C++ syntax

--eec++ Enables Extended Embedded C++ syntax

--enable_alternative_register_

allocator
Reuses freed registers to generate smaller code.

--enable_multibytes Enables support for multibyte characters in source 
files

--error_limit Specifies the allowed number of errors before 
compilation stops

-f Extends the command line

Table 29: Compiler options summary
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--guard_calls Enables guards for function static variable 
initialization

--header_context Lists all referred source files and header files

-I Specifies include file path

-l Creates a list file

--mfc Enables multi-file compilation

--misrac1998 Enables error messages specific to MISRA-C:1998. 
See the IAR Embedded Workbench® MISRA C:1998 
Reference Guide.

--misrac2004 Enables error messages specific to MISRA-C:2004. 
See the IAR Embedded Workbench® MISRA C:2004 
Reference Guide.

--misrac_verbose Enables verbose logging of MISRA C checking. See 
the IAR Embedded Workbench® MISRA C:1998 
Reference Guide or the IAR Embedded Workbench® 
MISRA C:2004 Reference Guide.

--no_clustering Disables static clustering optimizations

--no_code_motion Disables code motion optimization

--no_cse Disables common subexpression elimination

--no_fragments Disables section fragment handling

--no_inline Disables function inlining

--no_path_in_file_macros Removes the path from the return value of the 
symbols __FILE__ and __BASE_FILE__

--no_scheduling Disables the instruction scheduler

--no_size_constraints Relaxes the normal restrictions for code size 
expansion when optimizing for speed.

--no_system_include Disables the automatic search for system include 
files

--no_tbaa Disables type-based alias analysis

--no_typedefs_in_diagnostics Disables the use of typedef names in diagnostics

--no_unroll Disables loop unrolling

--no_warnings Disables all warnings

--no_wrap_diagnostics Disables wrapping of diagnostic messages

-O Sets the optimization level

Command line option Description

Table 29: Compiler options summary (Continued)
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Descriptions of options
The following section gives detailed reference information about each compiler option.

Note that if you use the options page Extra Options to specify specific command line 
options, the IDE does not perform an instant check for consistency problems like 
conflicting options, duplication of options, or use of irrelevant options.

-o Sets the object filename. Alias for --output.

--only_stdout Uses standard output only

--output Sets the object filename

--predef_macros Lists the predefined symbols.

--preinclude Includes an include file before reading the source 
file

--preprocess Generates preprocessor output

--public_equ Defines a global named assembler label

--quad_align_labels Aligns labels on 4-byte boundaries

-r Generates debug information Alias for --debug.

--relaxed_fp Relaxes the rules for optimizing floating-point 
expressions

--remarks Enables remarks

--require_prototypes Verifies that functions are declared before they are 
defined

--silent Sets silent operation

--strict Checks for strict compliance with Standard C/C++

--system_include_dir Specifies the path for system include files

--use_unix_directory_

separators

Uses / as directory separator in paths

--vla Enables VLA support

--warnings_affect_exit_code Warnings affects exit code

--warnings_are_errors Warnings are treated as errors

Command line option Description

Table 29: Compiler options summary (Continued)
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--c89

Syntax --c89

Description Use this option to enable the C89 standard instead of Standard C.

Note: This option is mandatory when the MISRA C checking is enabled.

See also C language overview, page 143.

Project>Options>C/C++ Compiler>Language>C dialect: C89

--char_is_signed

Syntax --char_is_signed 

Description Use this option to make the compiler interpret the plain char type as signed. This is the 
default interpretation of the plain char type.

Project>Options>C/C++ Compiler>Language>Plain ‘char’ is

--char_is_unsigned

Syntax --char_is_unsigned 

Description By default, the compiler interprets the plain char type as signed. Use this option to 
make the compiler interpret the plain char type as unsigned instead. This can be useful 
when you, for example, want to maintain compatibility with another compiler.

Note: The runtime library is compiled without the --char_is_unsigned option and 
cannot be used with code that is compiled with this option.

Project>Options>C/C++ Compiler>Language>Plain ‘char’ is

--code_model

Syntax --code_model={small|medium|large|huge}

Parameters
small Functions are by default placed in the high or low 32 Kbytes of memory

medium Functions are by default placed in the high or low 512 Kbytes of memory
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Description Use this option to select the code model, which means a default placement of functions. 
If you do not select a code model option, the compiler uses the default code model. Note 
that all modules of your application must use the same code model.

See also Code models and memory attributes for function storage, page 63.

Project>Options>General Options>Target>Code model

--core

Syntax --core={sh2a|sh2afpu}

Parameters

Description Use this option to select the processor core for which the code will be generated. If you 
do not use the option to specify a core, the compiler uses the SH-2A core without an 
FPU as default. Note that all modules of your application must use the same core.

The compiler supports all devices based on the SH-2A microprocessor core.

To set related options, choose:

Project>Options>General Options>Target>Device

-D

Syntax -D symbol[=value]

Parameters

Description Use this option to define a preprocessor symbol. If no value is specified, 1 is used. This 
option can be used one or more times on the command line.

large Functions are by default placed in the high or low 128 Mbytes of memory

huge (default) Functions can be placed anywhere in memory

sh2a (default) Generates code for SH-2A microprocessors without a hardware FPU

sh2afpu Generates code for SH-2A microprocessors with a hardware FPU

symbol The name of the preprocessor symbol

value The value of the preprocessor symbol
DSH-2

IAR C/C++ Development Guide
Compiling and Linking for SH



Compiler options
The option -D has the same effect as a #define statement at the top of the source file:

-Dsymbol

is equivalent to:

#define symbol 1

To get the equivalence of:

#define FOO

specify the = sign but nothing after, for example:

-DFOO=

Project>Options>C/C++ Compiler>Preprocessor>Defined symbols

--data_model

Syntax --data_model={small|medium|large|huge}

Parameters

Description Use this option to select the data model, which means a default placement of data 
objects. If you do not select a data model option, the compiler uses the default data 
model. Note that all modules of your application must use the same data model.

See also Data models, page 56.

Project>Options>General Options>Target>Data model

small Variable and constant data is by default placed in the high or low 32 
Kbytes of memory

medium Variable and constant data is by default placed in the high or low 512 
Kbytes of memory

large Variable and constant data is by default placed in the high or low 128 
Mbytes of memory

huge (default) Variable and constant data can be placed anywhere in memory
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--debug, -r

Syntax --debug
-r

Description Use the --debug or -r option to make the compiler include information in the object 
modules required by the IAR C-SPY® Debugger and other symbolic debuggers.

Note: Including debug information will make the object files larger than otherwise.

Project>Options>C/C++ Compiler>Output>Generate debug information

--dependencies

Syntax --dependencies[=[i|m]] {filename|directory} 

Parameters

For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 200.

Description Use this option to make the compiler list the names of all source and header files opened 
for input into a file with the default filename extension i.

Example If --dependencies or --dependencies=i is used, the name of each opened input 
file, including the full path, if available, is output on a separate line. For example:

   c:\iar\product\include\stdio.h
   d:\myproject\include\foo.h

If --dependencies=m is used, the output is in makefile style. For each input file, one 
line containing a makefile dependency rule is produced. Each line consists of the name 
of the object file, a colon, a space, and the name of an input file. For example:

   foo.o: c:\iar\product\include\stdio.h
   foo.o: d:\myproject\include\foo.h

An example of using --dependencies with a popular make utility, such as gmake 
(GNU make):

1 Set up the rule for compiling files to be something like:

     %.o : %.c
           $(ICC) $(ICCFLAGS) $< --dependencies=m $*.d

i (default) Lists only the names of files

m Lists in makefile style
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That is, in addition to producing an object file, the command also produces a 
dependency file in makefile style (in this example, using the extension .d).

2 Include all the dependency files in the makefile using, for example:

     -include $(sources:.c=.d)

Because of the dash (-) it works the first time, when the .d files do not yet exist.

This option is not available in the IDE.

--diag_error

Syntax --diag_error=tag[,tag,...] 

Parameters

Description Use this option to reclassify certain diagnostic messages as errors. An error indicates a 
violation of the C or C++ language rules, of such severity that object code will not be 
generated. The exit code will be non-zero. This option may be used more than once on 
the command line.

Project>Options>C/C++ Compiler>Diagnostics>Treat these as errors

--diag_remark

Syntax --diag_remark=tag[,tag,...] 

Parameters

Description Use this option to reclassify certain diagnostic messages as remarks. A remark is the 
least severe type of diagnostic message and indicates a source code construction that 
may cause strange behavior in the generated code. This option may be used more than 
once on the command line.

tag The number of a diagnostic message, for example the message 
number Pe117

tag The number of a diagnostic message, for example the message 
number Pe177
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Note: By default, remarks are not displayed; use the --remarks option to display 
them.

Project>Options>C/C++ Compiler>Diagnostics>Treat these as remarks

--diag_suppress

Syntax --diag_suppress=tag[,tag,...] 

Parameters

Description Use this option to suppress certain diagnostic messages. These messages will not be 
displayed. This option may be used more than once on the command line.

Project>Options>C/C++ Compiler>Diagnostics>Suppress these diagnostics

--diag_warning

Syntax --diag_warning=tag[,tag,...] 

Parameters

Description Use this option to reclassify certain diagnostic messages as warnings. A warning 
indicates an error or omission that is of concern, but which will not cause the compiler 
to stop before compilation is completed. This option may be used more than once on the 
command line.

Project>Options>C/C++ Compiler>Diagnostics>Treat these as warnings

--diagnostics_tables

Syntax --diagnostics_tables {filename|directory} 

Parameters For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 200.

tag The number of a diagnostic message, for example the message 
number Pe117

tag The number of a diagnostic message, for example the message 
number Pe826
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Description Use this option to list all possible diagnostic messages in a named file. This can be 
convenient, for example, if you have used a pragma directive to suppress or change the 
severity level of any diagnostic messages, but forgot to document why.

This option cannot be given together with other options.

This option is not available in the IDE.

--discard_unused_publics

Syntax --discard_unused_publics 

Description Use this option to discard unused public functions and variables from the compilation 
unit. This enhances interprocedural optimizations such as inlining, cross call, and cross 
jump by limiting their scope to public functions and variables that are actually used. 

This option is only useful when all source files are compiled as one unit, which means 
that the --mfc compiler option is used.

Note: Do not use this option only on parts of the application, as necessary symbols 
might be removed from the generated output.

See also --mfc, page 217 and Multi-file compilation units, page 177.

Project>Options>C/C++ Compiler>Discard unused publics

--dlib

Syntax --dlib

Description Use this option to use the system header files for the DLIB library; the compiler will 
automatically locate the files and use them when compiling.

Note: This option is used by default.

See also --dlib_config, page 212, --no_system_include, page 220, --system_include_dir, page 
228.

To set related options, choose:

Project>Options>General Options>Library Configuration
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 --dlib_config

Syntax --dlib_config filename.h|config

Parameters

Description Each runtime library has a corresponding library configuration file. Use this option to 
explicitly specify which library configuration file to use, either by specifying an explicit 
file or by specifying a library configuration—in which case the default file for that 
library configuration will be used. Make sure that you specify a configuration that 
corresponds to the library you are using. If you do not specify this option, the default 
library configuration file will be used.

All prebuilt runtime libraries are delivered with corresponding configuration files. You 
can find the library object files and the library configuration files in the directory 
sh\lib. For examples and a list of prebuilt runtime libraries, see Using a prebuilt 
library, page 95.

If you build your own customized runtime library, you should also create a 
corresponding customized library configuration file, which must be specified to the 
compiler. For more information, see Building and using a customized library, page 103.

To set related options, choose:

Project>Options>General Options>Library Configuration

 --double

Syntax --double={32|64}

Parameters

filename A DLIB configuration header file. For information about specifying a 
filename, see Rules for specifying a filename or directory as parameters, 
page 200.

config The default configuration file for the specified configuration will be 
used. Choose between:
none, no configuration will be used
normal, the normal library configuration will be used (default)
full, the full library configuration will be used.

32 (default) 32-bit doubles are used

64 64-bit doubles are used
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Description Use this option to select the precision used by the compiler for representing the 
floating-point types double and long double. The compiler can use either 32-bit or 
64-bit precision. By default, the compiler uses 32-bit precision.

See also Floating-point types, page 253.

Project>Options>General Options>Target>Size of type 'double'

-e 

Syntax -e 

Description In the command line version of the compiler, language extensions are disabled by 
default. If you use language extensions such as extended keywords and anonymous 
structs and unions in your source code, you must use this option to enable them.

Note: The -e option and the --strict option cannot be used at the same time.

See also Enabling language extensions, page 145.

Project>Options>C/C++ Compiler>Language>Standard with IAR extensions

Note: By default, this option is selected in the IDE.

--ec++

Syntax --ec++

Description In the compiler, the default language is C. If you use Embedded C++, you must use this 
option to set the language the compiler uses to Embedded C++.

Project>Options>C/C++ Compiler>Language>Embedded C++

--eec++

Syntax --eec++

Description In the compiler, the default language is C. If you take advantage of Extended Embedded 
C++ features like namespaces or the standard template library in your source code, you 
must use this option to set the language the compiler uses to Extended Embedded C++. 
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See also Extended Embedded C++, page 154.

Project>Options>C/C++ Compiler>Language>Extended Embedded C++

--enable_alternative_register_allocator

Syntax --enable_alternative_register_allocator 

Description By default, the compiler uses a register allocation scheme that enables better scheduling 
and, most of the time, smaller code. The alternative register allocation method reuses 
freed registers and can generate smaller code, but code that is not as good for scheduling.

Project>Options>C/C++ Compiler>Optimizations>Alternative register allocation 
scheme

--enable_multibytes

Syntax --enable_multibytes 

Description By default, multibyte characters cannot be used in C or C++ source code. Use this option 
to make multibyte characters in the source code be interpreted according to the host 
computer’s default setting for multibyte support.

Multibyte characters are allowed in C and C++ style comments, in string literals, and in 
character constants. They are transferred untouched to the generated code.

Project>Options>C/C++ Compiler>Language>Enable multibyte support

--error_limit

Syntax --error_limit=n 

Parameters

Description Use the --error_limit option to specify the number of errors allowed before the 
compiler stops the compilation. By default, 100 errors are allowed.

This option is not available in the IDE.

n The number of errors before the compiler stops the compilation. n 
must be a positive integer; 0 indicates no limit.
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-f

Syntax -f filename 

Parameters For information about specifying a filename, see Rules for specifying a filename or 
directory as parameters, page 200.

Descriptions Use this option to make the compiler read command line options from the named file, 
with the default filename extension xcl.

In the command file, you format the items exactly as if they were on the command line 
itself, except that you may use multiple lines, because the newline character acts just as 
a space or tab character.

Both C and C++ style comments are allowed in the file. Double quotes behave in the 
same way as in the Microsoft Windows command line environment.

To set this option, use Project>Options>C/C++ Compiler>Extra Options.

--guard_calls

Syntax --guard_calls

Description Use this option to enable guards for function static variable initialization. This option 
should be used in a threaded C++ environment.

See also Managing a multithreaded environment, page 118.

To set this option, use Project>Options>C/C++ Compiler>Extra Options.

--header_context

Syntax --header_context 

Description Occasionally, to find the cause of a problem it is necessary to know which header file 
that was included from which source line. Use this option to list, for each diagnostic 
message, not only the source position of the problem, but also the entire include stack at 
that point.

This option is not available in the IDE.
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-I

Syntax -I path

Parameters

Description Use this option to specify the search paths for #include files. This option can be used 
more than once on the command line.

See also Include file search procedure, page 191.

Project>Options>C/C++ Compiler>Preprocessor>Additional include directories

-l

Syntax -l[a|A|b|B|c|C|D][N][H] {filename|directory}

Parameters

* This makes the list file less useful as input to the assembler, but more useful for reading by a 
human.

path The search path for #include files

a (default) Assembler list file

A Assembler list file with C or C++ source as comments

b Basic assembler list file. This file has the same contents as a list file 
produced with -la, except that no extra compiler-generated 
information (runtime model attributes, call frame information, frame 
size information) is included *

B Basic assembler list file. This file has the same contents as a list file 
produced with -lA, except that no extra compiler generated 
information (runtime model attributes, call frame information, frame 
size information) is included *

c C or C++ list file

C (default) C or C++ list file with assembler source as comments

D C or C++ list file with assembler source as comments, but without 
instruction offsets and hexadecimal byte values

N No diagnostics in file

H Include source lines from header files in output. Without this 
option, only source lines from the primary source file are included
DSH-2

IAR C/C++ Development Guide
Compiling and Linking for SH



Compiler options
For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 200.

Description Use this option to generate an assembler or C/C++ listing to a file. Note that this option 
can be used one or more times on the command line.

To set related options, choose:

Project>Options>C/C++ Compiler>List

--mfc

Syntax --mfc 

Description Use this option to enable multi-file compilation. This means that the compiler compiles 
one or several source files specified on the command line as one unit, which makes 
interprocedural optimizations such as inlining, cross call, and cross jump possible.

Note: The compiler will generate one object file per input source code file, where the 
first object file contains all relevant data and the other ones are empty. If you want only 
the first file to be produced, use the -o compiler option and specify a certain output file.

Example iccsh myfile1.c myfile2.c myfile3.c --mfc

See also --discard_unused_publics, page 211, --output, -o, page 224, and Multi-file compilation 
units, page 177.

Project>Options>C/C++ Compiler>Multi-file compilation

--no_clustering

Syntax --no_clustering 

Description Use this option to disable static clustering optimizations. When static clustering is 
enabled, static and global variables are arranged so that variables that are accessed in the 
same function are stored close to each other. This makes it possible for the compiler to 
use the same base pointer for several accesses. These optimizations, which are 
performed at optimization levels Medium and High, normally reduce code size and 
execution time.
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Note: This option has no effect at optimization levels below Medium.

Project>Options>C/C++ Compiler>Optimizations>Enable 
transformations>Static clustering

--no_code_motion

Syntax --no_code_motion 

Description Use this option to disable code motion optimizations. These optimizations, which are 
performed at the optimization levels Medium and High, normally reduce code size and 
execution time. However, the resulting code might be difficult to debug.

Note: This option has no effect at optimization levels below Medium.

Project>Options>C/C++ Compiler>Optimizations>Enabled 
transformations>Code motion

--no_cse

Syntax --no_cse 

Description Use this option to disable common subexpression elimination. At the optimization 
levels Medium and High, the compiler avoids calculating the same expression more than 
once. This optimization normally reduces both code size and execution time. However, 
the resulting code might be difficult to debug.

Note: This option has no effect at optimization levels below Medium.

Project>Options>C/C++ Compiler>Optimizations>Enabled 
transformations>Common subexpression elimination

--no_fragments

Syntax --no_fragments 

Description Use this option to disable section fragment handling. Normally, the toolset uses IAR 
proprietary information for transferring section fragment information to the linker. The 
linker uses this information to remove unused code and data, and thus further minimize 
the size of the executable image.
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See also Keeping symbols and sections, page 85.

To set this option, use Project>Options>C/C++ Compiler>Extra Options

--no_inline

Syntax --no_inline 

Description Use this option to disable function inlining. Function inlining means that a simple 
function, whose definition is known at compile time, is integrated into the body of its 
caller to eliminate the overhead of the call. 

This optimization, which is performed at optimization level High, normally reduces 
execution time, but the resulting code might be difficult to debug.

The compiler heuristically decides which functions to inline. Different heuristics are 
used when optimizing for speed, size, or when balancing between size and speed. 
Normally, code size does not increase when optimizing for speed.

If you do not want to disable inlining for a whole module, use #pragma inline=never 
on an individual function instead.

Note: This option has no effect at optimization levels below High.

Project>Options>C/C++ Compiler>Optimizations>Enabled 
transformations>Function inlining

--no_path_in_file_macros

Syntax --no_path_in_file_macros

Description Use this option to exclude the path from the return value of the predefined preprocessor 
symbols __FILE__ and __BASE_FILE__.

See also Descriptions of predefined preprocessor symbols, page 302.

This option is not available in the IDE.
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--no_scheduling

Syntax --no_scheduling 

Description Use this option to disable the instruction scheduler. The compiler features an instruction 
scheduler to increase the performance of the generated code. To achieve that goal, the 
scheduler rearranges the instructions to minimize the number of pipeline stalls 
emanating from resource conflicts within the microprocessor. This optimization, which 
is performed at optimization level High, normally reduces execution time. However, the 
resulting code might be difficult to debug.

Note: This option has no effect at optimization levels below High.

Project>Options>C/C++ Compiler>Optimizations>Enabled 
transformations>Scheduling

--no_size_constraints

Syntax --no_size_constraints

Description Use this option to relax the normal restrictions for code size expansion when optimizing 
for high speed.

This option has no effect unless used with -Ohs.

See also Speed versus size, page 178.

Project>Options>C/C++ Compiler>Optimizations>Enable transformations>No 
size constraints

--no_system_include

Syntax --no_system_include

Description By default, the compiler automatically locates the system include files. Use this option 
to disable the automatic search for system include files. In this case, you might need to 
set up the search path by using the -I compiler option.

See also --dlib, page 211, --dlib_config, page 212, and --system_include_dir, page 228.

Project>Options>C/C++ Compiler>Preprocessor>Ignore standard include 
directories
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--no_tbaa

Syntax --no_tbaa

Description Use this option to disable type-based alias analysis. When this options is not used, the 
compiler is free to assume that objects are only accessed through the declared type or 
through unsigned char. 

See also Type-based alias analysis, page 180.

Project>Options>C/C++ Compiler>Optimizations>Enabled 
transformations>Type-based alias analysis

--no_typedefs_in_diagnostics

Syntax --no_typedefs_in_diagnostics 

Description Use this option to disable the use of typedef names in diagnostics. Normally, when a 
type is mentioned in a message from the compiler, most commonly in a diagnostic 
message of some kind, the typedef names that were used in the original declaration are 
used whenever they make the resulting text shorter.

Example typedef int (*MyPtr)(char const *);
MyPtr p = "foo";

will give an error message like this:

Error[Pe144]: a value of type "char *" cannot be used to 
initialize an entity of type "MyPtr"

If the --no_typedefs_in_diagnostics option is used, the error message will be like 
this:

Error[Pe144]: a value of type "char *" cannot be used to 
initialize an entity of type "int (*)(char const *)"

To set this option, use Project>Options>C/C++ Compiler>Extra Options.
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--no_unroll

Syntax --no_unroll 

Description Use this option to disable loop unrolling. The code body of a small loop, whose number 
of iterations can be determined at compile time, is duplicated to reduce the loop 
overhead. 

For small loops, the overhead required to perform the looping can be large compared 
with the work performed in the loop body.

The loop unrolling optimization duplicates the body several times, reducing the loop 
overhead. The unrolled body also opens up for other optimization opportunities.

This optimization, which is performed at optimization level High, normally reduces 
execution time, but increases code size. The resulting code might also be difficult to 
debug.

The compiler heuristically decides which loops to unroll. Different heuristics are used 
when optimizing for speed and size. 

Note: This option has no effect at optimization levels below High.

Project>Options>C/C++ Compiler>Optimizations>Enabled 
transformations>Loop unrolling

--no_warnings

Syntax --no_warnings 

Description By default, the compiler issues warning messages. Use this option to disable all warning 
messages.

This option is not available in the IDE.

--no_wrap_diagnostics

Syntax --no_wrap_diagnostics 

Description By default, long lines in diagnostic messages are broken into several lines to make the 
message easier to read. Use this option to disable line wrapping of diagnostic messages.

This option is not available in the IDE.
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-O

Syntax -O[n|l|m|h|hs|hz] 

Parameters

*The most important difference between None and Low is that at None, all non-static variables 
will live during their entire scope.

Description Use this option to set the optimization level to be used by the compiler when optimizing 
the code. If no optimization option is specified, the optimization level Low is used by 
default. If only -O is used without any parameter, the optimization level High balanced 
is used.

A low level of optimization makes it relatively easy to follow the program flow in the 
debugger, and, conversely, a high level of optimization makes it relatively hard.

See also Controlling compiler optimizations, page 176.

Project>Options>C/C++ Compiler>Optimizations

--only_stdout

Syntax --only_stdout 

Description Use this option to make the compiler use the standard output stream (stdout) also for 
messages that are normally directed to the error output stream (stderr).

This option is not available in the IDE.

n None* (Best debug support)

l (default) Low*

m Medium

h High, balanced

hs High, favoring speed

hz High, favoring size
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--output, -o

Syntax --output {filename|directory} 
-o {filename|directory}

Parameters For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 200.

Description By default, the object code output produced by the compiler is located in a file with the 
same name as the source file, but with the extension o. Use this option to explicitly 
specify a different output filename for the object code output.

This option is not available in the IDE.

--predef_macros

Syntax --predef_macros {filename|directory}

Parameters For information about specifying a filename, see Rules for specifying a filename or 
directory as parameters, page 200.

Description Use this option to list the predefined symbols. When using this option, make sure to also 
use the same options as for the rest of your project.

If a filename is specified, the compiler stores the output in that file. If a directory is 
specified, the compiler stores the output in that directory, in a file with the predef 
filename extension.

Note that this option requires that you specify a source file on the command line.

This option is not available in the IDE.

--preinclude 

Syntax --preinclude includefile

Parameters For information about specifying a filename, see Rules for specifying a filename or 
directory as parameters, page 200.
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Description Use this option to make the compiler include the specified include file before it starts to 
read the source file. This is useful if you want to change something in the source code 
for the entire application, for instance if you want to define a new symbol.

Project>Options>C/C++ Compiler>Preprocessor>Preinclude file

--preprocess

Syntax --preprocess[=[c][n][l]] {filename|directory}

Parameters

For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 200.

Description Use this option to generate preprocessed output to a named file.

Project>Options>C/C++ Compiler>Preprocessor>Preprocessor output to file

--public_equ

Syntax --public_equ symbol[=value]

Parameters

Description This option is equivalent to defining a label in assembler language using the EQU 
directive and exporting it using the PUBLIC directive. This option can be used more than 
once on the command line. 

This option is not available in the IDE.

c Preserve comments

n Preprocess only

l Generate #line directives

symbol The name of the assembler symbol to be defined

value An optional value of the defined assembler symbol
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--quad_align_labels

Syntax --quad_align_labels 

Description Use this option to align internal labels on 4-byte boundaries.

This option is not available in the IDE.

--relaxed_fp

Syntax --relaxed_fp

Description Use this option to allow the compiler to relax the language rules and perform more 
aggressive optimization of floating-point expressions. This option improves 
performance for floating-point expressions that fulfill these conditions:

● The expression consists of both single- and double-precision values

● The double-precision values can be converted to single precision without loss of 
accuracy

● The result of the expression is converted to single precision.

Note that performing the calculation in single precision instead of double precision 
might cause a loss of accuracy.

When the --relaxed_fp option is used, errno might not be set according to 
Standard C for some math functions. Thus, your source code should not rely on errno.

Example float f(float a, float b)
{
  return a + b * 3.0;
}

The C standard states that 3.0 in this example has the type double and therefore the 
whole expression should be evaluated in double precision. However, when the 
--relaxed_fp option is used, 3.0 will be converted to float and the whole expression 
can be evaluated in float precision.

Project>Options>C/C++ Compiler>Language>Relaxed floating-point precision
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--remarks

Syntax --remarks 

Description The least severe diagnostic messages are called remarks. A remark indicates a source 
code construct that may cause strange behavior in the generated code. By default, the 
compiler does not generate remarks. Use this option to make the compiler generate 
remarks. 

See also Severity levels, page 195.

Project>Options>C/C++ Compiler>Diagnostics>Enable remarks

--require_prototypes

Syntax --require_prototypes

Description Use this option to force the compiler to verify that all functions have proper prototypes. 
Using this option means that code containing any of the following will generate an error:

● A function call of a function with no declaration, or with a Kernighan & Ritchie 
C declaration

● A function definition of a public function with no previous prototype declaration

● An indirect function call through a function pointer with a type that does not include 
a prototype.

Note: This option only applies to functions in the C standard library.

Project>Options>C/C++ Compiler>Language>Require prototypes

--silent

Syntax --silent 

Description By default, the compiler issues introductory messages and a final statistics report. Use 
this option to make the compiler operate without sending these messages to the standard 
output stream (normally the screen). 

This option does not affect the display of error and warning messages.

This option is not available in the IDE.
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--strict

Syntax --strict 

Description By default, the compiler accepts a relaxed superset of Standard C and C++. Use this 
option to ensure that the source code of your application instead conforms to strict 
Standard C and C++.

Note: The -e option and the --strict option cannot be used at the same time.

See also Enabling language extensions, page 145.

Project>Options>C/C++ Compiler>Language>Language conformance>Strict

--system_include_dir

Syntax --system_include_dir path

Parameters

Description By default, the compiler automatically locates the system include files. Use this option 
to explicitly specify a different path to the system include files. This might be useful if 
you have not installed IAR Embedded Workbench in the default location.

See also --dlib, page 211, --dlib_config, page 212, and --no_system_include, page 220.

This option is not available in the IDE.

--use_unix_directory_separators

Syntax --use_unix_directory_separators

Description Use this option to make DWARF debug information use / (instead of \) as directory 
separators in file paths.

This option can be useful if you have a debugger that requires directory separators in 
UNIX style.

To set this option, use Project>Options>C/C++ Compiler>Extra Options.

path The path to the system include files. For information about 
specifying a path, see Rules for specifying a filename or directory as 
parameters, page 200.
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--vla

Syntax --vla

Description Use this option to allow variable length arrays. Note that this option requires Standard 
C and cannot be used together the --c89 compiler option.

See also C language overview, page 143.

Project>Options>C/C++ Compiler>Language>Allow VLA

--warnings_affect_exit_code

Syntax --warnings_affect_exit_code 

Description By default, the exit code is not affected by warnings, because only errors produce a 
non-zero exit code. With this option, warnings will also generate a non-zero exit code.

This option is not available in the IDE.

--warnings_are_errors

Syntax --warnings_are_errors 

Description Use this option to make the compiler treat all warnings as errors. If the compiler 
encounters an error, no object code is generated. Warnings that have been changed into 
remarks are not treated as errors.

Note: Any diagnostic messages that have been reclassified as warnings by the option 
--diag_warning or the #pragma diag_warning directive will also be treated as 
errors when --warnings_are_errors is used.

See also --diag_warning, page 210.

Project>Options>C/C++ Compiler>Diagnostics>Treat all warnings as errors
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This chapter gives detailed reference information about each linker option.

For general syntax rules, see Options syntax, page 199.

Summary of linker options
This table summarizes the linker options:

Command line option Description

--config Specifies the linker configuration file to be used by 
the linker

--config_def Defines symbols for the configuration file

--cpp_init_routine Specifies a user-defined C++ dynamic initialization 
routine

--debug_lib Uses the C-SPY debug library

--define_symbol Defines symbols that can be used by the application

--dependencies Lists file dependencies

--diag_error Treats these message tags as errors

--diag_remark Treats these message tags as remarks

--diag_suppress Suppresses these diagnostic messages

--diag_warning Treats these message tags as warnings

--diagnostics_tables Lists all diagnostic messages

--entry Treats the symbol as a root symbol and as the start 
of the application

--error_limit Specifies the allowed number of errors before 
linking stops

--export_builtin_config Produces an icf file for the default configuration

-f Extends the command line

--force_output Produces an output file even if errors occurred

--GBR Specifies the GBR address

--image_input Puts an image file in a section

--keep Forces a symbol to be included in the application

--log Enables log output for selected topics

Table 30: Linker options summary
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--log_file Directs the log to a file

--mangled_names_in_messages Adds mangled names in messages

--map Produces a map file

--misrac1998 Enables error messages specific to MISRA-C:1998. 
See the IAR Embedded Workbench® MISRA C:1998 
Reference Guide.

--misrac2004 Enables error messages specific to MISRA-C:2004. 
See the IAR Embedded Workbench® MISRA C:2004 
Reference Guide.

--misrac_verbose Enables verbose logging of MISRA C checking. See 
the IAR Embedded Workbench® MISRA C:1998 
Reference Guide and the IAR Embedded Workbench® 
MISRA C:2004 Reference Guide.

--no_fragments Disables section fragment handling

--no_library_search Disables automatic runtime library search

--no_locals Removes local symbols from the ELF executable 
image.

--no_range_reservations Disables range reservations for absolute symbols

--no_remove Disables removal of unused sections

--no_warnings Disables generation of warnings

--no_wrap_diagnostics Does not wrap long lines in diagnostic messages

-o Sets the object filename. Alias for --output.

--only_stdout Uses standard output only

--output Sets the object filename

--place_holder Reserve a place in ROM to be filled by some other 
tool, for example a checksum calculated by 
ielftool.

--redirect Redirects a reference to a symbol to another 
symbol

--remarks Enables remarks

--search Specifies more directories to search for object and 
library files

--silent Sets silent operation

--strip Removes debug information from the executable 
image

Command line option Description

Table 30: Linker options summary (Continued)
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Descriptions of options
The following section gives detailed reference information about each compiler and 
linker option.

Note that if you use the options page Extra Options to specify specific command line 
options, the IDE does not perform an instant check for consistency problems like 
conflicting options, duplication of options, or use of irrelevant options.

--config

Syntax --config filename

Parameters For information about specifying a filename, see Rules for specifying a filename or 
directory as parameters, page 200.

Description Use this option to specify the configuration file to be used by the linker (the default 
filename extension is icf). If no configuration file is specified, a default configuration 
is used. This option can only be used once on the command line.

See also The chapter The linker configuration file.

Project>Options>Linker>Config>Linker configuration file

--config_def

Syntax --config_def symbol[=constant_value]

Parameters

--warnings_affect_exit_code Warnings affect exit code

--warnings_are_errors Warnings are treated as errors

Command line option Description

Table 30: Linker options summary (Continued)

symbol The name of the symbol to be used in the configuration file. By 
default, the value 0 (zero) is used.

constant_value The constant value of the configuration symbol.
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Description Use this option to define a constant configuration symbol to be used in the configuration 
file. This option has the same effect as the define symbol directive in the linker 
configuration file. This option can be used more that once on the command line.

See also --define_symbol, page 235 and Interaction between ILINK and the application, page 89.

Project>Options>Linker>Config>Defined symbols for configuration file

--cpp_init_routine

Syntax --cpp_init_routine routine

Parameters

Description When using the IAR C/C++ compiler and the standard library, C++ dynamic 
initialization is handled automatically. In other cases you might need to use this option.

If any sections with the section type INIT_ARRAY or PREINIT_ARRAY are included in 
your application, the C++ dynamic initialization routine is considered to be needed. By 
default, this routine is named __iar_cstart_call_ctors and is called by the startup 
code in the standard library. Use this option if you are not using the standard library and 
require another routine to handle these section types.

To set this option, use Project>Options>Linker>Extra Options.

--debug_lib

Syntax --debug_lib

Description Use this option to include the C-SPY debug library.

See also Application debug support, page 99 for more information about the C-SPY debug 
library.

Project>Options>Linker>Library>Include C-SPY debugging support

routine A user-defined C++ dynamic initialization routine.
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--define_symbol

Syntax --define_symbol symbol=constant_value

Parameters

Description Use this option to define a constant symbol that can be used by your application. This 
option can be used more than once on the command line. Note that his option is different 
from the define symbol directive.

See also --config_def, page 233 and Interaction between ILINK and the application, page 89.

Project>Options>Linker>#define>Defined symbols

--dependencies

Syntax --dependencies[=[i|m]] {filename|directory} 

Parameters

For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 200.

Description Use this option to make the linker list the names of the linker configuration, object, and 
library files opened for input into a file with the default filename extension i.

Example If --dependencies or --dependencies=i is used, the name of each opened input 
file, including the full path, if available, is output on a separate line. For example:

   c:\myproject\foo.o
   d:\myproject\bar.o

If --dependencies=m is used, the output is in makefile style. For each input file, one 
line containing a makefile dependency rule is produced. Each line consists of the name 
of the output file, a colon, a space, and the name of an input file. For example:

   a.out: c:\myproject\foo.o

symbol The name of the constant symbol that can be used by the 
application.

constant_value The constant value of the symbol.

i (default) Lists only the names of files

m Lists in makefile style
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   a.out: d:\myproject\bar.o

This option is not available in the IDE.

--diag_error

Syntax --diag_error=tag[,tag,...] 

Parameters

Description Use this option to reclassify certain diagnostic messages as errors. An error indicates a 
problem of such severity that an executable image will not be generated. The exit code 
will be non-zero. This option may be used more than once on the command line.

Project>Options>Linker>Diagnostics>Treat these as errors

--diag_remark

Syntax --diag_remark=tag[,tag,...] 

Parameters

Description Use this option to reclassify certain diagnostic messages as remarks. A remark is the 
least severe type of diagnostic message and indicates a construction that may cause 
strange behavior in the executable image. This option may be used more than once on 
the command line.

Note: By default, remarks are not displayed; use the --remarks option to display 
them.

Project>Options>Linker>Diagnostics>Treat these as remarks

tag The number of a diagnostic message, for example the message 
number Pe117

tag The number of a diagnostic message, for example the message 
number Pe177
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--diag_suppress

Syntax --diag_suppress=tag[,tag,...] 

Parameters

Description Use this option to suppress certain diagnostic messages. These messages will not be 
displayed. This option may be used more than once on the command line.

Project>Options>Linker>Diagnostics>Suppress these diagnostics

--diag_warning

Syntax --diag_warning=tag[,tag,...] 

Parameters

Description Use this option to reclassify certain diagnostic messages as warnings. A warning 
indicates an error or omission that is of concern, but which will not cause the linker to 
stop before linking is completed. This option may be used more than once on the 
command line.

Project>Options>Linker>Diagnostics>Treat these as warnings

--diagnostics_tables

Syntax --diagnostics_tables {filename|directory} 

Parameters For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 200.

tag The number of a diagnostic message, for example the message 
number Pe117

tag The number of a diagnostic message, for example the message 
number Pe826
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Description Use this option to list all possible diagnostic messages in a named file.

This option cannot be given together with other options.

This option is not available in the IDE.

--entry

Syntax --entry symbol

Parameters

Description Use this option to make a symbol be treated as a root symbol and the start label of the 
application. This is useful for loaders. If this option is not used, the default start symbol 
is __iar_program_start. A root symbol is kept whether or not it is referenced from 
the rest of the application, provided its module is included. A module in an object file is 
always included and a module part of a library is only included if needed.

Project>Options>Linker>Library>Override default program entry

--error_limit

Syntax --error_limit=n 

Parameters

Description Use the --error_limit option to specify the number of errors allowed before the 
linker stops the linking. By default, 100 errors are allowed.

This option is not available in the IDE.

--export_builtin_config

Syntax --export_builtin_config filename

Parameters For information about specifying a filename, see Rules for specifying a filename or 
directory as parameters, page 200.

symbol The name of the symbol to be treated as a root symbol and start 
label

n The number of errors before the linker stops linking. n must be a 
positive integer; 0 indicates no limit.
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Description Exports the configuration used by default to a file.

This option is not available in the IDE.

-f

Syntax -f filename 

Parameters For information about specifying a filename, see Rules for specifying a filename or 
directory as parameters, page 200.

Descriptions Use this option to make the linker read command line options from the named file, with 
the default filename extension xcl.

In the command file, you format the items exactly as if they were on the command line 
itself, except that you may use multiple lines, because the newline character acts just as 
a space or tab character.

Both C and C++ style comments are allowed in the file. Double quotes behave in the 
same way as in the Microsoft Windows command line environment.

To set this option, use Project>Options>Linker>Extra Options.

--force_output

Syntax --force_output

Description Use this option to produce an output executable image regardless of any linking errors.

To set this option, use Project>Options>Linker>Extra Options

--GBR

Syntax --GBR address 

Parameters

Description Use this option to specify where the global base register (GBR) should point to.

This option is not available in the IDE.

address The memory address to which the GBR register should point
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--image_input

Syntax --image_input filename [symbol,[section[,alignment]]]

Parameters

Description Use this option to link pure binary files in addition to the ordinary input files. The file’s 
entire contents are placed in the section, which means it can only contain pure binary 
data.

The section where the contents of the filename file are placed, is only included if the 
symbol symbol is required by your application. Use the --keep option if you want to 
force a reference to the section.

Example --image_input bootstrap.abs,Bootstrap,CSTARTUPCODE,4

The contents of the pure binary file bootstrap.abs are placed in the section 
CSTARTUPCODE. The section where the contents are placed is 4-byte aligned and will 
only be included if your application (or the command line option --keep) includes a 
reference to the symbol Bootstrap.

See also --keep, page 240.

Project>Options>Linker>Input>Raw binary image

--keep

Syntax --keep symbol

Parameters

Description Normally, the linker keeps a symbol only if it is needed by your application. Use this 
option to make a symbol always be included in the final application.

Project>Options>Linker>Input>Keep symbols

filename The pure binary file containing the raw image you want to link

symbol The symbol which the binary data can be referenced with.

section The section where the binary data will be placed; default is .text.

alignment The alignment of the section; default is 1.

symbol The name of the symbol to be treated as a root symbol
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--log

Syntax --log topic,topic,...

Parameters

Description Use this option to make the linker log information to stdout. The log information can 
be useful for understanding why an executable image became the way it is.

See also --log_file, page 241.

Project>Options>Linker>List>Generate log file

--log_file

Syntax --log_file filename

Parameters For information about specifying a filename, see Rules for specifying a filename or 
directory as parameters, page 200.

Description Use this option to direct the log output to the specified file.

See also --log, page 241.

Project>Options>Linker>List>Generate log file

--mangled_names_in_messages

Syntax --mangled_names_in_messages

Descriptions Use this option to produce both mangled and unmangled names for C/C++ symbols in 
messages. Mangling is a technique used for mapping a complex C name or a C++ name 
(for example, for overloading) into a simple name. For example, void h(int, char) 
becomes _Z1hic.

This option is not available in the IDE.

initialization Log initialization decisions

modules Log module selections

sections Log section selections
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--map

Syntax --map {filename|directory}

Description Use this option to produce a linker memory map file. The map file has the default 
filename extension map. The map file contains:

● Linking summary in the map file header which lists the version of the linker, the 
current date and time, and the command line that was used.

● A summary of IAR-specific runtime attributes.

● Placement summary which lists each section/block in address order, sorted by 
placement directives.

● Initialization table layout which lists the data ranges, packing methods, and 
compression ratios.

● Module summary which lists contributions from each module to the image, sorted 
by directory and library.

● Entry list which lists all public and some local symbols in alphabetical order, 
indicating which module they came from.

● Some of the bytes might be reported as shared.

Shared objects are functions or data objects that are shared between modules. If any 
of these occur in more than one module, only one copy is retained. For example, in 
some cases inline functions are not inlined, which means that they are marked as 
shared, because only one instance of each function will be included in the final 
application. This mechanism is sometimes also used for compiler-generated code or 
data not directly associated with a particular function or variable, and when only one 
instance is required in the final application.

 This option can only be used once on the command line.

Project>Options>Linker>List>Generate linker map file

--no_fragments

Syntax --no_fragments 

Description Use this option to disable section fragment handling. Normally, the toolset uses IAR 
proprietary information for transferring section fragment information to the linker. The 
linker uses this information to remove unused code and data, and thus further minimize 
the size of the executable image. 
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See also Keeping symbols and sections, page 85.

To set this option, use Project>Options>Linker>Extra Options

--no_library_search

Syntax --no_library_search

Description Use this option to disable the automatic runtime library search. This option turns off the 
automatic inclusion of the correct standard libraries. This is useful, for example, if the 
application needs a user-built standard library, etc.

Project>Options>Linker>Library>Automatic runtime library selection

--no_locals

Syntax --no_locals

Description Use this option to remove local symbols from the ELF executable image.

Note: This option does not remove any local symbols from the DWARF information 
in the executable image.

Project>Options>Linker>Output

--no_range_reservations

Syntax --no_range_reservations

Description Normally, the linker reserves any ranges used by absolute symbols with a non-zero size, 
excluding them from consideration for place in commands.

When this option is used, these reservations are disabled, and the linker is free to place 
sections in such a way as to overlap the extent of absolute symbols.

To set this option, use Project>Options>Linker>Extra Options.
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--no_remove

Syntax --no_remove

Description When this option is used, unused sections are not removed. In other words, each module 
that is included in the executable image contains all its original sections.

See also Keeping symbols and sections, page 85.

To set this option, use Project>Options>Linker>Extra Options

--no_warnings

Syntax --no_warnings 

Description By default, the linker issues warning messages. Use this option to disable all warning 
messages.

This option is not available in the IDE.

--no_wrap_diagnostics

Syntax --no_wrap_diagnostics 

Description By default, long lines in diagnostic messages are broken into several lines to make the 
message easier to read. Use this option to disable line wrapping of diagnostic messages.

This option is not available in the IDE.

--only_stdout

Syntax --only_stdout 

Description Use this option to make the linker use the standard output stream (stdout) also for 
messages that are normally directed to the error output stream (stderr).

This option is not available in the IDE.
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--output, -o

Syntax --output {filename|directory} 
-o {filename|directory}

Parameters For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 200.

Description By default, the object executable image produced by the linker is located in a file with 
the name a.out. Use this option to explicitly specify a different output filename, which 
by default will have the filename extension out.

Project>Options>Linker>Output>Output file

 --place_holder

Syntax --place_holder symbol[,size[,section[,alignment]]]

Parameters

Description Use this option to reserve a place in ROM to be filled by some other tool, for example a 
checksum calculated by ielftool. Each use of this linker option results in a section 
with the specified name, size, and alignment. The symbol can be used by your 
application to refer to the section.

Note: Like any other section, sections created by the --place_holder option will 
only be included in your application if the section appears to be needed. The --keep 
linker option, or the keep linker directive can be used for forcing such section to be 
included.

See also IAR utilities, page 347.

To set this option, use Project>Options>Linker>Extra Options

symbol The name of the symbol to create

size Size in ROM; by default 4 bytes

section Section name to use; by default .text

alignment Alignment of section; by default 1
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--redirect

Syntax --redirect from_symbol=to_symbol 

Parameters

Description Use this option to change a reference from one symbol to another symbol.

To set this option, use Project>Options>Linker>Extra Options

--remarks

Syntax --remarks 

Description The least severe diagnostic messages are called remarks. A remark indicates a source 
code construct that may cause strange behavior in the generated code. By default, the 
linker does not generate remarks. Use this option to make the linker generate remarks. 

See also Severity levels, page 195.

Project>Options>Linker>Diagnostics>Enable remarks

--search

Syntax --search path 

Parameters

Description Use this option to specify more directories for the linker to search for object and library 
files in.

By default, the linker searches for object and library files only in the working directory. 
Each use of this option on the command line adds another search directory.

See also The linking process, page 72.

This option is not available in the IDE.

from_symbol The name of the source symbol

to_symbol The name of the destination symbol

path A path to a directory where the linker should search for object 
and library files.
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--silent

Syntax --silent 

Description By default, the linker issues introductory messages and a final statistics report. Use this 
option to make the linker operate without sending these messages to the standard output 
stream (normally the screen). 

This option does not affect the display of error and warning messages.

This option is not available in the IDE.

--strip

Syntax --strip

Description By default, the linker retains the debug information from the input object files in the 
output executable image. Use this option to remove that information.

To set related options, choose:

Project>Options>Linker>Output>Include debug information in output

--warnings_affect_exit_code

Syntax --warnings_affect_exit_code 

Description By default, the exit code is not affected by warnings, because only errors produce a 
non-zero exit code. With this option, warnings will also generate a non-zero exit code.

This option is not available in the IDE.

--warnings_are_errors

Syntax --warnings_are_errors 

Description Use this option to make the linker treat all warnings as errors. If the linker encounters 
an error, no executable image is generated. Warnings that have been changed into 
remarks are not treated as errors.
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Descriptions of options
Note: Any diagnostic messages that have been reclassified as warnings by the option 
--diag_warning directive will also be treated as errors when 
--warnings_are_errors is used.

See also --diag_warning, page 237 and --diag_warning, page 210.

Project>Options>Linker>Diagnostics>Treat all warnings as errors
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This chapter describes the data types, pointers, and structure types supported 
by the compiler.

See the chapter Efficient coding for embedded applications for information about 
which data types and pointers provide the most efficient code for your 
application.

Alignment
Every C data object has an alignment that controls how the object can be stored in 
memory. Should an object have an alignment of, for example, 4, it must be stored on an 
address that is divisible by 4.

The reason for the concept of alignment is that some processors have hardware 
limitations for how the memory can be accessed.

Assume that a processor can read 4 bytes of memory using one instruction, but only 
when the memory read is placed on an address divisible by 4. Then, 4-byte objects, such 
as long integers, will have alignment 4.

Another processor might only be able to read 2 bytes at a time; in that environment, the 
alignment for a 4-byte long integer might be 2.

A structure type will have the same alignment as the structure member with the most 
strict alignment. To decrease the alignment requirements on the structure and its 
members, use the #pragma pack directive.

All data types must have a size that is a multiple of their alignment. Otherwise, only the 
first element of an array would be guaranteed to be placed in accordance with the 
alignment requirements. This means that the compiler might add pad bytes at the end of 
the structure. For more information about pad bytes, see Packed structure types, page 
256.

Note that with the #pragma data_alignment directive you can increase the alignment 
demands on specific variables.

ALIGNMENT ON THE SH MICROPROCESSOR 

The SH microprocessor can access memory using 8- to 32-bit accesses. However, when 
an unaligned access is performed, an exception is generated. The compiler avoids this 
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by assigning an alignment to every data type, which means that the SH microprocessor 
can read the data efficiently.

Basic data types 

The compiler supports both all Standard C basic data types and some additional types.

INTEGER TYPES

This table gives the size, range, and alignment of each integer data type:

Signed variables are represented using the two’s complement form.

Bool

The bool data type is supported by default in the C++ language. If you have enabled 
language extensions, the bool type can also be used in C source code if you include the 
file stdbool.h. This will also enable the boolean values false and true.

The enum type 

The compiler will use the smallest type required to hold enum constants, preferring 
signed rather than unsigned.

When IAR Systems language extensions are enabled, and in C++, the enum constants 
and types can also be of the type long, unsigned long, long long, or unsigned 
long long. 

Data type Size Range Alignment

bool 8 bits 0 to 1 1

char 8 bits 0 to 255 1

signed char 8 bits -128 to 127 1

unsigned char 8 bits 0 to 255 1

signed short 16 bits -32768 to 32767 2

unsigned short 16 bits 0 to 65535 2

signed int 32 bits -231 to 231-1 4

unsigned int 32 bits 0 to 232-1 4

signed long 32 bits -231 to 231-1 4

unsigned long 32 bits 0 to 232-1 4

signed long long 64 bits -263 to 263-1 4

unsigned long long 64 bits 0 to 264-1 4

Table 31: Integer types 
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To make the compiler use a larger type than it would automatically use, define an enum 
constant with a large enough value. For example:

/* Disables usage of the char type for enum */
enum Cards{Spade1, Spade2,
           DontUseChar=257};

The char type 

The char type is by default unsigned in the compiler, but the --char_is_signed 
compiler option allows you to make it signed. Note, however, that the library is compiled 
with the char type as unsigned.

The wchar_t type 

The wchar_t data type is an integer type whose range of values can represent distinct 
codes for all members of the largest extended character set specified among the 
supported locals.

The wchar_t data type is supported by default in the C++ language. To use the 
wchar_t type also in C source code, you must include the file stddef.h from the 
runtime library.

Bitfields

In Standard C, int, signed int, and unsigned int can be used as the base type for 
integer bitfields. In standard C++, and in C when language extensions are enabled in the 
compiler, any integer or enumeration type can be used as the base type. It is 
implementation defined whether a plain integer type (char, short, int, etc) results in 
a signed or unsigned bitfield.

In the IAR C/C++ Compiler for SH, plain integer types are treated as signed.

Bitfields in expressions are treated as int if int can represent all values of the bitfield. 
Otherwise, they are treated as the bitfield base type.

Each bitfield is placed into a container of its base type from the least significant bit to 
the most significant bit. If the last container is of the same type and has enough bits 
available, the bitfield is placed into this container, otherwise a new container is 
allocated.

If you use the directive #pragma bitfield=reversed, bitfields are placed from the 
most significant bit to the least significant bit in each container. See bitfields, page 277.

Example

Assume this example:

struct bitfield_example
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{
  uint32_t a : 12;
  uint16_t b : 3;
  uint16_t c : 7;
  uint8_t  d;
};

To place the first bitfield, a, the compiler allocates a 32-bit container at offset 0 and puts 
a into the least significant 12 bits of the container.

To place the second bitfield, b, a new container is allocated at offset 4, because the type 
of the bitfield is not the same as that of the previous one. b is placed into the least 
significant three bits of this container.

The third bitfield, c, has the same type as b and fits into the same container.

The fourth member, d, is allocated into the byte at offset 6. d cannot be placed into the 
same container as b and c because it is not a bitfield, it is not of the same type, and it 
would not fit.

When using reverse order, each bitfield is instead placed starting from the most 
significant bit of its container.

This is the layout of bitfield_example:

Figure 14: Layout of bitfield_example
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FLOATING-POINT TYPES 

In the IAR C/C++ Compiler for SH, floating-point values are represented in standard 
IEEE 754 format. The sizes for the different floating-point types are:

Note: The size of double and long double depends on the --double={32|64} 
option, see --double, page 212. (By default, they are 32-bit.) The type long double uses 
the same precision as double.

The compiler does not support subnormal numbers. All operations that should produce 
subnormal numbers will instead generate zero.

Exception flags according to the IEEE 754 standard are not supported.

32-bit floating-point format

The representation of a 32-bit floating-point number as an integer is:

The exponent is 8 bits, and the mantissa is 23 bits.

The value of the number is:

(-1)S * 2(Exponent-127) * 1.Mantissa

The range of the number is:

±1.18E-38 to ±3.39E+38

The precision of the float operators (+, -, *, and /) is approximately 7 decimal digits.

Type Size if --double=32 Size if --double=64

float 32 bits 32 bits

double 32 bits 64 bits

long double 32 bits 64 bits

Table 32: Floating-point types 

   31  30                 23 22                               0
S Exponent Mantissa
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64-bit floating-point format

The representation of a 64-bit floating-point number as an integer is:

The exponent is 11 bits, and the mantissa is 52 bits.

The value of the number is:

(-1)S * 2(Exponent-1023) * 1.Mantissa

The range of the number is:

±2.23E-308 to ±1.79E+308

The precision of the float operators (+, -, *, and /) is approximately 15 decimal digits.

Representation of special floating-point numbers

This list describes the representation of special floating-point numbers:

● Zero is represented by zero mantissa and exponent. The sign bit signifies positive or 
negative zero.

● Infinity is represented by setting the exponent to the highest value and the mantissa 
to zero. The sign bit signifies positive or negative infinity.

● Not a number (NaN) is represented by setting the exponent to the highest positive 
value and the mantissa to a non-zero value. The value of the sign bit is ignored.

Pointer types
The compiler has two basic types of pointers: function pointers and data pointers.

FUNCTION POINTERS

The function pointer of the IAR C/C++ Compiler for SH is __code32. It is a 32-bit 
pointer that can address the entire memory. The internal representation of the function 
pointer is the actual address it refers to.

DATA POINTERS

The data pointer of the IAR C/C++ Compiler for SH is __data32. It is a 32-bit 
signed int pointer that can address the entire memory.

   63  62                 52 51                               0
S Exponent Mantissa
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CASTING

Casts between pointers have these characteristics:

● Casting a value of an integer type to a pointer of a smaller type is performed by 
truncation

● Casting a value of an integer type to a pointer of a larger type is performed by 
integral promotion first and then to a pointer

● Casting a pointer type to a smaller integer type is performed by truncation

● Casting a pointer type to a larger integer type is performed by zero extension

● Casting a data pointer to a function pointer and vice versa is illegal

● Casting a function pointer to an integer type gives an undefined result

size_t

size_t is the unsigned integer type required to hold the maximum size of an object. In 
the IAR C/C++ Compiler for SH, the size of size_t is 32 bits.

ptrdiff_t

ptrdiff_t is the type of the signed integer required to hold the difference between two 
pointers to elements of the same array. In the IAR C/C++ Compiler for SH, the size of 
ptrdiff_t is 32 bits.

intptr_t

intptr_t is a signed integer type large enough to contain a void *. In the IAR C/C++ 
Compiler for SH, the size of intptr_t is 32 bits.

uintptr_t

uintptr_t is equivalent to intptr_t, with the exception that it is unsigned.

Structure types 
The members of a struct are stored sequentially in the order in which they are 
declared: the first member has the lowest memory address.

ALIGNMENT

The struct and union types have the same alignment as the member with the highest 
alignment requirement. The size of a struct is also adjusted to allow arrays of aligned 
structure objects.
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GENERAL LAYOUT 

Members of a struct are always allocated in the order specified in the declaration. 
Each member is placed in the struct according to the specified alignment (offsets). 

Example

struct First
{
  char c;
  short s;
} s;

This diagram shows the layout in memory:

Figure 15: Structure layout

The alignment of the structure is 2 bytes, and a pad byte must be inserted to give 
short s the correct alignment.

PACKED STRUCTURE TYPES 

The #pragma pack directive is used for relaxing the alignment requirements of the 
members of a structure. This changes the layout of the structure. The members are 
placed in the same order as when declared, but there might be less pad space between 
members.

Note that accessing an object that is not correctly aligned requires code that is both 
larger and slower. If such structure members are accessed many times, it is usually better 
to construct the correct values in a struct that is not packed, and access this struct 
instead.

Special care is also needed when creating and using pointers to misaligned members. 
For direct access to misaligned members in a packed struct, the compiler will emit the 
correct (but slower and larger) code when needed. However, when a misaligned member 
is accessed through a pointer to the member, the normal (smaller and faster) code is 
used. In the general case, this will not work.
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Example

This example declares a packed structure:

#pragma pack(1)
struct S 
{
  char c;
  short s;
};

#pragma pack()

In this example, the structure S has this memory layout: 

Figure 16: Packed structure layout

This example declares a new non-packed structure, S2, that contains the structure s 
declared in the previous example:

struct S2
{
  struct S s;
  long l;
};

S2 has this memory layout

Figure 17: Packed structure layout

The structure S will use the memory layout, size, and alignment described in the 
previous example. The alignment of the member l is 4, which means that alignment of 
the structure S2 will become 4.

For more information, see Alignment of elements in a structure, page 170.
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Type qualifiers
According to the C standard, volatile and const are type qualifiers.

DECLARING OBJECTS VOLATILE 

There are three main reasons for declaring an object volatile:

● Shared access; the object is shared between several tasks in a multitasking 
environment

● Trigger access; as for a memory-mapped SFR where the fact that an access occurs 
has an effect

● Modified access; where the contents of the object can change in ways not known to 
the compiler.

Definition of access to volatile objects

The C standard defines an abstract machine, which governs the behavior of accesses to 
volatile declared objects. In general and in accordance to the abstract machine:

● The compiler considers each read and write access to an object declared volatile 
as an access

● The unit for the access is either the entire object or, for accesses to an element in a 
composite object—such as an array, struct, class, or union—the element. For 
example:

char volatile a;
a = 5;   /* A write access */
a += 6;  /* First a read then a write access */

● An access to a bitfield is treated as an access to the underlying type

● Adding a const qualifier to a volatile object will make write accesses to the 
object impossible, but the placement of the object will not change.

However, these rules are not detailed enough to handle the hardware-related 
requirements. The rules specific to the IAR C/C++ Compiler for SH are described 
below.

Rules for accesses

In the IAR C/C++ Compiler for SH, accesses to volatile declared objects are subject 
to these rules:

● All accesses are preserved

● All accesses are complete, that is, the whole object is accessed

● All accesses are performed in the same order as given in the abstract machine
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● Read and Write accesses are atomic up to 32-bit accesses, that is, they cannot be 
interrupted.

DECLARING OBJECTS VOLATILE AND CONST

If you declare a volatile object const, the volatile object will be write-protected, 
but nothing else will change. This can be used for protecting objects stored in flash 
memory.

To protect an object in flash memory from write accesses, define the variables like this:

const volatile int x @ "FLASH";

The compiler will generate the read-write section FLASH. That section should be placed 
in ROM and used for manually initializing the variables when the application starts up.

Thereafter, the initializers can be reflashed with other values at any time.

DECLARING OBJECTS CONST

The const type qualifier is used for indicating that a data object, accessed directly or 
via a pointer, is non-writable. A pointer to const declared data can point to both 
constant and non-constant objects. It is good programming practice to use const 
declared pointers whenever possible because this improves the compiler’s possibilities 
to optimize the generated code and reduces the risk of application failure due to 
erroneously modified data.

Static and global objects declared const are allocated in ROM.

In C++, objects that require runtime initialization cannot be placed in ROM.

Data types in C++
In C++, all plain C data types are represented in the same way as described earlier in this 
chapter. However, if any Embedded C++ features are used for a type, no assumptions 
can be made concerning the data representation. This means, for example, that it is not 
supported to write assembler code that accesses class members.
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Extended keywords
This chapter describes the extended keywords that support specific features 
of the SH microprocessor and the general syntax rules for the keywords. 
Finally the chapter gives a detailed description of each keyword.

For information about the address ranges of the different memory areas, see 
the chapter Section reference.

General syntax rules for extended keywords
To understand the syntax rules for the extended keywords, it is important to be familiar 
with some related concepts.

The compiler provides a set of attributes that can be used on functions or data objects to 
support specific features of the SH microprocessor. There are two types of 
attributes—type attributes and object attributes:

● Type attributes affect the external functionality of the data object or function

● Object attributes affect the internal functionality of the data object or function.

The syntax for the keywords differs slightly depending on whether it is a type attribute 
or an object attribute, and whether it is applied to a data object or a function.

For information about how to use attributes to modify data, see the chapter Data storage. 
For information about how to use attributes to modify functions, see the chapter 
Functions. For detailed information about each attribute, see Descriptions of extended 
keywords, page 265.

Note: The extended keywords are only available when language extensions are enabled 
in the compiler.

In the IDE, language extensions are enabled by default.

Use the -e compiler option to enable language extensions. See -e, page 213 for 
additional information.

TYPE ATTRIBUTES

Type attributes define how a function is called, or how a data object is accessed. This 
means that if you use a type attribute, it must be specified both when a function or data 
object is defined and when it is declared.
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General syntax rules for extended keywords
You can either place the type attributes directly in your source code, or use the pragma 
directive #pragma type_attribute.

Type attributes can be further divided into memory type attributes and general type 
attributes. Memory type attributes are referred to as simply memory attributes in the rest 
of the documentation.

Memory attributes

A memory attribute corresponds to a certain logical or physical memory in the 
microprocessor.

● Available function memory attributes: __code16, __code20, __code28, 
__code32, and __tbr

● Available data memory attributes: __data16, __data20, __data28, and 
__data32

Data objects, functions, and destinations of pointers or C++ references always have a 
memory attribute. If no attribute is explicitly specified in the declaration or by the 
pragma directive #pragma type_attribute, an appropriate default attribute is used. 
You can specify one memory attribute for each level of pointer indirection.

General type attributes

These general type attributes are available:

● Function type attributes affect how the function should be called: __interrupt, 
__monitor, __task, and __trap

● Data type attributes: const and volatile

You can specify as many type attributes as required for each level of pointer indirection.

To read more about the type qualifiers const and volatile, see Type qualifiers, page 
258.

Syntax for type attributes used on data objects

In general, type attributes for data objects follow the same syntax as the type qualifiers 
const and volatile.

The following declaration assigns the __data20 type attribute to the variables i and j; 
in other words, the variable i and j is placed in data20 memory. The variables k and l 
behave in the same way:

__data20 int i, j;
int __data20 k, l;

Note that the attribute affects both identifiers.
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This declaration of i and j is equivalent with the previous one:

#pragma type_attribute=__data20
int i, j;

The advantage of using pragma directives for specifying keywords is that it offers you a 
method to make sure that the source code is portable. Note that the pragma directive has 
no effect if a memory attribute is already explicitly declared.

For more examples of using memory attributes, see More examples, page 60.

An easier way of specifying storage is to use type definitions. These two declarations 
are equivalent:

typedef char __data20 Byte;
Byte b;

and

__data20 char b;

Note that #pragma type_attribute can be used together with a typedef 
declaration.

Syntax for type attributes on data pointers

The syntax for declaring pointers using type attributes follows the same syntax as the 
type qualifiers const and volatile:

Syntax for type attributes on functions

The syntax for using type attributes on functions differs slightly from the syntax of type 
attributes on data objects. For functions, the attribute must be placed either in front of 
the return type, or in parentheses, for example:

__interrupt void my_handler(void);

or

void (__interrupt my_handler)(void);

This declaration of my_handler is equivalent with the previous one:

#pragma type_attribute=__interrupt
void my_handler(void);

int * __data20 p; The pointer is located in data20 memory.

__data20 int * p; The pointer is located in data20 memory.
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OBJECT ATTRIBUTES 

Object attributes affect the internal functionality of functions and data objects, but not 
how the function is called or how the data is accessed. This means that an object attribute 
does not need to be present in the declaration of an object.

These object attributes are available:

● Object attributes that can be used for variables: __no_init

● Object attributes that can be used for functions and variables: location, @, 
__root, and __weak, 

● Object attributes that can be used for functions: __fast_interrupt, 
__intrinsic, and __noreturn, and vector.

You can specify as many object attributes as required for a specific function or data 
object.

For more information about location and @, see Controlling data and function 
placement in memory, page 173. For more information about vector, see vector, page 
292.

Syntax for object attributes

The object attribute must be placed in front of the type. For example, to place myarray 
in memory that is not initialized at startup:

__no_init int myarray[10]; 

The #pragma object_attribute directive can also be used. This declaration is 
equivalent to the previous one:

#pragma object_attribute=__no_init
int myarray[10];

Note: Object attributes cannot be used in combination with the typedef keyword.

Summary of extended keywords
This table summarizes the extended keywords:

Extended keyword Description

__code16 Controls the storage of functions

__code20 Controls the storage of functions

__code28 Controls the storage of functions

__code32 Controls the storage of functions

Table 33: Extended keywords summary
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Descriptions of extended keywords
These sections give detailed information about each extended keyword.

__code16

Syntax Follows the generic syntax rules for memory type attributes that can be used on 
functions, see Type attributes, page 261.

Description The __code16 memory attribute overrides the default storage of functions given by the 
selected code model and places individual functions in code16 memory.

Storage information ● Address ranges: 0x00000000-0x00007FFF and 0xFFFF8000-0xFFFFFFFF (2x32 
Kbytes)

● Maximum size: 32 Kbytes-1

● Pointer size: 4 bytes

__data16 Controls the storage of data objects

__data20 Controls the storage of data objects

__data28 Controls the storage of data objects

__data32 Controls the storage of data objects

__fast_interrupt Specifies a fast method of saving registers for interrupt 
functions

__interrupt Supports interrupt functions

__intrinsic Reserved for compiler internal use only

__monitor Supports atomic execution of a function

__no_init Supports non-volatile memory

__noreturn Informs the compiler that the function will not return

__root Ensures that a function or variable is included in the object 
code even if unused

__task Relaxes the rules for preserving registers

__tbr Places individual functions in the table that the TBR register 
points to

__trap Supports trap functions

__weak Declares a symbol to be externally weakly linked

Extended keyword Description

Table 33: Extended keywords summary (Continued)
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Example __code16 void myfunction(void);

See also Code models and memory attributes for function storage, page 63.

__code20

Syntax Follows the generic syntax rules for memory type attributes that can be used on 
functions, see Type attributes, page 261.

Description The __code20 memory attribute overrides the default storage of functions given by the 
selected code model and places individual functions in code20 memory.

Storage information ● Address range: 0x00000000-0x0007FFFF and 0xFFF80000-0xFFFFFFFF 
(2x512 Kbytes)

● Maximum size: 512 Kbytes-1

● Pointer size: 4 bytes

Example __code20 void myfunction(void);

See also Code models and memory attributes for function storage, page 63.

__code28

Syntax Follows the generic syntax rules for memory type attributes that can be used on 
functions, see Type attributes, page 261.

Description The __code28 memory attribute overrides the default storage of functions given by the 
selected code model and places individual functions in code28 memory.

Storage information ● Address range: 0x00000000-0x07FFFFFF and 0xF8000000-0xFFFFFFFF 
(2x128 Mbytes)

● Maximum size: 128 Mbytes-1

● Pointer size: 4 bytes

Example __code28 void myfunction(void);

See also Code models and memory attributes for function storage, page 63.
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__code32

Syntax Follows the generic syntax rules for memory type attributes that can be used on 
functions, see Type attributes, page 261.

Description The __code32 memory attribute overrides the default storage of functions given by the 
selected code model and places individual functions in code32 memory.

Storage information ● Address range: 0x00000000-0xFFFFFFFF (4 Gbytes)

● Maximum object size: 4 Gbytes

● Pointer size: 4 bytes

Example __code32 void myfunction(void);

See also Code models and memory attributes for function storage, page 63.

__data16

Syntax Follows the generic syntax rules for memory type attributes that can be used on data 
objects, see Type attributes, page 261.

Description The __data16 memory attribute overrides the default storage of variables given by the 
selected data model and places individual variables and constants in data16 memory.

Storage information ● Address ranges: 0x00000000-0x00007FFF and 0xFFFF8000-0xFFFFFFFF (2x32 
Kbytes)

● Maximum size: 32 Kbytes-1

● Pointer size: 4 bytes

Example __data16 int x;

See also Memory types, page 57.

__data20

Syntax Follows the generic syntax rules for memory type attributes that can be used on data 
objects, see Type attributes, page 261.

Description The __data20 memory attribute overrides the default storage of variables given by the 
selected data model and places individual variables and constants in data20 memory.
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Storage information ● Address range: 0x00000000-0x0007FFFF and 0xFFF80000-0xFFFFFFFF 
(2x512 Kbytes)

● Maximum size: 512 Kbytes-1

● Pointer size: 4 bytes

Example __data20 int x;

See also Memory types, page 57.

__data28

Syntax Follows the generic syntax rules for memory type attributes that can be used on data 
objects, see Type attributes, page 261.

Description The __data28 memory attribute overrides the default storage of variables given by the 
selected data model and places individual variables and constants in data28 memory.

Storage information ● Address range: 0x00000000-0x07FFFFFF and 0xF8000000-0xFFFFFFFF 
(2x128 Mbytes)

● Maximum size: 128 Mbytes-1

● Pointer size: 4 bytes

Example __data28 int x;

See also Memory types, page 57.

__data32

Syntax Follows the generic syntax rules for memory type attributes that can be used on data 
objects, see Type attributes, page 261.

Description The __data32 memory attribute overrides the default storage of variables given by the 
selected data model and places individual variables and constants in data32 memory.

Storage information ● Address range: 0x00000000-0xFFFFFFFF (4 Gbytes)

● Maximum object size: 4 Gbytes

● Pointer size: 4 bytes

Example __data32 int x;
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See also Memory types, page 57.

__fast_interrupt

Syntax Follows the generic syntax rules for object attributes, see Object attributes, page 264.

Description The __fast_interrupt keyword specifies the register bank mechanism to be used 
with interrupt functions when many common registers are saved.

Example __fast_interrupt __interrupt void my_interrupt_handler(void);

__interrupt

Syntax Follows the generic syntax rules for type attributes that can be used on functions, see 
Type attributes, page 261.

Description The __interrupt keyword specifies interrupt functions. To specify one or several 
interrupt vectors, use the #pragma vector directive. The range of the interrupt vectors 
depends on the device used. It is possible to define an interrupt function without a vector, 
but then the compiler will not generate an entry in the interrupt vector table.

An interrupt function must have a void return type and cannot have any parameters.

The header file iodevice.h, where device corresponds to the selected device, 
contains predefined names for the existing interrupt vectors.

Example #pragma vector=0x14
__interrupt void my_interrupt_handler(void);

See also Interrupt functions, page 65, vector, page 292, .intvec, page 346. 

__intrinsic

Description The __intrinsic keyword is reserved for compiler internal use only.

__monitor

Syntax Follows the generic syntax rules for type attributes that can be used on functions, see 
Type attributes, page 261.
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Description The __monitor keyword causes interrupts to be disabled during execution of the 
function. This allows atomic operations to be performed, such as operations on 
semaphores that control access to resources by multiple processes. A function declared 
with the __monitor keyword is equivalent to any other function in all other respects.

Example __monitor int get_lock(void);

See also Monitor functions, page 66. Read also about the intrinsic functions __disable_interrupt, 
page 295, __enable_interrupt, page 296, __get_interrupt_state, page 296, and 
__set_interrupt_state, page 297.

__no_init

Syntax Follows the generic syntax rules for object attributes, see Object attributes, page 264.

Description Use the  __no_init keyword to place a data object in non-volatile memory. This means 
that the initialization of the variable, for example at system startup, is suppressed. 

Example __no_init int myarray[10];

See also Do not initialize directive, page 326.

__noreturn

Syntax Follows the generic syntax rules for object attributes, see Object attributes, page 264.

Description The __noreturn keyword can be used on a function to inform the compiler that the 
function will not return. If you use this keyword on such functions, the compiler can 
optimize more efficiently. Examples of functions that do not return are abort and exit.

Example __noreturn void terminate(void);

__root

Syntax Follows the generic syntax rules for object attributes, see Object attributes, page 264.

Description A function or variable with the __root attribute is kept whether or not it is referenced 
from the rest of the application, provided its module is included. Program modules are 
always included and library modules are only included if needed.

Example __root int myarray[10];
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See also To read more about root symbols and how they are kept, see Keeping symbols and 
sections, page 85.

__task

Syntax Follows the generic syntax rules for type attributes that can be used on functions, see 
Type attributes, page 261.

Description This keyword allows functions to relax the rules for preserving registers. Typically, the 
keyword is used on the start function for a task in an RTOS. 

By default, functions save the contents of used preserved registers on the stack upon 
entry, and restore them at exit. Functions that are declared __task do not save all 
registers, and therefore require less stack space.

Because a function declared __task can corrupt registers that are needed by the calling 
function, you should only use __task on functions that do not return or call such a 
function from assembler code.

The function main can be declared __task, unless it is explicitly called from the 
application. In real-time applications with more than one task, the root function of each 
task can be declared __task.

Example __task void my_handler(void);

__tbr

Syntax Follows the generic syntax rules for memory type attributes that can be used on 
functions, see Type attributes, page 261.

Description Calls to TBR (jump table base register) functions can be performed by executing a JSR 
instruction. The __tbr memory attribute places individual function entries in the table 
that the TBR register points to.

Storage information Pointer size: 4 bytes

Example Declaring a TBR function:

__tbr void my_TBR_function(int my_int);

See also To read more about the ELF section where the jump table is placed, see .tbr_table, page 
346.
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__trap

Syntax Follows the generic syntax rules for type attributes that can be used on functions, see 
Type attributes, page 261.

Description A trap function is called and then executed by the TRAPA assembler instruction and 
returned by the RTE instruction. To specify one or several vectors, use the 
#pragma vector directive. See the chip manufacturer’s hardware documentation for 
information about the trap vector range. If a trap vector is not given, an error will be 
issued if the function is called. A trap function can take parameters and return a value 
and it has the same calling convention as other functions. You can call the trap functions 
from your C or C++ application.

Example #pragma vector=0x25
__trap int my_trap_function(void);

The range where the trap vector can be placed is 0x20–0x3F.

See also Calling convention, page 131 and Trap functions, page 66.

__weak

Syntax Follows the generic syntax rules for object attributes, see Object attributes, page 264.

Description Using the __weak object attribute on an external declaration of a symbol makes all 
references to that symbol in the module weak.

Using the __weak object attribute on a public definition of a symbol makes that 
definition a weak definition.

The linker will not include a module from a library solely to satisfy weak references to 
a symbol, nor will the lack of a definition for a weak reference result in an error. If no 
definition is included, the address of the object will be zero.

When linking, a symbol can have any number of weak definitions, and at most one 
non-weak definition. If the symbol is needed, and there is a non-weak definition, this 
definition will be used. If there is no non-weak definition, one of the weak definitions 
will be used.

Example extern __weak int foo; /* A weak reference */

__weak void bar(void); /* A weak definition */
{
  /* Increment foo if it was included */
  if (&foo != 0)
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    ++foo;
}
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This chapter describes the pragma directives of the compiler.

The #pragma directive is defined by Standard C and is a mechanism for using 
vendor-specific extensions in a controlled way to make sure that the source 
code is still portable. 

The pragma directives control the behavior of the compiler, for example how 
it allocates memory for variables and functions, whether it allows extended 
keywords, and whether it outputs warning messages.

The pragma directives are always enabled in the compiler.

Summary of pragma directives
This table lists the pragma directives of the compiler that can be used either with the 
#pragma preprocessor directive or the _Pragma() preprocessor operator:

Pragma directive Description

basic_template_matching Makes a template function fully memory-attribute aware

bitfields Controls the order of bitfield members

constseg Places constant variables in a named section

data_alignment Gives a variable a higher (more strict) alignment

dataseg Places variables in a named section

diag_default Changes the severity level of diagnostic messages

diag_error Changes the severity level of diagnostic messages

diag_remark Changes the severity level of diagnostic messages

diag_suppress Suppresses diagnostic messages

diag_warning Changes the severity level of diagnostic messages

error Signals an error while parsing

include_alias Specifies an alias for an include file

inline Controls inlining of a function

language Controls the IAR Systems language extensions

Table 34: Pragma directives summary
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Summary of pragma directives
Note: For portability reasons, see also Recognized pragma directives (6.10.6), page 
384.

location Specifies the absolute address of a variable, or places groups 
of functions or variables in named sections

message Prints a message 

monitor_level Sets the level of disabled interrupts for monitor functions.

object_attribute Changes the definition of a variable or a function

optimize Specifies the type and level of an optimization

pack Specifies the alignment of structures and union members

__printf_args Verifies that a function with a printf-style format string is 
called with the correct arguments

required Ensures that a symbol that is needed by another symbol is 
included in the linked output

rtmodel Adds a runtime model attribute to the module

__scanf_args Verifies that a function with a scanf-style format string is 
called with the correct arguments

section Declares a section name to be used by intrinsic functions

STDC CX_LIMITED_RANGE Specifies whether the compiler can use normal complex 
mathematical formulas or not

STDC FENV_ACCESS Specifies whether your source code accesses the 
floating-point environment or not.

STDC FP_CONTRACT Specifies whether the compiler is allowed to contract 
floating-point expressions or not.

type_attribute Changes the declaration and definitions of a variable or 
function

vector Specifies the vector of an interrupt function

weak Makes a definition a weak definition, or creates a weak alias 
for a function or a variable

Pragma directive Description

Table 34: Pragma directives summary (Continued)
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Descriptions of pragma directives
This section gives detailed information about each pragma directive.

basic_template_matching

Syntax #pragma basic_template_matching

Description Use this pragma directive in front of a template function declaration to make the 
function fully memory-attribute aware, in the rare cases where this is useful. That 
template function will then match the template without any modifications.

Example #pragma basic_template_matching
template<typename T> void fun(T *);

fun((int __data20 *) 0);   /* Template parameter T becomes
                           int __data20 */

bitfields

Syntax #pragma bitfields=disjoint_types|joined_types|
                  reversed_disjoint_types|reversed|default}

Parameters

Description Use this pragma directive to control the order of bitfield members. 

disjoint_types Bitfield members are placed from the least significant bit to 
the most significant bit in the container type. Storage 
containers of bitfields with different base types will not 
overlap.

joined_types Bitfield members are placed depending on the byte order. 
Storage containers of bitfields will overlap other structure 
members. For more information, see Bitfields, page 251.

reversed_disjoint_types Bitfield members are placed from the most significant bit to 
the least significant bit in the container type. Storage 
containers of bitfields with different base types will not 
overlap.

reversed This is an alias for reversed_disjoint_types.

default Restores to default layout of bitfield members. The default 
behavior for the compiler is joined_types.
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Example #pragma bitfields=disjoint_types
/* Structure that uses disjoint bitfield types. */
{
  unsigned char error :1;
  unsigned char size  :4;
  unsigned short code  :10;
}
#pragma bitfields=default /* Restores to default setting. */

See also Bitfields, page 251.

constseg

Syntax #pragma constseg=[__memoryattribute ]{SECTION_NAME|default}

Parameters

Description Use this pragma directive to place constant variables in a named section. The section 
name cannot be a section name predefined for use by the compiler and linker. The setting 
remains active until you turn it off again with the #pragma constseg=default 
directive.

Example #pragma constseg=__data28 MY_CONSTANTS
const int factorySettings[] = {42, 15, -128, 0};
#pragma constseg=default

data_alignment

Syntax #pragma data_alignment=expression

Parameters

Description Use this pragma directive to give a variable a higher (more strict) alignment of the start 
address than it would otherwise have. This directive can be used on variables with static 
and automatic storage duration.

__memoryattribute An optional memory attribute denoting in what memory the 
section will be placed; if not specified, default memory is used.

SECTION_NAME A user-defined section name; cannot be a section name predefined 
for use by the compiler and linker.

default Uses the default section for constants.

expression A constant which must be a power of two (1, 2, 4, etc.).
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When you use this directive on variables with automatic storage duration, there is an 
upper limit on the allowed alignment for each function, determined by the calling 
convention used.

Note: Normally, the size of a variable is a multiple of its alignment. The 
data_alignment directive only affects the alignment of the variable’s start address, 
and not its size, and can thus be used for creating situations where the size is not a 
multiple of the alignment.

dataseg

Syntax #pragma dataseg=[__memoryattribute ]{SECTION_NAME|default}

Parameters

Description Use this pragma directive to place variables in a named section. The section name cannot 
be a section name predefined for use by the compiler and linker. The variable will not 
be initialized at startup, and can for this reason not have an initializer, which means it 
must be declared __no_init. The setting remains active until you turn it off again with 
the #pragma constseg=default directive.

Example #pragma dataseg=__data28 MY_SECTION 
__no_init char myBuffer[1000];
#pragma dataseg=default

diag_default

Syntax #pragma diag_default=tag[,tag,...]

Parameters

Description Use this pragma directive to change the severity level back to the default, or to the 
severity level defined on the command line by any of the options --diag_error, 

__memoryattribute An optional memory attribute denoting in what memory the 
section will be placed; if not specified, default memory is used.

SECTION_NAME A user-defined section name; cannot be a section name predefined 
for use by the compiler and linker.

default Uses the default section.

tag The number of a diagnostic message, for example the message 
number Pe117.
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--diag_remark, --diag_suppress, or --diag_warnings, for the diagnostic 
messages specified with the tags.

See also Diagnostics, page 194.

diag_error

Syntax #pragma diag_error=tag[,tag,...]

Parameters

Description Use this pragma directive to change the severity level to error for the specified 
diagnostics.

See also Diagnostics, page 194.

diag_remark

Syntax #pragma diag_remark=tag[,tag,...]

Parameters

Description Use this pragma directive to change the severity level to remark for the specified 
diagnostic messages. 

See also Diagnostics, page 194.

diag_suppress

Syntax #pragma diag_suppress=tag[,tag,...]

Parameters

Description Use this pragma directive to suppress the specified diagnostic messages. 

tag The number of a diagnostic message, for example the message 
number Pe117.

tag The number of a diagnostic message, for example the message 
number Pe177.

tag The number of a diagnostic message, for example the message 
number Pe117.
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See also Diagnostics, page 194.

diag_warning

Syntax #pragma diag_warning=tag[,tag,...]

Parameters

Description Use this pragma directive to change the severity level to warning for the specified 
diagnostic messages. 

See also Diagnostics, page 194.

error

Syntax #pragma error message

Parameters

Description Use this pragma directive to cause an error message when it is parsed. This mechanism 
is different from the preprocessor directive #error, because the #pragma error 
directive can be included in a preprocessor macro using the _Pragma form of the 
directive and only causes an error if the macro is used.

Example #if FOO_AVAILABLE
#define FOO ...
#else
#define FOO _Pragma("error\"Foo is not available\"")
#endif

If FOO_AVAILABLE is zero, an error will be signaled if the FOO macro is used in actual 
source code.

tag The number of a diagnostic message, for example the message 
number Pe826.

message A string that represents the error message.
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include_alias

Syntax #pragma include_alias ("orig_header" , "subst_header")
#pragma include_alias (<orig_header> , <subst_header>)

Parameters

Description Use this pragma directive to provide an alias for a header file. This is useful for 
substituting one header file with another, and for specifying an absolute path to a relative 
file.

This pragma directive must appear before the corresponding #include directives and 
subst_header must match its corresponding #include directive exactly.

Example #pragma include_alias (<stdio.h> , <C:\MyHeaders\stdio.h>)
#include <stdio.h>

This example will substitute the relative file stdio.h with a counterpart located 
according to the specified path.

See also Include file search procedure, page 191.

inline

Syntax #pragma inline[=forced|never]

Parameters

Description Use #pragma inline to advise the compiler that the function whose declaration 
follows immediately after the directive should be inlined—that is, expanded into the 
body of the calling function. Whether the inlining actually occurs is subject to the 
compiler’s heuristics.

#pragma inline is similar to the C++ keyword inline. The difference is that the 
compiler uses C++ inline semantics for the #pragma inline directive, but uses the 
Standard C semantics for the inline keyword.

orig_header The name of a header file for which you want to create an alias.

subst_header The alias for the original header file.

No parameter Has the same effect as the inline keyword.

forced Disables the compiler’s heuristics and forces inlining.

never Disables the compiler’s heuristics and makes sure that the function 
will not be inlined.
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Specifying #pragma inline=never disables the compiler’s heuristics and makes sure 
that the function will not be inlined.

Specifying #pragma inline=forced disables the compiler’s heuristics and forces 
inlining. If the inlining fails for some reason, for example if it cannot be used with the 
function type in question (like printf), an error message is emitted.

Note: Because specifying #pragma inline=forced disables the compiler’s 
heuristics, including the inlining heuristics, the function declared immediately after the 
directive will not be inlined on optimization levels None or Low. No error or warning 
message will be emitted.

See also Function inlining, page 179.

language

Syntax #pragma language={extended|default|save|restore}

Parameters

Description Use this pragma directive to control the use of language extensions.

Example 1 At the top of a file that needs to be compiled with IAR Systems extensions enabled:

#pragma language=extended
/* The rest of the file. */

Example 2 Around a particular part of the source code that needs to be compiled with IAR Systems 
extensions enabled:

#pragma language=extended
/* Part of source code. */
#pragma language=default

extended Enables the IAR Systems language extensions from the first use of 
the pragma directive and onward.

default From the first use of the pragma directive and onward, restores the 
settings for the IAR Systems language extensions to whatever that 
was specified by compiler options.

save|restore Saves and restores, respectively, the IAR Systems language 
extensions setting around a piece of source code.
Each use of save must be followed by a matching restore in the 
same file without any intervening #include directive.
DSH-2

Part 2. Reference information 283



284

Descriptions of pragma directives
Example 3 Around a particular part of the source code—normally in a system header file—that 
needs to be compiled with IAR Systems extensions enabled, but where the state before 
the sequence cannot be assumed to be the same as that specified by the compiler options 
in use:

#pragma language=save
#pragma language=extended
/* Part of source code. */
#pragma language=restore

See also -e, page 213 and --strict, page 228.

location

Syntax #pragma location={address|NAME}

Parameters

Description Use this pragma directive to specify the location—the absolute address—of the global 
or static variable whose declaration follows the pragma directive. The variable must be 
declared __no_init. Alternatively, the directive can take a string specifying a section 
for placing either a variable or a function whose declaration follows the pragma 
directive.

Example #pragma location=0xFFFF2000
__no_init volatile char PORT1; /* PORT1 is located at address
                                  0xFFFF2000 */

#pragma location="foo" 
char PORT1; /* PORT1 is located in section foo */

/* A better way is to use a corresponding mechanism */
#define FLASH _Pragma("location=\"FLASH\"")
...
FLASH int i; /* i is placed in the FLASH section */

See also Controlling data and function placement in memory, page 173.

address The absolute address of the global or static variable for which you 
want an absolute location.

NAME A user-defined section name; cannot be a section name predefined 
for use by the compiler and linker.
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message

Syntax #pragma message(message)

Parameters

Description Use this pragma directive to make the compiler print a message to the standard output 
stream when the file is compiled. 

Example: #ifdef TESTING
#pragma message("Testing")
#endif

monitor_level

Syntax #pragma monitor_level=level

Parameters

Description Use this pragma directive to set the level of disabled interrupts for monitor functions.

Example: #pragma monitor_level=4
__monitor void myfunction();
{
  ...
}

object_attribute

Syntax #pragma object_attribute=object_attribute[,object_attribute,...]

Parameters For a list of object attributes that can be used with this pragma directive, see Object 
attributes, page 264.

Description Use this pragma directive to declare a variable or a function with an object attribute. This 
directive affects the definition of the identifier that follows immediately after the 
directive. The object is modified, not its type. Unlike the directive #pragma 

message The message that you want to direct to the standard output stream.

level The level of disabled interrupts, an integer from 0 to 15.
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type_attribute that specifies the storing and accessing of a variable or function, it is 
not necessary to specify an object attribute in declarations.

Example #pragma object_attribute=__no_init 
char bar; 

See also General syntax rules for extended keywords, page 261.

optimize

Syntax #pragma optimize=param[ param...]

Parameters

Description Use this pragma directive to decrease the optimization level, or to turn off some specific 
optimizations. This pragma directive only affects the function that follows immediately 
after the directive.

The parameters size, balanced, speed, and no_size_constraints only have 
effect on the high optimization level and only one of them can be used as it is not 
possible to optimize for speed and size at the same time. It is also not possible to use 
preprocessor macros embedded in this pragma directive. Any such macro will not be 
expanded by the preprocessor.

Note: If you use the #pragma optimize directive to specify an optimization level that 
is higher than the optimization level you specify using a compiler option, the pragma 
directive is ignored.

balanced|size|speed|no_size_

constraints

Optimizes balanced between speed and size, 
optimizes for size, optimizes for speed, or optimizes 
for speed, but relaxes the normal restrictions for 
code size expansion.

none|low|medium|high Specifies the level of optimization

no_code_motion Turns off code motion

no_cse Turns off common subexpression elimination

no_inline Turns off function inlining

no_tbaa Turns off type-based alias analysis

no_unroll Turns off loop unrolling
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Example #pragma optimize=speed
int small_and_used_often()
{
    ...
}

#pragma optimize=size no_inline
int big_and_seldom_used()
{
    ...
}

pack 

Syntax #pragma pack(n)
#pragma pack()
#pragma pack({push|pop}[,name] [,n])

Parameters

Description Use this pragma directive to specify the maximum alignment of struct and union 
members.

The #pragma pack directive affects declarations of structures following the pragma 
directive to the next #pragma pack or end of file.

Note: This can result in significantly larger and slower code when accessing members 
of the structure.

n Sets an optional structure alignment; one of: 1, 2, 4, 8, or 16

Empty list Restores the structure alignment to default

push Sets a temporary structure alignment

pop Restores the structure alignment from a temporarily pushed alignment

name An optional pushed or popped alignment label
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See also Structure types, page 255.

__printf_args

Syntax #pragma __printf_args

Description Use this pragma directive on a function with a printf-style format string. For any call to 
that function, the compiler verifies that the argument to each conversion specifier (for 
example %d) is syntactically correct.

Example #pragma __printf_args
int printf(char const *,...);

/* Function call */
printf("%d",x);  /* Compiler checks that x is an integer */

required

Syntax #pragma required=symbol

Parameters

Description Use this pragma directive to ensure that a symbol which is needed by a second symbol 
is included in the linked output. The directive must be placed immediately before the 
second symbol.

Use the directive if the requirement for a symbol is not otherwise visible in the 
application, for example if a variable is only referenced indirectly through the section it 
resides in.

Example const char copyright[] = "Copyright by me";

#pragma required=copyright
int main()
{
  /* Do something here. */
}

Even if the copyright string is not used by the application, it will still be included by the 
linker and available in the output.

symbol Any statically linked function or variable.
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rtmodel

Syntax #pragma rtmodel="key","value"

Parameters

Description Use this pragma directive to add a runtime model attribute to a module, which can be 
used by the linker to check consistency between modules.

This pragma directive is useful for enforcing consistency between modules. All modules 
that are linked together and define the same runtime attribute key must have the same 
value for the corresponding key, or the special value *. It can, however, be useful to state 
explicitly that the module can handle any runtime model.

A module can have several runtime model definitions.

Note: The predefined compiler runtime model attributes start with a double underscore. 
To avoid confusion, this style must not be used in the user-defined attributes. 

Example #pragma rtmodel="I2C","ENABLED"

The linker will generate an error if a module that contains this definition is linked with 
a module that does not have the corresponding runtime model attributes defined.

See also Checking module consistency, page 123.

__scanf_args

Syntax #pragma __scanf_args

Description Use this pragma directive on a function with a scanf-style format string. For any call to 
that function, the compiler verifies that the argument to each conversion specifier (for 
example %d) is syntactically correct.

Example #pragma __scanf_args
int printf(char const *,...);

/* Function call */
scanf("%d",x);  /* Compiler checks that x is an integer */

"key" A text string that specifies the runtime model attribute.

"value" A text string that specifies the value of the runtime model attribute. 
Using the special value * is equivalent to not defining the attribute at 
all.
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Descriptions of pragma directives
section

Syntax #pragma section="NAME" [__memoryattribute] [align]

alias

#pragma segment="NAME" [__memoryattribute] [align]

Parameters

Description Use this pragma directive to define a section name that can be used by the section 
operators __section_begin, __section_end, and __section_size. All section 
declarations for a specific section must have the same memory type attribute and 
alignment.

If an optional memory attribute is used, the return type of the section operators 
__section_begin and __section_end is:

void __memoryattribute *.

Example #pragma section="MYHUGE" __data32 4

See also Dedicated section operators, page 147. For more information about sections, see the 
chapter Linking your application.

STDC CX_LIMITED_RANGE

Syntax #pragma STDC CX_LIMITED_RANGE {ON|OFF|DEFAULT}

Parameters

Description Use this pragma directive to specify that the compiler can use the normal complex 
mathematics formulas for x (multiplication), / (division), and abs. 

NAME The name of the section or segment 

__memoryattribute An optional memory attribute identifying the memory the section 
will be placed in; if not specified, default memory is used.

align Specifies an alignment for the section. The value must be a constant 
integer expression to the power of two.

ON Normal complex mathematics formulas can be used.

OFF Normal complex mathematics formulas cannot be used.

DEFAULT Sets the default behavior, that is OFF.
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Note: This directive is required by Standard C. The directive is recognized but has no 
effect in the compiler.

STDC FENV_ACCESS

Syntax #pragma STDC FENV_ACCESS {ON|OFF|DEFAULT}

Parameters

Description Use this pragma directive to specify whether your source code accesses the 
floating-point environment or not. 

Note: This directive is required by Standard C.

STDC FP_CONTRACT

Syntax #pragma STDC FP_CONTRACT {ON|OFF|DEFAULT}

Parameters

Description Use this pragma directive to specify whether the compiler is allowed to contract 
floating-point expressions or not. This directive is required by Standard C.

Example #pragma STDC_FP_CONTRACT=ON

type_attribute

Syntax #pragma type_attribute=type_attribute[,type_attribute,...]

Parameters For a list of type attributes that can be used with this pragma directive, see Type 
attributes, page 261.

ON Source code accesses the floating-point environment. Note that this 
argument is not supported by the compiler.

OFF Source code does not access the floating-point environment.

DEFAULT Sets the default behavior, that is OFF.

ON The compiler is allowed to contract floating-point expressions.

OFF The compiler is not allowed to contract floating-point expressions. 
Note that this argument is not supported by the compiler.

DEFAULT Sets the default behavior, that is ON.
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Descriptions of pragma directives
Description Use this pragma directive to specify IAR-specific type attributes, which are not part of 
Standard C. Note however, that a given type attribute might not be applicable to all kind 
of objects.

This directive affects the declaration of the identifier, the next variable, or the next 
function that follows immediately after the pragma directive.

Example In this example, an int object with the memory attribute __data16 is defined:

#pragma type_attribute=__data16
int x;

This declaration, which uses extended keywords, is equivalent:

__data16 int x;

See also  See the chapter Extended keywords for more details.

vector

Syntax #pragma vector=vector1[, vector2, vector3, ...]

Parameters

Description Use this pragma directive to specify the vector(s) of an interrupt or trap function whose 
declaration follows the pragma directive. Note that several vectors can be defined for 
each function. 

Example #pragma vector=0x14
__interrupt void my_handler(void);

weak

Syntax #pragma weak symbol1={symbol2}

Parameters

Description This pragma directive can be used in one of two ways:

● To make the definition of a function or variable with external linkage a weak 
definition. The __weak attribute can also be used for this purpose.

vector The vector number(s) of an interrupt or trap function.

symbol1 A function or variable with external linkage.

symbol2 A defined function or variable.
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● To create a weak alias for another function or variable. You can make more than one 
alias for the same function or variable.

Example To make the definition of foo a weak definition, write:

#pragma weak foo

To make NMI_Handler a weak alias for Default_Handler, write:

#pragma weak NMI_Handler=Default_Handler

If NMI_Handler is not defined elsewhere in the program, all references to 
NMI_Handler will refer to Default_Handler.

See also __weak, page 272.
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Intrinsic functions
This chapter gives reference information about the intrinsic functions, a 
predefined set of functions available in the compiler.

The intrinsic functions provide direct access to low-level processor operations 
and can be very useful in, for example, time-critical routines. The intrinsic 
functions compile into inline code, either as a single instruction or as a short 
sequence of instructions.

Descriptions of intrinsic functions
This section gives reference information about each intrinsic function.

To use intrinsic functions in an application, include the header file intrinsics.h. 
There are two sets of functions for convenient access to low-level functions; one set of 
intrinsic functions developed by IAR Systems and one set of intrinsic functions for 
compatibility with the Renesas SH compiler.

Note that the IAR intrinsic function names start with double underscores, but the names 
of functions for compatibility with the Renesas SH compiler start with only one 
underscore.

IAR intrinsic functions
These functions have been developed by IAR Systems to provide convenient access to 
low-level functions:

__disable_interrupt

Syntax void __disable_interrupt(void);

Description Disables interrupts by setting the interrupt level to 15.
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IAR intrinsic functions
__enable_interrupt

Syntax void __enable_interrupt(void);

Description Enables interrupts by setting the interrupt level to 0.

__get_interrupt_state

Syntax __istate_t __get_interrupt_state(void);

Description Returns the global interrupt state. The return value can be used as an argument to the 
__set_interrupt_state intrinsic function, which will restore the interrupt state.

Example __istate_t s = __get_interrupt_state();
__disable_interrupt();

/* Do something here. */

__set_interrupt_state(s);

The advantage of using this sequence of code compared to using 
__disable_interrupt and __enable_interrupt is that the code in this example 
will not enable any interrupts disabled before the call of __get_interrupt_state.

__get_interrupt_table 

Syntax void *__get_interrupt_table(void); 

Description Returns the value of the TBR register. 

__no_operation

Syntax void __no_operation(void);

Description Inserts a NOP instruction.

__prefetch 

Syntax void __prefetch(void * address); 

Description Inserts a PREFETCH instruction.
DSH-2

IAR C/C++ Development Guide
Compiling and Linking for SH



Intrinsic functions
__set_interrupt_state

Syntax void __set_interrupt_state(__istate_t);

Descriptions Restores the interrupt state to a value previously returned by the 
__get_interrupt_state function.

For information about the __istate_t type, see __get_interrupt_state, page 296.

__set_interrupt_table 

Syntax void __set_interrupt_table(void *); 

Description Writes a specific value to the TBR register. 

__sleep 

Syntax void __sleep(void);

Description Inserts a SLEEP instruction.

Renesas intrinsic functions
This set of intrinsic functions is provided for compatibility with the Renesas SH 
compiler. For information about these functions, see the documentation from Renesas.

Function Syntax

_builtin_addc long _builtin_addc(long, long); 

_builtin_addv long _builtin_addv(long, long); 

_builtin_clipsb long _builtin_clipsb(long); 

_builtin_clipsw long _builtin_clipsw(long); 

_builtin_clipub unsigned long _builtin_clipub(unsigned 
long); 

_builtin_clipuw unsigned long _builtin_clipuw(unsigned 
long); 

_builtin_clrt void _builtin_clrt(void); 

_builtin_div0s int _builtin_div0s(long, long); 

_builtin_div0u void _builtin_div0u(void); 

Table 35: Intrinsic functions for compatibility with Renesas compiler
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Renesas intrinsic functions
_builtin_div1 unsigned long _builtin_div1(unsigned 
long, unsigned long); 

_builtin_dmuls_h long _builtin_dmuls_h(long, long); 

_builtin_dmuls_l unsigned long _builtin_dmuls_l(long, 
long); 

_builtin_dmulu_h unsigned long _builtin_dmulu_h(unsigned 
long, unsigned long); 

_builtin_dmulu_l unsigned long _builtin_dmulu_l(unsigned 
long, unsigned long); 

_builtin_end_cnvl unsigned long _builtin_end_cnvl(unsigned 
long); 

_builtin_gbr_and_byte void _builtin_gbr_and_byte(int, unsigned 
char); 

_builtin_gbr_or_byte void _builtin_gbr_or_byte(int, unsigned 
char); 

_builtin_gbr_read_long unsigned long 
_builtin_gbr_read_long(int); 

_builtin_gbr_read_byte unsigned char 
_builtin_gbr_read_byte(int); 

_builtin_gbr_read_word unsigned short 
_builtin_gbr_read_word(int); 

_builtin_gbr_tst_byte int _builtin_gbr_tst_byte(int, unsigned 
char); 

_builtin_gbr_write_long void _builtin_gbr_write_long(int, 
unsigned long); 

_builtin_gbr_write_byte void _builtin_gbr_write_byte(int, 
unsigned char); 

_builtin_gbr_write_word void _builtin_gbr_write_word(int, 
unsigned short); 

_builtin_gbr_xor_byte void _builtin_gbr_xor_byte(int, unsigned 
char); 

_builtin_get_cr int _builtin_get_cr(void); 

_builtin_get_gbr void *_builtin_get_gbr(void); 

_builtin_get_tbr void *_builtin_get_tbr(void); 

_builtin_get_vbr void *_builtin_get_vbr(void); 

Function Syntax

Table 35: Intrinsic functions for compatibility with Renesas compiler (Continued)
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_builtin_macl int _builtin_macl(int *, int *, unsigned 
int); 

_builtin_macll int _builtin_macll(int *, int *, 
unsigned int, unsigned int); 

_builtin_macw int _builtin_macw(short *, short *, 
unsigned int); 

_builtin_macwl int _builtin_macwl(short *, short *, 
unsigned int, unsigned int);

_builtin_movt int _builtin_movt(void); 

_builtin_negc long _builtin_negc(long); 

_builtin_nop void _builtin_nop(void); 

_builtin_ovf_addc int _builtin_ovf_addc(long, long); 

_builtin_prefetch void _builtin_prefetch(void *); 

_builtin_rotcl unsigned long _builtin_rotcl(unsigned 
long); 

_builtin_rotcr unsigned long _builtin_rotcr(unsigned 
long); 

_builtin_rotl unsigned long _builtin_rotl(unsigned 
long); 

_builtin_rotr unsigned long _builtin_rotr(unsigned 
long); 

_builtin_set_cr void _builtin_set_cr(int); 

_builtin_set_gbr void _builtin_set_gbr(void *); 

_builtin_sett void _builtin_sett(void); 

_builtin_set_tbr void _builtin_set_tbr(void *); 

_builtin_set_vbr void _builtin_set_vbr(void *); 

_builtin_shar long _builtin_shar(long); 

_builtin_shll unsigned long _builtin_shll(unsigned 
long); 

_builtin_shlr unsigned long _builtin_shlr(unsigned 
long); 

_builtin_sleep void _builtin_sleep(void); 

_builtin_subc long _builtin_subc(long, long); 

_builtin_subv long _builtin_subv(long, long); 

Function Syntax

Table 35: Intrinsic functions for compatibility with Renesas compiler (Continued)
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Renesas intrinsic functions
_builtin_swapb unsigned short _builtin_swapb(unsigned 
short); 

_builtin_swapw unsigned long _builtin_swapw(unsigned 
long); 

_builtin_tas int _builtin_tas(char *); 

_builtin_unf_subc int _builtin_unf_subc(long, long); 

_builtin_unf_subv int _builtin_unf_subv(long, long); 

_builtin_xtrct unsigned long _builtin_xtrct(unsigned 
long, unsigned long); 

Function Syntax

Table 35: Intrinsic functions for compatibility with Renesas compiler (Continued)
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The preprocessor
This chapter gives a brief overview of the preprocessor, including reference 
information about the different preprocessor directives, symbols, and other 
related information.

Overview of the preprocessor
The preprocessor of the IAR C/C++ Compiler for SH adheres to Standard C. The 
compiler also makes these preprocessor-related features available to you:

● Predefined preprocessor symbols

These symbols allow you to inspect the compile-time environment, for example the 
time and date of compilation. For details, see Descriptions of predefined 
preprocessor symbols, page 302.

● User-defined preprocessor symbols defined using a compiler option

In addition to defining your own preprocessor symbols using the #define directive, 
you can also use the option -D, see -D, page 206.

● Preprocessor extensions

There are several preprocessor extensions, for example many pragma directives; for 
more information, see the chapter Pragma directives in this guide. Read also about 
the corresponding _Pragma operator and the other extensions related to the 
preprocessor, see Descriptions of miscellaneous preprocessor extensions, page 304.

● Preprocessor output

Use the option --preprocess to direct preprocessor output to a named file, see 
--preprocess, page 225.

To specify a path for an include file, use forward slashes:

#include "mydirectory/myfile"

In source code, use forward slashes:

file = fopen("mydirectory/myfile","rt");

Note that backslashes can also be used. In this case, use one in include file paths and two 
in source code strings.
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Descriptions of predefined preprocessor symbols
Descriptions of predefined preprocessor symbols
This table describes the predefined preprocessor symbols:

Predefined symbol Identifies

__BASE_FILE__ A string that identifies the name of the base source file (that is, 
not the header file), being compiled. See also __FILE__, page 
303, and --no_path_in_file_macros, page 219.

__BUILD_NUMBER__ A unique integer that identifies the build number of the 
compiler currently in use.

__CODE_MODEL__ An integer that identifies the code model in use. The symbol 
reflects the --code_model option and is defined to 
__CODE_MODEL_SMALL__, 
__CODE_MODEL_MEDIUM__, 
__CODE_MODEL_LARGE__, or 
__CODE_MODEL_HUGE__. These symbolic names can be 
used when testing the __CODE_MODEL__ symbol.

__CORE__ An integer that identifies the chip core in use. The symbol 
reflects the --core option and is defined to __SH2A__ or 
__SH2AFPU__. These symbolic names can be used when 
testing the __CORE__ symbol.

__cplusplus An integer which is defined when the compiler runs in any of 
the C++ modes, otherwise it is undefined. When defined, its 
value is 199711L. This symbol can be used with #ifdef to 
detect whether the compiler accepts C++ code. It is 
particularly useful when creating header files that are to be 
shared by C and C++ code.*

__DATA_MODEL__ An integer that identifies the data model in use. The symbol 
reflects the --data_model option and is defined to 
__DATA_MODEL_SMALL__, 
__DATA_MODEL_MEDIUM__, 
__DATA_MODEL_LARGE__, or 
__DATA_MODEL_HUGE__. These symbolic names can be 
used when testing the __DATA_MODEL__ symbol.

__DATE__ A string that identifies the date of compilation, which is 
returned in the form "Mmm dd yyyy", for example "Mar 30 

2010". *

__DOUBLE__ An integer that identifies the size of the data type double. 
The symbol reflects the --double option and is defined to 
32 or 64.

Table 36: Predefined symbols 
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The preprocessor
__embedded_cplusplus An integer which is defined to 1 when the compiler runs in 
any of the C++ modes, otherwise the symbol is undefined. 
This symbol can be used with #ifdef to detect whether the 
compiler accepts C++ code. It is particularly useful when 
creating header files that are to be shared by C and C++ 
code.*

__FILE__ A string that identifies the name of the file being compiled, 
which can be both the base source file and any included 
header file. See also __BASE_FILE__, page 302, and 
--no_path_in_file_macros, page 219.*

__func__ A string that identifies the name of the function in which the 
symbol is used. This is useful for assertions and other trace 
utilities. The symbol requires that language extensions are 
enabled, see -e, page 213. See also __PRETTY_FUNCTION__, 
page 303.

__FUNCTION__ A string that identifies the name of the function in which the 
symbol is used. This is useful for assertions and other trace 
utilities. The symbol requires that language extensions are 
enabled, see -e, page 213. See also __PRETTY_FUNCTION__, 
page 303.

__IAR_SYSTEMS_ICC__ An integer that identifies the IAR compiler platform. The 
current value is 8. Note that the number could be higher in a 
future version of the product. This symbol can be tested with 
#ifdef to detect whether the code was compiled by a 
compiler from IAR Systems.

__ICCSH__ An integer that is set to 1 when the code is compiled with the 
IAR C/C++ Compiler for SH, and otherwise to 0.

__LINE__ An integer that identifies the current source line number of 
the file being compiled, which can be both the base source file 
and any included header file.*

__PRETTY_FUNCTION__ A string that identifies the function name, including parameter 
types and return type, of the function in which the symbol is 
used, for example "void func(char)". This symbol is 
useful for assertions and other trace utilities. The symbol 
requires that language extensions are enabled, see -e, page 
213. See also __func__, page 303.

Predefined symbol Identifies

Table 36: Predefined symbols  (Continued)
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Descriptions of miscellaneous preprocessor extensions
* This symbol is required by Standard C.

Descriptions of miscellaneous preprocessor extensions
This section gives reference information about the preprocessor extensions that are 
available in addition to the predefined symbols, pragma directives, and Standard C 
directives.

NDEBUG 

Description This preprocessor symbol determines whether any assert macros you have written in 
your application shall be included or not in the built application.

If this symbol is not defined, all assert macros are evaluated. If the symbol is defined, 
all assert macros are excluded from the compilation. In other words, if the symbol is:

● defined, the assert code will not be included

● not defined, the assert code will be included

This means that if you write any assert code and build your application, you should 
define this symbol to exclude the assert code from the final application.

__STDC__ An integer that is set to 1, which means the compiler adheres 
to Standard C. This symbol can be tested with #ifdef to 
detect whether the compiler in use adheres to Standard C.*

__STDC_VERSION__ An integer that identifies the version of the C standard in use. 
The symbol expands to 199901L,unless the --c89 compiler 
option is used in which case the symbol expands to 199409L. 
This symbol does not apply in EC++ mode.*

__SUBVERSION__ An integer that identifies the subversion number of the 
compiler version number, for example 3 in 1.2.3.4.

__TIME__ A string that identifies the time of compilation in the form 
"hh:mm:ss".*

__VER__ An integer that identifies the version number of the IAR 
compiler in use. The value of the number is calculated in this 
way: (100 * the major version number + the 
minor version number). For example, for compiler 
version 3.34, 3 is the major version number and 34 is the 
minor version number. Hence, the value of __VER__ is 334.

Predefined symbol Identifies

Table 36: Predefined symbols  (Continued)
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The preprocessor
Note that the assert macro is defined in the assert.h standard include file.

See also Assert, page 117.

In the IDE, the NDEBUG symbol is automatically defined if you build your application in 
the Release build configuration.

#warning message 

Syntax #warning message

where message can be any string.

Description Use this preprocessor directive to produce messages. Typically, this is useful for 
assertions and other trace utilities, similar to the way the Standard C #error directive 
is used. This directive is not recognized when the --strict compiler option is used.
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Library functions
This chapter gives an introduction to the C and C++ library functions. It also 
lists the header files used for accessing library definitions.

For detailed reference information about the library functions, see the online 
help system.

Library overview
The IAR DLIB Library is a complete library, compliant with Standard C and C++. It 
supports floating-point numbers in IEEE 754 format and it can be configured to include 
different levels of support for locale, file descriptors, multibyte characters, et cetera.

For detailed information about the library functions, see the online documentation 
supplied with the product. There is also keyword reference information for the DLIB 
library functions. To obtain reference information for a function, select the function 
name in the editor window and press F1.

For additional information about library functions, see the chapter 
Implementation-defined behavior in this guide.

HEADER FILES

Your application program gains access to library definitions through header files, which 
it incorporates using the #include directive. The definitions are divided into several 
different header files, each covering a particular functional area, letting you include just 
those that are required.

It is essential to include the appropriate header file before making any reference to its 
definitions. Failure to do so can cause the call to fail during execution, or generate error 
or warning messages at compile time or link time.

LIBRARY OBJECT FILES

Most of the library definitions can be used without modification, that is, directly from 
the library object files that are supplied with the product. For information about how to 
choose a runtime library, see Basic project configuration, page 51. The linker will 
include only those routines that are required—directly or indirectly—by your 
application.
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IAR DLIB Library
REENTRANCY

A function that can be simultaneously invoked in the main application and in any 
number of interrupts is reentrant. A library function that uses statically allocated data is 
therefore not reentrant. 

Most parts of the DLIB library are reentrant, but the following functions and parts are 
not reentrant because they need static data:

● Heap functions—malloc, free, realloc, calloc, and the C++ operators new 
and delete

● Time functions—asctime, localtime, gmtime, mktime

● Multibyte functions—mbrlen, mbrtowc, mbsrtowc, wcrtomb, wcsrtomb, 
wctomb

● The miscellaneous functions setlocale, rand, atexit, strerror, strtok

● Functions that use files or the heap in some way. This includes printf, sprintf, 
scanf, scanf, getchar, and putchar.

Some functions also share the same storage for errno. These functions are not 
reentrant, since an errno value resulting from one of these functions can be destroyed 
by a subsequent use of the function before it is read. Among these functions are:

exp, exp10, ldexp, log, log10, pow, sqrt, acos, asin, atan2, 
cosh, sinh, strtod, strtol, strtoul

Remedies for this are:

● Do not use non-reentrant functions in interrupt service routines

● Guard calls to a non-reentrant function by a mutex, or a secure region, etc.

IAR DLIB Library
The IAR DLIB Library provides most of the important C and C++ library definitions 
that apply to embedded systems. These are of the following types:

● Adherence to a free-standing implementation of Standard C. The library supports 
most of the hosted functionality, but you must implement some of its base 
functionality. For additional information, see the chapter Implementation-defined 
behavior in this guide.

● Standard C library definitions, for user programs.

● Embedded C++ library definitions, for user programs.

● CSTARTUP, the module containing the start-up code. It is described in the chapter 
The DLIB runtime environment in this guide.

● Runtime support libraries; for example low-level floating-point routines.
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● Intrinsic functions, allowing low-level use of SH features. See the chapter Intrinsic 
functions for more information.

In addition, the IAR DLIB Library includes some added C functionality, see Added C 
functionality, page 312.

C HEADER FILES

This section lists the header files specific to the DLIB library C definitions. Header files 
may additionally contain target-specific definitions; these are documented in the chapter 
Using C.

This table lists the C header files:

Header file Usage

assert.h Enforcing assertions when functions execute

complex.h Computing common complex mathematical functions

ctype.h Classifying characters

errno.h Testing error codes reported by library functions

fenv.h Floating-point exception flags

float.h Testing floating-point type properties

inttypes.h Defining formatters for all types defined in stdint.h

iso646.h Using Amendment 1—iso646.h standard header

limits.h Testing integer type properties

locale.h Adapting to different cultural conventions

math.h Computing common mathematical functions

setjmp.h Executing non-local goto statements

signal.h Controlling various exceptional conditions

stdarg.h Accessing a varying number of arguments

stdbool.h Adds support for the bool data type in C.

stddef.h Defining several useful types and macros

stdint.h Providing integer characteristics

stdio.h Performing input and output

stdlib.h Performing a variety of operations

string.h Manipulating several kinds of strings

tgmath.h Type-generic mathematical functions

time.h Converting between various time and date formats

uchar.h Unicode functionality (IAR extension to Standard C)

Table 37: Traditional Standard C header files—DLIB 
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IAR DLIB Library
C++ HEADER FILES

This section lists the C++ header files.

Embedded C++

This table lists the Embedded C++ header files:

Extended Embedded C++ standard template library

The following table lists the Extended EC++ standard template library (STL) header 
files:

wchar.h Support for wide characters

wctype.h Classifying wide characters

Header file Usage

complex Defining a class that supports complex arithmetic

exception Defining several functions that control exception handling

fstream Defining several I/O stream classes that manipulate external files

iomanip Declaring several I/O stream manipulators that take an argument

ios Defining the class that serves as the base for many I/O streams classes

iosfwd Declaring several I/O stream classes before they are necessarily defined

iostream Declaring the I/O stream objects that manipulate the standard streams

istream Defining the class that performs extractions

new Declaring several functions that allocate and free storage

ostream Defining the class that performs insertions

sstream Defining several I/O stream classes that manipulate string containers

stdexcept Defining several classes useful for reporting exceptions

streambuf Defining classes that buffer I/O stream operations

string Defining a class that implements a string container

strstream Defining several I/O stream classes that manipulate in-memory character 
sequences

Table 38: Embedded C++ header files 

Header file Description

algorithm Defines several common operations on sequences

Table 39: Standard template library header files 

Header file Usage

Table 37: Traditional Standard C header files—DLIB  (Continued)
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Using Standard C libraries in C++

The C++ library works in conjunction with some of the header files from the Standard 
C library, sometimes with small alterations. The header files come in two forms—new 
and traditional—for example, cassert and assert.h. 

This table shows the new header files:

deque A deque sequence container

functional Defines several function objects

hash_map A map associative container, based on a hash algorithm

hash_set A set associative container, based on a hash algorithm

iterator Defines common iterators, and operations on iterators

list A doubly-linked list sequence container

map A map associative container

memory Defines facilities for managing memory

numeric Performs generalized numeric operations on sequences

queue A queue sequence container

set A set associative container

slist A singly-linked list sequence container

stack A stack sequence container

utility Defines several utility components

vector A vector sequence container

Header file Usage

cassert Enforcing assertions when functions execute

ccomplex Computing common complex mathematical functions

cctype Classifying characters

cerrno Testing error codes reported by library functions

cfenv.h Floating-point exception flags

cfloat Testing floating-point type properties

cinttypes Defining formatters for all types defined in stdint.h

ciso646 Using Amendment 1—iso646.h standard header

climits Testing integer type properties

Table 40: New Standard C header files—DLIB 

Header file Description

Table 39: Standard template library header files  (Continued)
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IAR DLIB Library
LIBRARY FUNCTIONS AS INTRINSIC FUNCTIONS

Certain C library functions will under some circumstances be handled as intrinsic 
functions and will generate inline code instead of an ordinary function call, for example 
memcpy, memset, and strcat.

ADDED C FUNCTIONALITY

The IAR DLIB Library includes some added C functionality.

The following include files provide these features:

● fenv.h

● stdio.h

● stdlib.h

● string.h

fenv.h

In fenv.h, trap handling support for floating-point numbers is defined with the 
functions fegettrapenable and fegettrapdisable. No floating-point status flags 
are supported.

clocale Adapting to different cultural conventions

cmath Computing common mathematical functions

csetjmp Executing non-local goto statements

csignal Controlling various exceptional conditions

cstdarg Accessing a varying number of arguments

cstdbool Adds support for the bool data type in C.

cstddef Defining several useful types and macros

cstdint Providing integer characteristics

cstdio Performing input and output

cstdlib Performing a variety of operations

cstring Manipulating several kinds of strings

ctgmath.h Type-generic mathematical functions

ctime Converting between various time and date formats

cwchar Support for wide characters

cwctype Classifying wide characters

Header file Usage

Table 40: New Standard C header files—DLIB  (Continued)
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stdio.h

These functions provide additional I/O functionality:

string.h

These are the additional functions defined in string.h:

fdopen Opens a file based on a low-level file descriptor.

fileno Gets the low-level file descriptor from the file descriptor 
(FILE*).

__gets Corresponds to fgets on stdin.

getw Gets a wchar_t character from stdin.

putw Puts a wchar_t character to stdout.

__ungetchar Corresponds to ungetc on stdout.

__write_array Corresponds to fwrite on stdout.

strdup Duplicates a string on the heap.

strcasecmp Compares strings case-insensitive.

strncasecmp Compares strings case-insensitive and bounded.

strnlen Bounded string length.
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The linker configuration 
file
This chapter describes the purpose of the linker configuration file and 
describes its contents.

To read this chapter you must be familiar with the concept of sections, see 
Modules and sections, page 71.

Overview
To link and locate an application in memory according to your requirements, ILINK 
needs information about how to handle sections and how to place them into the available 
memory regions. In other words, ILINK needs a configuration, passed to it by means of 
the linker configuration file.

This file consists of a sequence of directives and typically, provides facilities for:

● Defining available addressable memories

giving the linker information about the maximum size of possible addresses and 
defining the available physical memory, as well as dealing with memories that can be 
addressed in different ways.

● Defining the regions of the available memories that are populated with ROM or 
RAM

giving the start and end address for each region.

● Section groups

dealing with how to group sections into blocks and overlays depending on the section 
requirements.

● Defining how to handle initialization of the application

giving information about which sections that are to be initialized, and how that 
initialization should be made.

● Memory allocation

defining where—in what memory region—each set of sections should be placed.

● Using symbols, expressions, and numbers

expressing addresses and sizes, etc, in the other configuration directives. The 
symbols can also be used in the application itself.
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● Structural configuration

meaning that you can include or exclude directives depending on a condition, and to 
split the configuration file into several different files.

Comments can be written either as C comments (/*...*/) or as C++ comments 
(//...).

Defining memories and regions
ILINK needs information about the available memory spaces, or more specifically it 
needs information about:

● The maximum size of possible addressable memories

The define memory directive defines a memory space with a given size, which is 
the maximum possible amount of addressable memory, not necessarily physically 
available. See Define memory directive, page 316.

● Available physical memory

The define region directive defines a region in the available memories in which 
specific sections of application code and sections of application data can be placed. 
See Define region directive, page 317.

A region consists of one or several memory ranges. A range is a continuous sequence 
of bytes in a memory and several ranges can be expressed by using region 
expressions. See Region expression, page 319.

● Whether a physical memory appears in more than one memory space, or in more 
than one location in a memory space

Define memory directive

Syntax define memory [ name ] with size = size_expr [ ,unit-size ];

where unit-size is one of:

unitbitsize = bitsize_expr
unitbytesize = bytesize_expr

and where expr is an expression, see Expressions, page 333.

Parameters
size_expr Specifies how many units the memory space contains; always 

counted from address zero.

bitsize_expr Specifies how many bits each unit contains.
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Description The define memory directive defines a memory space with a given size, which is the 
maximum possible amount of addressable memory, not necessarily physically available. 
This sets the limits for the possible addresses to be used in the linker configuration file. 
For many microcontrollers, one memory space is sufficient. However, some 
microcontrollers require two or more. For example, a Harvard architecture usually 
requires two different memory spaces, one for code and one for data. If only one 
memory is defined, the memory name is optional. If no unit-size is given, the unit 
contains 8 bits.

Example /* Declare the memory space Mem of four Gigabytes */
define memory Mem with size = 4G;

Define region directive

Syntax define region name = region-expr;

where region-expr is a region expression, see also Regions, page 317.

Parameters

Description The define region directive defines a region in which specific sections of code and 
sections of data can be placed. A region consists of one or several memory ranges, where 
each memory range consists of a continuous sequence of bytes in a specific memory. 
Several ranges can be combined by using region expressions. Note that those ranges do 
not need to be consecutive or even in the same memory.

Example /* Define the 0x10000-byte code region ROM located at address
   0x10000 in memory Mem */
define region ROM = Mem:[from 0x10000 size 0x10000];

Regions
A region is s a set of non-overlapping memory ranges. A region expression is built up 
out of region literals and set operations (union, intersection, and difference) on regions.

bytesize_expr Specifies how many bytes each unit contains. Each byte 
contains 8 bits.

name The name of the region.
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Region literal

Syntax [ memory-name: ][from expr { to expr | size expr }

  [ repeat expr [ displacement expr ]]]

where expr is an expression, see Expressions, page 333.

Parameters

Description A region literal consists of one memory range. When you define a range, the memory it 
resides in, a start address, and a size must be specified. The range size can be stated 
explicitly by specifying a size, or implicitly by specifying the final address of the range. 
The final address is included in the range and a zero-sized range will only contain an 
address. A range can span over the address zero and the range can even be expressed by 
unsigned values, because it is known where the memory wraps.

The repeat parameter will create a region literal that contains several ranges, one for 
each repeat. This is useful for banked or far regions.

Example /* The 5-byte size range spans over the address zero */
Mem:[from -2 to 2]

/* The 512-byte size range spans over zero, in a 64-Kbyte memory 
*/
Mem:[from 0xFF00 to 0xFF]

/* Defining several ranges in the same memory, a repeating
   literal */
Mem:[from 0 size 0x100 repeat 3 displacement 0x1000]

memory-name The name of the memory space in which the region literal will be 
located. If there is only one memory, the name is optional.

from The start address of the memory range (inclusive).

to The end address of the memory range (inclusive).

size The size of the memory range.

repeat Defines several ranges in the same memory for the region literal.

displacement Displacement from the previous range start in the repeat sequence. 
Default displacement is the same value as the range size.
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/* Resulting in a region containing:
   Mem:[from 0 size 0x100]
   Mem:[from 0x1000 size 0x100]
   Mem:[from 0x2000 size 0x100]
*/

See also Define region directive, page 317, and Region expression, page 319.

Region expression

Syntax region-operand 
 | region-expr | region-operand 
 | region-expr - region-operand 
 | region-expr & region-operand 

where region-operand is one of:

( region-expr )
region-name
region-literal
empty-region

where region-name is a region, see Define region directive, page 317

where region-literal is a region literal, see Region literal, page 318

and where empty-region is an empty region, see Empty region, page 320.

Description Normally, a region consists of one memory range, which means a region literal is 
sufficient to express it. When a region contains several ranges, possibly in different 
memories, it is instead necessary to use a region expression to express it. Region 
expressions are actually set expressions on sets of memory ranges.

To create region expressions, three operators are available: union (|), intersection (&), 
and difference (-). These operators work as in set theory. For example, if you have the 
sets A and B, then the result of the operators would be:

● A | B: all elements in either set A or set B

● A & B: all elements in both set A and B

● A - B: all elements in set A but not in B.

Example /* Resulting in a range starting at 1000 and ending at 2FFF, in
   memory Mem */
Mem:[from 0x1000 to 0x1FFF] | Mem:[from 0x1500 to 0x2FFF]
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/* Resulting in a range starting at 1500 and ending at 1FFF, in
   memory Mem */
Mem:[from 0x1000 to 0x1FFF] & Mem:[from 0x1500 to 0x2FFF]

/* Resulting in a range starting at 1000 and ending at 14FF, in
   memory Mem */
Mem:[from 0x1000 to 0x1FFF] - Mem:[from 0x1500 to 0x2FFF]

/* Resulting in two ranges. The first starting at 1000 and ending
   at 1FFF, the second starting at 2501 and ending at 2FFF.
   Both located in memory Mem */
Mem:[from 0x1000 to 0x2FFF] - Mem:[from 0x2000 to 0x24FF]

Empty region

Syntax [ ]

Description The empty region does not contain any memory ranges. If the empty region is used in a 
placement directive that actually is used for placing one or more sections, ILINK will 
issue an error. 

Example define region Code = Mem:[from 0 size 0x10000];
if (Banked) {
  define region Bank = Mem:[from 0x8000 size 0x1000];
} else {
  define region Bank = [];
}
define region NonBanked = Code - Bank;

/* Depending on the Banked symbol, the NonBanked region is either
   one range with 0x10000 bytes, or two ranges with 0x8000 and
   0x7000 bytes, respectively. */

See also Region expression, page 319.

Section handling
Section handling describes how ILINK should handle the sections of the execution 
image, which means:

● Placing sections in regions

The place at and place into directives place sets of sections with similar 
attributes into previously defined regions. See Place at directive, page 327 and Place 
in directive, page 328.
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● Making sets of sections with special requirements

The block directive makes it possible to create empty sections with specific sizes 
and alignments, sequentially sorted sections of different types, etc. 

The overlay directive makes it possible to create an area of memory that can 
contain several overlay images. See Define block directive, page 321, and Define 
overlay directive, page 322.

● Initializing the application

The directives initialize and do not initialize control how the application 
should be started. With these directives, the application can initialize global symbols 
at startup, and copy pieces of code. The initializers can be stored in several ways, for 
example they can be compressed. See Initialize directive, page 323 and Do not 
initialize directive, page 326.

● Keeping removed sections

The keep directive retains sections even though they are not referred to by the rest 
of the application, which means it is equivalent to the root concept in the assembler 
and compiler. See Keep directive, page 326.

Define block directive

Syntax define block name 
  [ with param, param... ]
{
  extended-selectors
}
[except
 {
   section_selectors
  }];

where param can be one of:

size = expr
maximum size = expr
alignment = expr
fixed order

and where the rest of the directive selects sections to include in the block, see Section 
selection, page 328.

Parameters
name The name of the defined block.

size Customizes the size of the block. By default, the size of a block is 
the sum of its parts dependent of its contents.
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Description The block directive defines a named set of sections. By defining a block you can create 
empty blocks of bytes that can be used, for example as stacks or heaps. Another use for 
the directive is to group certain types of sections, consecutive or non-consecutive. A 
third example of use for the directive is to group sections into one memory area to access 
the start and end of that area from the application.

Example /* Create a 0x1000-byte block for the heap */
define block HEAP with size = 0x1000, alignment = 4 { };

See also Interaction between the tools and your application, page 163. See Define overlay 
directive, page 322 for an accessing example.

Define overlay directive

Syntax define overlay name [ with param, param... ]
{
  extended-selectors;
}
[except
 {
   section_selectors
  }];

For information about extended selectors and except clauses, see Section selection, page 
328.

Parameters

maximum size Specifies an upper limit for the size of the block. An error is 
generated if the sections in the block do not fit.

alignment Specifies a minimum alignment for the block. If any section in the 
block has a higher alignment than the minimum alignment, the block 
will have that alignment.

fixed order Places sections in fixed order; if not specified, the order of the 
sections will be arbitrary.

name The name of the overlay.

size Customizes the size of the overlay. By default, the size of a overlay is 
the sum of its parts dependent of its contents.

maximum size Specifies an upper limit for the size of the overlay. An error is 
generated if the sections in the overlay do not fit.
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Description The overlay directive defines a named set of sections. In contrast to the block 
directive, the overlay directive can define the same name several times. Each definition 
will then be grouped in memory at the same place as all other definitions of the same 
name. This creates an overlaid memory area, which can be useful for an application that 
has several independent sub-applications.

Place each sub-application image in ROM and reserve a RAM overlay area that can hold 
all sub-applications. To execute a sub-application, first copy it from ROM to the RAM 
overlay. Note that ILINK does not help you with managing interdependent overlay 
definitions, apart from generating a diagnostic message for any reference from one 
overlay to another overlay.

The size of an overlay will be the same size as the largest definition of that overlay name 
and the alignment requirements will be the same as for the definition with the highest 
alignment requirements.

Note: Sections that were overlaid must be split into a RAM and a ROM part and you 
must take care of all the copying needed.

See also Manual initialization, page 87. 

Initialize directive

Syntax initialize { by copy | manually }
  [ with param, param... ]
{
  section-selectors
}
[except
 {
   section_selectors
  }];

where param is one of:

packing = { none | zeros | packbits | bwt | lzw | auto |
            smallest }

alignment Specifies a minimum alignment for the overlay. If any section in the 
overlay has a higher alignment than the minimum alignment, the 
overlay will have that alignment.

fixed order Places sections in fixed order; if not specified, the order of the 
sections will be arbitrary.
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and where the rest of the directive selects sections to include in the block. See Section 
selection, page 328.

Parameters

Description The initialize directive splits the initialization section into one section holding the 
initializers and another section holding the initialized data. You can choose whether the 

by copy Splits the section into sections for initializers and initialized data, 
and handles the initialization at application startup automatically.

manually Splits the section into sections for initializers and initialized data. 
The initialization at application startup is not handled automatically.

packing Specifies how to handle the initializers. Choose between:

none Disables compression of the selected 
section contents. This is the default method 
for initialize manually.

zeros Compresses sequential bytes with the value 
zero.

packbits Compresses with the PackBits algorithm. 
This method generates good results for data 
with many consecutive bytes of the same 
value.

bwt Compresses with the Burrows-Wheeler 
algorithm. This method improves the 
packbits method by transforming blocks 
of data before they are compressed.

lzw Compresses with the Lempel-Ziv-Welch 
algorithm. This method uses a dictionary to 
store byte patterns in the data.

auto Similar to smallest, but ILINK chooses 
between none and packbits. This is the 
default method for initialize by 
copy.

smallest ILINK estimates the resulting size using each 
packing method (except for auto), and 
then chooses the packing method that 
produces the smallest estimated size. Note 
that the size of the decompressor is also 
included.
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initialization at startup should be handled automatically (initialize by copy) or 
whether you should handle it yourself (initialize manually).

When you use the packing method auto (default for initialize by copy) or 
smallest, ILINK will automatically choose an appropriate packing algorithm for the 
initializers and automatically revert it at the initialization process when the application 
starts. To override this, specify a different packing method. Use the copy routine 
parameter to override the method for copying the initializers. The --log 
initialization option shows how ILINK decided which packing algorithm to use.

When initializers are compressed, a decompressor is automatically added to the image. 
The decompressors for bwt and lzw use significantly more execution time and RAM 
than zeros and packbits. Approximately 9 Kbytes of stack space is needed for bwt 
and 3.5 Kbytes for lzw.

When initializers are compressed, the exact size of the compressed initializers is 
unknown until the exact content of the uncompressed data is known. If this data contains 
other addresses, and some of these addresses are dependent on the size of the 
compressed initializers, the linker fails with error Lp017. To avoid this, place 
compressed initializers last, or in a memory region together with sections whose 
addresses do not need to be known. 

Optionally, ILINK will also produce a table that an initialization function in the system 
startup code uses for copying the section contents from the initializer sections to the 
corresponding original sections. Normally, the section content is initialized variables.

Zero-initialized sections are not affected by the initialize directive.

Sections that must execute before the initialization finishes are not affected by the 
initialize by copy directive. This includes the __low_level_init function and 
anything it references.

Anything reachable from the program entry label is considered needed for initialization 
unless reached via a section fragment with a label starting with __iar_init$$done. 
The --log sections option can be used for creating a log of this process (in addition 
to the more general process of marking section fragments to be included in the 
application).

The initialize directive can be used for copying other things as well, for example 
copying executable code from slow ROM to fast RAM. For another example, see Define 
overlay directive, page 322.

Example /* Copy all read-write sections automatically from ROM to RAM at
   program start */
initialize by copy { rw };
place in RAM { rw };
place in ROM { ro };
DSH-2

Part 2. Reference information 325



326

Section handling
See also Initialization at system startup, page 77, and Do not initialize directive, page 326.

Do not initialize directive

Syntax do not initialize 
{
  section-selectors
}
[except
 {
   section-selectors
 }];

For information about extended selectors and except clauses, see Section selection, page 
328.

Description The do not initialize directive specifies the sections that should not be initialized 
by the system startup code. The directive can only be used on zeroinit sections.

The compiler keyword __no_init places variables into sections that must be handled 
by a do not initialize directive.

Example /* Do not initialize read-write sections whose name ends with
   _noinit at program start */
do not initialize { rw section .*_noinit };
place in RAM { rw section .*_noinit };

See also Initialization at system startup, page 77, and Initialize directive, page 323.

Keep directive

Syntax keep
{
  section-selectors
}
[except
 {
   section-selectors
 }];

For information about extended selectors and except clauses, see Section selection, page 
328.

Description The keep directive specifies that all selected sections should be kept in the executable 
image, even if there are no references to the sections.
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Example keep { section .keep* } except {section .keep};

Place at directive

Syntax [ "name": ]
place at { address [ memory: ] expr | start of region_expr |
           end of region_expr }
{
  extended-selectors
}
[except
 {
   section-selectors
 }];

For information about extended selectors and except clauses, see Section selection, page 
328.

Parameters

Description The place at directive places sections and blocks either at a specific address or, at the 
beginning or the end of a region. The same address cannot be used for two different 
place at directives. It is also not possible to use an empty region in a place at 
directive. If placed in a region, the sections and blocks will be placed before any other 
sections or blocks placed in the same region with a place in directive.

The sections and blocks will be placed in the region in an arbitrary order. To specify a 
specific order, use the block directive.

The name, if specified, is used in the map file and in some log messages.

Example /* Place the read-only section .startup at the beginning of the
   code_region */
"START": place at start of ROM { readonly section .startup };

See also Place in directive, page 328.

memory: expr A specific address in a specific memory. The address must be 
available in the supplied memory defined by the define 
memory directive. The memory specifier is optional if there is 
only one memory.

start of region_expr A region expression. The start of the region is used.

end of region_expr A region expression. The end of the region is used.
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Place in directive

Syntax [ "name": ]
place in region-expr
{
  extended-selectors
}
 [except{
   section-selectors
 }];

where region-expr is a region expression, see also Regions, page 317.

and where the rest of the directive selects sections to include in the block. See Section 
selection, page 328.

Description The place in directive places sections and blocks in a specific region. The sections and 
blocks will be placed in the region in an arbitrary order.

To specify a specific order, use the block directive. The region can have several ranges.

The name, if specified, is used in the map file and in some log messages.

Example /* Place the read-only sections in the code_region */
"ROM": place in ROM { readonly };

See also Place at directive, page 327.

Section selection
The purpose of section selection is to specify—by means of section selectors and except 
clauses—the sections that an ILINK directive should be applied to. All sections that 
match one or more of the section selectors will be selected, and none of the sections 
selectors in the except clause, if any. Each section selector can match sections on section 
attributes, section name, and object or library name.

Some directives provide functionality that requires more detailed selection capabilities, 
for example directives that can be applied on both sections and blocks. In this case, the 
extended-selectors are used.
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Section-selectors

Syntax { [ section-selector ][, section-selector...] }

where section-selector is:

 [ section-attribute ][ section-type ][ section sectionname ]
    [object {module | filename} ]

where section-attribute is:

 [ ro [ code | data ] | rw [ code | data ] | zi ]

and where ro, rw, and zi also can be readonly, readwrite, and zeroinit, 
respectively.

And section-type is:

 [ preinit_array | init_array ]

Parameters

Description A section selector selects all sections that match the section attribute, section type, 
section name, and the name of the object, where object is an object file, a library, or an 

ro or readonly Read-only sections.

rw or readwrite Read/write sections.

zi or zeroinit Zero-initialized sections. These sections should be initialized with 
zeros during system startup.

code Sections that contain code.

data Sections that contain data.

preinit_array Sections of the ELF section type SHT_PREINIT_ARRAY.

init_array Sections of the ELF section type SHT_INIT_ARRAY.

sectionname The section name. Two wildcards are allowed: 
? matches any single character
* matches zero or more characters.

module A name in the form objectname(libraryname). Sections 
from object modules where both the object name and the library 
name match their respective patterns are selected. An empty library 
name pattern selects only sections from object files.

filename The name of an object file, a library, or an object in a library. Two 
wildcards are allowed: 
? matches any single character
* matches zero or more characters.
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object in a library. Only up to three of the four conditions can be omitted. If the section 
attribute is omitted, any section will be selected, without restrictions on the section 
attribute. If the section type is omitted, sections of any type will be selected.

If the section name part or the object name part is omitted, sections will be selected 
without restrictions on the section name or object name, respectively.

It is also possible to use only { } without any section selectors, which can be useful 
when defining blocks.

Note that a section selector with narrower scope has higher priority than a more generic 
section selector.

If more than one section selector matches for the same purpose, one of them must be 
more specific. A section selector is more specific than another one if:

● It specifies a section type and the other one does not

● It specifies a section name or object name with no wildcards and the other one does 
not

● There could be sections that match the other selector that also match this one, and 
the reverse is not true.

Example { rw }                      /* Selects all read-write sections */

{ section .mydata* }        /* Selects only .mydata* sections */
/* Selects .mydata* sections available in the object special.o */
{ section .mydata* object special.o }

Assuming a section in an object named foo.o in a library named lib.a, any of these 
selectors will select that section:

object foo.o(lib.a)
object f*(lib*)
object foo.o
object lib.a

Selector 1 Selector 2 More specific

section "foo*” section "f*" Selector 1

section "*x" section "f*" Neither

ro code section "f*” ro section "f*" Selector 1

init_array ro section "xx" Selector 1

section ".intvec” ro section ".int*" Selector 1

section ".intvec” object "foo.o" Neither

Table 41: Examples of section selector specifications 
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See also Initialize directive, page 323, Do not initialize directive, page 326, and Keep directive, 
page 326.

Extended-selectors

Syntax { [ extended-selector ][, extended-selector...] }

where extended-selector is:

 [ first | last ]{ section-selector |
                    block name [ inline-block-def ]|
                    overlay name }

where inline-block-def is:

 [ block-params ] extended-selectors

Parameters

Description In addition to what the section-selector does, extended-selector provides 
functionality for placing blocks or overlays first or last in a set of sections, a block, or 
an overlay. It is also possible to create an inline definition of a block. This means that 
you can get more precise control over section placement.

Example define block First { section .first }; /* Define a block holding
                                          the section .first */
define block Table { first block First }; /* Define a block where
                                             the first is placed
                                             first */

or, equivalently using an inline definition of the block First:

define block Table { first block First { section .first }};

See also Define block directive, page 321, Define overlay directive, page 322, and Place at 
directive, page 327.

first Places the selected name first in the region, block, or overlay.

last Places the selected name last in the region, block, or overlay.

block The name of the block.

overlay The name of the overlay.
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Using symbols, expressions, and numbers
In the linker configuration file, you can also:

● Define and export symbols

The define symbol directive defines a symbol with a specified value that can be 
used in expressions in the configuration file. The symbol can also be exported to be 
used by the application or the debugger. See Define symbol directive, page 332, and 
Export directive, page 333.

● Use expressions and numbers

In the linker configuration file, expressions and numbers are used for specifying 
addresses, sizes, etc. See Expressions, page 333.

Define symbol directive

Syntax define [ exported ] symbol name = expr;

Parameters

Description The define symbol directive defines a symbol with a specified value. The symbol can 
then be used in expressions in the configuration file. The symbols defined in this way 
work exactly like the symbols defined with the option --config_def outside of the 
configuration file.

The define exported symbol variant of this directive is a shortcut for using the 
directive define symbol in combination with the export symbol directive. On the 
command line this would require both a --config_def option and a 
--define_symbol option to achieve the same effect.

Note:

● A symbol cannot be redefined

● Symbols that are either prefixed by _X, where X is a capital letter, or that contain 
__ (double underscore) are reserved for toolset vendors.

Example /* Define the symbol my_symbol with the value 4 */
define symbol my_symbol = 4;

See also Export directive, page 333 and Interaction between ILINK and the application, page 89.

exported Exports the symbol to be usable by the executable image.

name The name of the symbol.

expr The symbol value.
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Export directive

Syntax export symbol name;

Parameters

Description The export directive defines a symbol to be exported, so that it can be used both from 
the executable image and from a global label. The application, or the debugger, can then 
refer to it for setup purposes etc.

Example /* Define the symbol my_symbol to be exported */
export symbol my_symbol;

Expressions

Syntax An expression is built up of the following constituents:

expression binop expression
unop expression
expression ? expression : expression
(expression)
number
symbol
func-operator

where binop is one of these binary operators:

+, -, *, /, %, <<, >>, <, >, ==, !=, &, ^, |, &&, ||

where unop is one of this unary operators:

+, -, !, ~

where number is a number, see Numbers, page 334

where symbol is a defined symbol, see Define symbol directive, page 332 and 
--config_def, page 233

and where func-operator is one of these function-like operators:

name The name of the symbol.

minimum(expr,expr) Returns the smallest of the two parameters.

maximum(expr,expr) Returns the largest of the two parameters.

isempty(r) Returns True if the region is empty, otherwise False.
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where expr is an expression, and r is a region expression, see Region expression, page 
319.

Description In the linker configuration file, an expression is a 65-bit value with the range -2^64 to 
2^64. The expression syntax closely follows C syntax with some minor exceptions. 
There are no assignments, casts, pre- or post-operations, and no address operations (*, 
&, [], ->, and .). Some operations that extract a value from a region expression, etc, use 
a syntax resembling that of a function call. A boolean expression returns 0 (false) or 1 
(true).

Numbers

Syntax nr [nr-suffix]

where nr is either a decimal number or a hexadecimal number (0x... or 0X...).

and where nr-suffix is one of:

K          /* Kilo = (1 << 10) 1024 */
M          /* Mega = (1 << 20) 1048576 */
G          /* Giga = (1 << 30) 1073741824 */
T          /* Tera = (1 << 40) 1099511627776 */
P          /* Peta = (1 << 50) 1125899906842624 */

Description A number can be expressed either by normal C means or by suffixing it with a set of 
useful suffixes, which provides a compact way of specifying numbers.

Example 1024 is the same as 0x400, which is the same as 1K.

isdefinedsymbol(expr-symbol)Returns True if the expression symbol is defined, 
otherwise False.

start(r) Returns the lowest address in the region.

end(r) Returns the highest address in the region.

size(r) Returns the size of the complete region.
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Structural configuration
The structural directives provide means for creating structure within the configuration, 
such as:

● Conditional inclusion

An if directive includes or excludes other directives depending on a condition, 
which makes it possible to have directives for several different memory 
configurations in the same file. See If directive, page 335.

● Dividing the linker configuration file into several different files

The include directive makes it possible to divide the configuration file into several 
logically distinct files. See Include directive, page 336.

If directive

Syntax if (expr) {
  directives
[ } else if (expr) {
  directives ]
[ } else {
  directives ]
}

where expr is an expression, see Expressions, page 333.

Parameters

Description An if directive includes or excludes other directives depending on a condition, which 
makes it possible to have directives for several different memory configurations, for 
example both a banked and non-banked memory configuration, in the same file.

The directives inside an if part, else if part, or an else part are syntax checked and 
processed regardless of whether the conditional expression was true or false, but only 
the directives in the part where the conditional expression was true, or the else part if 
none of the conditions were true, will have any effect outside the if directive. The if 
directives can be nested.

Example See Empty region, page 320.

directives Any ILINK directive.
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Include directive

Syntax include filename;

Parameters

Description The include directive makes it possible to divide the configuration file into several 
logically distinct files. For instance, files that you need to change often and files that you 
seldom edit.

filename A string literal where both / and \ can be used as the directory 
delimiter.
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The compiler places code and data into sections. Based on a configuration 
specified in the linker configuration file, ILINK places sections in memory. 

This chapter lists all predefined sections and blocks that are available for the 
IAR build tools for SH, and gives detailed reference information about each 
section.

For more information about sections, see the chapter Modules and sections, 
page 71.

Summary of sections 
This table lists the sections and blocks that are used by the IAR build tools:

Section Description

.code16.text Holds program code declared _ _code16.

.code20.text Holds program code declared _ _code20.

.code28.text Holds program code declared _ _code28.

.code32.text Holds program code declared _ _code32.

CSTACK Holds the stack used by C or C++ programs.

.data16.bss Holds zero-initialized __data16 static and global variables.

.data16.data Holds __data16 static and global initialized variables.

.data16.data_init Holds initializers for .data16.data sections when the linker 
directive initialize by copy is used.

.data16.noinit Holds __no_init __data16 static and global variables.

.data16.rodata Holds __data16 constant data.

.data20.bss Holds zero-initialized __data20 static and global variables.

.data20.data Holds __data20 static and global initialized variables.

.data20.data_init Holds initializers for .data20.data sections when the linker 
directive initialize by copy is used.

.data20.noinit Holds __no_init __data20 static and global variables.

.data20.rodata Holds __data20 constant data.

.data28.bss Holds zero-initialized __data28 static and global variables.

Table 42: Section summary 
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Summary of sections
In addition to the ELF sections used for your application, the tools use a number of other 
ELF sections for a variety of purposes:

● Sections starting with .debug generally contain debug information in the DWARF 
format

● Sections starting with .iar.debug contain supplemental debug information in an 
IAR format

● The section .comment contains the tools and command lines used for building the 
file

● Sections starting with .rel or .rela contain ELF relocation information

● The section .symtab contains the symbol table for a file

● The section .strtab contains the names of the symbol in the symbol table

● The section .shstrtab contains the names of the sections.

.data28.data Holds __data28 static and global initialized variables.

.data28.data_init Holds initializers for .data28.data sections when the linker 
directive initialize by copy is used.

.data28.noinit Holds __no_init __data28 static and global variables.

.data28.rodata Holds __data28 constant data.

.data32.bss Holds zero-initialized __data32 static and global variables.

.data32.data Holds __data32 static and global initialized variables.

.data32.data_init Holds initializers for .data32.data sections when the linker 
directive initialize by copy is used.

.data32.noinit Holds __no_init __data32 static and global variables.

.data32.rodata Holds __data32 constant data.

.difunct Holds pointers to code, typically C++ constructors, that should be 
executed by the system startup code before main is called.

__DLIB_PERTHREAD Holds variables that contain static states for DLIB modules.

HEAP Holds the heap used for dynamically allocated data.

.iar.dynexit Holds the atexit table.

.inttable Holds the interrupt table (except reset vectors).

.intvec Holds the reset vector table.

.tbr_table Holds the jump table for TBR calls.

Section Description

Table 42: Section summary  (Continued)
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Descriptions of sections and blocks
This section gives reference information about each section, where the:

● Description describes what type of content the section is holding and, where 
required, how the section is treated by the linker

● Memory placement describes memory placement restrictions.

For information about how to allocate sections in memory by modifying the linker 
configuration file, see the Placing code and data—the linker configuration file, page 74.

.code16.text

Description Holds program code declared __code16, except the code for system initialization.

Memory placement 0x00000000-0x00007FFF or 0xFFFF8000-0xFFFFFFFF

See also Using function memory attributes, page 64.

.code20.text

Description Holds program code declared __code20, except the code for system initialization.

Memory placement 0x00000000-0x0007FFFF or 0xFFF80000-0xFFFFFFFF

See also Using function memory attributes, page 64.

.code28.text

Description Holds program code declared __code28, except the code for system initialization.

Memory placement 0x00000000-0x07FFFFFF or 0xF8000000-0xFFFFFFFF

See also Using function memory attributes, page 64.

.code32.text

Description Holds program code declared __code32, except the code for system initialization.

Memory placement This section can be placed anywhere in memory.
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Descriptions of sections and blocks
See also Using function memory attributes, page 64.

CSTACK

Description Block that holds the internal data stack.

Memory placement This block can be placed anywhere in memory.

See also Setting up the stack, page 86.

.data16.bss

Description Holds zero-initialized __data16 static and global variables.

Memory placement 0x00000000-0x00007FFF or 0xFFFF8000-0xFFFFFFFF

See also Memory types, page 57.

.data16.data

Description Holds __data16 static and global initialized variables. In object files, this includes the 
initial values. When the linker directive initialize by copy is used, a corresponding 
.data16.data_init section is created for each .data16.data section, holding the 
possibly compressed initial values.

Memory placement 0x00000000-0x00007FFF or 0xFFFF8000-0xFFFFFFFF

See also Memory types, page 57.

.data16.data_init

Description Holds the possibly compressed initial values for .data16.data sections. This section 
is created by the linker if the initialize by copy linker directive is used.

Memory placement 0x00000000-0x00007FFF or 0xFFFF8000-0xFFFFFFFF

See also Memory types, page 57.
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.data16.noinit

Description Holds static and global __no_init __data16 variables.

Memory placement 0x00000000-0x00007FFF or 0xFFFF8000-0xFFFFFFFF

See also Memory types, page 57.

.data16.rodata

Description Holds __data16 constant data. This can include constant variables, string and 
aggregate literals, etc.

Memory placement 0x00000000-0x00007FFF or 0xFFFF8000-0xFFFFFFFF

See also Memory types, page 57.

.data20.bss

Description Holds zero-initialized __data20 static and global variables.

Memory placement 0x00000000-0x0007FFFF or 0xFFF80000-0xFFFFFFFF

See also Memory types, page 57.

.data20.data

Description Holds __data20 static and global initialized variables. In object files, this includes the 
initial values. When the linker directive initialize by copy is used, a corresponding 
.data20.data_init section is created for each .data20.data section, holding the 
possibly compressed initial values.

Memory placement 0x00000000-0x0007FFFF or 0xFFF80000-0xFFFFFFFF

See also Memory types, page 57.
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.data20.data_init

Description Holds the possibly compressed initial values for .data20.data sections. This section 
is created by the linker if the initialize by copy linker directive is used.

Memory placement 0x00000000-0x0007FFFF or 0xFFF80000-0xFFFFFFFF

See also Memory types, page 57.

.data20.noinit

Description Holds static and global __no_init __data20 variables.

Memory placement 0x00000000-0x0007FFFF or 0xFFF80000-0xFFFFFFFF

See also Memory types, page 57.

.data20.rodata

Description Holds __data20 constant data. This can include constant variables, string and 
aggregate literals, etc.

Memory placement 0x00000000-0x0007FFFF or 0xFFF80000-0xFFFFFFFF

See also Memory types, page 57.

.data28.bss

Description Holds zero-initialized __data28 static and global variables.

Memory placement 0x00000000-0x07FFFFFF or 0xF8000000-0xFFFFFFFF

See also Memory types, page 57.

.data28.data

Description Holds __data28 static and global initialized variables. In object files, this includes the 
initial values. When the linker directive initialize by copy is used, a corresponding 
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.data28.data_init section is created for each .data28.data section, holding the 
possibly compressed initial values.

Memory placement 0x00000000-0x07FFFFFF or 0xF8000000-0xFFFFFFFF

See also Memory types, page 57.

.data28.data_init

Description Holds the possibly compressed initial values for .data28.data sections. This section 
is created by the linker if the initialize by copy linker directive is used.

Memory placement 0x00000000-0x07FFFFFF or 0xF8000000-0xFFFFFFFF

See also Memory types, page 57.

.data28.noinit

Description Holds static and global __no_init __data28 variables.

Memory placement 0x00000000-0x07FFFFFF or 0xF8000000-0xFFFFFFFF

See also Memory types, page 57.

.data28.rodata

Description Holds __data28 constant data. This can include constant variables, string and 
aggregate literals, etc.

Memory placement 0x00000000-0x07FFFFFF or 0xF8000000-0xFFFFFFFF

See also Memory types, page 57.

.data32.bss

Description Holds zero-initialized __data32 static and global variables.

Memory placement This section can be placed anywhere in memory.

See also Memory types, page 57.
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.data32.data

Description Holds __data32 static and global initialized variables. In object files, this includes the 
initial values. When the linker directive initialize by copy is used, a corresponding 
.data32.data_init section is created for each .data32.data section, holding the 
possibly compressed initial values.

Memory placement This section can be placed anywhere in memory.

See also Memory types, page 57.

.data32.data_init

Description Holds the possibly compressed initial values for .data32.data sections. This section 
is created by the linker if the initialize by copy linker directive is used.

Memory placement This section can be placed anywhere in memory.

See also Memory types, page 57.

.data32.noinit

Description Holds static and global __no_init __data32 variables.

Memory placement This section can be placed anywhere in memory.

See also Memory types, page 57.

.data32.rodata

Description Holds __data32 constant data. This can include constant variables, string and 
aggregate literals, etc.

Memory placement This section can be placed anywhere in memory.

See also Memory types, page 57.
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.difunct

Description Holds the dynamic initialization vector used by C++.

Memory placement In the Small data model, this section must be placed in the first 64 Kbytes of memory. 
In other data models, this section can be placed anywhere in memory.

__DLIB_PERTHREAD

Description Holds thread-local static and global initialized variables used by the main thread.

This section is placed automatically. If you change the placement, you must not change 
its initialization. The initialization of this section must be controlled with the 
initialize by copy directive.

Memory placement This section can be placed anywhere in memory.

See also Managing a multithreaded environment, page 118.

HEAP

Description Holds the heap used for dynamically allocated data, in other words data allocated by 
malloc and free, and in C++, new and delete. 

Memory placement This section can be placed anywhere in memory.

See also  Setting up the heap, page 86.

.iar.dynexit

Description Holds the table of calls to be made at exit. 

Memory placement This section can be placed anywhere in memory.

See also Setting up the atexit limit, page 86.

.inttable

Description Holds the interrupt vector table generated by the use of the __interrupt extended 
keyword in combination with the #pragma vector directive.
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.intvec

Description Holds the reset vector table.

Memory placement This section must be placed at address 0x0.

.tbr_table

Description Holds the jump table for TBR calls.

Memory placement This section can be placed anywhere in memory.
DSH-2

IAR C/C++ Development Guide
Compiling and Linking for SH
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This chapter describes the IAR command line utilities that are available:

● The IAR Archive Tool—iarchive—creates and manipulates a library (an 
archive) of several ELF object files

● The IAR ELF Tool—ielftool—performs various transformations on an ELF 
executable image (such as fill, checksum, format conversions, etc)

● The IAR ELF Dumper for SH—ielfdumpsh—creates a text representation 
of the contents of an ELF relocatable or executable image

● The IAR ELF Object Tool—iobjmanip—is used for performing low-level 
manipulation of ELF object files

● The IAR Absolute Symbol Exporter—isymexport—exports absolute 
symbols from a ROM image file, so that they can be used when you link an 
add-on application.

The IAR Archive Tool—iarchive
The IAR Archive Tool, iarchive, can create a library (an archive) file from several 
ELF object files. You can also use iarchaive to manipulate ELF libraries.

A library file contains several relocatable ELF object modules, each of which can be 
independently used by a linker. In contrast with object modules specified directly to the 
linker, each module in a library is only included if it is needed.

For information about how to build a library in the IDE, see the IAR Embedded 
Workbench® IDE User Guide.

INVOCATION SYNTAX

The invocation syntax for the archive builder is:

iarchive parameters
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The IAR Archive Tool—iarchive
Parameters

The parameters are:

Examples

This example creates a library file called mylibrary.a from the source object files 
module1.o, module.2.o, and module3.o:

iarchive mylibrary.a module1.o module2.o module3.o.

This example lists the contents of mylibrary.a:

iarchive --toc mylibrary.a

This example replaces module3.o in the library with the content in the module3.o file 
and appends module4.o to mylibrary.a:

iarchive --replace mylibrary.a module3.o module4.o

SUMMARY OF IARCHIVE COMMANDS

This table summarizes the iarchive commands:

For detailed descriptions, see Descriptions of options, page 361.

Parameter Description

command Command line options that define an operation to be performed. Such 
an option must be specified before the name of the library file.

libraryfile The library file to be operated on.

objectfile1 ...

objectfileN

The object file(s) that the specified command operates on.

options Command line options that define actions to be performed. These 
options can be placed anywhere on the command line.

Table 43: iarchive parameters 

Command line option Description

--create Creates a library that contains the listed object files.

--delete, -d Deletes the listed object files from the library.

--extract, -x Extracts the listed object files from the library.

--replace, -r Replaces or appends the listed object files to the library.

--symbols Lists all symbols defined by files in the library.

--toc, -t Lists all files in the library.

Table 44: iarchive commands summary 
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SUMMARY OF IARCHIVE OPTIONS

This table summarizes the iarchive options:

For detailed descriptions, see Descriptions of options, page 361.

DIAGNOSTIC MESSAGES

This section lists the messages produced by iarchive: 

La001:  could not open file filename

iarchive failed to open an object file.

La002:  illegal path pathname

The path pathname is not a valid path.

La006:  too many parameters to cmd command

A list of object modules was specified as parameters to a command that only accepts a 
single library file.

La007:  too few parameters to cmd command

A command that takes a list of object modules was issued without the expected modules.

La008:  lib is not a library file

The library file did not pass a basic syntax check. Most likely the file is not the intended 
library file.

La009:  lib has no symbol table

The library file does not contain the expected symbol information. The reason might be 
that the file is not the intended library file, or that it does not contain any ELF object 
modules.

Command line option Description

-f Extends the command line.

--output, -o Specifies the library file.

--silent Sets silent operation.

--verbose, -V Reports all performed operations.

Table 45: iarchive options summary 
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La010:  no library parameter given

The tool could not identify which library file to operate on. The reason might be that a 
library file has not been specified.

La011:  file file already exists

The file could not be created because a file with the same name already exists.

La013:  file confusions, lib given as both library and object

The library file was also mentioned in the list of object modules.

La014:  module module not present in archive lib

The specified object module could not be found in the archive.

La015:  internal error

The invocation triggered an unexpected error in iarchive.

Ms003:  could not open file filename for writing

iarchive failed to open the archive file for writing. Make sure that it is not write 
protected.

Ms004:  problem writing to file filename

An error occurred while writing to file filename. A possible reason for this is that the 
volume is full.

Ms005:  problem closing file filename

An error occurred while closing the file filename.

The IAR ELF Tool—ielftool
The IAR ELF Tool, ielftool, can generate a checksum on specific ranges of 
memories. This checksum can be compared with a checksum calculated on your 
application.

The source code for ielftool and a Microsoft VisualStudio 2005 template project are 
available in the sh\src\elfutils directory. If you have specific requirements for how 
the checksum should be generated or requirements for format conversion, you can 
modify the source code accordingly.
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INVOCATION SYNTAX

The invocation syntax for the IAR ELF Tool is:

ielftool [options] inputfile outputfile [options]

The ielftool tool will first process all the fill options, then it will process all the 
checksum options (from left to right).

Parameters

The parameters are:

For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 200.

Example

This example fills a memory range with 0xFF and then calculates a checksum on the 
same range:

ielftool my_input.out my_output.out --fill 0xFF;0–0xFF
           --checksum __checksum:4,crc32;0–0xFF

SUMMARY OF IELFTOOL OPTIONS

This table summarizes the ielftool command line options:

Parameter Description

inputfile An absolute ELF executable image produced by the ILINK linker.

options Any of the available command line options, see Summary of ielftool 
options, page 351.

outputfile An absolute ELF executable image.

Table 46: ielftool parameters 

Command line option Description

--bin Sets the format of the output file to binary.

--checksum Generates a checksum.

--fill Specifies fill requirements.

--ihex Sets the format of the output file to linear Intel hex.

--self_reloc Not for general use.

--silent Sets silent operation.

--simple Sets the format of the output file to Simple code.

--srec Sets the format of the output file to Motorola S-records.

Table 47: ielftool options summary 
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The IAR ELF Dumper for SH—ielfdumpsh
For detailed descriptions, see Descriptions of options, page 361.

The IAR ELF Dumper for SH—ielfdumpsh 
The IAR ELF Dumper for SH, ielfdumpsh, can be used for creating a text 
representation of the contents of a relocatable or absolute ELF file.

ielfdumpsh can be used in one of three ways:

● To produce a listing of the general properties of the input file and the ELF segments 
and ELF sections it contains. This is the default behavior when no command line 
options are used.

● To also include a textual representation of the contents of each ELF section in the 
input file. To specify this behavior, use the command line option --all.

● To produce a textual representation of selected ELF sections from the input file. To 
specify this behavior, use the command line option --section.

INVOCATION SYNTAX

The invocation syntax for ielfdumpsh is:

ielfdumpsh input_file [output_file]

Note: ielfdumpsh is a command line tool which is not primarily intended to be used 
in the IDE.

Parameters

The parameters are:

--srec-len Restricts the number of data bytes in each S-record.

--srec-s3only Restricts the S-record output to contain only a subset of records.

--strip Removes debug information.

--verbose, -V Prints all performed operations.

Command line option Description

Table 47: ielftool options summary  (Continued)

Parameter Description

input_file An ELF relocatable or executable file to use as input.

output_file A file or directory where the output is emitted. If absent and no 
--output option is specified, output is directed to the console.

Table 48: ielfdumpsh parameters 
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For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 200.

SUMMARY OF IELFDUMPSH OPTIONS

This table summarizes the ielfdumpsh command line options:

For detailed descriptions, see Descriptions of options, page 361.

The IAR ELF Object Tool—iobjmanip
Use the IAR ELF Object Tool, iobjmanip, to perform low-level manipulation of ELF 
object files.

INVOCATION SYNTAX

The invocation syntax for the IAR ELF Object Tool is:

iobjmanip options inputfile outputfile

Parameters

The parameters are:

Command line option Description

--all Generates output for all input sections regardless of their names or 
numbers.

--code Dumps all sections that contain executable code.

-f Extends the command line.

--output, -o Specifies an output file.

--no_strtab Suppresses dumping of string table sections.

--raw Uses the generic hexadecimal/ASCII output format for the contents of 
any selected section, instead of any dedicated output format for that 
section.

--section, -s Generates output for selected input sections.

Table 49: ielfdumpsh options summary 

Parameter Description

options Command line options that define actions to be performed. These 
options can be placed anywhere on the command line. At least one of 
the options must be specified.

inputfile A relocatable ELF object file.

Table 50: iobjmanip parameters 
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For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 200.

Examples

This example renames the section .example in input.o to .example2 and stores the 
result in output.o:

iobjmanip --rename_section .example=.example2 input.o output.o

SUMMARY OF IOBJMANIP OPTIONS

This table summarizes the iobjmanip options:

For detailed descriptions, see Descriptions of options, page 361.

DIAGNOSTIC MESSAGES

This section lists the messages produced by iobjmanip: 

Lm001:  No operation given

None of the command line parameters specified an operation to perform.

Lm002:  Expected nr parameters but got nr

Too few or too many parameters. Check invocation syntax for iobjmanip and for the 
used command line options.

Lm003:  Invalid section/symbol renaming pattern pattern

The pattern does not define a valid renaming operation.

outputfile A relocatable ELF object file with all the requested operations applied.

Command line option Description

-f Extends the command line.

--remove_section Removes a section.

--rename_section Renames a section.

--rename_symbol Renames a symbol.

--strip Removes debug information.

Table 51: iobjmanip options summary 

Parameter Description

Table 50: iobjmanip parameters  (Continued)
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Lm004:  Could not open file filename

iobjmanip failed to open the input file.

Lm005:  ELF format error msg

The input file is not a valid ELF object file.

Lm006:  Unsupported section type nr

The object file contains a section that iobjmanip cannot handle. This section will be 
ignored when generating the output file.

Lm007:  Unknown section type nr

iobjmanip encountered an unrecognized section. iobjmanip will try to copy the 
content as is.

Lm008:  Symbol symbol has unsupported format

iobjmanip encountered a symbol that cannot be handled. iobjmanip will ignore this 
symbol when generating the output file.

Lm009:  Group type nr not supported

iobjmanip only supports groups of type GRP_COMDAT. If any other group type is 
encountered, the result is undefined.

Lm010:  Unsupported ELF feature in file: msg

The input file uses a feature that iobjmanip does not support.

Lm011:  Unsupported ELF file type

The input file is not a relocatable object file.

Lm012:  Ambiguous rename for section/symbol name (alt1 and alt2)

An ambiguity was detected while renaming a section or symbol. One of the alternatives 
will be used.

Lm013:  Section name removed due to transitive dependency on 
name

A section was removed as it depends on an explicitly removed section.
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Lm014:  File has no section with index nr

A section index, used as a parameter to --remove_section or --rename_section, 
did not refer to a section in the input file.

Ms003:  could not open file filename for writing

iobjmanip failed to open the output file for writing. Make sure that it is not write 
protected.

Ms004:  problem writing to file filename

An error occurred while writing to file filename. A possible reason for this is that the 
volume is full.

Ms005:  problem closing file filename

An error occurred while closing the file filename.

The IAR Absolute Symbol Exporter—isymexport
The IAR Absolute Symbol Exporter, isymexport, can export absolute symbols from a 
ROM image file, so that they can be used when you link an add-on application.

INVOCATION SYNTAX

The invocation syntax for the IAR Absolute Symbol Exporter is:

isymexport [options] inputfile outputfile [options]
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Parameters

The parameters are:

For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 200.

SUMMARY OF ISYMEXPORT OPTIONS

This table summarizes the isymexport command line options:

For detailed descriptions, see Descriptions of options, page 361.

STEERING FILES

A steering file can be used for controlling which symbols that are included, and also to 
rename some of the symbols if that is desired. In the file, you can use show and hide 
directives to select which public symbols from the input file that are to be included in 
the output file. rename directives can be used for changing the names of symbols in the 
input file.

Syntax

The following syntax rules apply:

Parameter Description

inputfile A ROM image in the form of an executable ELF file (output from 
linking).

options Any of the available command line options, see Summary of isymexport 
options, page 357.

outputfile A relocatable ELF file that can be used as input to linking, and which 
contains all or a selection of the absolute symbols in the input file. The 
output file contains only the symbols, not the actual code or data 
sections. A steering file can be used to control which symbols that are 
included, and also to rename some of the symbols if that is desired. 

Table 52: ielftool parameters 

Command line option Description

--edit Specifies a steering file.

-f Extends the command line.

--ram_reserve_ranges Generates symbols to reserve the areas in RAM that the 
image uses.

--reserve_ranges Generates symbols to reserve the areas in ROM and RAM 
that the image uses.

Table 53: isymexport options summary 
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● Each directive is specified on a separate line.

● C comments (/*...*/) and C++ comments (//...) can be used.

● Patterns can contain wildcard characters that match more than one possible 
character in a symbol name.

● The * character matches any sequence of zero or more characters in a symbol name.

● The ? character matches any single character in a symbol name.

Example

rename xxx_* as YYY_* /*Change symbol prefix from xxx_ to YYY_ */
show YYY_*            /* Export all symbols from YYY package */
hide *_internal       /* But do not export internal symbols */
show zzz?             /* Export zzza, but not zzzaaa */
hide zzzx             /* But do not export zzzx */

Show directive

Syntax show pattern

Parameters

Description A symbol with a name that matches the pattern will be included in the output file unless 
this is overridden by a later hide directive.

Example /* Include all public symbols ending in _pub. */
show *_pub

Hide directive

Syntax hide pattern

Parameters

Description A symbol with a name that matches the pattern will not be included in the output file 
unless this is overridden by a later show directive.

Example /* Do not include public symbols ending in _sys. */
hide *_sys

pattern A pattern to match against a symbol name.

pattern A pattern to match against a symbol name.
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Rename directive

Syntax rename pattern1 pattern2

Parameters

Description Use this directive to rename symbols from the output file to the input file. No exported 
symbol is allowed to match more than one rename pattern.

rename directives can be placed anywhere in the steering file, but they are executed 
before any show and hide directives. Thus, if a symbol will be renamed, all show and 
hide directives in the steering file must refer to the new name.

If the name of a symbol matches a pattern1 pattern that contains no wildcard 
characters, the symbol will be renamed pattern2 in the output file.

If the name of a symbol matches a pattern1 pattern that contains a wildcard character, 
the symbol will be renamed pattern2 in the output file, with part of the name matching 
the wildcard character preserved.

Example /* xxx_start will be renamed Y_start_X in the output file,
   xxx_stop will be renamed Y_stop_X in the output file. */
rename xxx_* Y_*_X

DIAGNOSTIC MESSAGES

This section lists the messages produced by isymexport: 

Es001:  could not open file filename

isymexport failed to open the specified file.

Es002:  illegal path pathname

The path pathname is not a valid path.

Es003:  format error: message

A problem occurred while reading the input file.

pattern1 A pattern used for finding symbols to be renamed. The pattern can 
contain no more than one * or ? wildcard character.

pattern2 A pattern used for the new name for a symbol. If the pattern contains a 
wildcard character, it must be of the same kind as in pattern1.
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Es004:  no input file

No input file was specified.

Es005:  no output file

An input file, but no output file was specified.

Es006:  too many input files

More than two files were specified.

Es007:  input file is not an ELF executable

The input file is not an ELF executable file.

Es008:  unknown directive: directive

The specified directive in the steering file is not recognized.

Es009:  unexpected end of file

The steering file ended when more input was required.

Es010:  unexpected end of line

A line in the steering file ended before the directive was complete.

Es011:  unexpected text after end of directive

There is more text on the same line after the end of a steering file directive.

Es012:  expected text

The specified text was not present in the steering file, but must be present for the 
directive to be correct.

Es013:  pattern can contain at most one * or ?

Each pattern in the current directive can contain at most one * or one ? wildcard 
character.

Es014:  rename patterns have different wildcards

Both patterns in the current directive must contain exactly the same kind of wildcard. 
That is, both must either contain:

● No wildcards
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● Exactly one *

● Exactly one ?

This error occurs if the patterns are not the same in this regard.

Es014:  ambiguous pattern match: symbol matches more than one 
rename pattern

A symbol in the input file matches more than one rename pattern.

Descriptions of options
This section gives detailed reference information about each command line option 
available for the different utilities.

--all

Syntax --all

Tool ielfdumpsh

Description Use this option to include the contents of all ELF sections in the output, in addition to 
the general properties of the input file. Sections are output in index order, except that 
each relocation section is output immediately after the section it holds relocations for.

By default, no section contents are included in the output.

This option is not available in the IDE.

--bin

Syntax --bin

Tool ielftool

Description Sets the format of the output file to binary.

To set related options, choose:

Project>Options>Output converter
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--checksum

Syntax --checksum {symbol[+offset]|address}:size,algorithm[:flags]
[,start];range[;range...]

Parameters

Tool ielftool

Description Use this option to calculate a checksum with the specified algorithm for the specified 
ranges. The checksum will then replace the original value in symbol. A new absolute 
symbol will be generated; with the symbol name suffixed with _value containing the 
calculated checksum. This symbol can be used for accessing the checksum value later 
when needed, for example during debugging.

symbol The name of the symbol where the checksum value should be stored. 
Note that it must exist in the symbol table in the input ELF file.

offset An offset to the symbol.

address The absolute address where the checksum value should be stored.

size The number of bytes in the checksum: 1, 2, or 4; must not be larger 
than the size of the checksum symbol.

algorithm The checksum algorithm used, one of:
• sum, a byte-wise calculated arithmetic sum. The result is truncated to 
8 bits.
• sum8wide, a byte-wise calculated arithmetic sum. The result is 
truncated to the size of the symbol.
• sum32, a word-wise (32 bits) calculated arithmetic sum
• crc16, CRC16 (generating polynomial 0x11021); used by default
• crc32, CRC32 (generating polynomial 0x104C11DB7)
• crc=n, CRC with a generating polynomial of n.

flags 1 specifies one's complement and 2 specifies two's complement. m 
reverses the order of the bits within each byte when calculating the 
checksum. For example, 2m.

start By default, the initial value of the checksum is 0. If necessary, use start 
to supply a different initial value.

range The address range on which the checksum should be calculated. 
Hexadecimal and decimal notation is allowed (for example, 
0x8002–0x8FFF).
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If the --checksum option is used more than once on the command line, the options are 
evaluated from left to right. If a checksum is calculated for a symbol that is specified in 
a later evaluated --checksum option, an error is issued.

To set related options, choose:

Project>Options>Linker>Checksum

--code

Syntax --code

Tool ielfdump

Description Use this option to dump all sections that contain executable code (sections with the ELF 
section attribute SHF_EXECINSTR).

This option is not available in the IDE.

--create

Syntax --create libraryfile objectfile1 ... objectfileN

Parameters

Tool iarchive

Description Use this command to build a new library from a set of object files (modules). The object 
files are added to the library in the exact order that they are specified on the command 
line.

If no command is specified on the command line, --create is used by default.

This option is not available in the IDE.

libraryfile The library file that the command operates on. For information about 
specifying a filename, see Rules for specifying a filename or directory as 
parameters, page 200.

objectfile1 ... 

objectfileN

The object file(s) to build the library from.
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--delete, -d

Syntax --delete libraryfile objectfile1 ... objectfileN
-d libraryfile objectfile1 ... objectfileN

Parameters

Tool iarchive

Description Use this command to remove object files (modules) from an existing library. All object 
files that are specified on the command line will be removed from the library.

This option is not available in the IDE.

--edit

Syntax --edit steering_file

Tool isymexport

Description Use this option to specify a steering file to control which symbols that are included in 
the isymexport output file, and also to rename some of the symbols if that is desired.

See also Steering files, page 357.

This option is not available in the IDE.

--extract, -x

Syntax --extract libraryfile [objectfile1 ... objectfileN]
-x libraryfile [objectfile1 ... objectfileN]

Parameters

libraryfile The library file that the command operates on. For information about 
specifying a filename, see Rules for specifying a filename or directory as 
parameters, page 200.

objectfile1 ... 

objectfileN

The object file(s) that the command operates on.

libraryfile The library file that the command operates on. For information about 
specifying a filename, see Rules for specifying a filename or directory as 
parameters, page 200.
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Tool iarchive

Description Use this command to extract object files (modules) from an existing library. If a list of 
object files is specified, only these files are extracted. If a list of object files is not 
specified, all object files in the library are extracted.

This option is not available in the IDE.

-f

Syntax -f filename

Parameters For information about specifying a filename, see Rules for specifying a filename or 
directory as parameters, page 200.

Tool iarchive, ielfdumpsh, iobjmanip, and isymexport.

Description Use this option to make the tool read command line options from the named file, with 
the default filename extension xcl.

In the command file, you format the items exactly as if they were on the command line 
itself, except that you can use multiple lines, because the newline character acts just as 
a space or tab character.

Both C and C++ style comments are allowed in the file. Double quotes behave in the 
same way as in the Microsoft Windows command line environment.

This option is not available in the IDE.

--fill

Syntax --fill pattern;range[;range...]

Parameters

objectfile1 ... 

objectfileN

The object file(s) that the command operates on.

range Specifies the address range for the fill. Hexadecimal and decimal 
notation is allowed (for example, 0x8002–0x8FFF). Note that each 
address must be 4-byte aligned.
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Applicability ielftool

Description Use this option to fill all gaps in one or more ranges with a pattern, which can be either 
an expression or a hexadecimal string. The contents will be calculated as if the fill 
pattern was repeatedly filled from the start address until the end address is passed, and 
then the real contents will overwrite that pattern.

If the --fill option is used more than once on the command line, the fill ranges cannot 
overlap each other.

To set related options, choose:

Project>Options>Linker>Checksum

--ihex

Syntax --ihex

Tool ielftool

Description Sets the format of the output file to linear Intel hex.

To set related options, choose:

Project>Options>Linker>Output converter

--no_strtab

Syntax --no_strtab

Tool ielfdumpsh

Description Use this option to suppress dumping of string table sections (sections of type 
SHT_STRTAB).

pattern A hexadecimal string with the 0x prefix (for example, 0xEF) 
interpreted as a sequence of bytes, where each pair of digits 
corresponds to one byte (for example 0x123456, for the sequence of 
bytes 0x12, 0x34, and 0x56). This sequence is repeated over the fill 
area. If the length of the fill pattern is greater than 1 byte, it is repeated 
as if it started at address 0. 
DSH-2

IAR C/C++ Development Guide
Compiling and Linking for SH



IAR utilities
This option is not available in the IDE.

--output, -o

Syntax -o {filename|directory} 
--output {filename|directory} 

Parameters For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 200.

Tool iarchive and ielfdumpsh.

Description iarchive

By default, iarchive assumes that the first argument after the iarchive command is 
the name of the destination library. Use this option to explicitly specify a different 
filename for the library.

ielfdumpsh

By default, output from the dumper is directed to the console. Use this option to direct 
the output to a file instead. The default name of the output file is the name of the input 
file with an added id filename extension 

You can also specify the output file by specifying a file or directory following the name 
of the input file.

This option is not available in the IDE.

--ram_reserve_ranges

Syntax --ram_reserve_ranges[=symbol_prefix]

Parameters

Tool isymexport

Description Use this option to generate symbols for the areas in RAM that the image uses. One 
symbol will be generated for each such area. The name of each symbol is based on the 
name of the area and is prefixed by the optional parameter symbol_prefix.

Generating symbols that cover an area in this way prevents the linker from placing other 
content at the affected addresses. This can be useful when linking against an existing 
image.

symbol_prefix The prefix of symbols created by this option.
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If --ram_reserve_ranges is used together with --reserve_ranges, the RAM 
areas will get their prefix from the --ram_reserve_ranges option and the non-RAM 
areas will get their prefix from the --reserve_ranges option.

See also --reserve_ranges, page 370.

This option is not available in the IDE.

--raw

Syntax --raw

Tool ielfdumpsh

Description By default, many ELF sections will be dumped using a text format specific to a 
particular kind of section. Use this option to dump each selected ELF section using the 
generic text format.

The generic text format dumps each byte in the section in hexadecimal format, and 
where appropriate, as ASCII text.

This option is not available in the IDE.

--remove_section

Syntax --remove_section {section|number}

Parameters

Tool iobjmanip

Description Use this option to make iobjmanip omit the specified section when generating the 
output file.

This option is not available in the IDE.

section The section—or sections, if there are more than one section with the 
same name—to be removed.

number The number of the section to be removed. Section numbers can be 
obtained from an object dump created using ielfdumpsh.
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--rename_section

Syntax --rename_section {oldname|oldnumber}=newname

Parameters

Tool iobjmanip

Description Use this option to make iobjmanip rename the specified section when generating the 
output file.

This option is not available in the IDE.

--rename_symbol

Syntax --rename_symbol oldname =newname

Parameters

Tool iobjmanip

Description Use this option to make iobjmanip rename the specified symbol when generating the 
output file.

This option is not available in the IDE.

oldname The section—or sections, if there are more than one section with the 
same name—to be renamed.

oldnumber The number of the section to be renamed. Section numbers can be 
obtained from an object dump created using ielfdumpsh.

newname The new name of the section.

oldname The symbol to be renamed.

newname The new name of the symbol.
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--replace, -r

Syntax --replace libraryfile objectfile1 ... objectfileN
-r libraryfile objectfile1 ... objectfileN

Parameters

Tool iarchive

Description Use this command to replace or add object files (modules) to an existing library. The 
object files specified on the command line either replace existing object files in the 
library (if they have the same name) or are appended to the library.

This option is not available in the IDE.

--reserve_ranges

Syntax --reserve_ranges[=symbol_prefix]

Parameters

Tool isymexport

Description Use this option to generate symbols for the areas in ROM and RAM that the image uses. 
One symbol will be generated for each such area. The name of each symbol is based on 
the name of the area and is prefixed by the optional parameter symbol_prefix.

Generating symbols that cover an area in this way prevents the linker from placing other 
content at the affected addresses. This can be useful when linking against an existing 
image.

If --reserve_ranges is used together with --ram_reserve_ranges, the RAM 
areas will get their prefix from the --ram_reserve_ranges option and the non-RAM 
areas will get their prefix from the --reserve_ranges option.

libraryfile The library file that the command operates on. For information about 
specifying a filename, see Rules for specifying a filename or directory as 
parameters, page 200.

objectfile1 ... 

objectfileN

The object file(s) that the command operates on.

symbol_prefix The prefix of symbols created by this option.
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See also --ram_reserve_ranges, page 367.

This option is not available in the IDE.

--section, -s

Syntax --section section_number|section_name[,...]
--s section_number|section_name[,...]

Parameters

Tool ielfdumpsh

Description Use this option to dump the contents of a section with the specified number, or any 
section with the specified name. If a relocation section is associated with a selected 
section, its contents are output as well.

If you use this option, the general properties of the input file will not be included in the 
output.

You can specify multiple section numbers or names by separating them with commas, 
or by using this option more than once.

By default, no section contents are included in the output.

Example -s 3,17                  /* Sections #3 and #17
-s .debug_frame,42       /* Any sections named .debug_frame and
                            also section #42 */ 

This option is not available in the IDE.

--self_reloc

Syntax --self_reloc

Tool ielftool

Description This option is intentionally not documented as it is not intended for general use.

This option is not available in the IDE.

section_number The number of the section to be dumped.

section_name The name of the section to be dumped.
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--silent

Syntax --silent 
-S (iarchive only)

Tool iarchive and ielftool.

Description Causes the tool to operate without sending any messages to the standard output stream.

By default, ielftool sends various messages via the standard output stream. You can 
use this option to prevent this. ielftool sends error and warning messages to the error 
output stream, so they are displayed regardless of this setting.

This option is not available in the IDE.

--simple

Syntax --simple

Tool ielftool

Description Sets the format of the output file to Simple code.

To set related options, choose:

Project>Options>Output converter

--srec

Syntax --srec

Tool ielftool

Description Sets the format of the output file to Motorola S-records.

To set related options, choose:

Project>Options>Output converter
DSH-2

IAR C/C++ Development Guide
Compiling and Linking for SH



IAR utilities
--srec-len

Syntax --srec-len=length

Parameters

Tool ielftool

Description Restricts the number of data bytes in each S-record. This option can be used in 
combination with the --srec option.

This option is not available in the IDE.

--srec-s3only

Syntax --srec-s3only

Tool ielftool

Description Restricts the S-record output to contain only a subset of records, that is S3 and S7 
records. This option can be used in combination with the --srec option.

This option is not available in the IDE.

--strip

Syntax --strip 

Tool iobjmanip and ielftool.

Description Use this option to remove all sections containing debug information before the output 
file is written.

Note that ielftool needs an unstripped input ELF image. If you use the --strip 
option in the linker, remove it and use the --strip option in ielftool instead.

To set related options, choose:

Project>Options>Linker>Output>Include debug information in output

length The number of data bytes in each S-record.
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--symbols

Syntax --symbols libraryfile

Parameters

Tool iarchive

Description Use this command to list all external symbols that are defined by any object file 
(module) in the specified library, together with the name of the object file (module) that 
defines it.

In silent mode (--silent), this command performs symbol table-related syntax checks 
on the library file and displays only errors and warnings.

This option is not available in the IDE.

--toc, -t

Syntax --toc libraryfile
-t libraryfile

Parameters

Tool iarchive

Description Use this command to list the names of all object files (modules) in a specified library.

In silent mode (--silent), this command performs basic syntax checks on the library 
file, and displays only errors and warnings.

This option is not available in the IDE.

--verbose, -V

Syntax --verbose 
-V (iarchive only)

libraryfile The library file that the command operates on. For information about 
specifying a filename, see Rules for specifying a filename or directory as 
parameters, page 200.

libraryfile The library file that the command operates on. For information about 
specifying a filename, see Rules for specifying a filename or directory as 
parameters, page 200.
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Tool iarchive and ielftool.

Description Use this option to make the tool report which operations it performs, in addition to 
giving diagnostic messages.

This option is not available in the IDE because this setting is always enabled.
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Implementation-defined 
behavior
This chapter describes how IAR Systems handles the implementation-defined 
areas of the C language.

Note: The IAR Systems implementation adheres to a freestanding 
implementation of Standard C. This means that parts of a standard library can 
be excluded in the implementation.

Descriptions of implementation-defined behavior
This section follows the same order as the C standard. Each item includes references to 
the ISO chapter and section (in parenthesis) that explains the implementation-defined 
behavior.

J.3.1 Translation

Diagnostics (3.10, 5.1.1.3)

Diagnostics are produced in the form:

filename,linenumber level[tag]: message

where filename is the name of the source file in which the error was encountered, 
linenumber is the line number at which the compiler detected the error, level is the 
level of seriousness of the message (remark, warning, error, or fatal error), tag is a 
unique tag that identifies the message, and message is an explanatory message, possibly 
several lines.

White-space characters (5.1.1.2)

At translation phase three, each non-empty sequence of white-space characters is 
retained.
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J.3.2 Environment

The character set (5.1.1.2)

The source character set is the same as the physical source file multibyte character set. 
By default, the standard ASCII character set is used. However, if you use the 
--enable_multibytes compiler option, the host character set is used instead.

Main (5.1.2.1)

The function called at program startup is called main. No prototype is declared for 
main, and the only definition supported for main is:

int main(void)

To change this behavior, see Customizing system initialization, page 107.

The effect of program termination (5.1.2.1)

Terminating the application returns the execution to the startup code (just after the call 
to main).

Alternative ways to define main (5.1.2.2.1)

There is no alternative ways to define the main function.

The argv argument to main (5.1.2.2.1)

The argv argument is not supported.

Streams as interactive devices (5.1.2.3)

The streams stdin, stdout, and stderr are treated as interactive devices.

Signals, their semantics, and the default handling (7.14)

In the DLIB library, the set of supported signals is the same as in Standard C. A raised 
signal will do nothing, unless the signal function is customized to fit the application.

Signal values for computational exceptions (7.14.1.1)

In the DLIB library, there are no implementation-defined values that correspond to a 
computational exception.

Signals at system startup (7.14.1.1)

In the DLIB library, there are no implementation-defined signals that are executed at 
system startup.
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Environment names (7.20.4.5)

In the DLIB library, there are no implementation-defined environment names that are 
used by the getenv function.

The system function (7.20.4.6)

The system function is not supported.

J.3.3 Identifiers

Multibyte characters in identifiers (6.4.2)

Additional multibyte characters may not appear in identifiers.

Significant characters in identifiers (5.2.4.1, 6.1.2)

The number of significant initial characters in an identifier with or without external 
linkage is guaranteed to be no less than 200.

J.3.4 Characters

Number of bits in a byte (3.6)

A byte contains 8 bits.

Execution character set member values (5.2.1)

The values of the members of the execution character set are the values of the ASCII 
character set, which can be augmented by the values of the extra characters in the host 
character set.

Alphabetic escape sequences (5.2.2)

The standard alphabetic escape sequences have the values \a–7, \b–8, \f–12, \n–10, 
\r–13, \t–9, and \v–11.

Characters outside of the basic executive character set (6.2.5)

A character outside of the basic executive character set that is stored in a char is not 
transformed.

Plain char (6.2.5, 6.3.1.1)

A plain char is treated as an unsigned char.
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Source and execution character sets (6.4.4.4, 5.1.1.2)

The source character set is the set of legal characters that can appear in source files. By 
default, the source character set is the standard ASCII character set. However, if you use 
the command line option --enable_multibytes, the source character set will be the 
host computer’s default character set.

The execution character set is the set of legal characters that can appear in the execution 
environment. By default, the execution character set is the standard ASCII character set.

However, if you use the command line option --enable_multibytes, the execution 
character set will be the host computer’s default character set. The IAR DLIB Library 
needs a multibyte character scanner to support a multibyte execution character set. See 
Locale, page 113.

Integer character constants with more than one character (6.4.4.4)

An integer character constant that contains more than one character will be treated as an 
integer constant. The value will be calculated by treating the leftmost character as the 
most significant character, and the rightmost character as the least significant character, 
in an integer constant. A diagnostic message will be issued if the value cannot be 
represented in an integer constant.

Wide character constants with more than one character (6.4.4.4)

A wide character constant that contains more than one multibyte character generates a 
diagnostic message.

Locale used for wide character constants (6.4.4.4)

By default, the C locale is used. If the --enable_multibytes compiler option is used, 
the default host locale is used instead.

Locale used for wide string literals (6.4.5)

By default, the C locale is used. If the --enable_multibytes compiler option is used, 
the default host locale is used instead.

Source characters as executive characters (6.4.5)

All source characters can be represented as executive characters.
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J.3.5 Integers

Extended integer types (6.2.5)

There are no extended integer types.

Range of integer values (6.2.6.2)

The representation of integer values are in the two's complement form. The most 
significant bit holds the sign; 1 for negative, 0 for positive and zero. 

See Basic data types, page 250, for information about the ranges for the different integer 
types.

The rank of extended integer types (6.3.1.1)

There are no extended integer types.

Signals when converting to a signed integer type (6.3.1.3)

No signal is raised when an integer is converted to a signed integer type.

Signed bitwise operations (6.5)

Bitwise operations on signed integers work the same way as bitwise operations on 
unsigned integers; in other words, the sign-bit will be treated as any other bit.

J.3.6 Floating point

Accuracy of floating-point operations (5.2.4.2.2)

The accuracy of floating-point operations is unknown.

Rounding behaviors (5.2.4.2.2)

There are no non-standard values of FLT_ROUNDS.

Evaluation methods (5.2.4.2.2)

There are no non-standard values of FLT_EVAL_METHOD.

Converting integer values to floating-point values (6.3.1.4)

When an integral value is converted to a floating-point value that cannot exactly 
represent the source value, the round-to-nearest rounding mode is used (FLT_ROUNDS is 
defined to 1).
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Converting floating-point values to floating-point values (6.3.1.5)

When a floating-point value is converted to a floating-point value that cannot exactly 
represent the source value, the round-to-nearest rounding mode is used (FLT_ROUNDS is 
defined to 1).

Denoting the value of floating-point constants (6.4.4.2)

The round-to-nearest rounding mode is used (FLT_ROUNDS is defined to 1).

Contraction of floating-point values (6.5)

Floating-point values are contracted. However, there is no loss in precision and because 
signaling is not supported, this does not matter.

Default state of FENV_ACCESS (7.6.1)

The default state of the pragma directive FENV_ACCESS is OFF.

Additional floating-point mechanisms (7.6, 7.12)

There are no additional floating-point exceptions, rounding-modes, environments, and 
classifications.

Default state of FP_CONTRACT (7.12.2)

The default state of the pragma directive FP_CONTRACT is OFF.

J.3.7 Arrays and pointers

Conversion from/to pointers (6.3.2.3)

See Casting, page 255, for information about casting of data pointers and function 
pointers.

ptrdiff_t (6.5.6)

For information about ptrdiff_t, see ptrdiff_t, page 255.

J.3.8 Hints

Honoring the register keyword (6.7.1)

User requests for register variables are not honored.
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Inlining functions (6.7.4)

User requests for inlining functions increases the chance, but does not make it certain, 
that the function will actually be inlined into another function. See the pragma directive 
inline, page 282.

J.3.9 Structures, unions, enumerations, and bitfields

Sign of 'plain' bitfields (6.7.2, 6.7.2.1)

For information about how a 'plain' int bitfield is treated, see Bitfields, page 251.

Possible types for bitfields (6.7.2.1)

All integer types can be used as bitfields in the compiler’s extended mode, see -e, page 
213.

Bitfields straddling a storage-unit boundary (6.7.2.1)

A bitfield is always placed in one—and one only—storage unit, which means that the 
bitfield cannot straddle a storage-unit boundary.

Allocation order of bitfields within a unit (6.7.2.1)

For information about how bitfields are allocated within a storage unit, see Bitfields, 
page 251.

Alignment of non-bitfield structure members (6.7.2.1)

The alignment of non-bitfield members of structures is the same as for the member 
types, see Alignment, page 249.

Integer type used for representing enumeration types (6.7.2.2)

The chosen integer type for a specific enumeration type depends on the enumeration 
constants defined for the enumeration type. The chosen integer type is the smallest 
possible.

J.3.10 Qualifiers

Access to volatile objects (6.7.3)

Any reference to an object with volatile qualified type is an access, see Declaring 
objects volatile, page 258.
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J.3.11 Preprocessing directives

Mapping of header names (6.4.7)

Sequences in header names are mapped to source file names verbatim. A backslash '\' 
is not treated as an escape sequence. See Overview of the preprocessor, page 301.

Character constants in constant expressions (6.10.1)

A character constant in a constant expression that controls conditional inclusion 
matches the value of the same character constant in the execution character set.

The value of a single-character constant (6.10.1)

A single-character constant may only have a negative value if a plain character (char) 
is treated as a signed character, see --char_is_signed, page 205.

Including bracketed filenames (6.10.2)

For information about the search algorithm used for file specifications in angle brackets 
<>, see Include file search procedure, page 191.

Including quoted filenames (6.10.2)

For information about the search algorithm used for file specifications enclosed in 
quotes, see Include file search procedure, page 191.

Preprocessing tokens in #include directives (6.10.2)

Preprocessing tokens in an #include directive are combined in the same way as outside 
an #include directive.

Nesting limits for #include directives (6.10.2)

There is no explicit nesting limit for #include processing.

Universal character names (6.10.3.2)

Universal character names (UCN) are not supported.

Recognized pragma directives (6.10.6)

In addition to the pragma directives described in the chapter Pragma directives, the 
following directives are recognized and will have an indeterminate effect. If a pragma 
directive is listed both in the Pragma directives chapter and here, the information 
provided in the Pragma directives chapter overrides the information here.

alignment
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baseaddr

building_runtime

can_instantiate

codeseg

cspy_support

define_type_info

do_not_instantiate

early_dynamic_initialization

function

hdrstop

important_typedef

instantiate

keep_definition

memory

module_name

no_pch

once 

public_equ

system_include

warnings

Default __DATE__ and __TIME__ (6.10.8)

The definitions for __TIME__ and __DATE__ are always available.

J.3.12 Library functions

Additional library facilities (5.1.2.1)

Most of the standard library facilities are supported. Some of them—the ones that need 
an operating system—requiere a low-level implementation in the application. For more 
details, see The DLIB runtime environment, page 93.

Diagnostic printed by the assert function (7.2.1.1)

The assert() function prints:

filename:linenr expression -- assertion failed

when the parameter evaluates to zero.
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Representation of the floating-point status flags (7.6.2.2)

For information about the floating-point status flags, see fenv.h, page 312.

Feraiseexcept raising floating-point exception (7.6.2.3)

For information about the feraiseexcept function raising floating-point exceptions, 
see fenv.h, page 312.

Strings passed to the setlocale function (7.11.1.1)

For information about strings passed to the setlocale function, see Locale, page 113.

Types defined for float_t and double_t (7.12)

The FLT_EVAL_METHOD macro can only have the value 0.

Domain errors (7.12.1)

No function generates other domain errors than what the standard requires.

Return values on domain errors (7.12.1)

Mathematics functions return a floating-point NaN (not a number) for domain errors.

Underflow errors (7.12.1)

Mathematics functions set errno to the macro ERANGE (a macro in errno.h) and 
return zero for underflow errors.

fmod return value (7.12.10.1)

The fmod function returns a floating-point NaN when the second argument is zero.

The magnitude of remquo (7.12.10.3)

The magnitude is congruent modulo INT_MAX.

signal() (7.14.1.1)

The signal part of the library is not supported. 

Note: Low-level interface functions exist in the library, but will not perform anything. 
Use the template source code to implement application-specific signal handling. See 
Signal and raise, page 116.
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NULL macro (7.17)

The NULL macro is defined to 0.

Terminating newline character (7.19.2)

stdout stream functions recognize either newline or end of file (EOF) as the 
terminating character for a line.

Space characters before a newline character (7.19.2)

Space characters written to a stream immediately before a newline character are 
preserved.

Null characters appended to data written to binary streams (7.19.2)

No null characters are appended to data written to binary streams.

File position in append mode (7.19.3)

The file position is initially placed at the beginning of the file when it is opened in 
append-mode.

Truncation of files (7.19.3)

Whether a write operation on a text stream causes the associated file to be truncated 
beyond that point, depends on the application-specific implementation of the low-level 
file routines. See File input and output, page 112.

File buffering (7.19.3)

An open file can be either block-buffered, line-buffered, or unbuffered.

A zero-length file (7.19.3)

Whether a zero-length file exists depends on the application-specific implementation of 
the low-level file routines.

Legal file names (7.19.3)

The legality of a filename depends on the application-specific implementation of the 
low-level file routines.

Number of times a file can be opened (7.19.3)

Whether a file can be opened more than once depends on the application-specific 
implementation of the low-level file routines.
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Multibyte characters in a file (7.19.3)

The encoding of multibyte characters in a file depends on the application-specific 
implementation of the low-level file routines.

remove() (7.19.4.1)

The effect of a remove operation on an open file depends on the application-specific 
implementation of the low-level file routines. See File input and output, page 112.

rename() (7.19.4.2)

The effect of renaming a file to an already existing filename depends on the 
application-specific implementation of the low-level file routines. See File input and 
output, page 112.

Removal of open temporary files (7.19.4.3)

Whether an open temporary file is removed depends on the application-specific 
implementation of the low-level file routines.

Mode changing (7.19.5.4)

freopen closes the named stream, then reopens it in the new mode. The streams stdin, 
stdout, and stderr can be reopened in any new mode.

Style for printing infinity or NaN  (7.19.6.1, 7.24.2.1)

The style used for printing infinity or NaN for a floating-point constant is inf and nan 
(INF and NAN for the F conversion specifier), respectively. The n-char-sequence is not 
used for nan.

%p in printf() (7.19.6.1, 7.24.2.1)

The argument to a %p conversion specifier, print pointer, to printf() is treated as 
having the type void *. The value will be printed as a hexadecimal number, similar to 
using the %x conversion specifier.

Reading ranges in scanf (7.19.6.2, 7.24.2.1)

A - (dash) character is always treated as a range symbol.

%p in scanf (7.19.6.2, 7.24.2.2)

The %p conversion specifier, scan pointer, to scanf() reads a hexadecimal number and 
converts it into a value with the type void *.
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File position errors (7.19.9.1, 7.19.9.3, 7.19.9.4)

On file position errors, the functions fgetpos, ftell, and fsetpos store EFPOS in 
errno.

An n-char-sequence after nan (7.20.1.3, 7.24.4.1.1)

An n-char-sequence after a NaN is read and ignored.

errno value at underflow (7.20.1.3, 7.24.4.1.1)

errno is set to ERANGE if an underflow is encountered.

Zero-sized heap objects (7.20.3)

A request for a zero-sized heap object will return a valid pointer and not a null pointer.

Behavior of abort and exit (7.20.4.1, 7.20.4.4)

A call to abort() or _Exit() will not flush stream buffers, not close open streams, and 
not remove temporary files.

Termination status (7.20.4.1, 7.20.4.3, 7.20.4.4)

The termination status will be propagated to __exit() as a parameter. exit() and 
_Exit() use the input parameter, whereas abort uses EXIT_FAILURE.

The system function return value (7.20.4.6)

The system function is not supported.

The time zone (7.23.1)

The local time zone and daylight savings time must be defined by the application. For 
more information, see Time, page 117.

Range and precision of time (7.23)

The implementation uses signed long for representing clock_t and time_t, based 
at the start of the year 1970. This gives a range of approximately plus or minus 69 years 
in seconds. However, the application must supply the actual implementation for the 
functions time and clock. See Time, page 117.

clock() (7.23.2.1)

The application must supply an implementation of the clock function. See Time, page 
117.
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%Z replacement string (7.23.3.5, 7.24.5.1)

By default, ":" is used as a replacement for %Z. Your application should implement the 
time zone handling. See Time, page 117.

Math functions rounding mode (F.9)

The functions in math.h honor the rounding direction mode in FLT-ROUNDS.

J.3.13 Architecture

Values and expressions assigned to some macros (5.2.4.2, 7.18.2, 
7.18.3)

There are always 8 bits in a byte.

MB_LEN_MAX is at the most 6 bytes depending on the library configuration that is used.

For information about sizes, ranges, etc for all basic types, see Data representation, page 
249.

The limit macros for the exact-width, minimum-width, and fastest minimum-width 
integer types defined in stdint.h have the same ranges as char, short, int, long, 
and long long.

The floating-point constant FLT_ROUNDS has the value 1 (to nearest) and the 
floating-point constant FLT_EVAL_METHOD has the value 0 (treat as is).

The number, order, and encoding of bytes (6.2.6.1)

See Data representation, page 249.

The value of the result of the sizeof operator (6.5.3.4)

See Data representation, page 249.

J.4 Locale

Members of the source and execution character set (5.2.1)

By default, the compiler accepts all one-byte characters in the host’s default character 
set. If the compiler option --enable_multibytes is used, the host multibyte 
characters are accepted in comments and string literals as well.
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The meaning of the additional character set (5.2.1.2)

Any multibyte characters in the extended source character set is translated verbatim into 
the extended execution character set. It is up to your application with the support of the 
library configuration to handle the characters correctly.

Shift states for encoding multibyte characters (5.2.1.2)

Using the compiler option --enable_multibytes enables the use of the host’s default 
multibyte characters as extended source characters.

Direction of successive printing characters (5.2.2)

The application defines the characteristics of a display device.

The decimal point character (7.1.1)

The default decimal-point character is a '.'. You can redefine it by defining the library 
configuration symbol _LOCALE_DECIMAL_POINT.

Printing characters (7.4, 7.25.2)

The set of printing characters is determined by the chosen locale.

Control characters (7.4, 7.25.2)

The set of control characters is determined by the chosen locale.

Characters tested for (7.4.1.2, 7.4.1.3, 7.4.1.7, 7.4.1.9, 7.4.1.10, 
7.4.1.11, 7.25.2.1.2, 7.25.5.1.3, 7.25.2.1.7, 7.25.2.1.9, 7.25.2.1.10, 
7.25.2.1.11)

The sets of characters tested are determined by the chosen locale.

The native environment (7.1.1.1)

The native environment is the same as the "C" locale.

Subject sequences for numeric conversion functions (7.20.1, 
7.24.4.1)

There are no additional subject sequences that can be accepted by the numeric 
conversion functions.

The collation of the execution character set (7.21.4.3, 7.24.4.4.2)

The collation of the execution character set is determined by the chosen locale.
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Message returned by strerror (7.21.6.2)

The messages returned by the strerror function depending on the argument is:

Argument Message

EZERO no error

EDOM domain error

ERANGE range error

EFPOS file positioning error

EILSEQ multi-byte encoding error

<0 || >99 unknown error

all others error nnn

Table 54: Message returned by strerror()—IAR DLIB library
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